Preface

• Change History, on page iii
• About This Guide, on page iv
• Audience, on page iv
• Related Documents, on page iv
• Communications, Services, and Additional Information, on page iv
• Documentation Feedback, on page v

Change History

This table lists changes made to this guide. Most recent changes appear at the top.

<table>
<thead>
<tr>
<th>Change</th>
<th>See</th>
<th>Date</th>
</tr>
</thead>
<tbody>
<tr>
<td>Updated Unified CVP Security based on TAC comments</td>
<td>Unified CVP Security</td>
<td>Nov 3, 2017</td>
</tr>
<tr>
<td><strong>Initial Release of Document for Release 11.6(1)</strong></td>
<td></td>
<td>August 2017</td>
</tr>
<tr>
<td>Added a new section for configuring CVP Security</td>
<td>Unified CVP Security</td>
<td></td>
</tr>
<tr>
<td>Added a new section for VRU-Only Call Flow Model</td>
<td>Configure Cisco VVB Settings for VRU-Only Call Flow Model</td>
<td></td>
</tr>
<tr>
<td>Added new steps for configuration TLS (SIP)/SRTP</td>
<td>Cisco VVB Configuration</td>
<td></td>
</tr>
<tr>
<td>Added new steps to enable active/standby VXML Server feature</td>
<td>VXML Server Settings</td>
<td></td>
</tr>
<tr>
<td>Updated the Location of Media Files figure</td>
<td>Media Server Settings</td>
<td></td>
</tr>
<tr>
<td>Updated the SIP app-info header information</td>
<td>Gateway Settings</td>
<td></td>
</tr>
</tbody>
</table>
About This Guide

The Configuration Guide for Cisco Unified Customer Voice Portal provides the following information:

- Configuration of Cisco Unified Customer Voice Portal (CVP) components and additional solution components involved in the Unified CVP call path.
- Configuration of high availability and single node for CVP components.

Audience

This guide is intended for managers, Unified CVP system managers, Cisco Unified Intelligent Contact Management Enterprise (Unified ICME)/Cisco Unified Intelligent Management Hosted (Unified ICMH) system managers, VoIP technical experts, and IVR application developers, who are familiar with the following:

- Configuring Cisco Gateways
- Configuring Cisco Unified Communications Manager
- ICM Configuration Manager and ICM Script Editor tools for call center operations and management

Related Documents

- Compatibility Matrix for Unified CCE
- Feature Guide - Writing Scripts for Unified Customer Voice Portal

Communications, Services, and Additional Information

- To receive timely, relevant information from Cisco, sign up at Cisco Profile Manager.
- To get the business impact you’re looking for with the technologies that matter, visit Cisco Services.
- To submit a service request, visit Cisco Support.
- To discover and browse secure, validated enterprise-class apps, products, solutions and services, visit Cisco Marketplace.
- To obtain general networking, training, and certification titles, visit Cisco Press.
- To find warranty information for a specific product or product family, access Cisco Warranty Finder.
Cisco Bug Search Tool

Cisco Bug Search Tool (BST) is a web-based tool that acts as a gateway to the Cisco bug tracking system that maintains a comprehensive list of defects and vulnerabilities in Cisco products and software. BST provides you with detailed defect information about your products and software.

Documentation Feedback

Provide your comments about this document to: mailto:contactcenterproducts_docfeedback@cisco.com.
CONTENTS

PREFACE

Preface iii
Change History iii
About This Guide iv
Audience iv
Related Documents iv
Communications, Services, and Additional Information iv
Documentation Feedback v

CHAPTER 1

Preconfiguration 1
Prerequisites for Call Flow Model Configuration 1
Design Prerequisites 1
Preconfiguration Tasks 1
Network Information 2
Unified CVP Installation 3
Route Calls Through the Network to the VRU 4
Ethernet Switch/Server NIC, Gateways and Call Server Settings 4
Call Server and VXML Gateway in Different Subnets 5
Trunk Utilization and Reporting 5
DS0 Trunk Information 5
Trunk Utilization Routing and Reporting 6
Apply Contact Center Gateway Debug Settings 7
Network VRU Types 8
SIP Dialed Number Pattern Matching Algorithm 9
Additional Configuration Instructions 9
Order of Device Operations 10
Manage Devices 11
CHAPTER 2

Unified CVP Call Flow Models 13
  Common Tasks for Unified CVP Call Flow Models 13
  Call Services for Call Flow Models 13
  Standalone Call Flow Model 14
    Configure VXML Server Standalone Call Flow Model 16
    Enable Reporting for Standalone Call Flow Model 17
    Enable ICM Lookup for Standalone Call Flow Model 18
  Comprehensive Call Flow Model 19
    Comprehensive Call Flow Model for ICME 20
    Comprehensive Call Flow Model for ICMH 22
    Set Up Comprehensive Call Flow Model Using SIP for ICME and ICMH 25
    DNS Zone File Configuration for Comprehensive Call Flow Model 30
    REFER Transfers 32
  Comprehensive Call Flows for Pre-Routed Calls 33
    Calls Arriving at ICME Through a Pre-Route-Only NIC 34
    Calls Originated by Unified CM 35
    Calls Originated by an ACD or Call Routing Interface 38
  Call Director Call Flow Model 41
    Call Director Call Flow Model for Unified ICME 42
    Call Director Call Flow Model for Unified ICMH 43
    Set Up Call Director Call Flow Model 44
    Examples: Ingress Gateway Configuration 50
    DNS Zone File Configuration for Call Director Call Flow Model 52
  VRU-Only Call Flow Model with NIC Routing 53
    Type 8 VRU-Only Call Flow Model for ICME 54
    Type 8 VRU-Only Call Flow Model for ICMH 55
    Set Up Type 8 VRU-Only Call Flow Model for ICME and ICMH 56
    Type 7 VRU-Only Call Flow Model Network VRU for ICMH 61
    Set Up Type 3 or 7 VRU-Only Call Flow Model Network VRU for ICMH 62
    Set Up sendtooriginator Setting in the SIP Service of a Call Server 65

CHAPTER 3

Operations Console 67
  Sign In to Operations Console 67
CHAPTER 4  Call Server Configuration  77
  Configure Call Server  77
  Call Server Settings  78
    General Settings  78
    ICM Service Settings  79
    SIP Service Settings  82
      Ring No Answer Settings with SIP  94
      Valid Format for Dialed Numbers  94
    IVR Service Settings  94
    Device Pool  97
      Add or Remove Device From Device Pool  98
    Infrastructure Service Settings  98
      License Thresholds  101

CHAPTER 5  VXML Server Configuration  103
  Configure VXML Server (Standalone)  103
  Configure VXML Server  104
  Configure VXML Server (Standalone) with ICM Lookup Call Flow Model  105
  Configure the Unified CVP VXML Server (Standalone) Call Flow Model (Without ICM Lookup)  107
  Takeback and Transfer in VoiceXML Scripts  108
    Configure Two B-Channel Transfer  109
    Configure Hookflash Relay  110
    Configure SIP REFER  111
  VXML Server Settings  112
    General Settings  112
    Configuration Settings  113
    Add VXML Server to Device Pool  115
    Infrastructure Service Settings  115
  Enable Active and Standby VXML Server  118
### CHAPTER 6 Reporting Server Configuration

Configure Reporting Server 127

Reporting Server Settings 128
- General Settings 128
- Reporting Properties Settings 129
- Infrastructure Settings 130

### CHAPTER 7 Unified ICM Configuration

Configure Unified ICM Server 133

ICM Server Settings 134
- General Settings 134
- Add Unified ICM to Device Pool 134

Configure ICM Settings for Standalone Call Flow Model 134

Configure ICM Settings for Comprehensive Call Flow Model for ICME and ICMH 136
- Configure Common Unified ICMH for Unified CVP Switch Leg 140
- Define Unified CVP ECC Variables 141
- Metadata ECC Variable 147

Configure ICM Settings for Differentiating VRUs Based on Dialed Number 148

Configure ICM Settings for Call Director Call Flow Model 149

Configure ICM Settings for VRU-Only Call Flow Model: Type 8 151

Configure ICM Settings for VRU-Only Call Flow Model: Type 7 157
CHAPTER 8  Unified Communications Manager Configuration  163
  Configure Unified Communications Manager Server  163
  Unified CM Settings  164
    General Settings  164

CHAPTER 9  SIP Devices Configuration  167
  Set Up Ingress Gateway to Use Redundant Proxy Servers  167
  Set Up Call Server with Redundant Proxy Servers  167
  Local SRV File Configuration Example for SIP Messaging Redundancy  168
  Load-Balancing SIP Calls  168
  Cisco Unified SIP Proxy (CUSP) Configuration  168
  Configure Custom Streaming Ringtones  171

CHAPTER 10  Media Server Configuration  175
  Configure Media Server  175
  Media Server Settings  176
    General Settings  176
    Media File Names and Types  177
    Location of Media Files  178
    Media File Address  178
    Locale Backward Compatibility  181
    System Media Files  182
      Miscellaneous Files  197
      System Media File Error Messages  199
  Unified CVP Microapplication Configuration  200

CHAPTER 11  Speech Server Configuration  201
  Configure Speech Server  201
Speech Server Settings 202
General Settings 202
Generate G729 Prompts for Unified CVP 203
Convert the Audio Files from G.711 to G.729 Format 203
Change the G.729 Compression Identifier in the File Header 203

Configuration 204

**CHAPTER 12**

**Gateway Configuration** 205
Configure Gateway 205
Gateway Settings 206
General Settings 206
Activate Gateway Configuration 207
Add Gateway to Device Pool 207
Configure Gateway Settings for Standalone Call Flow Model 207
Example: Gateway Settings for Standalone Call Flow Model 208
Example: Dial-Peer for Standalone Call Flow Model 210
Configure Gateway Settings for Comprehensive Call Flow Model 210
Configure Gateway Settings for Call Director Call Flow Model 220
Configure Gateway Settings for VRU-Only Call Flow Model: Type 8 224
Configure Gateway Settings for VRU-Only: Type 7 226
Transfer Script and Media File to Gateway 228
VoiceXML Gateway 229
Configuration 230
Centralized VoiceXML Gateways 230
SIP VoiceXML Gateways 230
High-Availability Hardware Configuration on Voice Gateways 230
Distributed VoiceXML Gateways 231
SIP VoiceXML Gateways 231
Cache Types 233

**CHAPTER 13**

**Cisco VVB Configuration** 235
Configure Cisco VVB on Unified CVP 235
Configure Cisco VVB Call Flow 237
Configure Cisco VVB Settings for Standalone Call Flow Model 238
Configure Cisco VVB Settings for Comprehensive Call Flow Model 239
Configure Cisco VVB Settings for VRU-Only Call Flow Model 241
Configure Error Application 243
Configure SIP Triggers 244
  Add SIP Trigger 244
Configure SIP Properties 245
Configure SIP RAI 246
Configure Speech Servers 246
  Prepare to Provision ASR/TTS 247
  Provision ASR Servers 247
  Provision TTS Servers 248
Configure Prompt Management 249
  Manage Prompt Files 249
  Local Audio Files Stored on VVB 250
  Overriding Default Ringtone using CVP 250
Configure System Parameters 251
  Manage System Parameters 251
IP Address and Hostname Management 254
  IP Address Modification 254
    Change IP Address using CLI Commands 254
    Change IP Address using OS Administration interface 255
  Hostname Modification 255
    Change Hostname 256
    Change Hostname using OS Administration interface 256
Configure Reporting and Monitoring Services 257
  Real-Time Monitoring Tool 257
  Real-Time Reporting 257
  Logging 258
  Service Management 259
Cisco VVB Real-Time Reports 259
  Available Cisco VVB Real-Time Reports 260
  Open Real-Time Reports 260
  Run Reports 261
  View Detailed Subreports 261
## Contents

<table>
<thead>
<tr>
<th>Chapter</th>
<th>Section</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Print Reports</td>
<td>262</td>
</tr>
<tr>
<td></td>
<td>Reset Report Statistics</td>
<td>262</td>
</tr>
<tr>
<td></td>
<td>Set Report Options</td>
<td>262</td>
</tr>
<tr>
<td></td>
<td>Set Report Appearance</td>
<td>263</td>
</tr>
<tr>
<td></td>
<td>Application Reporting User Interface</td>
<td>263</td>
</tr>
<tr>
<td></td>
<td>Report Menu</td>
<td>264</td>
</tr>
<tr>
<td></td>
<td>Tools Menu</td>
<td>269</td>
</tr>
<tr>
<td></td>
<td>Views Menu</td>
<td>270</td>
</tr>
<tr>
<td></td>
<td>Settings Menu</td>
<td>271</td>
</tr>
<tr>
<td></td>
<td><strong>CHAPTER 14</strong> &lt;br&gt; <strong>SIP Proxy Server Configuration</strong></td>
<td>273</td>
</tr>
<tr>
<td></td>
<td>Configure SIP Proxy Server</td>
<td>273</td>
</tr>
<tr>
<td></td>
<td>SIP Proxy Server Settings</td>
<td>273</td>
</tr>
<tr>
<td></td>
<td>General Settings</td>
<td>273</td>
</tr>
<tr>
<td></td>
<td>Add SIP Proxy Server to Device Pool</td>
<td>275</td>
</tr>
<tr>
<td></td>
<td>Configuration</td>
<td>276</td>
</tr>
<tr>
<td></td>
<td><strong>CHAPTER 15</strong> &lt;br&gt; <strong>Unified CM SME Configuration</strong></td>
<td>277</td>
</tr>
<tr>
<td></td>
<td>Enable Session Refresh</td>
<td>277</td>
</tr>
<tr>
<td></td>
<td>Enable Session Timer</td>
<td>277</td>
</tr>
<tr>
<td></td>
<td>Configure Media Inactivity Timer in Cisco IOS Gateway</td>
<td>278</td>
</tr>
<tr>
<td></td>
<td>Configure SIP Trunk from SME to Unified CM Leaf Cluster</td>
<td>278</td>
</tr>
<tr>
<td></td>
<td>Configure SIP Trunk from Unified CM Leaf Cluster to SME</td>
<td>278</td>
</tr>
<tr>
<td></td>
<td><strong>CHAPTER 16</strong> &lt;br&gt; <strong>System Configuration</strong></td>
<td>279</td>
</tr>
<tr>
<td></td>
<td>System Tab Options</td>
<td>279</td>
</tr>
<tr>
<td></td>
<td>Import System Configuration</td>
<td>280</td>
</tr>
<tr>
<td></td>
<td>Export System Configuration</td>
<td>281</td>
</tr>
<tr>
<td></td>
<td>Location Configuration</td>
<td>282</td>
</tr>
<tr>
<td></td>
<td>Prerequisites for Location Configuration</td>
<td>286</td>
</tr>
<tr>
<td></td>
<td>Deploy Location Information</td>
<td>286</td>
</tr>
<tr>
<td></td>
<td>Add Location</td>
<td>286</td>
</tr>
<tr>
<td></td>
<td>SIP Server Group Configuration</td>
<td>287</td>
</tr>
<tr>
<td></td>
<td>Add SIP Server Groups</td>
<td>287</td>
</tr>
</tbody>
</table>
## Contents

<table>
<thead>
<tr>
<th>Section</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>General Settings</td>
<td>288</td>
</tr>
<tr>
<td>Heartbeat Properties Settings</td>
<td>288</td>
</tr>
<tr>
<td>Deploy Call Server</td>
<td>292</td>
</tr>
<tr>
<td>Dialed Number Pattern Configuration</td>
<td>293</td>
</tr>
<tr>
<td>Add and Deploy Dialed Number Pattern</td>
<td>294</td>
</tr>
<tr>
<td>Web Services Configuration</td>
<td>296</td>
</tr>
<tr>
<td>Deploy Web Services</td>
<td>297</td>
</tr>
<tr>
<td>IOS Configuration</td>
<td>297</td>
</tr>
<tr>
<td>IOS Template Format</td>
<td>298</td>
</tr>
<tr>
<td>IOS Template Management</td>
<td>300</td>
</tr>
<tr>
<td>Add New Template</td>
<td>300</td>
</tr>
<tr>
<td>Delete Template</td>
<td>300</td>
</tr>
<tr>
<td>Edit Templates</td>
<td>301</td>
</tr>
<tr>
<td>Copy Templates</td>
<td>301</td>
</tr>
<tr>
<td>IOS Template Deployment</td>
<td>302</td>
</tr>
<tr>
<td>Preview and Deploy Template</td>
<td>302</td>
</tr>
<tr>
<td>Check Deployment Status</td>
<td>303</td>
</tr>
<tr>
<td>Roll Back Deployment</td>
<td>303</td>
</tr>
<tr>
<td>IOS Gateway Configuration</td>
<td>303</td>
</tr>
<tr>
<td>Courtesy Callback</td>
<td>305</td>
</tr>
<tr>
<td>Callback Criteria</td>
<td>305</td>
</tr>
<tr>
<td>Modifiable Example Scripts and Sample Audio Files</td>
<td>306</td>
</tr>
<tr>
<td>Courtesy Callback Configuration</td>
<td>307</td>
</tr>
<tr>
<td>Configure Courtesy Callback</td>
<td>307</td>
</tr>
<tr>
<td>Configure Ingress Gateway for Courtesy Callback</td>
<td>309</td>
</tr>
<tr>
<td>Configure VXML Gateway for Courtesy Callback</td>
<td>311</td>
</tr>
<tr>
<td>Configure Reporting Server for Courtesy Callback</td>
<td>312</td>
</tr>
<tr>
<td>Configure Media Server for Courtesy Callback</td>
<td>314</td>
</tr>
<tr>
<td>Configure Call Studio Scripts for Courtesy Callback</td>
<td>315</td>
</tr>
<tr>
<td>CCE Script for Courtesy Callback</td>
<td>318</td>
</tr>
<tr>
<td>Overview of CCE Script Configuration for Courtesy Callback</td>
<td>320</td>
</tr>
<tr>
<td>Configure the CCE Script for Courtesy Callback</td>
<td>321</td>
</tr>
<tr>
<td>CHAPTER 17 Unified CVP Security</td>
<td>325</td>
</tr>
<tr>
<td>Contents</td>
<td></td>
</tr>
<tr>
<td>----------</td>
<td></td>
</tr>
<tr>
<td><strong>CHAPTER 18</strong></td>
<td><strong>Unified ICME Warm Consult Transfer/Conference</strong></td>
</tr>
<tr>
<td></td>
<td>Configure Unified ICME Warm Consult Transfer/Conference to Unified CVP</td>
</tr>
<tr>
<td></td>
<td>Minimal Component Version Requirement</td>
</tr>
<tr>
<td></td>
<td>Warm Transfer with SIP Calls</td>
</tr>
<tr>
<td></td>
<td>Set Up Unified ICME Warm Consult Transfer</td>
</tr>
<tr>
<td><strong>CHAPTER 19</strong></td>
<td><strong>Transfer and Queue Calls with Unified CVP</strong></td>
</tr>
<tr>
<td></td>
<td>IVRs From Perspective of Unified ICME</td>
</tr>
<tr>
<td></td>
<td>Call Transfer Using Unified CVP in Comprehensive Mode</td>
</tr>
<tr>
<td></td>
<td>Call Transfer Using SIP Service</td>
</tr>
<tr>
<td></td>
<td>Example: Transfer Call to a Label</td>
</tr>
<tr>
<td></td>
<td>Example: Queue and Transfer Call to a Skill Group</td>
</tr>
<tr>
<td></td>
<td>Example: Network Transfer Script</td>
</tr>
<tr>
<td></td>
<td>Call Transfer From Agent to Agent</td>
</tr>
<tr>
<td></td>
<td>Call Transfer Using SIP Service</td>
</tr>
<tr>
<td></td>
<td>Example: Transfer Call to a Label</td>
</tr>
<tr>
<td></td>
<td>Example: Queue and Transfer Call to a Skill Group</td>
</tr>
<tr>
<td></td>
<td>Example: Network Transfer Script</td>
</tr>
<tr>
<td></td>
<td>End Transfer From Agent to Agent</td>
</tr>
<tr>
<td></td>
<td>CLI Field on Outgoing Transfers</td>
</tr>
<tr>
<td></td>
<td>Configure CLI Override</td>
</tr>
<tr>
<td></td>
<td>Unified CCE Reroute on No Answer Configuration for Unified CVP</td>
</tr>
<tr>
<td></td>
<td>Reroute on No Answer Operation for Unified CCE with Unified IP IVR</td>
</tr>
<tr>
<td></td>
<td>Reroute on No Answer Operation with Unified CVP</td>
</tr>
<tr>
<td></td>
<td>Reroute on No Answer Agent Desk Settings Configuration</td>
</tr>
<tr>
<td></td>
<td>Router Requery Configuration</td>
</tr>
<tr>
<td></td>
<td>Reroute Configuration on No Answer for Unified CM with Unified CVP</td>
</tr>
<tr>
<td></td>
<td>Limitations</td>
</tr>
<tr>
<td></td>
<td>Call Survivability</td>
</tr>
<tr>
<td></td>
<td>Install Call Survivability Script</td>
</tr>
</tbody>
</table>
Configure the Gateway for Call Survivability 377
Examples of Call Survivability 380
Enhanced Location Call Admission Control 382
ELCAC Topic Definitions 382
ELCAC Queue-at-the-Edge Configuration 382
Locations-Based Call Admission Control Configuration 386
Unified CM Service Configuration Settings 386
Unified CVP Bandwidth Utilization 386
VoiceXML Documents 387
Prompt Retrieval 387
Gateway Prompt Caching Considerations 388
Configure Caching on the Gateway 388
Determine Gateway Caching 388
UUI as Correlation ID 389
How It Works 389
Debugging Tips 389
   Debug Trace Settings for the Gateway 389
   GTD Values in the Gateway Log 389
External Transfers in Unified ICME 390
   Unified ICM Script Label for Outpulse Transfer 390
   Unified ICME Script Label for Two B-Channel Transfer 391
   Unified ICME Script Label for Hookflash Transfer 391
Multicast Music on Hold (MMoH) 391
   Multicast MOH Usage Guidelines 392
   Mixed G.729 and G.711 Codec Support 392
Post Call Survey for SIP 393
   Configure Call Server for Post Call Survey 393
   Configure ICM for Post Call Survey 394

CHAPTER 20

Configure High Availability for Unified CVP 397
Server Groups 397
   Configure Server Groups 397
   Server Groups Diagnostics 398
Redundancy and Failover for Unified CVP 399
Preconfiguration

Prerequisites for Call Flow Model Configuration

This section describes the configuration procedures and information you need before you select a call flow model and implement it.

Design Prerequisites

- Read the *Configuration Guide for Cisco Unified Customer Voice Portal*.
- Understand Cisco Unified Customer Voice Portal (CVP) and the description of call flow models.
- Analyze the design information that is provided in *Configuration Guide for Cisco Unified Customer Voice Portal*, and then choose a call flow model for your desired Unified CVP implementation.
- Create the simplified all-in-one-box step-by-step call model examples.
- Use the troubleshooting information and examples as templates.

Preconfiguration Tasks

<table>
<thead>
<tr>
<th>Step</th>
<th>Procedure</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Have network information. See <em>Network Information</em>, on page 2.</td>
</tr>
<tr>
<td>2</td>
<td>Perform ring no answer settings with SIP. See <em>Ring No Answer Settings with SIP</em>, on page 94.</td>
</tr>
</tbody>
</table>

Step 4  Install Cisco Unified Intelligent Contact Management (ICM), Cisco Unified Communications Manager (CM), VXML and ingress gateways.

Step 5  Ensure that you have login credentials for Operations Console and Reporting Server. To sign in to Operations Console and view its menus, see Operations Console.

Step 6  Route calls through the network to the VRU. See Route Calls Through the Network to the VRU, on page 4.

Step 7  Configure ethernet switch/server NIC, gateways, and Call Server settings. See Ethernet Switch/Server NIC, Gateways and Call Server Settings, on page 4.

Step 8  Apply contact center gateway debug settings. Apply Contact Center Gateway Debug Settings, on page 7.

Step 9  Check the network VRU types. See the Network VRU Types, on page 8.

Step 10  Refer to the SIP dialed number pattern matching algorithm. See SIP Dialed Number Pattern Matching Algorithm, on page 9.

Step 11  Obtain licenses for the required Unified CVP components.

Step 12  Default security settings can prevent you from using Operations Console. Check your security policy and, if needed, change the settings to a less restrictive level.

Related Topics
- Network Information, on page 2
- Ring No Answer Settings with SIP, on page 94
- Route Calls Through the Network to the VRU, on page 4
- Ethernet Switch/Server NIC, Gateways and Call Server Settings, on page 4
- Apply Contact Center Gateway Debug Settings, on page 7
- Network VRU Types, on page 8
- SIP Dialed Number Pattern Matching Algorithm, on page 9

Network Information

To configure Unified CVP components and additional solution CVP components for a call flow model, ensure that you have the following network information:

- Understanding of which Unified CVP call flow model to implement.

  
  **Note**  
  For information about call flow models, see the *Configuration Guide for Cisco Unified Customer Voice Portal*.

- Network topology for your system, including addresses and names of the solution components.
- Failover strategy for Gateways, Unified CVP components, and Media Servers.
- Strategy for inbound call routing (that is, dial-peers versus Proxy Server).
- Naming resolution system for Gateways (DNS versus configured on the Gateway).
- Naming schemes to be used for Unified Intelligent Contact Management Enterprise (ICME) peripheral gateways, peripherals, and routing clients.
• If you are using a voice response unit (VRU) other than Unified CVP, have information about VRU trunk group number and number of trunks.

• Know locale values to be used for automatic speech recognition (ASR) and text to speech (TTS) servers.

• Know whether one or multiple VRUs, which refers to the dialed number, are to be used for each customer.

---

**Note**

If all the dialed numbers use the same VRU, use the default Network VRU instead of configuring multiple Network VRUs. For more information, see Configure Common Unified ICMH for Unified CVP Switch Leg, on page 140.

---

**Related Topics**

Configure Common Unified ICMH for Unified CVP Switch Leg, on page 140

---

**Unified CVP Installation**

• Install the Unified CVP software. For the installation procedures of Unified CVP components, see the https://www.cisco.com/en/US/products/sw/custcosw/ps1006/prod_installation_guides_list.html.

• Install the solution components.

• If you are using Unified CVP as a Unified ICME queuing platform, ensure that the VRU peripheral gateways use service control with Service Control Reporting enabled. If you are using it as a self-service platform, disable Service Control Reporting. Also, note the VRU Connection Port that is used for each VRU peripheral gateways Peripheral Interface Manager (PIM).

---

**Note**


---

• Ensure that the NIC cards, voice gateway, and network components have the Ethernet interfaces configured with matching speed and duplex settings.

---

**Note**

• For details about the required Ethernet Switch/Server NIC settings, see Ethernet Switch/Server NIC, Gateways and Call Server Settings, on page 4.

• For details on design considerations and guidelines for deploying enterprise network solutions that includes Unified CVP, see the Configuration Guide for Cisco Unified Customer Voice Portal.
**Related Topics**

*Ethernet Switch/Server NIC, Gateways and Call Server Settings*, on page 4

---

**Route Calls Through the Network to the VRU**

Most call flow models involve a step in which the call must be transferred to a VoiceXML gateway. Depending on the specific call flow model in use, one of two techniques is applied to direct that transfer. Both techniques involve one or multiple labels that Unified ICME or Unified Intelligent Contact Management Host (ICMH) provides. Configure these in the other call routing components of the solution to deliver a call to an appropriate VoiceXML gateway. Such labels are part of the overall dialed number plan of the contact center, and must be determined before you configure Unified CVP.

**Table 1: Call Flows Using Network VRUs and Customer VRU**

<table>
<thead>
<tr>
<th>Call Flows</th>
<th>Task</th>
</tr>
</thead>
<tbody>
<tr>
<td>Using Network VRUs of Type 7 or 10</td>
<td>Determine the Network Routing Number. This number is the base for routing calls through the network to the VRU. A correlation ID is appended to this number to transfer calls to a Network VRU through the network.</td>
</tr>
</tbody>
</table>
| With a Customer VRU in Unified ICMH environments and for NIC Type 8 call flow models | • Determine the translation route pools to use for each VRU.  
• Determine the labels to be sent to the network to connect the call to the VRU and the corresponding Dialed Number Identification Service (DNIS) that is seen by the VRU. For example, the label for the network might be 18008889999 and the DNIS received by the VRU and sent back to Unified ICME to identify the call might be 9999. |

---

**Ethernet Switch/Server NIC, Gateways and Call Server Settings**

Ensure to have the following Ethernet Switch/Server NIC, gateways, and Call Server settings:

⚠️ **Caution**

The **Auto** option is applicable only for matched port/NIC at Gigabit Ethernet (1000 Mbps). If you are unsure of the adjacent station configuration, select 1000/Full on the Gigabit interface. You can use the **Auto** option only if both stations supply Gigabit interfaces.

**Table 2: Ethernet Switch/Server NIC, Gateways and Call Server Settings**

<table>
<thead>
<tr>
<th>Ethernet Switch Speed</th>
<th>Server/Gateway NIC Speed</th>
<th>Speed/Duplex Setting for Switch Port</th>
<th>Speed/Duplex Setting for Server/GW NIC</th>
</tr>
</thead>
<tbody>
<tr>
<td>1000 Mb</td>
<td>1000 Mb</td>
<td>1000/Full</td>
<td>1000/Full</td>
</tr>
<tr>
<td>1000 Mb</td>
<td>1000 Mb</td>
<td>Auto/Auto</td>
<td>Auto/Auto</td>
</tr>
<tr>
<td>1000 Mb</td>
<td>100 Mb</td>
<td>100 Mb/Full</td>
<td>100 Mb/Full</td>
</tr>
</tbody>
</table>
### Call Server and VXML Gateway in Different Subnets

Unified CVP shows one to two seconds delay in the Call Server when VXML gateway bootstraps the call. The delay is caused if the Call Server and VXML gateway are in different subnets.

To avoid the delay:

**Procedure**

1. **Step 1**
   - Open the registry of the machine.
2. **Step 2**
   - Navigate to the following path:
     `HKEY_LOCAL_MACHINE\SYSTEM\CurrentControlSet\Services\Tcpip\Parameters\Interfaces\<Interface GUID>`.  
3. **Step 3**
   - Set `TcpAckFrequency` parameter to 1.
4. **Step 4**
   - Restart the windows machine.

---

### Trunk Utilization and Reporting

#### DS0 Trunk Information

Through Unified CVP, Unified ICM passes the gateway trunk and DS0 information from the arriving SIP call.

PSTN gateway trunk and DS0 information received at ICM has the following purposes:

- Reporting
- Routing in the Unified CCE Script Editor where TrunkGroupID and TrunkGroupChannelNum information is available for routing decisions.

Following message is used in the examples:

The PSTN trunk group data comes from the PSTN Gateway in the SIP INVITE as shown:

```
Via: SIP/2.0/UDP 192.168.1.79:5060;x-route-tag="tgrp:2811-b-000";x-ds0num="ISDN 0/0/0:15 0/0/0:DS0":branch
```

The following logic is used in Unified CVP to parse and pass the PSTN trunk group information to Unified ICM:

- For TrunkGroupID, look for `tgrp:` in the `x-route-tag` field.
If tgrp: found TrunkGroupID=value after tgrp: > + <data between ISDN and :DS1 tags> - Using the above example: TrunkGroupID = 2811-b-000<space>0/0:150/0/0.
TrunkGroupID = <IP addr of originating device in Via header> + <data between ISDN and:DS1 tags>
Using the above example: TrunkGroupID=192.168.1.79<space>0/0:150/0/0.

- For TrunkGroupChannelNum, look for DS0 in x-ds0nun field.
  - If found, TrunkGroupChannelNum = <value before the :DS0> - Using the above example: TrunkGroupChannelNum = 1
  - TrunkGroupChannelNum = <max int value> to indicate we did not find the DS0 value.
    Using the above example: TrunkGroupChannelNum = Integer.MAX_VALUE (2^31 - 1)

Trunk Utilization Routing and Reporting

Through the Trunk Utilization feature, a gateway is used for real-time Unified CVP routing and Unified ICM reporting and scripting. A gateway pushes the status of memory, DS0, DSP, and CPU to Unified CVP. Because this feature uses a push method to send resource data to Unified CVP, resources are monitored more closely and failover can occur faster when a device goes down or is out of resources.

This feature has the following characteristics:

- Each gateway can publish an SIP OPTIONS message with CPU, Memory, DS0, and DSP information to Unified CVP every three minutes when operation conditions are normal on the gateway.
- The push interval is configurable through the Cisco IOS CLI on the gateway.
- If a high watermark level is reached, the gateway sends the SIP OPTIONS message immediately with an Out-Of-Service = true indication, and does not send another OPTIONS message until the low watermark level is reached with an Out-Of-Service = false indication.
- Up to five Resource Availability Indication (RAI) targets can be set up on the gateway.

Trunk Utilization Routing can also be used to update trunk group status in the Unified CCE router. A PSTN call (through the ICM script) can query the router with a preroute from a NIC to use the available ingress gateway for the post route to Unified CVP.

---

**Note**

DS0 is the data line that provides utilization information about the number of trunks free on a gateway.

Gateway Trunk Utilization with Server Group Pinging Combination

When you combine the Server Group element polling feature with the Cisco IOS Gateway trunk utilization feature, your solution has faster failover for high availability call signaling.

Deployment Considerations

- For Proxy Server deployment with CUSP:
  - Configure TDM originating gateways for resource allocation indication-targets (RAI-targets) to provide status in OPTIONS message to primary and secondary Unified CVP Call Servers, for
reporting purposes. The data is used for reporting, and not routing so the data needs to be sent to Call Servers that have reporting enabled.

- Configure primary and secondary CUSP proxy servers with Server Groups pinging to Unified CVP, VXML Gateways, and Unified Communications Manager elements.
- Configure Unified CVP with Server Group that pings to both primary and secondary CUSP proxies for outbound calls.

- For a non-proxy deployment:
  
  - Configure TDM originating gateways for RAI-targets to provide status in OPTIONS message to primary and secondary Call Servers. Unified CVP can handle the messages for both reporting and routing purposes. If used for routing, then the gateway must be in a server group by itself on Unified CVP.
  
  - Configure Unified CVP with Server Groups that pings to Unified CVP, VXML Gateways, and Unified Communications Manager elements for outbound calls.
  
  - Configure VXML gateways for RAI-targets to provide status in the OPTIONS message to primary and secondary Call Servers.

- Configure the Unified CVP Call Servers to send the same hostname in the contact header of OPTIONS requests to the gateways. This process enables a single RAI-target to be configured to all Call Servers and is important because the limit is five targets. The parameter to set is called Options Header Override.

See the Cisco IOS documentation for guidelines on the high and low watermark settings.

Limitations:

- RAI is not supported on Proxy Servers.

CUSP servers do not handle the RAI header of OPTIONS messages, so they do not mark the status of elements with that information. If VXML Gateways are down, Unified CVP may send the call using the proxy, because the proxy does not handle incoming RAI headers in OPTIONS. It is possible to use a local static route scheme on Unified CVP to send all calls to the proxy except the Voice XML Gateways calls to create a server group for Voice XML Gateways and take advantage of RAI updates for routing.

### Apply Contact Center Gateway Debug Settings

#### Procedure

**Step 1** Log in to the gateway.

**Step 2** Type `enable` and type your password to enter the enable mode.

**Step 3** Enter the `configure terminal` command to enter configuration mode.

**Step 4** Type `ivr contact-center` to apply default debug settings.

**Step 5** Configure the logging buffer size using `set logging buffer`.

**Example:**

```
set logging buffer 1000000
```
**Note** The logging buffer size should be 1000000 or more.

**Step 6** Exit configuration mode and return to the enable prompt by pressing **Ctrl-Z**.

**Note** To view the current operating configuration, including the changes you made, enter the `show running-config` command.

**Step 7** To save the configuration changes, enter the `write running-config startup-config` command at the enable prompt.

**Example:**

```plaintext
User Access Verification
Password: 
ccbu-doc-gw4>en
Password: 
ccbu-doc-gw4#config t
Enter configuration commands, one per line. End with CNTL/Z.
ccbu-doc-gw4(config)#ivr
ccbu-doc-gw4(config)#ivr contact-center
ccbu-doc-gw4(config)#^Z
ccbu-doc-gw4#show debug
....
```

---

**Network VRU Types**

In Unified ICME, Network VRU is a configuration database entity. It is accessed using the Network VRU Explorer tool of ICM Configuration Manager. A Network VRU entry contains the following information:

- **Type**: A number from 7, 8, and 10, which corresponds to one of the types.

- **Labels**: This is a list of labels, which Unified ICME can use to transfer a call to the particular Network VRU that is being configured. These labels are relevant for Network VRUs of Types 7 and 10. These types use the Correlation ID mechanism to transfer calls. Labels for Type 8 are defined in the Translation Route Explorer tool of ICM Configuration Manager, and are invoked using a Translation Route to VRU node.

  Each label comprises the following components:

  - A digit string, which becomes a DNIS that is understood by a SIP Proxy Server, by a static route table, or by gateway dial-peers.
  
  - A routing client, also known as a switch leg peripheral. Each peripheral device that can act as a switch leg must have its own label, even if the digit strings are the same in all cases.

Unified ICME introduced Network VRU Type 10, which simplifies the configuration of Network VRU’s for Unified CVP. For most call flow models, a single Type 10 Network VRU can take the place of the Type 3, 5, 7, or 8 Network VRUs, which were associated with the Customer Instance and the Switch and VRU leg peripherals. The VRU-Only call flow models still require Type 8. However, in a specific case Type 7 is required.

Network VRU configuration entries themselves have no value until they are associated with active calls. Following are the three places in Unified ICME where you can perform this association:
• Advanced tab for a given peripheral in the PG Explorer tool of the ICM Configuration Manager.

• Customer Instance configuration in the ICM Instance Explorer tool of the ICM Configuration Manager.

• On every VRU Script configuration in the Network VRU Script List tool of the ICM Configuration Manager.

Depending on the call flow model, use Unified ICME to search either the peripheral or the customer instance to determine how to transfer a call to a VRU. Unified ICME examines the following:

• The Network VRU and the Network VRU using the Translation Route mechanism. The network VRU is associated with the switch leg peripheral when the call first arrives on a switch leg and Network VRU is associated with the VRU leg peripheral when the call is being transferred.

• The Network VRU from the System Information tool, when the call is being transferred to the VRU using the Correlation ID mechanism. The Network VRU is associated with the Customer Instance or the default Network VRU.

• The Network VRU, which is associated with the VRU Script every time it encounters a RunExternalScript node in its routing script. If the call is currently not connected to the designated Network VRU, Unified ICME does not execute the VRU Script.

The previously supported VRU types still work with Unified ICME 7.1(1) and later for existing deployments. However, new installations should use Type 10 and existing deployments should switch to Type 10 on upgrade.

---

**SIP Dialed Number Pattern Matching Algorithm**

Refer to the following points to create dialed number patterns:

• WildcardeD N patterns can contain “.” and “X” in any position to match a single wildcard character.

• Any of the wildcard characters in the set “>*!T” can match multiple characters. However, only one wildcard character can be used for trailing values, else they can always match with remaining characters in the string.

• The highest precedence of pattern matching is an exact match, followed by the most specific wildcard match. When the number of characters is matched equally by more than one wildcarded pattern, precedence is given from top to bottom of the configured DN list.

• There is no explicit software limit on the number of items in the DN pattern list.

---

**Additional Configuration Instructions**

• Comprehensive call flows for prerouted calls. See Comprehensive Call Flows for Pre-Routed Calls, on page 33. This class of call flows is similar to the Unified CVP Comprehensive call flow models, except that calls are first introduced into Unified ICME or Unified ICMH using a path other than through Unified CVP. A Unified ICME routing script is given the chance to preroute such calls before reaching Unified CVP. After the script transfers the call to Unified CVP for either self-service or queuing, the standard Unified CVP Comprehensive call flow model is used.
Order of Device Operations

Based on your call flow model, set up the device operations in the following order.

Table 3: Order of Devices

<table>
<thead>
<tr>
<th>Device Operations</th>
<th>Settings</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Device Deployment</strong></td>
<td>• SIP Proxy Server device (optional)</td>
</tr>
<tr>
<td></td>
<td>• Unified CVP Call Server device</td>
</tr>
<tr>
<td></td>
<td>• Unified CVP VXML Server device</td>
</tr>
<tr>
<td></td>
<td>• Unified CVP Reporting Server device</td>
</tr>
<tr>
<td></td>
<td>• Other Devices (for example, Gateways and Unified CM)</td>
</tr>
<tr>
<td><strong>System Configuration</strong></td>
<td>• SIP Server Groups</td>
</tr>
<tr>
<td></td>
<td>• Dialed Number Pattern</td>
</tr>
<tr>
<td></td>
<td>• Locations</td>
</tr>
<tr>
<td></td>
<td>• Courtesy Callback</td>
</tr>
</tbody>
</table>
### Device Operations

<table>
<thead>
<tr>
<th>Miscellaneous</th>
<th>Settings</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>• Transfer of licenses (required)</td>
</tr>
<tr>
<td></td>
<td>• Transfer of VXML applications (required)</td>
</tr>
<tr>
<td></td>
<td>• Bulk transfer of default Gateway files (required)</td>
</tr>
</tbody>
</table>

### Manage Devices

#### Procedure

**Step 1**  
Add new Unified CVP device.

**Step 2**  
Configure Unified CVP device.

**Step 3**  
Save and deploy Unified CVP device.

**Step 4**  
Transfer license.

**Step 5**  
Restart Unified CVP device to activate license.

**Step 6**  
Verify that Unified CVP devices are active in Operations Console.

**Step 7**  
Deploy system-level configuration, Dialed Number Pattern, SIP Server Groups, Locations, and Courtesy Callback, and verify their statuses.

**Step 8**  
Save and deploy the SNMP Configuration.
Unified CVP Call Flow Models

- Common Tasks for Unified CVP Call Flow Models, on page 13
- Standalone Call Flow Model, on page 14
- Comprehensive Call Flow Model, on page 19
- Comprehensive Call Flows for Pre-Routed Calls, on page 33
- Call Director Call Flow Model, on page 41
- VRU-Only Call Flow Model with NIC Routing, on page 53
- Set Up sendttooriginator Setting in the SIP Service of a Call Server, on page 65

Common Tasks for Unified CVP Call Flow Models

Call Services for Call Flow Models

Based on your call flow model, select the required call services in the Call Server Configuration window:

Table 4: Call Services for Call Flow Models

<table>
<thead>
<tr>
<th>Call Flow Model</th>
<th>Required Call Services</th>
</tr>
</thead>
<tbody>
<tr>
<td>Comprehensive Call Flow Model, on page 19</td>
<td>ICM, IVR, SIP</td>
</tr>
<tr>
<td>VRU-Only Call Flow Model with NIC Routing, on page 53</td>
<td>ICM, IVR</td>
</tr>
<tr>
<td>Call Director Call Flow Model, on page 41</td>
<td>ICM, IVR</td>
</tr>
<tr>
<td>Standalone Call Flow Model, on page 14</td>
<td>No Service</td>
</tr>
</tbody>
</table>

Related Topics

- Comprehensive Call Flow Model, on page 19
- VRU-Only Call Flow Model with NIC Routing, on page 53
- Call Director Call Flow Model, on page 41
- Standalone Call Flow Model, on page 14
Standalone Call Flow Model

In this call flow model, the VXML Server is a J2EE-compliant server that provides a complete solution for rapidly creating and deploying dynamic VoiceXML applications. You can install the VXML Server as a standalone component without the Unified CVP Call Server component and with or without the Reporting.

The following table lists the required and optional Unified CVP components needed for the Standalone call flow model:

Table 5: Required and Optional Unified CVP Components for Standalone Call Flow Model

<table>
<thead>
<tr>
<th>CVP components</th>
<th>Related topics</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Required CVP components</strong></td>
<td></td>
</tr>
<tr>
<td>VXML Server</td>
<td>• VXML Server Configuration</td>
</tr>
<tr>
<td>Ingress Gateway</td>
<td>• Gateway Configuration</td>
</tr>
<tr>
<td></td>
<td>• Example: Gateway Settings for Standalone Call Flow Model, on page 208</td>
</tr>
<tr>
<td></td>
<td>• Call Survivability, on page 374</td>
</tr>
<tr>
<td>VoiceXML Gateway</td>
<td>• Gateway Configuration</td>
</tr>
<tr>
<td></td>
<td>• Example: Gateway Settings for Standalone Call Flow Model, on page 208</td>
</tr>
<tr>
<td></td>
<td>• Call Survivability, on page 374</td>
</tr>
<tr>
<td>Operations Console</td>
<td>Operations Console</td>
</tr>
<tr>
<td>Call Server</td>
<td>• Call Server Configuration</td>
</tr>
<tr>
<td></td>
<td>• REFER Transfers, on page 32</td>
</tr>
<tr>
<td>Media Servers</td>
<td>Media Server Configuration</td>
</tr>
<tr>
<td><strong>Optional CVP components</strong></td>
<td></td>
</tr>
<tr>
<td>Reporting Server</td>
<td>Reporting Server Configuration</td>
</tr>
<tr>
<td>Speech Servers</td>
<td>Speech Server Configuration</td>
</tr>
<tr>
<td>Unified ICM Enterprise</td>
<td>Unified ICM Configuration</td>
</tr>
</tbody>
</table>

The Unified CVP VXML Server (Standalone) call flow model is available in the following variations:

- Standalone without reporting: Use the **VXML Server (Standalone)** option in the Operations Console. This call flow model does not require a Call Server and a Reporting Server.

- Standalone with reporting: Use the **VXML Server** option in the Operations Console. This call flow model requires a Call Server and a Reporting Server.
• Standalone, but adding reporting after the VXML Server (Standalone) version has already been configured: Configure the Unified CVP Call Server, delete the VXML Server (Standalone), and use the **VXML Server** option in the Operations Console to add the VXML Server.

See [Configure VXML Server (Standalone)](page103) for configuration instructions.

In this call flow model with reporting, the Unified CVP Call Server is used to route messages between the components. Calls arrive through a VoiceXML gateway and interact directly with a VXML Server to execute VoiceXML applications. The gateway performs both ingress and VoiceXML functions. This call flow model provides a sophisticated VoiceXML-based VRU, for applications which, in many cases, do not need to interact with a Unified ICME Server.

In the Unified CVP VXML Server (standalone) call flow model, *only* the VXML Server, Call Studio, and a Gateway are required, except when using reporting which requires a Call Server and a Reporting Server.

This standalone model has functions similar to the [VRU-Only Call Flow Model with NIC Routing](page53), on page 53.

---

**Note**

The CVP VXML standalone call flow model allows only one synchronous blind or bridged transfer. A synchronous blind transfer indicates that once the call has been transferred, a Unified CVP Standalone script has no ability to asynchronously take it back and deliver it somewhere else, whereas Unified ICME scripts, in the Unified ICME-integrated models, do have that ability.

The following figure displays the call flow for the Unified CVP VXML Server (standalone) call flow model.

*Figure 1: Call Flow for the Unified CVP VXML Server (Standalone) Call Flow Model*

---

The following, numbered, call flow description for the previous figure assumes:

- You installed and licensed the VXML Server.
- You created a Call Studio application and deployed it on the VXML Server.

The call flow shown in the previous figure is as follows:

1. The call arrives from the PSTN network to the Gateway.
2. The Gateway sends an HTTP URL request to the VXML Server.
3. The VXML Server returns the VoiceXML instructions to be executed on the VXML Gateway.

4. The VoiceXML instructions returned to the Gateway can include references to ASR/TTS to recognize voice input and play TTS files, and references to Media Servers to play .wav files.

5. The gateway can, optionally, transfer the call to any destination that it can deliver a call to, such as Unified CM.

6. Unified CM can then send the call to an agent.

**Related Topics**

- VXML Server Configuration
- Gateway Configuration
- Configure Gateway Settings for Standalone Call Flow Model, on page 207
- Call Survivability, on page 374
- Cisco VVB Configuration
- Configure Cisco VVB Settings for Standalone Call Flow Model, on page 238
- Operations Console
- Call Server Configuration
- REFER Transfers, on page 32
- Media Server Configuration
- Reporting Server Configuration
- Speech Server Configuration
- Unified ICM Configuration
- Configure VXML Server (Standalone), on page 103
- VRU-Only Call Flow Model with NIC Routing, on page 53

**Configure VXML Server Standalone Call Flow Model**

The following steps apply to all variations of standalone call flow model:

**Procedure**

### Step 1

Configure the gateway for VXML Server (Standalone) applications:

a) Define the VXML Server applications on the gateway.

   **Note**  
   Backup server is optional. For the Tomcat Application Server, set the port to 7000. The backup server cannot be the same server as the Primary Server.

b) Configure the base gateway and Cisco VVB settings.

   For gateway settings, see the Example: Gateway Settings for Standalone Call Flow Model, on page 208.

   For Cisco VVB settings, see the Configure Cisco VVB Settings for Standalone Call Flow Model, on page 238.

c) Configure the service settings on the gateway.

   See the Example: Gateway Settings for Standalone Call Flow Model, on page 208.
d) Configure a dial-peer, which will call the service to reach the Unified CVP VXML Server. See the Example: Dial-Peer for Standalone Call Flow Model, on page 210.
e) (Optional) Create additional dial-peers for any outgoing transfer destinations your application uses. Review the updated gateway configuration by issuing the `show run` command to examine the running configuration.

Step 2
Create an application using Call Studio and deploy it as a zip file.
For information about Unified Call Studio, see the User Guide for Cisco Unified CVP VXML Server and Unified Call Studio.

---

### Related Topics
- Example: Gateway Settings for Standalone Call Flow Model, on page 208
- Configure Cisco VVB Settings for Standalone Call Flow Model, on page 238
- Example: Dial-Peer for Standalone Call Flow Model, on page 210

---

**Enable Reporting for Standalone Call Flow Model**

**Procedure**

**Step 1**
Follow steps 1 and 2 from Configure VXML Server Standalone Call Flow Model, on page 16.

**Step 2**
Enable loggers on the Call Studio.
See the User Guide for Cisco Unified CVP VXML Server and Unified Call Studio for details on configuring loggers using Call Studio.

**Step 3**
Configure the Call Server.
For more information on configuring a Call Server, see Configure Call Server, on page 77

**Step 4**
Configure the VXML Server.
   a) In the Operations Console, select Device Management > VXML Server and add a VXML Server with an associated Primary Call Server.
   b) To enable reporting for this VXML Server, in the Operations Console, select the Configuration tab and select Enable Reporting for this VXML Server.
   c) Add appropriate filtering.
   For more information on configuring a VXML Server, see the Configure VXML Server section.

**Step 5**
Click Save and Deploy.

**Step 6**
Deploy the Call Studio application on the VXML Server.

**Note**
By default, CVPSNMPLogger is enabled when a new Call Studio application is created and deployed to the VXML Server.

**Step 7**
Configure the Reporting Server.
   a) In the Operations Console, select Device Management > CVP Reporting Server > General tab and configure the Reporting Server.
b) Select a Call Server to associate with this Reporting Server.
c) Check the default values of the Reporting properties and change, if desired.


Step 8 Click Save and Deploy.

Related Topics
Configure VXML Server Standalone Call Flow Model, on page 16
Configure Call Server, on page 77

Enable ICM Lookup for Standalone Call Flow Model

Procedure

Step 1 Follow steps 1 and 2 from Configure VXML Server Standalone Call Flow Model, on page 16.

Step 2 Use the ReqICMLabel element in the Call Studio script as a decision element.

The ReqICMLabel element has two exit states: error and done. The done path must connect to a transfer element to transfer the caller to ReqICMLabel as referenced by the ReqICMLabel Element.

For information about Unified Call Studio, see the User Guide for Cisco Unified CVP VXML Server and Unified Call Studio.

Step 3 Enable loggers on the Call Studio.

See the User Guide for Cisco Unified CVP VXML Server and Unified Call Studio for details on configuring loggers using Call Studio.

Step 4 Configure the Call Server and enable the ICM Service.

For more information on configuring a Call Server, see the Configure Call Server, on page 77.

Step 5 Configure the VXML Server.

For more information on configuring a VXML Server, see the Configure VXML Server section.

Step 6 Deploy the Call Studio application on the VXML Server.

Note By default, CVPSNMPLogger is enabled when a new Call Studio application is created and deployed to the VXML Server.

Step 7 Using the ICM Script Editor, create a Unified ICME script that returns a label.

In order to transfer information from Unified ICME to the VXML Server besides the label, use the ToExtVXML0 - 4 ECC Variables and Peripheral Variables 1 - 10. The format for using the ToExtVXML 0 - 4 is with name value pairs that are delimited by semi-colons.

Example:

ToExtVXML0 = "company=Cisco Systems;state=MA".
Use the Peripheral Variables 1 - 10 to pass information to the VXML Server. The values in the variables are taken as is.

For more information about creating a Unified ICME script that returns a label in, see the Unified ICME documentation.

For more information about using the ReqICMLabelelement, see the Pass Data to Unified ICME, on page 160.

Related Topics

- Configure VXML Server Standalone Call Flow Model, on page 16
- Configure Call Server, on page 77
- Pass Data to Unified ICME, on page 160
- Call Director Call Flow Model for Unified ICME, on page 42
- Call Director Call Flow Model for Unified ICMH, on page 43

Comprehensive Call Flow Model

The Comprehensive call flow model is deployed where the Unified CVP acts as a switch or is deployed at the Network Application Manager (NAM) to act as a switch. The call flow models to deploy these scenarios are listed in the Comprehensive Call Flow Model for ICME, on page 20 and Comprehensive Call Flow Model for ICMH, on page 22 sections. In these call flow models, a call can have two legs one with the Ingress Gateway and other with the Cisco VVB:

- **Switch leg**: For the Switch leg, the Gateway provides Gateway capabilities from TDM to VoIP and call-switching capabilities

- **VRU leg**: For the VRU leg, the VXML Gateway provides VRU voice treatment.

Note: Unified ICMH sees these as a single call routed through different peripherals for different purposes.

The SIP calls using the Unified CVP micro-applications use the IVR Service of Call Server that has the switch leg of the call. VoiceXML fetches are sent to the Call Server. The VoiceXML traffic for micro-applications must return only to the same Call Server as the switch leg.

Sending VoiceXML traffic to multiple application servers is implemented in Unified CVP 4.0(1) onwards by extracting the IP address of Call Server from the SIP signaling messages in the bootstrap service rather than using static configuration in the service parameter for the bootstrap servicesound of VoiceXML Gateway.

The Comprehensive call flow model extracts the Call Server host from the SIP signaling. The Comprehensive SIP Service is handling the switch legs of the call. If you make a SIP call that does not involve the switch leg with Unified CVP, the service parameters below applies for the VRU leg only. Comprehensive calls always use the same Call Server for both switch leg and VRU legs. Using the same Call Server simplifies the solution and makes it easier to troubleshoot and debug.
The *app-info header* parameter is for SIP calls only. If this parameter is blank, the primary Call Server IP address configured on the service, is used. In case the Call Server is non-functional, this parameter tries to access the backup Call Server.

**Related Topics**

- Comprehensive Call Flow Model for ICME, on page 20
- Comprehensive Call Flow Model for ICMH, on page 22

## Comprehensive Call Flow Model for ICME

The Comprehensive call flow model for ICME combines the Call Director using SIP and the VRU-Only call flow model scenarios. It provides initial prompt and collect, self-service IVR, queuing, and VoIP routing among all types of UCCE and TDM agents. This scenario is supported at the following port licensing levels:

- **Basic**: Supports the .wav files and input using dual tone multi-frequency (DTMF) signaling.
- **Advanced**: Supports ASR/TTS Servers, and VXML Server applications.

Unified CVP acts as the switch, transferring the call to the Network VRU and to agents. The Unified CVP IVR service in the Operations Console is configured to work with the VoiceXML Gateway to provide VRU treatment, which may include ASR/TTS Servers.

Both the Voice Gateway and the Call Server have two legs for the same call: the Switch leg and the VRU leg. For the Switch leg, the Gateway provides Gateway capabilities from TDM to VoIP, and call-switching capabilities whereas for the VRU leg, the Gateway provides VRU voice treatment.

- **A Network VRU**: Type 10, serves both the Switch and VRU legs.
- Use the SendToVRU node of the ICM Script Editor to connect the call to the Network VRU.

The following figures show the call flow for Comprehensive call flow model for ICME using SIP without and with a Proxy Server. The solid lines in these figures indicate voice paths and dashed lines indicate signaling paths.
The figures show two Gateways: the one where a call arrives and the other for the VRU leg. However, one physical Gateway can be used for both the purposes.

For simplicity, the figures do not illustrate redundancy and failover.

For more information, see REFER Transfers, on page 32 and Set Up sendtooriginator Setting in the SIP Service of a Call Server, on page 65.

**Related Topics**

REFER Transfers, on page 32
Comprehensive Call Flow Model for ICMH

In the Comprehensive call flow model for ICMH, Unified CVP is deployed at the NAM where it acts as the switch, transferring the call to the Network VRU and to agents. The Network VRU uses the Correlation ID transfer mechanism. On the Operations Console, the IVR Service is configured to work with the VoiceXML Gateway to provide VRU treatment, and can include the ASR/TTS Servers.

In this call flow model:

- There are two the Network VRUs: one on the NAM for the Switch leg and the VRU leg (Type 10) and the other for the CICM for the INCRP connection.
- The Network VRU names (where applicable) and the ECC variable configurations must be identical on the NAM and CICM. All labels must also be duplicated but their routing clients will be different.
- Use the SendToVRU node of the ICM Script Editor to connect the call to the Network VRU.

Note

- This call flow model does not support calls that originate in IP address.
- For instructions on how to implement IP-originated calls in a way which is supplemental to the Unified CVP Comprehensive Call Flow Model for ICME and ICMH, see the Calls Originated by Unified CM, on page 35 section. This implementation requires an additional Unified CVP Call Server to be connected to the CICM.

The following figures show the call flow for Comprehensive call flow model for ICMH using SIP without and with a Proxy Server. The solid lines in these figures indicate voice paths and dashed lines indicate signaling paths. The numbers in the figure indicate call flow progression.

Figure 4: Comprehensive Call Flow Model for ICMH Using SIP Without a Proxy Server
• The figures show two Gateways: the one where a call arrives and the other for the VRU leg. However, one physical Gateway can be used for both the purposes. Similarly, the IVR Service configured through the Operations Console and the peripheral gateway can be on the same server.

• For simplicity, the figures do not illustrate redundancy and failover.

• For more information, see REFER Transfers, on page 32 and Set Up sendtooriginator Setting in the SIP Service of a Call Server, on page 65.

Table 6: Required and Optional CVP Components for Comprehensive Call Flow Model

<table>
<thead>
<tr>
<th>CVP components</th>
<th>Related topics</th>
</tr>
</thead>
<tbody>
<tr>
<td>Required CVP components</td>
<td></td>
</tr>
<tr>
<td>Operations Console</td>
<td>Operations Console</td>
</tr>
<tr>
<td>Ingress Gateway</td>
<td>• Gateway Configuration</td>
</tr>
<tr>
<td></td>
<td>• Configure Gateway Settings for Comprehensive Call Flow Model</td>
</tr>
<tr>
<td></td>
<td>• Call Survivability</td>
</tr>
<tr>
<td>VoiceXML Gateway</td>
<td>• Gateway Configuration</td>
</tr>
<tr>
<td></td>
<td>• Configure Gateway Settings for Comprehensive Call Flow Model</td>
</tr>
<tr>
<td></td>
<td>• Call Survivability</td>
</tr>
<tr>
<td>CVP components</td>
<td>Related topics</td>
</tr>
<tr>
<td>----------------</td>
<td>---------------</td>
</tr>
</tbody>
</table>
| Unified ICME   | • Unified ICM Configuration  
|                | • Comprehensive Call Flow Model for ICME  
|                | • Comprehensive Call Flows for Pre-Routed Calls  
|                | • Calls Arriving at ICME through a Pre-Route-Only NIC  
|                | • Calls Originated by Unified CM  
|                | • Calls Originated by an ACD or Call Routing Interface  
|                | • Configure ICM Settings for Comprehensive Call Flow Model for ICME and ICMH  
|                | • Define Unified CVP ECC Variables  
| Unified ICMH   | • Unified ICM Configuration  
|                | • Comprehensive Call Flow Model for ICMH  
|                | • Configure ICM Settings for Comprehensive Call Flow Model for ICME and ICMH  
|                | • Configure Common Unified ICMH for Unified CVP Switch Leg  
|                | • Define Unified CVP ECC Variables  
| Call Server    | • Call Server Configuration  
|                | • REFER Transfers  

Optional CVP components

<table>
<thead>
<tr>
<th>Speech Servers</th>
<th>Speech Server Configuration</th>
</tr>
</thead>
<tbody>
<tr>
<td>SIP Proxy Server</td>
<td>SIP Proxy Server Configuration</td>
</tr>
<tr>
<td>Media Servers</td>
<td>Media Server Configuration</td>
</tr>
<tr>
<td>DNS Servers</td>
<td>DNS Zone File Configuration for Comprehensive Call Flow Model</td>
</tr>
<tr>
<td>Reporting Server</td>
<td>Reporting Server Configuration</td>
</tr>
</tbody>
</table>

Related Topics

- Calls Originated by Unified CM, on page 35
- REFER Transfers, on page 32
- Set Up sendtooriginator Setting in the SIP Service of a Call Server, on page 65
Set Up Comprehensive Call Flow Model Using SIP for ICME and ICMH

Procedure

Step 1  Perform Steps 1 to 5 of the Configure Gateway Settings for Comprehensive Call Flow Model, on page 210 procedure.

Step 2  (Optional) Configure a dial-peer for ringtone and error.

Step 3  If you are using a Proxy Server, configure your session target in the outbound Dial-peer to point to the Proxy Server.

Step 4  If you are using the sip-server global configuration, configure the sip-server in the sip-ua section to be your Proxy Server and point the session target of the dial-peer to the sip-server global variable.

Note 1. Make sure your Dial plan includes this information. See the Dial plan when you configure the SIP Proxy Server for Unified CVP.

2. The SIP Service voip dial-peer and the destination pattern on the Ingress Gateway must match the DNIS in static routes on the SIP Proxy Server or Unified CVP Call Server.

See the SIP Devices Configuration and SIP Dialed Number Pattern Matching Algorithm, on page 9 for detailed information.

Step 5  Perform Steps 6 to 10 of the Configure Gateway Settings for Comprehensive Call Flow Model, on page 210 procedure.

Step 6  Configure the ICM VRU Label. See Example of Dial-peer for ICM VRU Label for Type 8 Call Flow Model of the Configure ICM Settings for VRU-Only Call Flow Model: Type 8, on page 151 section.

Step 7  (Optional) Enable security for media fetches.

Note  • The VXML that the IVR Service returns as a response to an HTTP/HTTPS request from the VXML gateway contains URLs to media servers, so that the gateway knows where to fetch the media files from.

• To enable HTTPS communication between CVP and VVB or IOS, use the ICM Script Set Variables to specify the protocol/port in the call.user.microapp_server. An example of a URL that explicitly specifies an HTTP scheme is http://<servername>:80. One that specifies an HTTPS scheme is https://<servername>:443. An example of a URL that does not specify the scheme is <servername>.

In the Operations Console, the user-visible text for this property is “Use Security for Media Fetches.” Do not restart the Call Server for this property to take effect.

Click the Use Security for Media Fetches check box on the IVR Service tab.

See the Operations Console online help for detailed information about the IVR Service.

Step 8  Perform Steps 11 to 13 of the Configure Gateway Settings for Comprehensive Call Flow Model, on page 210 procedure.

Step 9  Configure the speech servers to work with Unified CVP.

Caution  The Operations Console can only manage speech servers installed on Windows, not on Linux. If the speech server is installed on Linux, the server cannot be managed.
To ensure that the speech servers work with Unified CVP, make the following changes on each speech server as part of configuring the Unified CVP solution.

**Step 10**
Configure the characteristics for the VRU leg.
Characteristics for VRU legs require ASR and TTS treatment. On IOS VXML Gateway, if you have other requirements for DTMF relay, codecs or VAD settings, you must modify the commands accordingly.

**Step 11**
Perform Steps 14 and 15 of the Configure Gateway Settings for Comprehensive Call Flow Model, on page 210 procedure.

**Step 12**
Define Network VRUs.

a) On Unified ICME or the NAM, ICM Configuration Manager, select Network VRU Explorer tool, define a Network VRU for the VRU leg and labels for each Unified CVP Call Server.

b) On the CICM only, ICM Configuration Manager, select Network VRU Explorer tool, define a Network VRU for the VRU leg and labels for reaching the NAM.

For each of the two previous substeps, specify the following:

- **Type:** 10
- **Name:** <Network VRU Name>
  - For example: cvp
- Define a label for each Unified CVP Call Server that is handling the Switch leg:
  - **Label:** <Network Routing Number>
  - **Type:** Normal
  - Routing client for Unified ICME or the NAM: Select the routing client configured for that Unified CVP Call Server peripheral from the drop-down list.
  - Routing client for **CICM only**: Select the INCRP routing client from the drop-down list.

**Note**
The Network VRU label in the NAM and CICM must be identical. The Network VRU Names on the NAM and CICM should also be identical to avoid confusion.

**Step 13**
Define network VRUs and PGs for the switch leg in the ICM Configuration Manager.

On Unified ICMH, on the NAM and CICMs, Network VRU Explorer tool, define one label per Unified CVP Call Server or NIC routing client.

**Note**
Use the same Type 10 Network VRU that you defined in the previous steps for the VRU leg.

For more information, see the ICM Configuration Guide for Cisco ICM Enterprise Edition.

**Step 14**
Set the client type for the INCRP NIC.

On the CICM, ICM Configuration Manager, NIC Explorer tool, set the client type for the INCRP NIC.

- **Client Type:** VRU

**Step 15**
Define a VRU that uses INCRP.

On the CICM, ICM Configuration Manager, Network VRU Explorer tool:

a) Define a Network VRU with a label that uses INCRP as its routing client.
Specify the following:

- **Type:** 10
- **Name:** `<name of Unified CVP VRU>`
  
  For example: `cvpVRU`

b) Define one label for the NAM routing client.

Specify the following:

- **Type:** Normal
- **Label:** `<Network Routing Number>`
- **Routing client:** INCRP NIC

For more information, see the ICM Configuration Guide for Cisco ICM Enterprise Edition.

**Step 16**

Perform Step 16 of the Configure Gateway Settings for Comprehensive Call Flow Model, on page 210 procedure.

**Step 17**

Define a default network VRU on Unified ICME or the NAM, in the ICM Configuration Manager, the System Information tool:

a) For Unified ICME or on the CICM only, define a default Network VRU.

   - Define the Default Network VRU: `<Network VRU Name>`
     
     For example: `cvpVRU`

b) If there are Routing Scripts on the NAM, define a default Network VRU.

For more information, see the ICM Configuration Guide for Cisco ICM Enterprise Edition.

**Step 18**

Configure dialed numbers, call types, and customers on the Unified ICME or Unified ICMH Server in the ICM Configuration Manager:

a) **Dialed Number List Tool** tab: Configure the dialed numbers.

b) **Call Type List tool** tab: Configure the call types.

c) **ICM Instance Explorer tool** tab: Configure the applicable customers.

For more information, see the ICM Configuration Guide for Cisco ICM Enterprise Edition.

**Step 19**

Configure ECC variables.

On Unified ICME, ICM Configuration Manager, configure ECC variables.

For more information, see Define Unified CVP ECC Variables, on page 141.

**Step 20**

Create a routing script that handles the incoming calls.

On the Unified ICME or Unified ICMH Server in the ICM Script Editor tool, use the SendToVRU node to connect the call to the Network VRU.

See Scripting and Media Routing Guide for Cisco Unified ICM/Contact Center Enterprise & Hosted for more information.

**Step 21** (Optional) Configure the SIP Proxy.

If using a SIP Proxy Server, configure it in the Unified CVP Operations Console.
Select: **Device Management** > **SIP Proxy Server**

**Step 22** Install and configure the **Call Server(s).**

In the Operations Console:

a) Enable the ICM, IVR, and SIP Services on the Call Server.
   - In the Operations Console select **Device Management** > **Unified CVP Call Server**.
   - Select the **ICM** and **SIP** check boxes.

b) Configure the IVR service.
   - In the Operations Console select **Device Management** > **Unified CVP Call Server** > **IVR tab** and configure the IVR service.
   Check the default values and change, if desired. Refer to the Operations Console online help for information about other settings you might want to adjust from their default values.

c) In the Operations Console select **Device Management** > **Unified CVP Call Server** > **SIP**. Configure the SIP Service:
   - If you are using a SIP Proxy Server, enable the Outbound Proxy and select the SIP Proxy Server.
   Select the **SIP tab** and configure the following:
     - Enable Outbound Proxy: **Yes**
     - Outbound Proxy Host: Select from drop-down list.
     - Configure Local Static Routes on the SIP Proxy Server itself.

   - If you are not using a SIP Proxy Server, configure Local Static Routes using the Dialed Number Pattern system configuration on the Operations Console. A Local Static Route must be configured for each SIP gateway/ACD, SIP endpoint in order to receive calls.

Local Static Routes, Dialed Number (DN): Specify the dialed number pattern for the destination.

Valid number patterns include the following characters:

- Use the period (.) or **X** character for single-digit wildcard matching in any position.
- Use the greater than (>) or exclamation (!) characters as a wildcard for 0 or more digits at the end of the DN.
- Do not use the **T** character for wildcard matching.
- Dialed numbers must not be longer than 24 characters.
- See **Valid Format for Dialed Numbers**, on page 94 for format and precedence information.

Example: **9>** (Errors are 9292 and ringtone is 9191)

See **SIP Dialed Number Pattern Matching Algorithm**, on page 9 for more information.

The following examples show the incorrect and correct static route configurations. The incorrect static route configuration does not show the least explicit routes at the end. Also, load balancing and failover of calls require DNS SRV domain names, not multiple routes with the same DN Pattern, but a single route to an SRV domain name.
Example: Incorrect static route configuration
1>,10.2.6.1
2>,10.2.6.2
3>,10.2.6.20
2229191>,10.2.6.241
2229292>,10.2.6.241
2229191>,10.2.6.242
2229292>,10.2.6.242
2>,ccm-subscribers.cisco.com
3>,ccm-subscribers.cisco.com

Example: Correct static route configuration
22291>,cvp-ringtone.cisco.com
22292>,cvp-error.cisco.com
1>,ccm-subscribers.cisco.com
2>,ccm-subscribers.cisco.com
3>,ccm-subscribers.cisco.com

Note: “91919191>” pattern does not match an exact DN of “91919191.”

• Check the default values for the SIP Service and change, if desired.

d) Configure the ICM Service by setting the maximum length DNIS to the length of the Network Routing Number.

Select Device Management > CVP Call Server > ICM tab: Maximum Length of DNIS: length of the Network Routing Number.

Example: if the Gateway dial pattern is 1800******, the maximum DNIS length is 10.

Step 23 Configure Local Static Routes:

If an outbound proxy is enabled on the Operations Console, configure local static routes on the SIP Proxy Server.

If no outbound proxy is enabled, configure local static routes using the Operations Console Dialed Number Pattern system configuration. Refer to SIP Dialed Number Pattern Matching Algorithm, on page 9 for detailed information.

The following example shows a local static route configuration. A local static route contains a dialed number pattern and a routing address (IP Address, Hostname, or SIP Server Group name):

• 22291>, cvp-ringtone.cisco.com
• 22292>, cvp-error.cisco.com
• 1>, ccm-subscribers.cisco.com
• 2>, ccm-subscribers.cisco.com
• 3>, ccm-subscribers.cisco.com

Step 24 Configure custom ringtone patterns. See Add and Deploy Dialed Number Pattern, on page 294.

Step 25 (Optional) Configure the Reporting Server and associate it with a Call Server.

On the Operations Console, select Device Management > CVP Reporting Server > General and complete the following steps:

a) Configure the Reporting Server.
b) Select a Call Server to associate with this Reporting Server.
c) Check the default values of the Reporting properties and change, if desired.


---

DNS Zone File Configuration for Comprehensive Call Flow Model

**DNS Zone File Linux NAMED Configuration Example**

```text
ringtone-1 IN A 10.86.129.20
ringtone-2 IN A 10.86.129.229
vxml-1 IN A 10.86.129.20
vxml-2 IN A 10.86.129.229
vxml-3 IN A 161.44.81.254
cvp-1 IN A 10.86.129.211
cvp-2 IN A 10.86.129.220
cvp-3 IN A 161.44.81.254

; Priority Weight Port Target
;                       SRV 1 1 5060 ringtone-2.sox.cisco.com.
                        ; SRV 1 1 5060 ringtone-2.sox.cisco.com.
SRV 1 1 5060 vxml-2.sox.cisco.com.
SRV 1 1 5060 vxml-3.sox.cisco.com.
SRV 2 1 5060 cvp-2.sox.cisco.com.
SRV 3 1 5060 cvp-3.sox.cisco.com.
```

---

Unified CVP Call Flow Models
Characteristics for the VRU Leg for Comprehensive Call Flow Model in IOS Gateway

Use the following commands to provide voice treatment:

```plaintext
This applies only to IOS VXML Gateway.

new-call is a required name.

Continue with the VRU Leg Example.

service vru-leg flash:bootstrap.tcl
  !
service new-call flash:bootstrap.vxml
  !
service handoff flash:handoff.tcl
  !
service ringtone flash:ringtone.tcl
  !
service cvperror flash:cvperror.tcl
  !
service cvp-survivability flash:survivability.tcl
  !
```
REFER Transfers

Unified CVP SIP Service can perform a SIP REFER transfer instead of using SIP re-invites, which allows Unified CVP to remove itself from the call, thus freeing up licensed Unified CVP ports. (Unified CVP cannot execute further call control operations after this kind of label has been executed. For example, it cannot perform subsequent transfers back to Unified CVP for self service or queuing to another agent.

However, if the transfer fails, configure survivability to transfer the call elsewhere. This process is not the same as an ICM router query; for example, it will appear as a new call to Unified ICME, but it is a way to take an alternate action, if the transfer fails.

- This feature can be used in Comprehensive (SIP only), Call Director, and Standalone call flow models.
- Router query can be performed with a REFER transfer only if the NOTIFY messages are sent back to Unified CVP with the result of the REFER operation. Unified CVP does not hang up the call after sending REFER and hence, it is possible to query Unified ICM, get another label, and send another REFER.
- The use of the survivability tel service on the ingress gateway cannot currently support sending the NOTIFY messages with a failed transfer result, so router query cannot be used with REFER when it is handled by the survivability service. Survivability service can handle REFER, except that it will always report a successful transfer to Unified CVP, even when the transfer failed. This is a known limitation of the TCL IVR API for REFER handling in IOS, including ingress and CUBE gateways.

Using this feature, the call can be queued at the VoiceXML gateway and then sent to an agent with a Unified ICME label that begins with the letters "rf." Otherwise, standard Unified ICME agent labels enable Unified CVP to remain in the signaling path for the duration of the call, and the licensed Unified CVP resource will not be freed until the end of the call. REFER transfers can be made to Unified CM or other SIP endpoints in the SIP cloud, such as an ACD. The ECC variable "user.sip.refertransfer" can also be set in Unified ICME scripts. (When using this ECC variable in a Unified ICME script, it must be set to the value of the single character "y" and Unified CVP will use REFERs when transferring to the agents.)

When using REFER transfers, including the REFER used to play back critical_error.wav for abnormal disconnects, the Ingress gateway must include an outbound voip dial peer. This outbound dial peer is necessary because when the REFER message enters the gateway from the Call Server, it needs to match an outbound dial peer in order for the call to succeed; otherwise, a 503 rejection occurs if no dial peers match the REFER-TO header URI. Dial peer destination targets must match the labels in the REFER-TO SIP URI; meaning that <errorDN>@<sip-server> and other labels that may be used in the Unified ICME routing label. For example:

dial-peer voice 1050
voip destination-pattern 1...
voice-class codec 1
session protocol sipv2
session target <your sip-server destination>
dtmf-relay rtp-nte
no vad

When configuring Route Patterns on Unified CM for REFERs to destinations outside of the cluster, such as to the CUSP Server or the gateways directly, you must add SIP Route Pattern for the SIP Trunk associated with that endpoint. For example, if you use REFER to Error DN to the IP Originated caller on Unified CM, and the host of the REFER To header SIP URL is the CUSP Server, you must create a SIP Route Pattern with that IP address or domain name and associate it with your SIP Trunk for the CUSP Server.
When a TDM gateway handles REFER, and not Cisco Unified Border Element (CUBE), a REFER triggered INVITE is sent out. The REFER triggered INVITE requires a dial peer with a session target and typical codec information. The REFER-TO header URI host that is formulated by the CVP routing algorithm configuration, is ignored.

When CUBE receives a CVP initiated REFER, it does not send it transparently through to the originator. A dial peer is required to match the DN (user portion of the REFER-TO header URI) and the host portion of the URI is rewritten to match the session target of the dial peer. The REFER is passed to the originator using cli "supplementary-service sip refer"; otherwise, CUBE will handle the REFER and send the triggered invite to the refer DN on its own as a back to back user agent.

Comprehensive Call Flows for Pre-Routed Calls

This class of call flows is similar to the Unified CVP Comprehensive call flow models, except that the calls are first introduced into Unified ICME or Unified ICMH using a path other than through Unified CVP. A Unified ICME routing script is executed to pre-route such calls before Unified CVP even sees them. After the script transfers the call to Unified CVP, for either self-service or queuing, a standard Unified CVP Comprehensive call flow model is used.

All the above call flows are similar because the original routing client is capable of a single route request only. A routing client is an NIC, a Unified CM, an ACD, or a VRU. A routing client makes a single request to Unified ICME, then the Unified ICME returns a destination label, and the routing client affects the transfer. At that point the route request dialog is ended, and Unified ICME neither sends a subsequent label nor conducts any form of third-party call control.

If the returned label was a translation route to VRU label, or if it was a correlation ID label resulting from a SendToVRU node, the routing script may get executed. In such a case, the call is transferred to Unified CVP, and the routing script continues executing after Unified CVP receives the call. The script then invokes micro-application requests as part of its queuing or self service treatment. If the call is then transferred to an agent or skill group, that label goes to Unified CVP rather than to the original routing client. If the call is to be blind-transferred later to another agent or skill group, or back into Unified CVP for additional queuing or self service, that label too goes to Unified CVP rather than to the original routing client.

When the call arrives at Unified CVP, for micro-applications to be supported, it must establish both the Switch and the VRU leg. In other words, it must enter a normal Unified CVP Comprehensive call flow model. The only difference between the pre-routed call and Comprehensive call flow model is the way a call first arrives at Unified CVP. If a call is pre-routed, it arrives using either a translation route or correlation-id transfer, whereas in the Comprehensive call flow model, the call arrives as a new call from the public switched telephone network (PSTN). In both the cases, a subsequent transfer to VRU leg of Unified CVP is required.

This section focuses on the following call flows:

• Calls Arriving at ICME Through a Pre-Route-Only NIC, on page 34.

• Calls Originated by Unified CM, on page 35.

• Calls Originated by an ACD or Call Routing Interface, on page 38.
If the ICM Lookup is meant to transfer the call to the Comprehensive call flow model deployment, then a VXML Server running as a Standalone with ICME Lookup call flow also falls in this category.

**Calls Arriving at ICME Through a Pre-Route-Only NIC**

The following Unified ICME NICs fall into this category: ATT, GKTMP, MCI, Sprint, Stentor. This call flow applies to both the Comprehensive call flow models for ICME and ICMH. In the latter, both Unified CVP and the NIC are deployed at NAM.

Based on the Release number of ICME, perform the following tasks:

**Table 7: Procedure for Different Releases of ICME**

<table>
<thead>
<tr>
<th>ICME Release</th>
<th>Procedure</th>
</tr>
</thead>
<tbody>
<tr>
<td>ICME Release 7.1 onwards</td>
<td>1. Configure a single Type 10 Network VRU and associate it with all Unified CVP peripherals in the PG Explorer configuration tool, and in the System Information tool, define it as the default system Network VRU.</td>
</tr>
<tr>
<td></td>
<td>2. To support the initial call transfer to Unified CVP from the preroute routing client, configure Translation Route labels to target the Unified CVP peripherals.</td>
</tr>
<tr>
<td></td>
<td>3. To support the transfer to VRU leg, configure the Type 10 Network VRU that you defined in Step 1 with Network Routing Number labels for each Unified CVP peripheral routing client.</td>
</tr>
<tr>
<td></td>
<td>4. Associate all micro-application VRU scripts with that same Type 10 Network VRU. When the routing script transfers the call to Unified CVP, it must use a <code>TranslationRouteToVRU</code> node. The transfer to VRU leg of Unified CVP happens automatically.</td>
</tr>
<tr>
<td></td>
<td><strong>Note</strong> Non-prerouted calls can also share the same Network VRU and Call Servers.</td>
</tr>
</tbody>
</table>
**Call Flow Models**

### Calls Originated by Unified CM

This category includes the following types of calls:

- **Internal Help Desk calls:** For these calls, the Unified Communication Manager (CM) phone user calls a CTI Route Point, which starts a routing script that can optionally deliver the call to Unified CVP for queuing or self-service.

- **Unified ICME Outbound Option calls:** For these calls, a dialer makes outbound calls and then transfers them to a CTI Route Point, which starts a routing script that can optionally deliver the call to Unified CVP for queuing or self-service.

- **Consultative Warm Transfer:** For these calls, a Unified CM agent places the caller on hold and dials in to Unified ICME to reach a second agent; this starts a routing script that can optionally deliver the call to Unified CVP for queuing or self-service.

---

<table>
<thead>
<tr>
<th>ICME Release</th>
<th>Procedure</th>
</tr>
</thead>
<tbody>
<tr>
<td>ICME Release 7.0 onwards</td>
<td>1. Configure Type 7 and Type 10 Network VRUs.</td>
</tr>
<tr>
<td></td>
<td>2. In the PG Explorer tool, assign all Unified CVP Call Servers to the Type 7 Network VRU.</td>
</tr>
<tr>
<td></td>
<td>3. Configure one set of Translation Route labels to target the Type 7 Call Servers. These sets are used to transfer the call from the original routing client to the Unified CVP Switch leg.</td>
</tr>
<tr>
<td></td>
<td>4. Assign a label to the Type 10 Network VRU for each Unified CVP Call Server routing client, whose label string is set to the Network Routing Number.</td>
</tr>
<tr>
<td></td>
<td>5. In the System Information configuration tool, configure the Type 10 Network VRU as the system default Network VRU.</td>
</tr>
<tr>
<td></td>
<td>6. Associate all micro-application VRU scripts with the Type 10 Network VRU.</td>
</tr>
</tbody>
</table>

**Note**

- When the routing script transfers the call into Unified CVP, it must use two nodes in succession: first, a TranslationRouteToVRU, and then an explicit SendToVRU node. The first node transfers the call from the initial routing client to one of the Type 7 Call Servers (Unified CVP Switch leg); the second one transfers the call from the Type 7 Call Server to the Unified CVP VRU leg. (The VRU leg will usually end up running through the same Unified CVP Call Server as the Switch leg.)

- Non-prerouted calls can also share the same Type 7 Call Servers and Type 7 and Type 10 Network VRUs; however, scripts which handle non-prerouted calls must also use an explicit SendToVRU node before they can execute any micro-applications.
For information about Consultative Warm Transfer, see Configure Unified ICME Warm Consult Transfer/Conference to Unified CVP, on page 355.

Note
If these call flows are used in a Cisco Unified Contact Center Management Portal environment, the target Unified CVP Call Servers are required to be connected to the same CICM as the Unified CM from which the call originates. For example, multiple CICMs will require multiple Unified CMs, so will they require multiple Unified CVP Call Servers.

Further configuration points differ depending on whether Unified CVP is being deployed with Unified ICME Release 7.0 or 7.1 and later.
<table>
<thead>
<tr>
<th>ICME Release</th>
<th>Task</th>
</tr>
</thead>
<tbody>
<tr>
<td>Unified ICME Release 7.0 onwards</td>
<td>1. Configure a single Type 10 Network VRU and defined as the default system Network VRU in the System Information tool.</td>
</tr>
<tr>
<td></td>
<td>2. Configure the Type 10 Network VRU with two sets of labels. Associate the first set with the Unified CM routing client, which contains a label that Unified CM uses to transfer the call to Unified CVP. Configure Unified CM with a series of route patterns, which include that label followed by one to five arbitrary digits. For example, if the selected label is 1111, then the following route pattern is needed: 1111!. The second set of Network VRU labels must contain the usual Comprehensive Model &quot;Network Routing Number,&quot; which must be associated with each Unified CVP Call Server routing client.</td>
</tr>
<tr>
<td></td>
<td>3. When the routing script transfers the call into Unified CVP, it should use a single SendToVRU node. No subsequent node is necessary in order to perform the transfer to Unified CVP's VRU leg; this will take place automatically. (The SendToVRU node can be omitted since any micro-application script node will invoke the same functionality automatically; however, you can include this node explicitly in the script for troubleshooting purposes).</td>
</tr>
<tr>
<td></td>
<td>• Non-prerouted calls can also share the same Network VRU and the same Unified CVP Call Servers as those calls which are transferred from Unified CM. However, the scripts which handle non-prerouted calls must also use an explicit SendToVRU node before they can execute any micro-applications.</td>
</tr>
<tr>
<td></td>
<td>Associate all micro-application VRU scripts with that same Type 10 Network VRU.</td>
</tr>
<tr>
<td>Note</td>
<td>• When the routing script transfers the call into Unified CVP, it should use a single SendToVRU node. No subsequent node is necessary in order to perform the transfer to Unified CVP's VRU leg; this will take place automatically. (The SendToVRU node can be omitted since any micro-application script node will invoke the same functionality automatically; however, you can include this node explicitly in the script for troubleshooting purposes.)</td>
</tr>
<tr>
<td></td>
<td>• Non-prerouted calls can also share the same Network VRU and the same Unified CVP Call Servers as those calls which are transferred from Unified CM. However, the scripts which handle non-prerouted calls must also use an explicit SendToVRU node before they can execute any micro-applications.</td>
</tr>
<tr>
<td>ICME Release</td>
<td>Task</td>
</tr>
<tr>
<td>--------------</td>
<td>------</td>
</tr>
</tbody>
</table>
| Unified ICME Release 7.1 onwards | **1.** Configure two Network VRUs: one Type 7 and one Type 10.  
**2.** In the PG Explorer tool, assign the Unified CVP Call Servers to the Type 7 Network VRU.  
**3.** Configure one set of Translation Route labels to target the Type 7 Call Servers; these will be used to transfer the call from the original routing client to the Unified CVP Switch leg.  
**4.** Assign a label to the Type 10 Network VRU for each Unified CVP Call Server routing client, whose label string is set to the Network Routing Number.  
**5.** Configure the Type 10 Network VRU as the system default Network VRU in the System Information configuration tool.  
**6.** Associate all micro-application VRU scripts with the Type 10 Network VRU.  
**Note** | When the routing script to transfers the call into Unified CVP, it should use two nodes in succession: first, a TranslationRouteToVRU, and then an explicit SendToVRU node (which contrary to the Unified ICME 7.1 case, is not optional). The first node transfers the call from the initial routing client to one of the Type 7 Call Servers (Unified CVP Switch leg); the second one transfers the call from the Type 7 Call Server to the Unified CVP VRU leg. (The VRU leg will usually end up running through the same Unified CVP Call Server as the Switch leg.)  
- Non-prerouted calls can also share the same Type 7 Call Servers and Type 7 and Type 10 Network VRUs. |

**Calls Originated by an ACD or Call Routing Interface**

These calls are very similar to those which arrive from a preroute-only NIC, except that the routing client is connected to Unified ICME using a PG rather than using a NIC. Therefore, if this call flow is used in a Unified ICMH environment, the target Unified CVP Call Servers are required to be connected to the same CICM as the ACD or CRI-based VRU from which the call originates. Just as multiple CICMs will require multiple ACD or VRU peripherals, so will they require multiple Unified CVP Call Servers.

Further configuration points differ depending on whether Unified CVP is being deployed with Unified ICME Release 7.0 or 7.1 and later.
<table>
<thead>
<tr>
<th>ICME Release</th>
<th>Tasks</th>
</tr>
</thead>
</table>
| ICME Release 7.1 onwards | 1. Configure a single Type 10 Network VRU and associate it with all Unified CVP peripherals in the PG Explorer configuration tool, and also define it as the default system Network VRU in the System Information tool.  
2. In order to support the initial call transfer to Unified CVP from the pre-route routing client, configure Translation Route labels to target the Unified CVP peripherals.  
3. In order to support the transfer to VRU leg, configure the Type 10 Network VRU with Network Routing Number labels for each Unified CVP peripheral routing client.  
4. Associate all micro-application VRU scripts with that same Type 10 Network VRU.  
**Note**  
• When the routing script transfers the call into Unified CVP, it must use a TranslationRouteToVRU node. No subsequent node is necessary in order to perform the transfer to Unified CVP’s VRU leg; this will take place automatically.  
• Non-prerouted calls can also share the same Network VRU and the same Unified CVP Call Servers. |
<table>
<thead>
<tr>
<th>ICME Release</th>
<th>Tasks</th>
</tr>
</thead>
<tbody>
<tr>
<td>ICME Release 7.0 onwards</td>
<td>1. Configure two Network VRUs: one Type 7 and one Type 10.</td>
</tr>
<tr>
<td></td>
<td>2. In the PG Explorer tool, assign all Unified CVP Call Servers to the Type 7 Network VRU.</td>
</tr>
<tr>
<td></td>
<td>3. Configure one set of Translation Route labels to target the Type 7 Call Servers; these will be used to transfer the call from the original routing client to the Unified CVP Switch leg.</td>
</tr>
<tr>
<td></td>
<td>4. Assign a label to the Type 10 Network VRU for each Unified CVP Call Server routing client, whose label string is set to the Network Routing Number.</td>
</tr>
<tr>
<td></td>
<td>5. Configure the Type 10 Network VRU as the system default Network VRU in the System Information configuration tool.</td>
</tr>
<tr>
<td></td>
<td>6. Associate all micro-application VRU scripts with the Type 7 Network VRU.</td>
</tr>
</tbody>
</table>

**Note**
- When the routing script transfers the call into Unified CVP, it should use *two* nodes in succession: first, a TranslationRouteToVRU, and then an explicit SendToVRU node. The first node transfers the call from the initial routing client to one of the Type 7 Call Servers (Unified CVP Switch leg); the second one transfers the call from the Type 7 Call Server to the Unified CVP VRU leg. (The VRU leg will usually end up running through the same Unified CVP Call Server as the Switch leg.)
- Non-prerouted calls can also share the same Type 7 Call Servers and Type 7 and Type 10 Network VRUs.
Call Director Call Flow Model

In Call Director call flow model, Unified CVP provides ICME with VoIP call routing capabilities only. If you are using an ICM Server to queue calls or queue calls directly on an ACD, use your own Service Control VRU. Calls can be transferred multiple times, from Ingress, to customer-provided VRU, to either UCCE or customer-provided ACD or agent, and back again. When calls are connected to customer-provided equipment, their voice paths must go to an Egress gateway, which is connected by TDM to that equipment. If the signaling is SIP, then Unified CVP works with customer-provided SIP endpoints that have been tested and certified to interoperate with Unified CVP. No VXML Server or VXML Gateway is used in this model.

The following table lists the required and optional CVP components needed for the Call Director call flow model:

<table>
<thead>
<tr>
<th>CVP components</th>
<th>Related topics</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Required CVP components</strong></td>
<td></td>
</tr>
<tr>
<td>Call Server</td>
<td>• Call Server Configuration</td>
</tr>
<tr>
<td></td>
<td>• REFER Transfers, on page 32</td>
</tr>
<tr>
<td>Unified ICME</td>
<td>• Unified ICM Configuration</td>
</tr>
<tr>
<td></td>
<td>• Call Director Call Flow Model for Unified ICME, on page 42</td>
</tr>
<tr>
<td></td>
<td>• Call Director Call Flow Model for Unified ICMH, on page 43</td>
</tr>
<tr>
<td></td>
<td>• Configure ICM Settings for Call Director Call Flow Model, on page 149</td>
</tr>
<tr>
<td></td>
<td>• Define Unified CVP ECC Variables, on page 141</td>
</tr>
<tr>
<td>Ingress Gateway</td>
<td>• Gateway Configuration</td>
</tr>
<tr>
<td></td>
<td>• Configure Gateway Settings for Call Director Call Flow Model, on page 220</td>
</tr>
<tr>
<td></td>
<td>• Call Survivability, on page 374</td>
</tr>
<tr>
<td>Operations Console</td>
<td>Operations Console</td>
</tr>
<tr>
<td><strong>Optional CVP components</strong></td>
<td></td>
</tr>
<tr>
<td>Reporting Server</td>
<td>Reporting Server Configuration</td>
</tr>
<tr>
<td>SIP Proxy Server, if Call Server is configured to use SIP signaling</td>
<td>SIP Proxy Server Configuration</td>
</tr>
</tbody>
</table>

This section describes the following Call Director call flow models:

- **Call Director Call Flow Model for Unified ICME, on page 42**
Call Director Call Flow Model for Unified ICME

In this call flow model, Unified CVP provides Unified ICME with VoIP call switching capabilities. Provide your own Service Control VRU, if you are using Unified ICME to queue calls or you might queue calls directly on your ACD. Calls might be transferred multiple times, from Ingress, to customer-provided VRU, to either Unified CCE or customer-provided ACD or agent, and back again. When calls are connected to customer-provided equipment (either VoIP or TDM), their voice paths must go to an egress gateway, which is connected by TDM to that equipment. If the signaling is SIP, then this call flow model works with customer-provided SIP endpoints which have been tested and certified to interoperate with Unified CVP.

The following figures show the call flow for Call Director call flow model for ICME using SIP without and with a Proxy Server. The solid lines in these figures indicate voice paths and dashed lines indicate signaling paths.

*Figure 6: Call Director Call Flow Model for ICME Using SIP Without a Proxy Server*

*Figure 7: Call Director Call Flow Model for ICME Using SIP With a Proxy Server*
In this call flow model, Unified CVP stays in the signaling path after the transfer.

In this call flow model, VRU scripts and transfer to a VRU leg are not available.

For more information, see REFER Transfers, on page 32 and Set Up sendtooriginator Setting in the SIP Service of a Call Server, on page 65.

**Call Director Call Flow Model for Unified ICMH**

In this call flow model, Unified CVP only provides the Network Applications Manager (NAM) with VoIP call switching capabilities. If you are using the NAM to queue calls, or you might queue calls directly on your ACD, provide your own Service Control VRU. Calls may be transferred multiple times, from Ingress, to customer-provided VRU, to either the NAM or customer-provided ACD or agent, and back again. When calls are connected to customer-provided equipment, their voice paths must go to an egress gateway, which is connected by TDM to that equipment. If the signaling is SIP, then this call flow model works with customer-provided SIP endpoints which have been tested and certified to interoperate with Unified CVP.

The following figures show the call flow for Call Director call flow model for ICMH using SIP without and with a Proxy Server. The solid lines in these figures indicate voice paths and dashed lines indicate signaling paths.

*Figure 8: Call Director Call Flow Model for ICMH Using SIP Without a Proxy Server*
Set Up Call Director Call Flow Model

Procedure

Step 1
Perform Steps 1 to 5 of the Configure Gateway Settings for Comprehensive Call Flow Model, on page 210 procedure.

Step 2
Configure the Ingress Gateway:
   a) Configure the Ingress Gateway dial-peer for the Unified CVP Call Server.
   b) Configure a dial-peer for ringtone and error.
   c) If you are using a Proxy Server, configure your session target in the outbound dial peer to point to the Proxy Server.
   d) If you are using the sip-server global configuration, then configure the sip-server in the sip-ua section to be your Proxy Server and point the session target of the dial-peer to the sip-server global variable.

Note
Make sure your dial plan includes this information. You will need to see the Dial plan when you configure the SIP Proxy Server for Unified CVP.

The SIP Service voip dial peer and the destination pattern on the Ingress Gateway must match the DNIS in static routes on the SIP Proxy Server or Unified CVP Call Server.

See the SIP Devices Configuration and SIP Dialed Number Pattern Matching Algorithm, on page 9 for detailed information.

Step 3
For SIP without a Proxy Server, complete the following steps:
a) If you are using DNS query with SRV or A types from the gateway, configure the gateway to use DNS.

See the Operations Console online help for details. If you are using DNS query with SRV or A types from the gateway, use the gateway configuration CLI as shown below:

**Non-DNS Setup:**

```
sip-ua
sip-server ipv4:xx.xx.xxx.xxx:5060
```

**DNS Setup:**

```
ip domain name patz.cisco.com
ip name-server 10.10.111.16
! sip-ua
sip-server dns:cvp.pats.cisco.com
```

b) Configure the DNS zone file for the separate DNS server that displays how the Service (SRV) records are configured.

**Note** SRV with DNS can be used in *any* of the SIP call flow models, with or without a Proxy server. Standard A type DNS queries can be used as well for the calls, without SRV, but they lose the load balancing and failover capabilities.

See the [DNS Zone File Configuration for Call Director Call Flow Model](#), on page 52 for more information.

**Step 4** For SIP with a Proxy Server, use one of the following methods:

**Note** You can configure the Gateway statically instead of using DNS.

The following example shows how both the A and SRV type records could be configured:

```
ip host cvp4cc2.cisco.com 10.4.33.132
ip host cvp4cc3.cisco.com 10.4.33.133
ip host cvp4cc1.cisco.com 10.4.33.131
```

**For SIP/TCP:**

```
ip host _sip._tcp.cvp.cisco.com srv 50 50 5060 cvp4cc3.cisco.com
ip host _sip._tcp.cvp.cisco.com srv 50 50 5060 cvp4cc2.cisco.com
ip host _sip._tcp.cvp.cisco.com srv 50 50 5060 cvp4cc1.cisco.com
```

**For SIP/UDP:**

```
ip host _sip._udp.cvp.cisco.com srv 50 50 5060 cvp4cc3.cisco.com
ip host _sip._udp.cvp.cisco.com srv 50 50 5060 cvp4cc2.cisco.com
ip host _sip._udp.cvp.cisco.com srv 50 50 5060 cvp4cc1.cisco.com
```

**Note** The DNS Server must be configured with all necessary A type or SRV type records.

See the [SIP Devices Configuration](#).

If you are using the DNS Server, you can set your SIP Service as the Host Name (either A or SRV type).

**Step 5** On the Unified CM server, CCMAdmin Publisher, complete the following SIP-specific actions:
a) Create SIP trunks.
   
   • If you are using a SIP Proxy Server, set up a SIP trunk to the SIP Proxy Server.
   
   • Add a SIP Trunk for the Unified CVP Call Server.
   
   • Add a SIP Trunk for each Ingress gateway that will send SIP calls to Unified CVP that might be routed to Unified CM.

To add an SIP trunk, select **Device > Trunk > Add New** and use the following parameters:

   • **Trunk Type**: SIP trunk
   
   • **Device Protocol**: SIP
   
   • **Destination Address**: IP address or host name of the SIP Proxy Server (if using a SIP Proxy Server). If not using a SIP Proxy Server, enter the IP address or host name of the Unified CVP Call Server.
   
   • **DTMF Signaling Method**: RFC 2833
   
   • Do not check the **Media Termination Point Required** check box.
   
   • If you are using UDP as the outgoing transport on Unified CVP, also set the outgoing transport to **UDP** on the SIP Trunk Security Profile.
   
   • **Connection to CUSP Server**: use 5060 as the default port.

b) Add route patterns for outbound calls from the Unified CM devices using a SIP Trunk to the Unified CVP Call Server. Also, add a route pattern for error DN.

Select **Call Routing > Route/Hunt > Route Pattern > Add New**

Add the following:

   • **Route Pattern**: Specify the route pattern; for example: 3XXX for a TDM phone that dials 9+3xxx and all Unified ICME scripts are set up for 3xxx dialed numbers.
   
   • **Gateway/Route List**: Select the SIP Trunk defined in the previous substep.

   **Note**  For warm transfers, the call from Agent 1 to Agent 2 does not typically use a SIP Trunk, but you must configure the CTI Route Point for that dialed number on the Unified CM server and associate that number with your peripheral gateway user (PGUSER) for the JTAPI gateway on the Unified CM peripheral gateway. An alternative is to use the Dialed Number Plan on Unified ICME to bypass the CTI Route Point.

c) If you are sending callsto Unified CM using an SRV cluster domain name, select **Enterprise Parameters > Clusterwide Domain Configuration** and add the Cluster fully qualified domain name **FQDN**.

**Step 6** 
(Optionally) Configure the **SIP Proxy Server**.

a) Configure the SIP static routes to the Unified CVP Call Servers, Unified CM SIP trunks, and Gateways.

Configure the SIP static routes for intermediary transfers for ringtone, playback dialed numbers, and error playback dialed numbers.

   **Note**  For failover and load balancing of calls to multiple destinations, configure the CUSP server static route with priority and weight.

b) Configure Access Control Lists for Unified CVP calls.
Select **Proxy Settings > Incoming ACL**.

Address pattern: **all**

c) Configure the service parameters.

Select **Service Parameters**, then set the following:

- Add record route: **off**
- Maximum invite retransmission count: **2**
- Proxy Domain and Cluster Name: if using DNS SRV, set to the FQDN of your Proxy Server SRV name

d) Write down the IP address and host name of the SIP Proxy Server. (You need this information when configuring the SIP Proxy Server in Unified CVP.)

e) If using redundant SIP Proxy Servers (primary and secondary or load balancing), then decide whether to use DNS server lookups for SRV records or non-DNS based local SRV record configuration.

**Note** If a single CUPS Server is used, then SRV record usage is not required.

Configure the SRV records on the DNS server or locally on Unified CVP with a .xml file (local xml configuration avoids the overhead of DNS lookups with each call).

**Note** See the Local SRV File Configuration Example for SIP Messaging Redundancy, on page 168 section for details.

The Call Director call flow model with SIP calls will typically be deployed with dual CUSP servers for redundancy. In some cases, you might want to purchase a second CUSP server. Regardless, the default transport for deployment will be UDP; make sure you **always** disable the record-route in a CUSP server as this advanced feature is not supported in Contact Center deployments.

For the required settings in the Unified CM Publisher configuration, see the Cisco Unified SIP Proxy documentation.

**Step 7**

Configure the PGs for the switch leg.

On Unified ICME, ICM Configuration Manager, **PG Explorer** tool:

a) Configure each peripheral gateway (PG) to be used for the **Switch** leg. In the tree view pane, select the applicable PG, and set the following:

1. **Logical Controller** tab:
   
   • Client Type: **VRU**
   
   • Name: A name descriptive of this PG
   
   For example: `<location>_A` for side A of a particular location

2. **Peripheral** tab:

   • Peripheral Name: A name descriptive of this Unified CVP peripheral
   
   For example: `<location>_<cvp1>` or `<dns_name>`

   • Client Type: **VRU**
• Select the check box: **Enable Post-routing**

3. **Routing Client** tab:
   - Name: By convention, use the same name as the peripheral.
   - Client Type: **VRU**

For more information, see the [ICM Configuration Guide for Cisco ICM Enterprise Edition](#).

b) Configure a peripheral for each Unified CVP Call Server to be used for a Switch leg connected to each PG.

**Step 8**

Configure dialed numbers.

On the Unified ICME or Unified ICMH Server, in the ICM Configuration Manager, configure the following items:

a) **Dialled Number List Tool** tab: Configure the dialed numbers.

b) **Call Type List tool** tab: Configure the call types.

c) **ICM Instance Explorer tool** tab: Configure the applicable customers.

For more information, see the [ICM Configuration Guide for Cisco ICM Enterprise Edition](#).

**Step 9**

Create a Routing Script.

On the Unified ICME or Unified ICMH Server in the ICM Script Editor tool:

Create a routing script that handles the incoming call. The routing script must execute a Label node or Select node (node that returns a label right away).

**Note** *Do not* use the Queue node in the routing script.

The label must be configured in the SIP Proxy Server to the IP address of the device that the label corresponds to. The Proxy Server is optional. If you do not have one, you must configure the Gateway dial-peer to point to the Call Server (refer to the first step in this process). Also, you must configure the **destination labels** in the SIP Service for the Call Server.

See the [Scripting and Media Routing Guide for Cisco Unified ICM/Contact Center Enterprise & Hosted](#) for more information.

**Step 10**

Configure the SIP Proxy Server using the Operations Console.

Select **Device Management > SIP Proxy Server**.

**Step 11**

In the Operations Console, install and configure Call Servers.

a) Enable the ICM and SIP Services on the Call Server.

   In the Operations Console, select **Device Management > Unified CVP Call Server**.

   Select the check boxes: **ICM** and **SIP**

b) Configure the SIP Service:

   Select **Device Management > CVP Call Server > SIP tab**.

   • If you are using a SIP Proxy Server, enable the Outbound Proxy and select the SIP Proxy Server. If using a SIP Proxy Server, configure Local Static Routes on the SIP Proxy Server itself.
• If you are not using a SIP Proxy Server, configure Local Static Routes using the Dialed Number Pattern system configuration in the Operations Console. A local static route must be configured for each SIP gateway/ACD, SIP endpoint in order to receive calls.

• Check the default values for the SIP Service and change, if desired.

See the SIP Dialed Number Pattern Matching Algorithm, on page 9 for detailed information.

c) Configure the ICM Service by setting the maximum length DNIS to the length of the Network Routing Number:

• Select Device Management > CVP Call Server > ICM tab.
• Set the Maximum Length of DNIS to length of the Network Routing Number.

Example: if the Gateway dial pattern is 1800******, the maximum DNIS length is 10.
For detailed information, see the Operations Console online help.

Step 12 Configure local static routes:

If an outbound proxy is enabled on the Operations Console, configure local static routes on the SIP Proxy Server.

If no outbound proxy is enabled, configure local static routes using the Operations Console Dialed Number Pattern system configuration. See the SIP Dialed Number Pattern Matching Algorithm, on page 9 for detailed information.

The following is an example of a local static route configuration. A local static route contains a dialed number pattern and a routing address (IP Address, Hostname, or SIP Server Group name):

• 22291>, cvp-ringtone.cisco.com
• 22292>, cvp-error.cisco.com
• 1>, ccm-subscribers.cisco.com
• 2>, ccm-subscribers.cisco.com
• 3>, ccm-subscribers.cisco.com

Step 13 (Optional) On the Operations Console, configure the Reporting Server. Select Device Management > CVP Reporting Server > General tab:

a) Configure the Reporting Server.
b) Select a Call Server to associate with this Reporting Server.
c) Check the default values of the Reporting properties and change, if desired.


Related Topics
   Configure Gateway Settings for Comprehensive Call Flow Model, on page 210
   Set Up Ingress Gateway to Use Redundant Proxy Servers, on page 167
   Set Up Call Server with Redundant Proxy Servers, on page 167
Examples: Ingress Gateway Configuration

Example: Gateway Settings for Call Director Call Flow Model

The first part of the following example provides the basic configuration for setting an Ingress gateway:

- Applies a timestamp to debugging and log messages
- Turns on logging
- Turns off printing to the command line interface console
- Sends RTP packets
- Configures gateway settings

The last part of this example provides the following:

- Allows SIP to play a .wav file that enables caller to hear message from critical_error.wav
- Performs survivability
- Enables SIP to play ring tone to caller while caller is being transferred to an agent
- Logs errors on the gateway when the call fails
- Defines requirements for SIP Call Server

```
service timestamps debug datetime msec localtime
service timestamps log datetime msec localtime
!
service internal
logging buffered 99999999 debugging
no logging console
!
ip cef
!
voice rtp send-recv
!
voice service voip
signaling forward unconditional
h323
sip
min-se 360
header-passing
!
voice class codec 1
codec preference 1 g711ulaw
codec preference 2 g729a
```
Example: Incoming Pots Dial-peer for Call Director Call Flow Model

dial-peer voice 8 pots
description Example incoming POTS dial-peer
service cvp-survivability
incoming called-number <your DN pattern here>
direct-inward-dial
!

Example: SIP Ringtone Dial-peer for Call Director Call Flow Model

dial-peer voice 9191 voip
description SIP ringtone dial-peer
service ringtone
voice-class codec 1
voice-class sip relu1xx disable
incoming called-number <your ringtone DN pattern here>
dtmf-relay rtp-nte
no vad
!

Example: SIP Error Dial-peer for Call Director Call Flow Model

dial-peer voice 9292 voip
description SIP error dial-peer
service cvperror
voice-class codec 1
voice-class sip relu1xx disable
incoming called-number <your error DN pattern here>
dtmf-relay rtp-nte
no vad
!

Example: Dial-peer to Reach the Unified CVP Call Server or CUSP Server for Call Director Call Flow Model

dial-peer voice 800 voip
description Example Call Server Dialpeer with CUSP Server
destination-pattern <your DN pattern here>
voice-class codec 1
session protocol sipv2
session target sip-server
dtmf-relay rtp-nte
DNS Zone File Configuration for Call Director Call Flow Model

Example: DNS Zone File Linux NAMED Configuration

```
ringtone-1 IN A 10.86.129.20
  ringtone-2 IN A 10.86.129.229
vxml-1 IN A 10.86.129.20
  vxml-2 IN A 10.86.129.229
vxml-3 IN A 161.44.81.254
cvp-1 IN A 10.86.129.211
  cvp-2 IN A 10.86.129.220
  cvp-3 IN A 161.44.81.254;
; Priority Weight Port Target
  _SRV 1 1 5060 ringtone-2.sox.cisco.com.
  _SRV 1 1 5060 ringtone-2.sox.cisco.com.
  _SRV 1 1 5060 vxml-2.sox.cisco.com.
  SRV 1 1 5060 vxml-3.sox.cisco.com.
  SRV 2 1 5060 cvp-2.sox.cisco.com.
  SRV 3 1 5060 cvp-3.sox.cisco.com.
  SRV 2 1 5060 cvp-2.sox.cisco.com.
  SRV 3 1 5060 cvp-3.sox.cisco.com.
```
Unified CVP provides ICM with VRU services for calls which are routed in a manner, such as by a carrier switched network through an ICM network interface card (NIC). VRU services can be for initial prompt and collect, for integrated self service applications, for queuing, or for any combination thereof. This scenario does not use SIP and requires no Ingress Gateway.

Depending on the type of routing client being in charge of call routing, ICM may transfer the call to the VRU-Only Call Server either by a Translation Route to VRU node, or by a Send To VRU node. In former, the Call Server determines that the arriving call is a VRU leg call by matching the arriving DNIS with its configured list of arriving DNIS numbers. In latter, it determines that it is a VRU leg call because the DNIS length is greater than its configured maximum DNIS length. Digits beyond the maximum DNIS length are taken as the Correlation ID.

This section describes the following VRU-Only call flow models:

- **Type 8 VRU-Only Call Flow Model for ICME**, on page 54
- **Type 8 VRU-Only Call Flow Model for ICMH**, on page 55
- **Configure Gateway Settings for VRU-Only**: Type 7, on page 226
In VRU-Only call flow model, Unified CVP by itself does not provide queuing capability. However, it can hold calls being queued when used with Unified ICME/Unified CCE with appropriate Unified ICME network interface controllers.

Related Topics
- Call Server Configuration
- REFER Transfers, on page 32
- Gateway Configuration
- Configure Gateway Settings for VRU-Only: Type 7, on page 226
- Call Survivability, on page 374
- Operations Console
- Comprehensive Call Flow Model for ICME, on page 20
- Calls Arriving at ICME Through a Pre-Route-Only NIC, on page 34
- Calls Originated by Unified CM, on page 35
- Calls Originated by an ACD or Call Routing Interface, on page 38
- Define Unified CVP ECC Variables, on page 141
- Configure Common Unified ICMH for Unified CVP Switch Leg, on page 140
- Type 8 VRU-Only Call Flow Model for ICME, on page 54
- Type 8 VRU-Only Call Flow Model for ICMH, on page 55
- VXML Server Configuration
- Speech Server Configuration
- Media Server Configuration
- Reporting Server Configuration

Type 8 VRU-Only Call Flow Model for ICME

In this call flow model, Unified CVP works with the Voice Gateway to act as the VRU. The VRU voice treatment is provided by the Gateway and can include ASR/TTS Servers.

When deployed with an NIC being used to queue and transfer calls (VRU Type 8), the NIC interfaces with the TDM switch or with the PSTN to transfer the call to an agent. The Unified CVP SIP Service is part of this call flow model.

The following figure shows the Type 8 VRU-Only call flow model where the NIC transfers the call. In the figure, solid lines indicate voice paths and dashed lines indicate signaling paths.
Figure 10: Type 8 VRU-Only Call Flow Model Where NIC Transfers a Call

- Numbers in the figure represent call flow progression.
- Confirm that there is one Network VRU: a Type 8 when NIC is queuing and transferring calls.
- Define a Translation Route and labels for the VRU Peripheral (Network VRU labels do not need to be configured).
- Use the TranslationRouteToVRU node of the ICM Script Editor to connect the call to the Network VRU.

Type 8 VRU-Only Call Flow Model for ICMH

In this call flow model, the Unified CVP Call Server is deployed at the CICM level to act only as the VRU leg for the call. The VRU voice treatment is provided at the Voice Gateway, and may include ASR/TTS Servers.

- This call flow model is used when Unified CVP is connected to the CICM. The routing client in this call flow model is connected to the NAM.

When deployed with a NIC being used to queue and transfer calls (VRU Type 8), the NIC interfaces to the TDM switch to transfer the call to an agent. The SIP Service is part of this call flow model.

The following figure shows the Type 8 VRU-Only call flow model for ICMH. The solid lines in this figure indicate voice paths and dashed lines indicate signaling paths.
Set Up Type 8 VRU-Only Call Flow Model for ICME and ICMH

Procedure

Step 1

From the Operations Console (or the Unified CVP product CD), transfer the following script, configuration, and .wav files to the VoiceXML Gateway used for the VRU leg.

Transfer the following files:
- bootstrap.tcl
- handoff.tcl
- survivability.tcl
- bootstrap.vxml
- recovery.vxml
- ringtone.tcl
- cvpererror.tcl
- ringback.wav
- critical_error.wav

**Step 2** Configure the VXML gateway base settings.

**Step 3** Configure the VXML gateway service settings.

**Step 4** Configure the ICM VRU Label.

**Step 5** Define a Network VRU on Unified ICME or (for Unified ICMH) on the NAM and each CICM.

On the ICM Configuration Manager, the **Network VRU Explorer** tool, specify the following:

- **Type**: 8
- **Name**: cvpVRU

**Note** Although any name will work, cvpVRU is used by convention, and is the example name referenced elsewhere in this document.

**Step 6** Configure the Peripheral Gates (PGs) on Unified ICME or (for Unified ICMH) on each CICM.

a) Configure each PG.

b) Configure a peripheral for each Unified CVP ICM Service connected to each PG.

Use the ICM Configuration Manager, the **PG Explorer** tool. For each Unified CVP ICM Service connected to this PG, in the tree view pane, select the applicable PG and configure the following items:

**Logical Controller** tab:
- **Client Type**: VRU
- **Name**: A name descriptive of this PG
  
  *Example: <location>_A for side A of a particular location*

**Peripheral** tab:
- **Peripheral Name**: A name descriptive of this Unified CVP peripheral
  
  *Examples: <location>_<cvp1> or <dns_name>*
- **Client Type**: VRU
- **Select the checkbox**: Enable Post-routing

**Advanced** tab:
- From the Network VRU field drop-down list, select the name: cvpVRU

**Routing Client** tab:
- **Name**: By convention, use the same name as the peripheral.
- **Client Type**: VRU

**Step 7** Configure a Service and Route for each VRU on Unified ICME or (for Unified ICMH) on each CICM.

**Note** You can also use service arrays. Refer to the Unified ICME documentation set for more information.
Using the ICM Configuration Manager, the **Service Explorer** tool, specify the following:

- **Service Name**: cvpVRU
- **Route Name**: PeripheralName_cvpVRU
- **Peripheral Number**: 2
  
  Must match the "Pre-routed Call Service ID" in the Call Server configuration on the ICM tab in the Operations Console
- **Select the checkbox**: Enable Post-routing

**Step 8**

Define trunk groups.

**Note**  
You must configure one Network Transfer Group and one associated Trunk Group for each VRU leg Unified CVP ICM Service.

Define and configure the network trunk group on Unified ICME or (for Unified ICMH) on each CICM.

Using the ICM Configuration Manager, the Network **Trunk Group Explorer** tool:

a) Identify the network trunk group.
   - **Network Trunk Group Name**: A name descriptive of this trunk group

b) For each Unified CVP ICM Service for the VRU leg, configure an associated trunk group.
   - **Peripheral Name**: A name descriptive of this trunk group
   - **Peripheral Number**: 200
     
     Must match the "Pre-routed Call Trunk Group ID" in the Call Server configuration on the ICM tab in the Operations Console
   - **Trunk Count**: Select **Use Trunk Data** from the drop-down list
   - **Do not** configure any trunks

**Step 9**

Define translation route(s).

Define and configure a Translation Route for each VRU Peripheral on Unified ICME or (for Unified ICMH) on each CICM.

On Unified ICME, ICM Configuration Manager, the **Translation Route Explorer** tool:

a) Define a Translation Route for each VRU Peripheral. Specify the following:

   **Translation Route** tab:
   - Set the **Name** field to the name of the target VRU peripheral. (This is by convention; this value must be unique in the enterprise)
   - Set the **Type** field to DNIS and select the Service defined in the previous step

b) Configure translation route and label information for each VRU peripheral. Complete the following:

   **Route** tab:
• Set the Name: by convention, this is the name of the target VRU peripheral, followed by the DNIS that this route will use, for example, MyVRU_2000
  This value must be unique in the enterprise
• Service Name drop-down list, select: PeripheralName.cvpVRU

Peripheral Target tab:
• Enter the first DNIS that will be seen by the VRU that you will be using for this translation route.
  Note The DNIS pool used for each VRU peripheral must be unique
• From the drop-down list, select a Network Trunk Group which belongs to the target VRU

Label tab:
• Enter the translation route label (which might or might not be the same DNIS you entered on the Peripheral Target tab)
  • Type: Normal
  • Routing Client: Select the NIC Routing Client

You must create an additional label for each NIC routing client.
  Note Repeat the Route and corresponding Peripheral Target and Label information for each DNIS in the pool.

Step 10 Create VRU and routing scripts.
Create VRU scripts and routing scripts for IVR treatment and agent transfer on Unified ICME or (for Unified ICMH) on each CICM.
Using the ICM Script Editor tool, create the VRU scripts and routing scripts to be used for IVR treatment and agent transfer, as described in other sections of this manual and in the ICM manuals.
The VRU scripts are associated with the applicable Network VRU.
For example, cvpVRU
Use the ICM Script Editor’s TranslationRouteToVRU node to connect the call to the Network VRU.

Step 11 Configure the ECC variables on Unified ICME or (for Unified ICMH) on the NAM and each CICM.
Using the ICM Configuration Manager, create the ECC variables.
For more information, see Define Unified CVP ECC Variables, on page 141.

Step 12 Configure dialed numbers and call types on Unified ICME or (for Unified ICMH) on the NAM and each CICM.
On Unified ICME, using the ICM Configuration Manager, configure dialed numbers and call types.
For more information, refer to ICM Configuration Guide for Cisco ICM Enterprise Edition.

Step 13 On Unified CM configure Unified CM.
For more information, refer to the Unified CM user documentation.
Step 14  Install and configure the Call Server(s).

Using the Operations Console, select Device Management > CVP Call Server and install and configure the Call Server(s).

Select the check boxes: ICM and IVR

For detailed information, refer to the Operations Console online help.

Step 15  Configure the ICM service.

Using the Operations Console, select Device Management > CVP Call Server > ICM tab. On each Unified CVP Call Server, configure the ICM Service by specifying the following required information:

a) VRU connection port number.
   Set the VRU Connection Port to match the VRU connection Port defined in ICM Setup for the corresponding VRU peripheral gateway (PIM).

b) Maximum Length of DNIS.
   Set the maximum length DNIS to a number which is at least the length of the translation route DNIS numbers.
   Example: if the Gateway dial pattern is 1800******, the maximum DNIS length is 10.

c) Call service IDs: New Call and Pre-routed.
   Enter the new and pre-routed call service IDs. Configure the ports for both groups according to the licenses purchased, call profiles, and capacity by completing the required fields on this tab.

d) Trunk group IDs: New Call and Pre-routed.
   • Enter the new and pre-routed call trunk group IDs
   • Configure the group number for the Pre-routed Call Trunk group. The group number must match the trunk group number in the Network Trunk group used for the translation route
   • Configure the number of ports according to the licenses purchased and capacity
   • Configure each of the numbers used for translation routes. (The “New Call” group is not used since the calls are being sent to the VRU (Unified CVP) after some initial processing by the NIC/Unified ICME)

e) Dialed numbers used in the translation route.
   Add the dialed numbers in the DNIS field.

f) Check the default values of the other settings and change, if desired.

Step 16  Configure the IVR Service.

In the Operations Console, select Device Management > CVP Call Server > IVR tab.

Check the default values and change, if desired.

Refer to the Operations Console online help for information about other settings you might want to adjust from their default values.

Step 17  (Optional) Configure the Reporting Server.

In the Operations Console, select Device Management > CVP Reporting Server > General tab:
1. Configure the Reporting Server.

2. Select a Call Server to associate with this Reporting Server.

3. Check the default values of the Reporting properties and change, if desired.

For more information, refer to Reporting Guide for Cisco Unified Customer Voice Portal

**Related Topics**

- Define Unified CVP ECC Variables, on page 141

**Type 7 VRU-Only Call Flow Model Network VRU for ICMH**

In this call flow model, Unified CVP is deployed as a Network VRU at the NAM. The Unified CVP IVR Service in the Operations Console works with the Voice Gateway to act as the VRU. The VRU voice treatment is provided at the Voice Gateway and can include ASR/TTS. (This call flow model is used when Unified CVP is connected to the NAM.)

The NIC interfaces to the TDM switch to transfer calls to Unified CVP for VRU treatment and to queue and transfer calls using a VRU Type 7 call flow.

---

**Note**

Use this call flow model only if the PSTN to which the NIC is connected can transport a Correlation ID when it transfers a call. If this is not the setup you are using, then use the Type 8 VRU-Only Call Flow Model for ICMH, on page 55. The Unified CVP SIP Service is part of this call flow model.

The following figure shows the Type 7 VRU-only call flow model network VRU for ICMH. In the figure, solid lines indicate voice paths and dashed lines indicate signaling paths.

*Figure 12: Type 7 VRU-Only Call Flow Model Network VRU for ICMH*
• For simplicity, the figure does not illustrate a call flow model for redundancy and failover.

• The numbers in the figure indicate call flow progression.

• Set the Network VRU Type to Type 7. There is no difference between these two types except that Type 7 causes ICME to explicitly inform Unified CVP when it is about to transfer the call away from Unified CVP. (Most customers use Type 7.)

• The Network VRU names (where applicable), correlation IDs, and the ECC variable configurations must be identical on the NAM and CICM. All Labels must also be duplicated, although their routing clients will be different.

• Use the SendToVRU node of CICM Script Editor to connect the call to the Network VRU.

Related Topics
Type 8 VRU-Only Call Flow Model for ICMH, on page 55

Set Up Type 3 or 7 VRU-Only Call Flow Model Network VRU for ICMH

Procedure

Step 1  Perform Steps 1 to 4 of the Set Up Type 8 VRU-Only Call Flow Model for ICME and ICMH, on page 56 procedure.

Step 2  Configure each PG.

On the NAM, ICM Configuration Manager, PG Explorer tool:

a) Configure each PG to be used for the VRU Client leg.
b) Configure a peripheral for each Unified CVP ICM Service to be used as a VRU leg connected to each PG.

For each Unified CVP ICM Service connected to this PG, in the tree view pane, select the applicable PG.

Logical Controller tab, configure:

• Client Type: VRU
• Name: A name descriptive of this PG
  For example: <location>_A for side A of a particular location

Peripheral tab, configure:

• Peripheral Name: A name descriptive of this VRU peripheral.
  For example: <location>_cvp1> or <dns_name>
• Client Type: VRU
• Select the checkbox: Enable Post-routing

Routing Client tab:
• Name: By convention, use the same name as the peripheral.

• Client Type: VRU

**Step 3**

Define a Network VRU and labels.

On the **CICM**, ICM Configuration Manager, **Network VRU Explorer** tool, define a Network VRU for the VRU leg and labels for reaching the NAM.

Specify the following:

• Type: 3 or 7

• Name: `cvpVRU`

  **Note**  This name is used by convention. Although any name will do, since it is referenced elsewhere in this document, `cvpVRU` is assumed.

• Define a **Label** for the NAM:

  • Label: Network routing number

  • Type: **Normal**

  • Routing client: Select the INCRP Routing Client from the drop-down list.

**Step 4**

Define a Network VRU and a label for each NIC.

On the **NAM**, ICM Configuration Manager, **Network VRU Explorer** tool, define a Network VRU and a label for each NIC that is using this VRU.

Specify the following:

• Type: 3 or 7

• Name: `cvpVRU`

  **Note**  This name is used by convention. Although any name will work, since it is referenced elsewhere in this document, `cvpVRU` is assumed.

• Define a **Label** for each NIC that is using this VRU:

  • Label: Network routing number

  • Type: **Normal**

  • Routing client: Select the Routing Client for that NIC from the drop-down list.

  **Note**  Make sure the Network VRU label is identical in the NAM and CICM. The Network VRU Name must be identical as well to avoid confusion.

**Step 5**

If there will be Routing Scripts on the NAM, define a default Network VRU.

On the **NAM**, ICM Configuration Manager, **System Information** tool, in the General section:

• Define the Default Network VRU: `cvpVRU`

**Step 6**

Define a default VRU.
On the CICM, ICM Configuration Manager, System Information tool, in the General section:

- Define a default Network VRU: cvpVRU

**Step 7**
Create the VRU and routing scripts.

On the CICM, ICM Script Editor tool:
Create the VRU scripts and routing scripts to be used for IVR treatment and agent transfer, as described in other sections of this manual and in the Unified ICME manuals. The VRU scripts are associated with the applicable Network VRU, that is, cvpVRU.

Use the ICM Script Editor’s SendToVRU node to connect the call to the Network VRU.

**Note** A RunVRU Script or Queue node is an “implicit” SendToVRU node, although error handling will be easier if the explicit “SendToVRU” node is used.

**Step 8**
Configure the ECC variables.

On the NAM and CICM, ICM Configuration Manager, configure the ECC variables.
For more information, see Define Unified CVP ECC Variables, on page 141.

**Step 9**
Configure dialed numbers and call types.

On the NAM and CICM, ICM Configuration Manager, configure dialed numbers and call types.
For more information, refer to ICM Configuration Guide for Cisco ICM Enterprise Edition.

**Step 10**
Define customers.

On the NAM and CICM, ICM Configuration Manager:
1. If necessary, differentiate VRUs (Unified CVPs) based on dialed number.
2. Define customers and their Network VRU.

For more information, see Common Configuration for Differentiating VRUs Based on Dialed Number, on page 148.

**Step 11**
On Cisco Unified CM, configure Unified CM.
For more information, refer to the Unified CM user documentation.

**Step 12**
Install and configure the Call Server(s).

In the Operations Console, select Device Management > CVP Call Server.

**Step 13**
Configure the ICM Service for each Call Server.

In the Operations Console, select Device Management > CVP Call Server > ICM tab. For each Unified CVP Call Server, configure the ICM Service by specifying the following required information:

1. VRU connection port number.
   - Set the VRU Connection Port to match the VRU connection Port defined in ICM Setup for the corresponding VRU peripheral gateway (PIM).

2. Set the maximum length DNIS to the length of the Network Routing Number.
   - Example: if the Gateway dial pattern is 1800******, the maximum DNIS length is 10.
3. Call service IDs: New Call and Pre-routed.
   Enter the new and pre-routed call service IDs. Configure the ports for both groups according to the licenses purchased, call profiles, and capacity by completing the required fields on this tab.

4. Trunk group IDs: New Call and Pre-routed.
   Enter the new and pre-routed call trunk group IDs. Configure the group number for the Pre-routed Call Trunk group. The group number must match the trunk group number in the Network Trunk group used for the translation route.
   Configure the number of ports according to the licenses purchased and capacity. Configure each of the numbers used for translation routes. (The “New Call” group is not used since the calls are being sent to the VRU (Unified CVP) after some initial processing by the NIC/Unified ICME.)

5. Check the default values of other settings and change, if desired.

Step 14 Configure the IVR service.
In the Operations Console, select Device Management > CVP Call Server > IVR tab and configure the IVR Service.
Check the default values and change, if desired.
Refer to the Operations Console online help for information about other settings you might want to adjust from their default values.

Step 15 (Optionally) Configure the Reporting Server.
In the Operations Console, select Device Management > CVP Reporting Server > General tab and configure the Reporting Server.

1. Configure the Reporting Server.
2. Select a Call Server to associate with this Reporting Server.
3. Check the default values of the Reporting properties and change, if desired.


Related Topics
Set Up Type 8 VRU-Only Call Flow Model for ICME and ICMH, on page 56
Define Unified CVP ECC Variables, on page 141
Common Configuration for Differentiating VRUs Based on Dialed Number, on page 148

Set Up sendtooriginator Setting in the SIP Service of a Call Server

For the Unified CVP Branch call flow model, incoming calls into the Unified CVP Call Server from a gateway can be automatically routed back to the originating gateway at the branch using the sendtooriginator setting in the SIP Service of the Call Server. This setting overrides sending the call to the outbound proxy or to any
locally configured static routes on Unified CVP. If the label returned from Unified ICME for the Unified CVP transfer matches one of the configured patterns in the Unified CVP sendtooriginator settings, then the call is routed to the sip:<label>@<host portion from header of incoming invite>SIP URL.

**Note**

- The setting on the IOS gateway for signaling forward unconditional is required only if ISDN call variables need to be available in the Unified ICME scripting environment. If these call variables are not required, then this setting can be omitted. The setting makes the SIP INVITE message larger in terms of bytes due to the extra payload in the message body for GTD variables. If the packet size is significantly greater than 1300 bytes, then TCP transport may be used over UDP transport due to the possibility of a network fragmentation of messages. See the Operations Console online help for more information.

- If the pattern matches the label returned from ICM, then the call is routed to the originating host derived from the incoming calls remote party ID header or contact header.

- The call is sent to the origination gateway if the following statements are true:
  - The remote party ID header is present on the incoming SIP invite.
  - The user agent header of the INVITE indicates an IOS gateway.
  - The pattern matcher on the label is configured for send-to-origin.
Operations Console

- Sign In to Operations Console, on page 67
- Sign Out of Operations Console, on page 68
- Operations Console Menus and Options, on page 69
- System-Level Operation States, on page 74

Sign In to Operations Console

Before you begin

- Install Operations Console from the Unified CVP software CD.
- Make a note of the password for the default Administrator account that you created during the installation.

Note

By default, the Operations Console session expires after 60 minutes. Relogin to Operations Console after the session expires.

Procedure

Step 1
From the web browser, enter https://ServerIP:9443/oamp, where ServerIP is the IP address or hostname of the machine on which the Operations Console is installed.

The main Unified CVP window opens.

Step 2
Enter your user ID in the Username field.

Enter Administrator, which is the default user account.

Step 3
In the Password field, enter your password.

If you are logging in to the default Administrator account, enter the password that was set for this account during installation.

If the user ID or password is invalid, the Operations Console Server displays the message, "Invalid Username or password." Enter your user ID and password again and click OK.
The main Cisco Unified Customer Voice Portal window opens.

**Step 4** Check your security policy and, if needed, change the settings to a less restrictive level. Default security settings can prevent users from using the Operations Console.

---

**Sign Out of Operations Console**

From the Operations Console header, click **Sign out**.

The Login page of Unified Customer Voice Portal window appears.
# Operations Console Menus and Options

<table>
<thead>
<tr>
<th>Menu</th>
<th>Options</th>
<th>Use To</th>
</tr>
</thead>
<tbody>
<tr>
<td>System</td>
<td>Control Center</td>
<td>View the status of the Cisco Unified CVP environment in a network control center. View the status and statistics by Device Type or Device Pools, logical groups of devices in the Cisco Unified CVP solution. Initiate Start, Shutdown, or Graceful Shutdown actions on devices in the Control Center.</td>
</tr>
<tr>
<td>Device Pool</td>
<td></td>
<td>Create, modify, and delete device pool names and descriptions for logical groups of devices (for example, all devices located in a geographical region).</td>
</tr>
<tr>
<td>Import System Configuration</td>
<td></td>
<td>Import a previously-saved Operations Console Server configuration file and apply it to the current system.</td>
</tr>
<tr>
<td>Export System Configuration</td>
<td></td>
<td>Save and export all configuration information for the Operations Console Server to a single file on your local computer. You can later use this file to restore an Operations Console Server during disaster recovery.</td>
</tr>
<tr>
<td>Location</td>
<td></td>
<td>Add, edit, synchronize, and delete Unified CM location information.</td>
</tr>
<tr>
<td>SIP Server Groups</td>
<td></td>
<td>Configure server groups for SIP and view Call Server deployment status.</td>
</tr>
<tr>
<td>Web Services</td>
<td></td>
<td>Configure Diagnostic Portal servlet credentials.</td>
</tr>
<tr>
<td>Dialed Number Pattern</td>
<td></td>
<td>Configure the Dialed Number Patterns for a destination. You can define the dialed numbers for the Error Tone, Ring Tone, and other destinations.</td>
</tr>
<tr>
<td>IOS Configuration</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Menu</td>
<td>Options</td>
<td>Use To</td>
</tr>
<tr>
<td>----------------------</td>
<td>-------------------------------------------------------------------------</td>
<td>----------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td></td>
<td><strong>IOS Template Management</strong> - Add, Delete, Edit, Copy, and View an IOS</td>
<td>configuration pushed to an IOS gateway. The template contains the IOS commands required for use in a Unified CVP deployment.</td>
</tr>
<tr>
<td></td>
<td><strong>IOS Template Deployment</strong> - Deploy a gateway configuration template to</td>
<td>an IOS gateway. The template provisions the gateway and substitutes any variables in the template with the source devices that are chosen when it is deployed.</td>
</tr>
<tr>
<td></td>
<td>an IOS gateway.</td>
<td></td>
</tr>
<tr>
<td></td>
<td><strong>Courtesy Callback</strong></td>
<td>Configure allowed and denied dialed numbers, maximum callbacks per number, and Call Server deployment.</td>
</tr>
<tr>
<td>Menu</td>
<td>Options</td>
<td>Use To</td>
</tr>
<tr>
<td>-------------------------------</td>
<td>--------------------------------</td>
<td>----------------------------------------------------------------------</td>
</tr>
<tr>
<td>Device Management</td>
<td>Unified CVP Call Server</td>
<td>Configure Call Server general and infrastructure settings; specify call services settings for each deployment model; associate Call Servers with device pools and the SIP Proxy Server; and apply licenses to a Call Server.</td>
</tr>
<tr>
<td></td>
<td>Unified CVP Reporting Server</td>
<td>Configure Reporting Server general and infrastructure settings, associate Reporting Servers with Call Servers, specify reporting properties, and associate Reporting Servers with device pools. Perform Reporting database administration: schedule database backups and purges; manage database and reporting user names and passwords; apply licenses to a Reporting Server.</td>
</tr>
<tr>
<td></td>
<td>Unified CVP VXML Server</td>
<td>Configure VXML Server general and infrastructure settings; specify primary and backup Call Servers; enable VXML Server reporting and specify VoiceXML data filters; associate VXML Servers with device pools; and apply licenses and transfer scripts to a VXML Server.</td>
</tr>
<tr>
<td></td>
<td>Unified CVP VXML Server (standalone)</td>
<td>Configure VXML Server (standalone) general settings; associate VXML Server (standalone) with device pools; and apply licenses and transfer scripts to a VXML Server (standalone).</td>
</tr>
<tr>
<td></td>
<td>Note</td>
<td>A VXML Server (standalone) handles calls that arrive through a VoiceXML gateway. (No statistics are provided when the VXML Server is configured this way.) Also, you cannot configure a database to and capture data from VXML Server (standalone) applications.</td>
</tr>
<tr>
<td>Gatekeeper</td>
<td>Configure a Gatekeeper and add this device to the Device Pool.</td>
<td></td>
</tr>
<tr>
<td>Gateway</td>
<td>Configure Gateway general settings; associate Gateways with device pools; execute a subset of IOS commands; view gateway statistics; and transfer files.</td>
<td></td>
</tr>
<tr>
<td>Menu</td>
<td>Options</td>
<td>Use To</td>
</tr>
<tr>
<td>-------------------------</td>
<td>------------------------------</td>
<td>------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Virtualized Voice Browser</td>
<td>Configure VVB general settings and associate VVB with device pools.</td>
<td></td>
</tr>
<tr>
<td>Device Past Configurations</td>
<td>Review and Restore past device configurations.</td>
<td></td>
</tr>
<tr>
<td>Media Server</td>
<td>Configure Media Server general settings and associate a Media Server with device pools.</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Note A Media Server administers the media files that contain messages and prompts callers hear.</td>
<td></td>
</tr>
<tr>
<td>Unified CM</td>
<td>Configure Unified CM general settings; specify the URL to the Unified CM Device Administration page; and associate the Unified CM with device pools.</td>
<td></td>
</tr>
<tr>
<td>Unified ICM</td>
<td>Configure ICM Server general settings and associate the ICM Server with device pools.</td>
<td></td>
</tr>
<tr>
<td>SIP Proxy Server</td>
<td>Configure SIP Proxy Server general settings; specify the URL to the SIP Proxy Server Device Administration page; and associate the SIP Proxy Server with device pools.</td>
<td></td>
</tr>
<tr>
<td>Unified IC</td>
<td>Configure CUIS Server general settings and associate the CUIS Server with device pools.</td>
<td></td>
</tr>
<tr>
<td>Device Past Configurations</td>
<td>Review and Restore past device configurations.</td>
<td></td>
</tr>
<tr>
<td>Device Versions</td>
<td>View version information for the Call Server, Reporting Server, VXML Server, and VXML Server (standalone).</td>
<td></td>
</tr>
<tr>
<td>User Management</td>
<td>User Roles</td>
<td>Create, modify, and delete user roles. Assign SuperUser, Administrator, or Read Only access privileges to roles.</td>
</tr>
<tr>
<td></td>
<td>User Groups</td>
<td>Create, modify, and delete user groups. Assign roles to user groups.</td>
</tr>
<tr>
<td></td>
<td>Users</td>
<td>Manage Unified CVP users, and assign them to groups and roles.</td>
</tr>
<tr>
<td>Menu</td>
<td>Options</td>
<td>Use To</td>
</tr>
<tr>
<td>----------------------</td>
<td>---------</td>
<td>----------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Bulk Administration</td>
<td>File Transfer</td>
<td>Transfer license files and script files to multiple devices at a time. The <strong>File Transfer</strong> submenu consists of the following options:</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Licenses</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Scripts and Media</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• VXML Applications</td>
</tr>
<tr>
<td>SNMP</td>
<td>V1/V2c</td>
<td>Configure the SNMP agent that runs on the Unified CVP device to use the V1/V2 SNMP protocol to communicate with an SNMP management station; add and delete SNMP V1/V2c community strings; configure a destination to receive SNMP notifications from an SNMP management station; and associate community strings with the device.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>The <strong>V1/V2c</strong> submenu consists of the following options:</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Community String</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Notification Destination</td>
</tr>
<tr>
<td>V3</td>
<td></td>
<td>Configure the SNMP agent that runs on the Unified CVP device to use the V3 SNMP protocol to communicate with an SNMP management station; add and delete SNMP users and set their access privileges; configure a destination to receive SNMP notifications from an SNMP management station; and associate SNMP users with devices.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>The <strong>V3</strong> submenu consists of the following options:</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• User</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Notification Destination</td>
</tr>
<tr>
<td>System Group</td>
<td></td>
<td>Configure the MIB2 System Group system contact and location settings, and associate the MIB2 System Group with devices. The <strong>System Group</strong> submenu consists of the <strong>MIB2</strong> option.</td>
</tr>
<tr>
<td>Tools</td>
<td>SNMP Monitor</td>
<td>Launch the SNMP Monitor application in a new browser window.</td>
</tr>
<tr>
<td></td>
<td>Configure</td>
<td>Display the URLs that launch the SNMP Monitor.</td>
</tr>
</tbody>
</table>
System-Level Operation States

The Operations Console provides status information of for each device. A device can be in one of the states as listed in the following table.

**Table 11: Description of States Displayed in the Status Window**

<table>
<thead>
<tr>
<th>State</th>
<th>Reasons</th>
</tr>
</thead>
<tbody>
<tr>
<td>Success</td>
<td>Indicates that the operation was successful.</td>
</tr>
<tr>
<td>Pending</td>
<td>Indicates that the operation has not yet been executed.</td>
</tr>
<tr>
<td>In Progress</td>
<td>Indicates that the operation is in progress.</td>
</tr>
<tr>
<td>State</td>
<td>Reasons</td>
</tr>
<tr>
<td>-----------------------</td>
<td>--------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Failed</td>
<td>The reasons for a <strong>failed deployment</strong> state are listed below:</td>
</tr>
<tr>
<td></td>
<td>• Unable to locate IP address in the database</td>
</tr>
<tr>
<td></td>
<td>• General database failure</td>
</tr>
<tr>
<td></td>
<td>• The call server was not deployed</td>
</tr>
<tr>
<td></td>
<td>• Unknown error</td>
</tr>
<tr>
<td></td>
<td>• Notification error: Contact administrator</td>
</tr>
<tr>
<td></td>
<td>• Could not write to properties file</td>
</tr>
<tr>
<td></td>
<td>• The Call Server device is using an unknown version of the Unified CVP software</td>
</tr>
<tr>
<td></td>
<td>• The Call Server device is using an older version of the Unified CVP software</td>
</tr>
<tr>
<td></td>
<td>• Configuration not removed from the database</td>
</tr>
<tr>
<td></td>
<td>This failure has multiple reasons:</td>
</tr>
<tr>
<td></td>
<td>• Could not write to properties file</td>
</tr>
<tr>
<td></td>
<td>• Device has not been deployed</td>
</tr>
<tr>
<td></td>
<td>• General failure</td>
</tr>
<tr>
<td></td>
<td>• Unable to access the Database</td>
</tr>
<tr>
<td></td>
<td>The reasons for a <strong>failed synchronization</strong> state are listed below:</td>
</tr>
<tr>
<td></td>
<td>• Device is inaccessible</td>
</tr>
<tr>
<td></td>
<td>• Authentication failure</td>
</tr>
<tr>
<td></td>
<td>• Web service is not available on the device</td>
</tr>
<tr>
<td></td>
<td>• General database error</td>
</tr>
<tr>
<td></td>
<td>• General error</td>
</tr>
<tr>
<td></td>
<td>• Unknown host address</td>
</tr>
<tr>
<td></td>
<td>• SOAP service error</td>
</tr>
</tbody>
</table>

**Note**

If you make any configuration changes after your initial deployment of any System-level configuration tasks, deploy the changed configuration again.
System-Level Operation States
CHAPTER 4

Call Server Configuration

• Configure Call Server, on page 77
• Call Server Settings, on page 78

Configure Call Server

Procedure

Step 1 Log in to the Operations Console and click Device Management > Unified CVP Call Server.
Step 2 Click Add New.

Note To use an existing Call Server as a template for configuring a new Call Server, select a Call Server from the list of available Call Servers, click Use As Template, and perform Steps 3 to 5.

Step 3 Click the General tab, enter the field values, and click Next. See General Settings, on page 78.

The Services you select in the General tab appear as tabs.

Step 4 Click the following tabs and modify the default values of fields, if required:
   a) ICM. See ICM Service Settings, on page 79.
   b) SIP. See SIP Service Settings, on page 82.
   c) IVR. See IVR Service Settings, on page 94.
   d) Device Pool. See Add or Remove Device From Device Pool, on page 98.
   e) Infrastructure. See Infrastructure Service Settings, on page 98.

Step 5 Click Save & Deploy.

Note Click Save to save the changes on the Operations Console and configure the Call Server later.

Related Topics
   General Settings, on page 78
   ICM Service Settings, on page 79
   SIP Service Settings, on page 82
   IVR Service Settings, on page 94
Call Server Settings

General Settings

To add or edit a Call Server, click the General tab and enter or modify the field values, as listed in the following table:

Table 12: Call Server General Tab Configuration Settings

<table>
<thead>
<tr>
<th>Property</th>
<th>Description</th>
<th>Default Value</th>
<th>Range</th>
<th>Restart Required</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>General</strong></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>IP Address</td>
<td>The IP address of the Call Server.</td>
<td>None</td>
<td>Valid IP address</td>
<td>No</td>
</tr>
<tr>
<td>Hostname</td>
<td>The hostname of the Call Server.</td>
<td>None</td>
<td>A valid DNS name, which includes the uppercase and lowercase letters, the numbers 0 through 9, and a dash</td>
<td>No</td>
</tr>
<tr>
<td>Description</td>
<td>The description of the Call Server.</td>
<td>None</td>
<td>0 to 1024 characters</td>
<td>No</td>
</tr>
<tr>
<td>Enable Secure Communication with the Ops Console</td>
<td>Select to enable secure communications between the Operations Console and the Call Server. The device is accessed using SSH and files are transferred using HTTPS.</td>
<td>None</td>
<td>Enabled or Disabled</td>
<td>Yes</td>
</tr>
<tr>
<td><strong>Note</strong></td>
<td>Enable this option after you configure secure communications.</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Device Version</td>
<td>Lists the Release and Build Number for this device.</td>
<td>Read-only</td>
<td>Read-only</td>
<td>No</td>
</tr>
</tbody>
</table>

Turn On Services
ICM Service Settings

Restart the Call Server if you configure the ICM Service on a Call Server for the first time. To configure ICM service settings on a Call Server, on the ICM tab, enter or modify the field values, as listed in the following table:

**Table 13: ICM Service Configuration Settings**

<table>
<thead>
<tr>
<th>Property</th>
<th>Description</th>
<th>Default Value</th>
<th>Range</th>
<th>Restart Required</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>General Configuration</strong></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>VRU Connection Port</td>
<td>The Port Number on which the Intelligent Call Management (ICM) Service listens for a TCP connection from the ICM PIM.</td>
<td>5000</td>
<td>Any valid TCP/IP connection port</td>
<td>Yes</td>
</tr>
</tbody>
</table>
### Maximum Length of DNIS

The maximum length of an incoming Dialed Number Identification Service (DNIS). DNIS is a phone service that identifies the number a caller dialed. Your network dial plan has the information for the maximum length of DNIS. The number of DNIS digits from the PSTN must be less than or equal to the maximum length of DNIS field.

For example, if the Gateway dial pattern is 1800******, the value of **Maximum Length of DNIS** field should be 10.

#### Note
If you are using the Correlation ID method in your ICM script to transfer calls to Unified CVP, the maximum length of DNIS should be the length of the label that is returned from ICM for the VRU leg of the call. When ICM transfers the call, the Correlation ID is appended to the label. Unified CVP then separates the two, assuming that any digits greater than maximum length of DNIS are the Correlation ID. The Correlation ID and label are then passed to ICM.

<table>
<thead>
<tr>
<th>Property</th>
<th>Description</th>
<th>Default Value</th>
<th>Range</th>
<th>Restart Required</th>
</tr>
</thead>
<tbody>
<tr>
<td>Maximum Length of DNIS</td>
<td>The maximum length of an incoming Dialed Number Identification Service (DNIS). DNIS is a phone service that identifies the number a caller dialed. Your network dial plan has the information for the maximum length of DNIS. The number of DNIS digits from the PSTN must be less than or equal to the maximum length of DNIS field. For example, if the Gateway dial pattern is 1800******, the value of <strong>Maximum Length of DNIS</strong> field should be 10. <strong>Note</strong> If you are using the Correlation ID method in your ICM script to transfer calls to Unified CVP, the maximum length of DNIS should be the length of the label that is returned from ICM for the VRU leg of the call. When ICM transfers the call, the Correlation ID is appended to the label. Unified CVP then separates the two, assuming that any digits greater than maximum length of DNIS are the Correlation ID. The Correlation ID and label are then passed to ICM.</td>
<td>10</td>
<td>Integer. Valid input for this field is 1 to 99999 characters.</td>
<td>No</td>
</tr>
</tbody>
</table>

### Translation Routed DNIS Pool

<table>
<thead>
<tr>
<th>Property</th>
<th>Description</th>
<th>Default Value</th>
<th>Range</th>
<th>Restart Required</th>
</tr>
</thead>
<tbody>
<tr>
<td>Add</td>
<td>Enter a single DNIS number for translation routed calls. Validation for DNIS field are:</td>
<td>None</td>
<td>Integer up to 32 characters</td>
<td>No</td>
</tr>
<tr>
<td></td>
<td>• The DNIS must be a positive integer and can begin with a zero.</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>• The first and the last values for the DNIS range must be of the same length.</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>• You cannot add a DNIS or DNIS range that already exists or overlaps with DNIS or is in the range of a DNIS.</td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>
### ICM Service Settings

#### Call Server Configuration

<table>
<thead>
<tr>
<th>Property</th>
<th>Description</th>
<th>Default Value</th>
<th>Range</th>
<th>Restart Required</th>
</tr>
</thead>
<tbody>
<tr>
<td>Add a Range</td>
<td>This range is a list of DNIS numbers used for translation of routed calls. Click Add a Range and enter the first and the last DNIS numbers in the range in the to field. Click Add DNIS to add the entered DNIS or DNIS range to the list of Configured DNIS numbers. Select a DNIS or DNIS range in the Configured DNIS box and click Delete DNIS to remove it from the list of Configured DNIS numbers. The first and the last values for the DNIS range must be of the same length.</td>
<td>None</td>
<td>Integer up to 32 characters</td>
<td>No</td>
</tr>
</tbody>
</table>

#### Advanced Configuration

<table>
<thead>
<tr>
<th>Property</th>
<th>Description</th>
<th>Default Value</th>
<th>Range</th>
<th>Restart Required</th>
</tr>
</thead>
<tbody>
<tr>
<td>New Call Service ID</td>
<td>Enter a value that identifies calls to be presented to ICM software as a new call. New Call Service ID calls result in a NEW CALL message being sent to ICM software and the call being treated as a new call, even if it had been prerouted by ICM software.</td>
<td>1</td>
<td>Integer</td>
<td>Yes</td>
</tr>
<tr>
<td>Pre-routed Service ID</td>
<td>Enter a value that identifies calls prerouted with either a translation route or correlation ID. Pre-routed Service ID calls result in a REQUEST_INSTRUCTION message being sent to ICM software, which continues to run the script for the call.</td>
<td>2</td>
<td>Integer</td>
<td>Yes</td>
</tr>
<tr>
<td>New Call Trunk Group ID</td>
<td>Calls presented to ICM as new calls are sent with New Trunk Group ID as part of the NEW_CALL message to ICM.</td>
<td>100</td>
<td>Integer</td>
<td>Yes</td>
</tr>
<tr>
<td>Pre-routed Call Trunk Group ID</td>
<td>Calls pre-routed with a Translation Route or correlation ID are sent with Pre-routed Trunk Group ID as part of the REQUEST_INSTRUCTION message to ICM.</td>
<td>200</td>
<td>Integer</td>
<td>Yes</td>
</tr>
</tbody>
</table>
SIP Service Settings

Restart the Call Server if you configure SIP service settings for the first time. To configure SIP service settings on a Call Server, on the SIP tab, enter or modify the field values, as listed in the following table:

<table>
<thead>
<tr>
<th>Property</th>
<th>Description</th>
<th>Default Value</th>
<th>Range</th>
<th>Restart Required</th>
</tr>
</thead>
<tbody>
<tr>
<td>Select QoS Level</td>
<td>Select the Quality of Service level between the ICM Service and the ICM VRU PIM.</td>
<td>cs3</td>
<td>The drop-down list has the following values: af11, af12, af13, af21, af22, af23, af31, af32, af33, af41, af42, af43, cs1, cs2, cs3, cs4, cs5, cs6, cs7, default, ef</td>
<td>Yes</td>
</tr>
<tr>
<td></td>
<td><strong>Note</strong> For more information, see Implementing Quality of Service Policies with DSCP (Document ID: 10103) at <a href="http://www.cisco.com/warp/public/105/dscp-values.html">http://www.cisco.com/warp/public/105/dscp-values.html</a>.</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td><strong>Note</strong> The default QoS setting between ICM and ICM VRU PIM is CS3.</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Trunk Utilization</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Enable Gateway</td>
<td>Check this check box to enable gateway trunk reporting.</td>
<td>None</td>
<td>Not applicable</td>
<td>No</td>
</tr>
<tr>
<td>Trunk Reporting</td>
<td><strong>Note</strong> While adding or editing a gateway, you can use the optional field, <strong>Trunk Group ID</strong> to customize the trunk group ID for each gateway.</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Maximum Gateway Ports</td>
<td>The value used for setting the maximum number of ports that a gateway supports in a CVP deployment. This value is be used to calculate the number of ports to report to the Unified ICM Server for each gateway.</td>
<td>700</td>
<td>1 to 1500</td>
<td>Yes</td>
</tr>
<tr>
<td>Available</td>
<td>The list of gateways available for trunk reporting.</td>
<td>None</td>
<td>Not applicable</td>
<td>No</td>
</tr>
<tr>
<td>Selected</td>
<td>The list of gateways selected for trunk reporting.</td>
<td>All Gateways Selected</td>
<td>Not applicable</td>
<td>No</td>
</tr>
</tbody>
</table>
Table 14: SIP Service Configuration Settings

<table>
<thead>
<tr>
<th>Property</th>
<th>Description</th>
<th>Default</th>
<th>Range</th>
<th>Restart Required</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Configuration</strong></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Enable Outbound Proxy</td>
<td>If you want to use a Cisco Unified SIP Proxy Server, in the <strong>Enable outbound proxy</strong> field, select <strong>Yes</strong>. Else, select <strong>No</strong>.</td>
<td>No</td>
<td>Yes or No</td>
<td>Yes</td>
</tr>
<tr>
<td>Enable Outbound Proxy</td>
<td>If you want to use a Cisco Unified SIP Proxy Server, in the <strong>Enable outbound proxy</strong> field, select <strong>Yes</strong>. Else, select <strong>No</strong>.</td>
<td>Yes</td>
<td>Yes or No</td>
<td>Yes</td>
</tr>
<tr>
<td>Use DNS SRV type query</td>
<td>If you want to use DNS SRV for outbound proxy lookup, select <strong>Yes</strong> in the <strong>Use DNS SRV type query</strong> field. Else, select <strong>No</strong>.</td>
<td>Yes</td>
<td>Yes or No</td>
<td>Yes</td>
</tr>
<tr>
<td><strong>Note</strong></td>
<td>If you enable <strong>Resolve SRV records locally</strong>, select <strong>Yes</strong> to ensure that the feature works properly.</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Resolve SRV records locally</td>
<td>Check the <strong>Resolve SRV records locally</strong> check box to resolve the SRV domain name with a local configuration file instead of a DNS Server.</td>
<td>Enabled</td>
<td>Yes or No</td>
<td>Yes</td>
</tr>
<tr>
<td>Outbound proxy Host</td>
<td>If you selected <strong>Enable Outbound Proxy</strong>, from the <strong>Outbound proxy Host</strong> drop-down list, select an Outbound Proxy Server.</td>
<td>No</td>
<td>Valid IP address</td>
<td>Yes</td>
</tr>
<tr>
<td><strong>Note</strong></td>
<td>An Outbound Proxy Server is a the SIP Proxy Server that is added to the Operations Console.</td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>
## Call Server Configuration

### SIP Service Settings

<table>
<thead>
<tr>
<th>Property</th>
<th>Description</th>
<th>Default</th>
<th>Range</th>
<th>Restart Required</th>
</tr>
</thead>
<tbody>
<tr>
<td>Outbound SRV domain name/Server group name (FQDN)</td>
<td>If you use a hostname that is an SRV type record instead of a standard DNS type record, in the <strong>Outbound SRV domain name/Server group name (FQDN)</strong> text box, enter a fully qualified domain name that is configured on the DNS server. Else, the field contains an SRV configuration file. <strong>Example:</strong> Outbound calls made from CVP SIP service are addressed to the URL of <code>sip:&lt;label&gt;@&lt;srvfqdn&gt;</code>. A server, such as Redundant Proxy Server, can route calls using this configuration.</td>
<td>None</td>
<td>Follows the same validation rules as hostname, which includes uppercase and lowercase letters, the numbers 0 through 9, and a dash. 0 to 256 character length.</td>
<td>Yes</td>
</tr>
<tr>
<td>DN on the Gateway to play the ringtone</td>
<td>Enter the dialed number configured on the gateway to play the ringtone, which is dedicated VoIP dial peer.</td>
<td>9191</td>
<td>Any valid label</td>
<td>No</td>
</tr>
<tr>
<td>DN on the Gateway to play the error tone</td>
<td>Enter a dial number pattern that you want to be played for an error tone. To find out which DN is configured on the gateway to play the error tone, execute the <code>sh run</code> command on the gateway and look for the dial peer that matches the incoming dialed number.</td>
<td>9292</td>
<td>Any valid label</td>
<td>No</td>
</tr>
<tr>
<td>DN on the Gateway to play the whisper announcement</td>
<td>Enter a dial number pattern that you want to be played for whisper announcement. If location ID exists, then append the location ID to the dial number.</td>
<td>9191919100</td>
<td>Any valid label</td>
<td>No</td>
</tr>
<tr>
<td>Property</td>
<td>Description</td>
<td>Default</td>
<td>Range</td>
<td>Restart Required</td>
</tr>
<tr>
<td>----------------------------------------------</td>
<td>-----------------------------------------------------------------------------</td>
<td>---------</td>
<td>----------------------------------------------------------------------</td>
<td>-------------------</td>
</tr>
</tbody>
</table>
| Override System Dialed Number Pattern Configuration | For upgraded devices, check the **Override System Dialed Number Pattern Configuration** check box. For new devices, keep this field unchecked. | Unchecked | The default state of the override check box differs depending on the device state:  
  • For new devices, override is disabled (unchecked). New Unified CVP Call Server devices will use configured system-level dialed number patterns by default.  
  • For upgraded devices, override is enabled (checked). Upgraded Unified CVP Call Server devices will use device-level dialed number patterns by default. | No                |

**Local Static Routes**
**Property** | **Description** | **Default** | **Range** | **Restart** | **Required**
--- | --- | --- | --- | --- | ---
Static routes for local routing without an outbound proxy - Dialed Number (DN) | In the **Dialed Number (DN)** text box, enter a dialed number. The **Static routes for local routing without an outbound proxy - Dialed Number (DN)** field is used to create a Static Proxy Route Configuration Table. Create static routes if you do not use a SIP Proxy Server. Before adding a local static route, enter a value into both the **Dialed Number (DN)** and **IP Address/Hostname/Server Group Name** fields so that the local static route is complete. Click **Add** to create a proxy route using the DN and the IP address or hostname entered in the **IP Address/Hostname/Server Group Name** fields. The newly created proxy route is added to the list of proxy routes displayed in the box below the **Add** button. | None | Dialed number pattern, destination must be format of NNN.NNN.NNN.NNN or a hostname. See **Valid Format for Dialed Numbers**, on page 94. | No

**IP Address/Hostname/Server Group Name** | Enter an IP address, hostname, or server group name. | None | Valid IP address, hostname, or SRV domain name | No

**Advanced Configuration**

**General**

**Outbound proxy port** | Enter a value for port on which the SIP service sends requests to the outbound proxy server. | 5060 | Any available port number. Valid port numbers are integers between 1 and 65535. | Yes

**Outgoing transport type** | Select a transport type for outgoing SIP requests. Select **TCP** when reliability is important or packet size is an issue. Select **UDP** in the high availability deployments, because the SIP retry counter and retransmission time settings make the change to a second priority DNS SRV destination occur faster. | TCP | TCP and UDP | Yes
## SIP Service Settings

<table>
<thead>
<tr>
<th>Property</th>
<th>Description</th>
<th>Default</th>
<th>Range</th>
<th>Restart Required</th>
</tr>
</thead>
<tbody>
<tr>
<td>Incoming transport type</td>
<td>The type of transport the SIP Service uses to listen for incoming SIP requests.</td>
<td>UDP+TCP</td>
<td>UDP+TCP</td>
<td>Yes</td>
</tr>
<tr>
<td>Time to wait for ICM instructions</td>
<td>The maximum number of milliseconds to wait for ICM to send further instructions.</td>
<td>2000</td>
<td>50 to 5000</td>
<td>No</td>
</tr>
<tr>
<td>SIP info tone duration</td>
<td>The maximum number of milliseconds for tone durations sent in when sending Dual Tone Multi-Frequency (DTMF) *8 outpulse digits to the gateway.</td>
<td>100 milliseconds</td>
<td>50 to 2000</td>
<td>No</td>
</tr>
<tr>
<td>SIP info comma duration</td>
<td>The maximum number of milliseconds to pause for each comma in the label when sending DTMF to the gateway.</td>
<td>100 milliseconds</td>
<td>50 to 2000</td>
<td>No</td>
</tr>
</tbody>
</table>

**Note**  
SIP info comma duration is a pause between the *8 and the number. For example, four commas imply four times the value.
<table>
<thead>
<tr>
<th>Property</th>
<th>Description</th>
<th>Default</th>
<th>Range</th>
<th>Restart Required</th>
</tr>
</thead>
<tbody>
<tr>
<td>Generic Type Descriptor (GTD) Parameter Forwarding</td>
<td>Enter a value for passing GTD (UUI) data to ICM in a new call.</td>
<td>UUS</td>
<td>48 characters</td>
<td>No</td>
</tr>
</tbody>
</table>

**Note**

- You can extract other parameters in the GTD and send them to ICM. Use commas for multiple values, such as UUS, PRN, GCI.
- You can extract any parameter contained in the NSS IAM message.
### Call Server Configuration

#### SIP Service Settings

<table>
<thead>
<tr>
<th>Property</th>
<th>Description</th>
<th>Default</th>
<th>Range</th>
<th>Restart Required</th>
</tr>
</thead>
<tbody>
<tr>
<td>Prepend digits</td>
<td>From the <strong>Prepend digits</strong> drop-down list, select the number of digits that are stripped from the beginning of the incoming Dialed Number (DN) before it is submitted to ICM for the scheduled routing script.</td>
<td>0</td>
<td>0 to 20 digits</td>
<td>No</td>
</tr>
<tr>
<td></td>
<td><strong>Note</strong> • When Unified ICM returns a label, Unified CVP prepends the stripped digits before initiating the transfer. • If you customized the <strong>Prepend Digits</strong> value manually, in the sip.properties files, set this value in Operations Console after upgrading to ensure that your custom value is not overwritten later. Set the Prepend Digits value and then click <strong>Save &amp; Deploy</strong> to ensure the values of both Operations Console and Call Server devices are in sync.</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>UDP Retransmission Count</td>
<td>From the <strong>UDP Retransmission Count</strong> drop-down list, select an option to set the UDP retry count for SIP retries.</td>
<td>3</td>
<td>1 to 6</td>
<td>No</td>
</tr>
<tr>
<td>Use Error Refer</td>
<td>Check the <strong>Use Error Refer</strong> checkbox to enable the SIP Use Error Refer property. Else, keep the checkbox unchecked.</td>
<td>Checked</td>
<td>Checked or unchecked</td>
<td>No</td>
</tr>
</tbody>
</table>
### Call Server Configuration

### SIP Service Settings

<table>
<thead>
<tr>
<th>Property</th>
<th>Description</th>
<th>Default</th>
<th>Range</th>
<th>Restart Required</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>IOS Gateway Options Dynamic Routing</strong></td>
<td>Check the <strong>IOS Gateway Options Dynamic Routing</strong> check box to identify if resource availability indication on a specific route or service basis is required for real-time routing based on trunk utilization data.</td>
<td>Checked</td>
<td>Checked or unchecked</td>
<td>No</td>
</tr>
<tr>
<td><strong>IOS Gateway Options Reporting</strong></td>
<td>Check the <strong>IOS Gateway Options Reporting</strong> check box to identify if trunk utilization reporting and resource availability on a router basis is required after the call is completed.</td>
<td>Checked</td>
<td>Checked or unchecked</td>
<td>No</td>
</tr>
</tbody>
</table>

### QoS

- **Select QoS level**
  - Select the Quality of Service (QoS) level between the SIP Service and the SIP Proxy Server.
  - **Note**: For more information, see the *Enterprise QoS Solution Reference Network Design Guide*.
  - Default: None
  - Range: Dialed Number pattern, destination (must be in the form of NNN.NNN.NNN.NNN or a hostname). See *Valid Format for Dialed Numbers*, on page 94.
  - Restart Required: No

### SIP Header Passing (to ICM)

- **Header Name**
  - Specify the SIP header name and click **Add** to add it to the list of SIP headers passed to ICM.
  - Default: None
  - Range: 210 characters
  - Restart Required: No

- **Parameter**
  - This field is optional for list addition.
  - Default: None
  - Range: 210 characters
  - Restart Required: No

### Dialed Number (DN) patterns
<table>
<thead>
<tr>
<th>Property</th>
<th>Description</th>
<th>Default</th>
<th>Range</th>
<th>Restart Required</th>
</tr>
</thead>
<tbody>
<tr>
<td>Patterns for sending calls to the originator - Dialed Number (DN)</td>
<td>Creates a SIP Send Back to Originator Lookup Table. Specify the DN patterns to match for sending the call back to the originating gateway for VXML treatment. For the Unified CVP branch model, use this field to automatically route incoming calls to the Call Server from the gateway back to the originating gateway at the branch. This setting overrides sending the call to the outbound proxy or to any locally configured static routes. It is also limited to calls from the IOS gateway SIP &quot;User Agent&quot; because it checks the User Agent header value of the incoming invite to verify this information. If the label returned from ICM for the transfer matches one of the patterns specified in this field, the call is routed to sip:&lt;label&gt;@&lt;host portion of from header of incoming invite&gt;. Three types of DN s work with Send To Originator: VRU label returned from ICM, Agent label returned from ICM, and Ringtone label. Send To Originator does not work for the error message DN because the inbound error message is played by survivability and the postroute error message is a SIP REFER. (Send To Originator does not work for REFER transfers). <strong>Note</strong> For Send To Originator to work properly, the call must be originated by TDM and have survivability configured on the pots dial peer.</td>
<td>None</td>
<td>24 characters. See <a href="#">Valid Format for Dialed Numbers, on page 94</a>.</td>
<td>No</td>
</tr>
<tr>
<td>Property</td>
<td>Description</td>
<td>Default</td>
<td>Range</td>
<td>Restart Required</td>
</tr>
<tr>
<td>----------</td>
<td>------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
<td>---------</td>
<td>--------------------</td>
<td>------------------</td>
</tr>
<tr>
<td>Patterns for RNA timeout on outbound SIP calls - Dialed Number (DN)</td>
<td>Creates a DN pattern outbound invite timeout using the DN and timeout entered above the Add button. Click Add to add the newly created DN pattern outbound invite timeout to the list displayed in the box below the Add button. Click Remove to delete the selected DN pattern outbound invite timeout from the list.</td>
<td>None</td>
<td>24 characters. See Valid Format for Dialed Numbers, on page 94.</td>
<td>No</td>
</tr>
<tr>
<td>Timeout</td>
<td>The number of seconds the SIP Service waits for transferee to answer the phone or accept the call. If a selected termination (for either a new or transferred call) returns a connection failure or busy status, or if the target rings for a period of time that exceeds the ring-no-answer (RNA) timeout setting of the Call Server, it cancels the transfer request and sends a transfer failure indication to Unified ICM. This scenario causes a router requery operation. The Unified ICM routing script then recovers control and has the opportunity to select a different target or take other remedial action.</td>
<td>60 seconds</td>
<td>5 to 60</td>
<td>No</td>
</tr>
<tr>
<td>Custom ringtone patterns - Dialed Number (DN)</td>
<td>Specify a custom DN pattern. Click Add to add the newly created DN pattern to the list displayed in the box below the Add button. To know which DN is configured on the gateway to play ringtone, execute the sh run command on the gateway and look for the dial peer that matches the incoming dialed number.</td>
<td>None</td>
<td>24 characters. See Valid Format for Dialed Numbers, on page 94.</td>
<td>No</td>
</tr>
</tbody>
</table>
## Call Server Configuration

### SIP Service Settings

<table>
<thead>
<tr>
<th>Property</th>
<th>Description</th>
<th>Default</th>
<th>Range</th>
<th>Restart Required</th>
</tr>
</thead>
<tbody>
<tr>
<td>Ringtone media filename</td>
<td>The filename of the ringtone to be played for the respective dialed number. You must save the ringtone media file to the VXML Gateway.</td>
<td>None</td>
<td>0 to 256 characters without spaces. Provide the URL for the stream name in the following form: rtsp://&lt;streaming server IP address&gt;/&lt;port&gt;/&lt;foldername&gt;/&lt;filename&gt;.rm</td>
<td>No</td>
</tr>
</tbody>
</table>

### Related Topics
- Valid Format for Dialed Numbers, on page 94

---

### Note
- The **Call Max Threshold** property specifies the simultaneous active calls that are allowed on a CVP Server instance. Requests above this value are rejected with a **503 Server Unavailable** status.

The default value is -1, which disables the check performed by this property. The expected range of values is 0 to the maximum number of concurrent sessions supported on CVP Servers for a given Unified CVP release. For more information, see the Section, **Sizing for Unified CVP** in the **Solution Design Guide for Cisco Unified Contact Center Enterprise** available at [https://www.cisco.com/c/en/us/support/customer-collaboration/unified-customer-voice-portal/products-implementation-design-guides-list.html](https://www.cisco.com/c/en/us/support/customer-collaboration/unified-customer-voice-portal/products-implementation-design-guides-list.html).

To change or update this property, you must manually edit the `sip.properties` file in `\Cisco\CVP\conf` folder.

Property: #Calls Max Threshold

Value: SIP.CallsMaxThreshold= -1

Ring No Answer Settings with SIP

If you use the Unified CVP Ring No Answer (RNA) settings in SIP, ensure that the RNA value is lower than the Unified ICME Agent Desk Setting RNA timeout. The range of RNA value is from 5 to 60 seconds; the default value is 15 seconds.

Unified CVP makes a call to the ringtone service on the VXML gateway. This call is followed by sending the call to the Unified Communications Manager trunk for the agent. During this period, an agent has sufficient time to receive the delivered event after being reserved, and also ensures that Unified ICME reporting is correct in terms of handled time and RNA call disposition calls reporting.

Valid Format for Dialed Numbers

Valid dialed number patterns are the same as for the ICM label sizes and limitations, including the following:

- Dialed numbers can be up to 24 characters.
- Use the period (.) or the letter X for single-digit wildcard matching in any combination. Avoid using the letter “T” for wildcard matching.
- Use the greater than (>), asterisk (*), or exclamation (!) character as a wildcard for zero or more digits at the trailing end of a dialing number.
- The highest precedence of pattern matching is an exact match, followed by the most specific wildcard match. When the number of characters is matched equally by more than one wildcard pattern, precedence is given from top to bottom of the configured DN list.

IVR Service Settings

The IVR service creates VXML documents that are used to implement microapplications based on Run Script instructions received by the ICM. The VXML pages are sent to the VXML Gateway to be executed. The IVR Service can also generate external VXML through the microapplications to engage the Unified CVP VXML Server to generate the VXML documents.

The IVR Service plays a significant role in implementing a failover mechanism. This capability is achieved without Automatic Speech Recognition (ASR)/Text To Speech (TTS) Server and VXML Servers. Up to two of each such server are supported, and the IVR Service orchestrates retries and failover between them.

Configure the following servers before you configure the IVR service:

- ICM Server
- Media Server
- ASR/TTS Servers
- VXML Server
- Gateway

To configure IVR settings on a Call Server, on the IVR tab, enter or modify the field values, as listed in the following table:

Note
### Table 15: IVR Service Settings

<table>
<thead>
<tr>
<th>Property</th>
<th>Description</th>
<th>Default</th>
<th>Range</th>
<th>Restart Required</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>CVP H.323 Service Configuration</strong></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Heartbeat timeout</td>
<td>Enter the number of seconds after which the heartbeat times out.</td>
<td>120</td>
<td></td>
<td></td>
</tr>
<tr>
<td><strong>IOS Voice Browser Configuration</strong></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Last Access Timeout (seconds)</td>
<td>Enter the number of seconds the IVR Service waits for a call request from a non-Unified CVP Voice Browser before removing that Voice Browser from its current client list. This value must be greater than or equal to the call timeout.</td>
<td>7320</td>
<td>0 to 2147483647</td>
<td>No</td>
</tr>
<tr>
<td>Media Server Timeout</td>
<td>Enter the number of seconds the Gateway should wait to connect to the HTTP Media Server before timing out.</td>
<td>4</td>
<td>0 to 2147483647</td>
<td>No</td>
</tr>
<tr>
<td>Media Server Retry Attempts</td>
<td>Maximum number of times the non-Unified CVP Voice Browser, such as IOS Voice Browser, or Unified CVP VXML Server attempts to connect to an HTTP Media Server to retrieve a single prompt. If the Voice Browser or Unified CVP VXML Server fails after the specified number of times, it tries the same number of times to retrieve the media from a backup media server before failing and reporting an error.</td>
<td>0</td>
<td>0 to 2147483647</td>
<td>No</td>
</tr>
</tbody>
</table>

**Note** The backup media server is defined on the gateway as `<mediaserver>-backup`. 
<table>
<thead>
<tr>
<th>Property</th>
<th>Description</th>
<th>Default</th>
<th>Range</th>
<th>Restart Required</th>
</tr>
</thead>
<tbody>
<tr>
<td>ASR/TTS Server Retry Attempts</td>
<td>Maximum number of times the Gateway tries to connect to an ASR/TTS server. If the Gateway fails to connect this many attempts, it tries the same number of times to connect to a backup ASR/TTS server before failing and reporting an error. Note The backup ASR and TTS servers are defined on the gateway as asr-&lt;locale&gt;-backup and tts-&lt;locale&gt;-backup.</td>
<td>0</td>
<td>0 to 2147483647</td>
<td>No</td>
</tr>
<tr>
<td>IVR Service Timeout</td>
<td>The number of seconds the gateway should wait to connect to the IVR Service before being timed out. This setting controls call results only. The initial NEW_CALL timeout from the Gateway to the IVR Service is controlled through the fetchtimeout property within the bootstrap VXML in flash memory on the Gateway.</td>
<td>7</td>
<td>0 to 2147483647</td>
<td>No</td>
</tr>
<tr>
<td>IVR Service Retry Attempts</td>
<td>Maximum number of times the gateway tries to connect to the IVR Service before failing and reporting an error. This setting controls call results only. The initial NEW_CALL retry count from the Gateway to the IVR Service is controlled from within the bootstrap VXML in flash memory on the Gateway.</td>
<td>0</td>
<td>0 to 2147483647</td>
<td>No</td>
</tr>
<tr>
<td>Use Backup ASR/TTS Servers</td>
<td>Click Yes if an ASR/TTS Server is unavailable so that the gateway attempts to connect to the backup ASR/TTS server. Else click No.</td>
<td>Yes</td>
<td>Yes or No</td>
<td>No</td>
</tr>
<tr>
<td>Use Backup Media Servers</td>
<td>Click Yes if the Media Server is unavailable so that the gateway attempts to connect to the backup Media Server. Else click No.</td>
<td>Yes</td>
<td>Yes or No</td>
<td>No</td>
</tr>
<tr>
<td>Use hostnames for default Media/VXML servers</td>
<td>Click No to use IP address VXML Server and Media Server. Click Yes to use hostnames instead of IP addresses.</td>
<td>No</td>
<td>Yes or No</td>
<td>No</td>
</tr>
</tbody>
</table>
## Device Pool

A device pool is a logical group of devices. It provides a convenient way to define a set of common characteristics that can be assigned to devices, for example, the region in which the devices are located. You can create device pools and assign devices to the device pools you created.

Every device you create is automatically assigned to a default device pool, which you can never remove from the selected device pool list. The Administrator account is also assigned to the default device pool automatically. Having the administrator account ensures that the administrator can view and manage all devices. You cannot remove the Administrator account from the default device pool.

### Configuration Guide for Cisco Unified Customer Voice Portal, Release 11.6(1)
When you create a user account, you can assign the user to one or more device pools, which allows the user to view the devices in those pools from the Control Center. Subsequently, you can remove the user from any associated device pools, which prevents that user from viewing the pool devices in the Control Center. Removing a user from the default device pool prevents the user from viewing all devices.

Add or Remove Device From Device Pool

Procedure

Step 1  From the Device Management menu, select a device to add to the Device Pool.

Example:
To add a Call Server to a device pool, select Unified CVP Call Server from the Device Management menu.
A window that lists known devices of the type you selected appears. For example, if you select Call Server, all the known Unified CVP Call Servers are listed.

Step 2  Select a device pool from the Device Pool list and click Edit.

Step 3  On the Device Pool tab:

- In the Available list box, select one or multiple devices and click the Add arrow. The added devices appear in the Selected list box.
- To remove the added devices from the Selected box, select them and click the Remove arrow. The added devices appear in the Selected list box.

Step 4  Click Save & Deploy.

Note

- Click Save to save the changes in Operations Console and add or remove a device from Device Pool later.
- Some edit-device windows have an Apply button instead of Save. Click Apply to copy the configuration to the device.

Infrastructure Service Settings

The Call Server, Unified CVP VXML Server, and Reporting Server offer one or more services. The Call Server provides SIP, IVR, and ICM call services. The Unified CVP VXML Server provides VXML services, and the Reporting Server provides reporting services. Changes to Infrastructure settings affect all services that use threads, publish statistics, send syslog events, or perform logging and tracing. For example, when you change the syslog server setting, the changes are applied to all services that write to syslog.

To configure Infrastructure settings, on the Infrastructure tab, enter or modify the field values, as listed in the following table:
<table>
<thead>
<tr>
<th>Property</th>
<th>Description</th>
<th>Default</th>
<th>Range</th>
<th>Restart Required</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Configuration: Thread Management</strong></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Maximum Threads</td>
<td>Enter the maximum number of threads allocated in the thread pool that can be shared by all services running as part of a CVP Web Application.</td>
<td>500</td>
<td>100 to 1000</td>
<td>No</td>
</tr>
<tr>
<td><strong>Statistics</strong></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Statistics Aggregation Interval</td>
<td>Enter the duration in minutes during which system and service statistics are published to the log file and SNMP events are sent. After the statistics are published, the counters reset and aggregate data for the next interval. Real-time statistics are generated on-demand and have no intervals. Statistics Publishing Interval is used for attributes, such as the number of calls in last interval, the number of transfers in last interval, and the number of HTTP sessions in last interval. <strong>Note</strong> The interval is different than the real time snapshot statistics (for the number of concurrent calls).</td>
<td>30 minutes</td>
<td>10 to 1440 minutes</td>
<td>No</td>
</tr>
<tr>
<td><strong>Log File Properties</strong></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Max Log File Size</td>
<td>Enter the maximum size of a log file in megabytes before a new log file is created. <strong>Note</strong> To increase the log file size, go to C: \Cisco \CVP \conf, open log4j.xml file and update the MaxFileSize value as shown: <code>&lt;param name=&quot;MaxFileSize&quot; value=&quot;10000000&quot;/&gt;</code> Save the file and restart Call Server to deploy the changes.</td>
<td>10 MB</td>
<td>1 through 100 MB</td>
<td>No</td>
</tr>
<tr>
<td>Property</td>
<td>Description</td>
<td>Default</td>
<td>Range</td>
<td>Restart Required</td>
</tr>
<tr>
<td>------------------------</td>
<td>------------------------------------------------------------------------------</td>
<td>-----------</td>
<td>------------------------</td>
<td>------------------</td>
</tr>
<tr>
<td>Max Log Directory Size</td>
<td>Enter the maximum number of megabytes to allocate for disk storage for log files. Note: Modifying the value to a setting that is below the default value might cause logs to be rolled over quickly. Consequently, log entries might be lost, which can affect troubleshooting.</td>
<td>20,000 MB</td>
<td>500 to 500000</td>
<td>No</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>The log folder size divided by the log file size must be less than 5000.</td>
<td></td>
</tr>
</tbody>
</table>

**Configuration: Primary Syslog Settings**

<table>
<thead>
<tr>
<th>Property</th>
<th>Description</th>
<th>Default</th>
<th>Range</th>
<th>Restart Required</th>
</tr>
</thead>
<tbody>
<tr>
<td>Primary Syslog Server</td>
<td>Enter a hostname or IP address of Primary Syslog Server to send syslog events from a CVP Application.</td>
<td>None</td>
<td>Valid IP address or hostname</td>
<td>No</td>
</tr>
<tr>
<td>Primary Syslog Server Port Number</td>
<td>Enter a port number of Primary Syslog Server.</td>
<td>None</td>
<td>Any available port number. Valid port numbers are integers between 1 and 65535.</td>
<td>No</td>
</tr>
<tr>
<td>Primary Backup Syslog Server</td>
<td>Enter a hostname or IP address of the Primary Backup Syslog Server to send syslog events from a CVP Application when the Syslog Server is not reachable.</td>
<td>None</td>
<td>Valid IP address or hostname</td>
<td>No</td>
</tr>
<tr>
<td>Primary Backup Syslog Server Port Number</td>
<td>Enter a port number of Primary Backup Syslog Server.</td>
<td>None</td>
<td>Any available port number. Valid port numbers are integers between 1 and 65535.</td>
<td>No</td>
</tr>
</tbody>
</table>

**Configuration: Secondary Syslog Settings**

<table>
<thead>
<tr>
<th>Property</th>
<th>Description</th>
<th>Default</th>
<th>Range</th>
<th>Restart Required</th>
</tr>
</thead>
<tbody>
<tr>
<td>Secondary Syslog Server</td>
<td>Enter the hostname or IP address of Secondary Syslog Server to send syslog events from a CVP Application.</td>
<td>None</td>
<td>Valid IP address or hostname</td>
<td>No</td>
</tr>
<tr>
<td>Secondary Syslog Server Port Number</td>
<td>Enter port number of Secondary Syslog Server.</td>
<td>None</td>
<td>Any available port number. Valid port numbers are integers between 1 and 65535.</td>
<td>No</td>
</tr>
<tr>
<td>Property</td>
<td>Description</td>
<td>Default</td>
<td>Range</td>
<td>Restart Required</td>
</tr>
<tr>
<td>--------------------------------</td>
<td>------------------------------------------------------------------------------</td>
<td>---------</td>
<td>-------------------------------------------------</td>
<td>------------------</td>
</tr>
<tr>
<td>Secondary Backup Syslog Server</td>
<td>Enter hostname or IP address of the Secondary Backup Syslog Server to send syslog events from a CVP Application when the Syslog Server is not reachable.</td>
<td>None</td>
<td>Valid IP address or hostname.</td>
<td>No</td>
</tr>
<tr>
<td>Secondary Backup Syslog Server Port Number</td>
<td>Enter the port number of Secondary Backup Syslog Server.</td>
<td>None</td>
<td>Any available port number. Valid port numbers are integers between 1 and 65535.</td>
<td>No</td>
</tr>
</tbody>
</table>

### License Thresholds

<table>
<thead>
<tr>
<th>Threshold</th>
<th>Description</th>
<th>Default</th>
<th>Range</th>
<th>Restart Required</th>
</tr>
</thead>
<tbody>
<tr>
<td>Critical</td>
<td>Percentage of licenses in use required to reach Critical licensing state. See License Thresholds, on page 101.</td>
<td>97%</td>
<td>Positive integer less than or equal to 100 and greater than the Warning threshold.</td>
<td>No</td>
</tr>
<tr>
<td>Warning</td>
<td>Percentage of licenses in use required to reach Warning licensing state. See License Thresholds, on page 101.</td>
<td>94%</td>
<td>Positive integer less than the Critical threshold and greater than the Safe threshold.</td>
<td>No</td>
</tr>
<tr>
<td>Safe</td>
<td>Percentage of licenses in use required to reach Safe licensing state. See License Thresholds, on page 101.</td>
<td>90%</td>
<td>Positive integer less than the Warning threshold and greater than 0.</td>
<td>No</td>
</tr>
</tbody>
</table>

**Related Topics**

License Thresholds, on page 101

### License Thresholds

The three thresholds namely safe, warning, and critical describe the percentage of licenses that must be in use to reach their respective licensing state.

Crossing a threshold does not always mean the state changes. For example, if you have 100 licenses and the Safe, Warning, and Critical license thresholds are set to the defaults of 90%, 94%, and 97%, and 89 licenses are in use, licenses are at a Safe level. When the number of licenses in use reaches 94, the license state changes...
from Safe to Warning level. If one more license is used, the license state remains at the Warning level. If three licenses, which are no longer in use, are released, 92 licenses remain in use and the license state remains at the Warning level. After the licenses in use return to the previous threshold (90), the state changes from Warning to Safe.
CHAPTER 5

VXML Server Configuration

- Configure VXML Server (Standalone), on page 103
- Configure VXML Server, on page 104
- Configure VXML Server (Standalone) with ICM Lookup Call Flow Model, on page 105
- Configure the Unified CVP VXML Server (Standalone) Call Flow Model (Without ICM Lookup), on page 107
- Takeback and Transfer in VoiceXML Scripts, on page 108
- VXML Server Settings, on page 112
- Enable Active and Standby VXML Server, on page 118
- Voice XML Service, on page 119
- VXML Server Reporting, on page 119
- Inclusive and Exclusive VXML Reporting Filters, on page 120
- Error Codes for VXML Server, on page 124

Configure VXML Server (Standalone)

The Unified CVP VXML Server is a J2EE-compliant application server that provides a complete solution for rapidly creating and deploying dynamic VoiceXML applications. You can install the Unified CVP VXML Server as a standalone component, without the Call Server component. The Unified CVP VXML Server (Standalone) is designed to handle self-service VoiceXML applications.

Procedure

Step 1 On the Unified CVP Operations Console, select Device Management > Unified CVP VXML Server (standalone).

Step 2 Click Add New to add a new VXML Server (standalone) or click Use As Template to use an existing template to configure the new VXML Server (standalone).

Step 3 Click the following tabs and configure the settings based on your call flow:
   a) General tab. For more information, see General Settings, on page 112.
   b) Device Pool tab. For more information about adding, deleting and editing device pool, see Add or Remove Device From Device Pool, on page 98.
Step 4  
Click **Save** to save the settings in the Operations Server database. Click **Save and Deploy** to deploy the changes to the VXML Server page.

**Related Topics**  
- General Settings, on page 112  
- Add or Remove Device From Device Pool, on page 98

## Configure VXML Server

Beginning with Unified CVP 11.5(1) Release, the Call Server IVR service is moved to the VXML Server. As a result, the VXML Server now handles the creation of VXML pages that implement the Unified CVP microapplications. To configure the IVR settings on VXML Server, on the IVR tab, see **IVR Service Settings**, on page 94.

### Before you begin

- Obtain the hostname or IP address of the VXML Server during the installation of the Cisco Unified Customer Voice Portal (CVP) software.
- Install and configure at least one Call Server. To install Call Server, see *Installation and Upgrade Guide for Cisco Unified Customer Voice Portal*. To configure a Call Server, see **Configure Call Server**, on page 77.

**Note**  
Do not install a Call Server if you are adding a Unified CVP VXML Server (standalone).

- Review Cisco Unified Call Studio scripts, noting any of the following items you want to include or exclude from Unified CVP VXML Server reporting data:
  - Application names
  - Element types
  - Element names
  - Element fields
  - ECC variables

### Procedure

**Step 1**  
Log in to the Operations Console and click **Device Management > Unified CVP VXML Server**.

**Step 2**  
Click **Add New**.

**Note**  
To use an existing VXML Server as a template for configuring a new VXML Server, select a VXML Server from the list of available VXML Servers. Click **Use As Template**, and perform Steps 3 to 5.
Step 3  Click the following tabs and modify the default values of fields, if necessary:
   a)  General. See General Settings, on page 112.
   b)  Configuration. See Configuration Settings, on page 113.
   c)  Device Pool. See Add or Remove Device From Device Pool, on page 98.
   d)  Infrastructure. See Infrastructure Service Settings, on page 115.

Step 4  Click Save & Deploy.

   Note  Click Save to save the changes on the Operations Console and configure the VXML Server later.

Step 5  Restart the following services:
   •  Cisco CVP VXML Server
   •  Cisco CVP Resource Manager
   •  Cisco CVP Call Server

Related Topics
   IVR Service Settings, on page 94
   Configure Call Server, on page 77
   General Settings, on page 112
   Configuration Settings, on page 113
   Add or Remove Device From Device Pool, on page 98
   Infrastructure Service Settings, on page 98

Configure VXML Server (Standalone) with ICM Lookup Call Flow Model

The following procedure describes how to configure the Unified CVP VXML Server (standalone) with ICM Lookup call flow model.:

Procedure

Step 1  Copy the following files from the Unified CVP VXML Server CD to the gateway flash memory using tftp:
   CVPSelfService.tcl
   critical_error.wav
   For example:
   copy tftp: flash:CVPSelfService.tcl
   copy tftp: flash:CVPSelfServiceBootstrap.vxml
   copy tftp: flash:critical_error.wav

Step 2  Define the Unified CVP VXML Server applications on the gateway. The following lines show an example configuration:
service CVPSelfService flash:CVPSelfServiceBootstrap.vxml
service [gateway application name] flash:CVPSelfService.tcl
param CVPBackupVXMLServer 12.34.567.890
param CVPSelfService-port 7000
param CVPSelfService-app [name of application on the VXML Server, exactly how it appears]
param CVPPrimaryVXMLServer 12.34.567.891

Note: CVPSelfService is required. Backup server is optional. For Tomcat Application Server, set the port to 7000.

After completing the gateway configuration, run the following to load and activate the applications:

call application voice load CVPSelfService
call application voice load [gateway application name]

Step 3 Define a dial-peer for the gateway application, for example:

dial-peer voice [dial-peer unique ID] voip /* for IP originated call */
    service [gateway application name]
    incoming called-number [dialed number]
    dtmf-relay rtp-nte
    codec g711ulaw

dial-peer voice [dial-peer unique ID] pots /* for TDM originated calls */
    service [gateway application name]
    incoming called-number [dialed number]
    direct-inward-dial

Step 4 Optionally, create another dial peer to do transfers using the Unified ICME label that is returned.

Step 5 Create the application in Call Studio. In the Call Studio application, the ReqICMLabel has two exit states: error and done. The done path grabs a transfer element to transfer the caller to that label. The gateway needs another dial peer to transfer the label it gets from this process (see Step 4). If you want to do real transfers, you must have the transfer element set up inside the Call Studio application.

Step 6 Drag the ReqICMLabel element onto the application created in Call Studio and configure it.

Note: This step is necessary to obtain a label from Unified ICME. For more information, see Pass Data to Unified ICME, on page 160.

Step 7 Save and deploy the application from Call Studio using the VoiceXML Service on the Operations Console.

Step 8 Install the Call Server, selecting only the Core Software component.

Step 9 Configure the Unified CVP VXML Server to communicate with the Call Server through the Operations Console.

Step 10 Transfer the application using File Transfer to the Unified CVP VXML Server. This automatically deploys the application on the selected Unified CVP VXML Server.

Related Topics
Pass Data to Unified ICME, on page 160
Configure the Unified CVP VXML Server (Standalone) Call Flow Model (Without ICM Lookup)

The following procedure describes how to configure the Unified CVP VXML Server (standalone) call flow model:

Procedure

Step 1
Copy the following files from the Unified CVP VXML Server CD to the gateway flash memory using tftp:
- CVPSelfService.tcl
- critical_error.wav
For example:

```
copy tftp: flash:CVPSelfService.tcl
copy tftp: flash:CVPSelfServiceBootstrap.vxml
copy tftp: flash:critical_error.wav
```

Step 2
Define the Unified CVP VXML Server applications on the gateway. The following lines show an example configuration:

```
service CVPSelfService flash:CVPSelfServiceBootstrap.vxml
!
! Note
CVPSelfService is required. Backup server is optional. For the Tomcat Application Server, set the port to 7000.
!
After completing the gateway configuration, run the following to load and activate the applications:
```
call application voice load CVPSelfService
call application voice load [gateway application name]
```

Step 3
Define a dial-peer for the gateway application, for example:

```
dial-peer voice [dial-peer unique ID] voip /* for IP originated call */
service [gateway application name]
incoming called-number [dialed number]
dtmf-relay rtp-nte
codec g711ulaw
!
dial-peer voice [dial-peer unique ID] pots /* for TDM originated calls */
service [gateway application name]
incoming called-number [dialed number]
```
Takeback and Transfer in VoiceXML Scripts

Unified CVP provides the following takeback and transfer methods that you invoke from a VoiceXML script:

- **Two B-Channel Transfer (TBCT)** - A call transfer standard for ISDN interfaces. This feature enables a Cisco voice gateway to request an NI-2 switch to directly connect two independent calls. The two calls can be served by the same PRI or by two different PRIs on the gateway.

- **Hookflash Relay** - A brief interruption in the loop current that the originating call entity (PBX or Public Switch Telephone Network switch) does not interpret as a call disconnect. Instead, once the PBX or Public Switch Telephone Network switch senses the hookflash, it puts the current call on hold and provides a secondary dial tone, which allows Unified CVP VXML Server to transfer the caller to another destination.
• SIP Refer - VoiceXML applications can use a SIP REFER transfer instead of a blind or bridged transfer. This allows Unified CVP to remove itself from the call, to free up licensed Unified CVP VXML Server ports. Unified CVP cannot execute further call control or IVR operations after the label has been executed.

## Configure Two B-Channel Transfer

This procedure describes how to configure Two B-Channel Transfer (TBCT) with Unified CVP from a VoiceXML script.

### Procedure

**Step 1** Configure the originating gateway for TBCT call transfer.

**Step 2** Locate the following files on the Unified CVP VXML Server and copy them to flash memory on the gateway, using the tftp command:

- `en_holdmusic.wav`
- `en_pleasewait.wav`
- `survivability.tcl`
- `CVPSelfService.tcl`
- `CVPSelfServiceBootstrap.vxml`

**Step 3** Add the following lines to the gateway:

```plaintext
service takeback flash:survivability.tcl
param icm-tbct 1
```

**Step 4** Configure the CVPSelfService application, as follows:

```plaintext
service [gateway application name] flash:CVPSelfService.tcl
param CVPBackupVXMLServer 10.78.26.28
param CVPSelfService-port 7000
param CVPSelfService-app [name of application on the VXML Server, exactly how it appears]
param CVPPrioryVXMLServer 12.34.567.891
```

**Note** CVPSelfService is required. Backup server is optional. For Tomcat Application Servers set the port to 7000.

**Step 5** From command line mode:

```plaintext
call application voice load takeback
call application voice load CVPSelfService
```

**Step 6** Specify the target destination for the TBCT transfer either by entering the number manually, or dynamically by using caller input.

a) Manually. In the SubdialogReturn node in the Unified CVP VXML Server application, next to Caller Input in the Settings Tab, enter `TBCT<target_destination_number>`, where `target_destination_number` is the target destination of the TBCT transfer. For example:

```
TBCT8005551212
```
b) Dynamically. The target destination is created dynamically using input entered by the caller during the call. Click the **Substitution** icon next to the Caller Input variable and select substitution values. For example:

Configure Hookflash Relay

The following procedure describes how to configure Hookflash Relay for use with Unified CVP from VoiceXML scripts.

**Procedure**

<table>
<thead>
<tr>
<th>Step 1</th>
<th>Configure the originating gateway for Hookflash Relay call transfer.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Step 2</td>
<td>Locate the following files on the Unified CVP VXML Server and copy them to flash memory on the gateway.</td>
</tr>
<tr>
<td></td>
<td>en_holdmusic.wav</td>
</tr>
<tr>
<td></td>
<td>en_pleasewait.wav</td>
</tr>
<tr>
<td></td>
<td>survivability.tcl</td>
</tr>
<tr>
<td></td>
<td>en_0.wav en_1.wav</td>
</tr>
<tr>
<td></td>
<td>en_2.wav en_3.wav</td>
</tr>
</tbody>
</table>
Step 3
Add the following lines to the gateway:

```
service hookflash flash:survivability.tcl
```

Step 4
If you have not already done so, configure the CVPSelfService application:

```
service [gateway application name] flash:CVPSelfService.tcl
param CVFBackupVXMLServer 10.78.26.28
param CVPSelfService-port 7000
param CVPSelfService-app [name of application on the VXML Server, exactly how it appears]
param CVFPrimaryVXMLServer 10.78.26.28
```

*Note*  CVPSelfService is required. Backup server is optional. For the Tomcat Application Server set the port to 7000.

Step 5
From the command line mode:

```
call application voice load hookflash
call application voice load CVPSelfService
```

Step 6
In the SubdialogReturn node in the Unified CVP VXML Server application, next to Caller Input in the Settings Tab, enter HF8005551212, replacing 8005551212 with the target destination of the hookflash transfer.

The label can also be defined dynamically using digits entered by the caller in conjunction with the Unified CVP VXML Server substitution tags. If the switch requires a pause after the hookflash, insert commas between the HF and the transfer number. Each comma represents 100ms.

## Configure SIP REFER

To configure SIP REFER for use with Unified CVP VXML Server from a VoiceXML script, follow this procedure:

**Procedure**

**Step 1**
Configure the gateway through the [Configure the Unified CVP VXML Server (Standalone) Call Flow Model (Without ICM Lookup)](on page 107) or [Configure VXML Server (Standalone) with ICM Lookup Call Flow Model](on page 105) procedure, according to your implementation.
Note The incoming dial-peer running the CVPSelfService application must be a VoIP dial-peer, not a POTS dial-peer.

Step 2 Specify the target destination for the REFER transfer in the Call Studio application by entering the number manually, or dynamically using caller input.

a) Manually — In the Subdialog Return node in the Unified CVP VXML Server application, next to CallerInput in the Settings tab, enter RF<target_destination_number>, where target_destination_number is the target destination of the REFER transfer. For example, RF8005551212.

b) Dynamically — The target destination is created dynamically using input entered by the caller during the call. Click the Substitution icon next to the Caller Input variable and select the substitution values.

Step 3 The following configuration must be added to the gateway configuration for the handoff to survivability.tcl to occur and to send the REFER:

```
service takeback flash: survivability.tcl
```

Related Topics

Configure the Unified CVP VXML Server (Standalone) Call Flow Model (Without ICM Lookup), on page 107
Configure VXML Server (Standalone) with ICM Lookup Call Flow Model, on page 105

VXML Server Settings

General Settings

You can configure settings that identify the VXML Server and choose a primary, and optionally, a backup Call Server to communicate with the Reporting Server. You can also enable secure communications between the Operations Console and the Unified CVP VXML Server.

To configure General settings, on the General tab, enter or modify the field values, as listed in the following table:

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
<th>Default</th>
<th>Values</th>
<th>Restart Required</th>
</tr>
</thead>
<tbody>
<tr>
<td>IP Address</td>
<td>The IP address of the VXML Server.</td>
<td>None</td>
<td>A valid IP address</td>
<td>No</td>
</tr>
<tr>
<td>Hostname</td>
<td>The hostname of the VXML Server. Hostnames must be valid DNS names, which can include letters, the numbers 0 through 9, and a dash.</td>
<td>None</td>
<td>A valid DNS name, which includes uppercase and lowercase letters, the numbers 0 through 9, and a dash.</td>
<td>No</td>
</tr>
<tr>
<td>Description</td>
<td>Enter additional information about the VXML Server.</td>
<td>None</td>
<td>Up to 1024 characters</td>
<td>No</td>
</tr>
</tbody>
</table>
## VXML Server Configuration

Use **Configuration settings** to enable the reporting of Unified CVP VXML Server and call activities to the Reporting Server. When the reporting is enabled, the Unified CVP VXML Server reports on call and application session summary data. Call summary data includes call identifier, start and end time stamps of calls, ANI,
and Dialed Number Identification Service (DNIS). Application session-data includes application names, session ID, and session time stamps.

If you choose Detailed Reporting, Unified CVP VXML Server application details are reported, including element access history, activities within the element, element variables, and element exit state. Customized values that you add in the **Add to Log** element configuration section in Unified Call Studio applications are also included in reporting data. You can also create report filters that define which data is included and excluded from the report.

To add configuration settings on VXML Server, on the **Configuration** tab, enter or modify the field values, as listed in the following table:

**Table 18: VXML Server Configuration Settings**

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
<th>Default</th>
<th>Values</th>
<th>Restart Required</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Configuration</strong></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Enable Reporting for this Unified CVP VXML Server</td>
<td>Indicates whether the VXML Server sends data to the Reporting Server. If this check box is unchecked, no data is sent to Reporting Server, and reports do not contain any VXML application data.</td>
<td>Checked</td>
<td>Checked or unchecked</td>
<td>No</td>
</tr>
<tr>
<td>Enable Reporting for VXML Application Details</td>
<td>Indicates whether VXML application details are reported.</td>
<td>Unchecked</td>
<td>Checked and unchecked</td>
<td>No</td>
</tr>
<tr>
<td>Max. Number of Messages</td>
<td>Define the maximum number of reporting messages that are saved in a file if both Primary and Backup Call Servers become unreachable. (Limited by amount of free disk space.)</td>
<td>100,000</td>
<td>Not applicable</td>
<td>Not applicable</td>
</tr>
<tr>
<td><strong>QoS</strong></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

**VXML Applications Details: Filters**
### Field

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
<th>Default</th>
<th>Values</th>
<th>Restart Required</th>
</tr>
</thead>
<tbody>
<tr>
<td>Inclusive Filters</td>
<td>List of applications, element types, element names, element fields, and ECC variables to include in reporting data.</td>
<td>None</td>
<td>A semicolon-separated list of text strings. The wildcard character, asterisk (*), is allowed within each element in the list. For information about filter syntax and rules, see Inclusive and Exclusive VXML Reporting Filters, on page 120.</td>
<td>Yes</td>
</tr>
<tr>
<td>Exclusive Filters</td>
<td>List of applications, element types, element names, and element fields, and ECC variables to exclude from reporting data.</td>
<td>None</td>
<td>A semicolon-separated list of text strings. The wildcard character, asterisk (*), is allowed within each element in the list. For information about filter syntax and rules, see Inclusive and Exclusive VXML Reporting Filters, on page 120.</td>
<td>Yes</td>
</tr>
</tbody>
</table>

**Related Topics**

- Inclusive and Exclusive VXML Reporting Filters, on page 120

---

### Add VXML Server to Device Pool

See Device Pool, on page 97 and Add or Remove Device From Device Pool, on page 98.

**Related Topics**

- Device Pool, on page 97
- Add or Remove Device From Device Pool, on page 98

### Infrastructure Service Settings

To configure infrastructure settings, on the Infrastructure tab, enter or modify the field values, as listed in the following table:
### Table 19: VXML Server Infrastructure Settings

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
<th>Default</th>
<th>Values</th>
<th>Restart Required</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Configuration: Thread Management</strong></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Maximum Threads</td>
<td>The maximum thread pool size in the VXML Server Java Virtual Machine.</td>
<td></td>
<td>300</td>
<td>Yes</td>
</tr>
<tr>
<td></td>
<td>100 to 1000</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td><strong>Advanced</strong></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Statistics Aggregation Interval</td>
<td>Interval during which the VXML Server publishes statistics.</td>
<td>30</td>
<td>10 to 1440 minutes</td>
<td>Yes</td>
</tr>
<tr>
<td>Log File Properties</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>
| Max Log File Size         | Enter the maximum size of a log file in megabytes before a new log file is created. The log file name follows this format: CVP.DateStamp.SeqNum.log. For example: CVP.2006-07-04.00.log Every midnight, a new log file is automatically created with a new date stamp. Also, when a log file exceeds the maximum log file size, a new one with the next sequence number is created. For example, when CVP.2006-07-04.00.log reaches 5 MB, CVP.2006-07-04.01.log is created automatically. **Note** To increase the log file size, go to C:\Cisco\CVP\conf, open log4j_vxml.xml file and update the MaxFileSize value as shown: `<param name="MaxFileSize" value="10000000"/>

Save the file and restart VXML Server to deploy the changes. | 10 MB  | 1 through 100 MB     | Yes              |
### Field Description

Max Log Directory Size: Enter the maximum size of the directory containing VXML Server log files.

**Note**: Modifying the value to a setting that is below the default value might cause logs to be rolled over quickly. Consequently, log entries might be lost, which can affect troubleshooting.

<table>
<thead>
<tr>
<th>Default</th>
<th>Values</th>
</tr>
</thead>
<tbody>
<tr>
<td>20,000 MB</td>
<td>500 to 500000 MB</td>
</tr>
</tbody>
</table>

- The value of Max Log File Size must be less than Max Log Directory Size.
- The value of the Max Log File size must be greater than 1.
- The value of Max Log directory Size or Max Log File Size must not be greater than 5000.

**Restart Required**: Yes

### Configuration: Primary Syslog Settings

<table>
<thead>
<tr>
<th>Primary Syslog Server</th>
<th>Hostname or IP address of Primary Syslog Server to send syslog events from a CVP Application.</th>
<th>None</th>
<th>Valid IP address or hostname.</th>
<th>No</th>
</tr>
</thead>
<tbody>
<tr>
<td>Primary Syslog Server Port Number</td>
<td>Port number of Primary Syslog Server.</td>
<td>None</td>
<td>Any available port number. Valid port numbers are integers between 1 and 65535.</td>
<td>No</td>
</tr>
<tr>
<td>Primary Backup Syslog Server</td>
<td>Hostname or IP address of the Primary Backup Syslog Server to send syslog events from a CVP Application when the Syslog Server cannot be reached.</td>
<td>None</td>
<td>Valid IP address or hostname.</td>
<td>No</td>
</tr>
<tr>
<td>Primary Backup Syslog Server Port Number</td>
<td>Port number of Primary Backup Syslog Server.</td>
<td>None</td>
<td>Any available port number. Valid port numbers are integers between 1 and 65535.</td>
<td>No</td>
</tr>
</tbody>
</table>

### Configuration: Secondary Syslog Settings

<table>
<thead>
<tr>
<th>Secondary Syslog Server</th>
<th>Hostname or IP address of Secondary Syslog Server to send syslog events from a CVP Application.</th>
<th>None</th>
<th>Valid IP address or hostname.</th>
<th>No</th>
</tr>
</thead>
<tbody>
<tr>
<td>Secondary Syslog Server Port Number</td>
<td>Port number of Secondary Syslog Server.</td>
<td>None</td>
<td>Any available port number. Valid port numbers are integers between 1 and 65535.</td>
<td>No</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
<td>Default</td>
<td>Values</td>
<td>Restart Required</td>
</tr>
<tr>
<td>--------------------------------------------</td>
<td>-----------------------------------------------------------------------------</td>
<td>---------</td>
<td>-----------------------------</td>
<td>------------------</td>
</tr>
<tr>
<td>Secondary Backup Syslog Server</td>
<td>Hostname or IP address of the Secondary Backup Syslog Server to send syslog events from a CVP Application when the Syslog Server is not reachable.</td>
<td>None</td>
<td>Valid IP address or hostname.</td>
<td>No</td>
</tr>
<tr>
<td>Secondary Backup Syslog Server Port Number</td>
<td>Port number of Secondary Backup Syslog Server.</td>
<td>None</td>
<td>Any available port number. Valid port numbers are integers between 1 and 65535.</td>
<td>No</td>
</tr>
</tbody>
</table>

**Enable Active and Standby VXML Server**

This feature enables failover mechanism for VXML Servers.

If the active VXML Server fails, then the configured backup VXML Server takes over.

**Configuration in CVP**

Enable the active/standby VXML Server feature in CVP by modifying the sip.properties.

SIP.UseBackupIVRSS=true

**Configuration in Gateway**

Enable the active/standby VXML Server feature in Gateway by configuring a backup VXML server.

**Example:**

If the active VXML Server's hostname is Callserver1 with the IP address 10.1.1.1 and the backup VXML Server's hostname is Callserver2 with the IP address 10.2.2.2, then the backup VXML Server is configured as:

```plaintext
service bootstrap flash:bootstrap.tcl
   paramspace english index 0
   paramspace english language en
   paramspace english location flash
   paramspace english prefix en
   param Callserver1 10.1.1.1
   param Callserver1-backup 10.2.2.2
```

**Configuration in Cisco VVB**

Enable the active/backup VXML Server feature in Cisco VVB by configuring a backup VXML server.

This can be done using CLI command `utils vvb add host-to-ip <hostname> <ip_address>`

**Example**

utils vvb add host-to-ip Callserver1 10.1.1.1
utils vvb add host-to-ip Callserver1-backup 10.2.2.2
**Voice XML Service**

The VoiceXML Service provides Unified ICME call control capabilities and data to the Reporting Service. The VoiceXML Service

- Resides outside of the Call Server that gives call control capabilities to the Standalone Mode.
- Is the connection between the VXML Server and the ICM Service that feeds data to the Reporting Service.
- In a Standalone Mode with ICM Lookup deployment:
  - Interacts with the VXML Server and the ICM Service to do call control piece
  - Interacts with VXML Server and Reporting Service to populate the Reporting database.

---

**Note**

For more information, see *Pass Data to Unified ICME*, on page 160.

**Related Topics**

- *Pass Data to Unified ICME*, on page 160

**VXML Server Reporting**

VXML Server applications can function in a wide range of paradigms, from the VXML Server virtually controlling the entire user interaction to performing individual interactions on a scale similar to that of the Unified CVP micro-applications. Between these extremes, you can design the VXML Server applications to implement specific transactions. For example, in a banking application a transaction can consist of all the user interactions required to successfully complete a balance transfer or a telephone bill payment. The high-level menus which the user can use to select a particular type of transaction is controlled by the Unified ICME routing script, using standard Unified CVP micro-applications, such as Menu and Play Media. Once a particular transaction type is chosen, the Unified ICME routing script issues an External VoiceXML micro-application to invoke the appropriate VXML Server application which implements that transaction type. Once the VXML Server application completes, control returns to the Unified ICME routing script for further menus. Typically, audit information about the transaction is returned, and can be stored in the Unified ICME database. It is also determines whether the transaction was successful, or it needs to be transferred or queued to an agent, and so on.

While Unified ICME VRU Progress reporting capabilities are always in effect, they compliment VXML Server applications most effectively when this transaction-oriented design is used. The customer defines a Unified ICME CallType for each type of transaction, and uses the audit information returned from the VXML Server to determine how to set the Unified ICME's VRUProgress variable. The setting selected dictates how the transaction is counted in the aggregate VRU reporting fields in the CallTypeHalfHour table.

VRU reporting enhancements are described in the Unified ICME 6.0(0) and online help.
Inclusive and Exclusive VXML Reporting Filters

Use Inclusive and Exclusive VXML filters to control the data that the Unified CVP VXML Server feeds to the Reporting Server.

Data feed control is crucial for the following purposes:

• Save space in the reporting database.
• Preserve messaging communication bandwidth.

VXML Inclusive and Exclusive Filter Rules

• Filters are case sensitive.

• By default, all items except the Start, End, Subdialog_Start and Subdialog_End elements are filtered from reporting data unless they are added to an Inclusive Filter. The Subdialog_Start and Subdialog_End elements are never filtered from reporting data unless reporting is disabled on the Unified CVP VXML Server.

• The Exclusive Filter takes precedence over the Inclusive Filter. For example, if an application name is in the Exclusive Filter, then the items of that application are excluded from reporting data even if a particular field or element is listed in the Inclusive filter.

• The Inclusive/Exclusive filters can have one of the following syntaxes:
  • Appname.ElementType.ElementName.FieldName
  • AppName.*.*.SESSION:Varname

  Note This syntax indicates session variables.

• Use a semicolon (;) to separate each item in a filter. For example, ElementA ; ElementB is valid.

• Use a single wildcard (*) anywhere within the application name, element type, element name, or field name.

• Form element types, element names, and field names that contain alphanumeric characters, underscores, and a space character.

• Use an application name that contains alphanumeric characters and underscores, without a space. For example, A_aa.B_bb.*C_cc_DD.E_ee_F* is valid.

VXML Filter Wildcard Matching Examples

Table 20: Examples - VXML Filter Wildcard Matching

<table>
<thead>
<tr>
<th>Filter</th>
<th>What It Matches</th>
</tr>
</thead>
<tbody>
<tr>
<td>MyApplication.voice.<em>.</em></td>
<td>Matches all voice elements in MyApplication</td>
</tr>
</tbody>
</table>
Configure Inclusive and Exclusive VXML Reporting Filters

<table>
<thead>
<tr>
<th>Filter</th>
<th>What It Matches</th>
</tr>
</thead>
<tbody>
<tr>
<td><em>.voice.</em>.*</td>
<td>Matches all Voice elements in all applications</td>
</tr>
<tr>
<td>MyApplication.<em>.</em>.var*</td>
<td>Matches all fields in MyApplication that start with the string var</td>
</tr>
<tr>
<td>MyApplication.<em>.</em>.*3</td>
<td>Matches all fields in MyApplication that end with 3</td>
</tr>
<tr>
<td>MyApplication.<em>.</em>.SESSION:Company</td>
<td>Matches the Company session variable in MyApplication</td>
</tr>
</tbody>
</table>

**Procedure**

**Step 1** Choose Device Management > Unified CVP VXML Server. The Find, Add, Delete, Edit Unified CVP VXML Servers window appears.

**Step 2** Search for a VXML Server.

**Step 3** From the list of matching records, choose the Unified CVP VXML Server that you want to edit.

**Step 4** Click Edit. The Unified CVP VXML Server Configuration window opens to the General Tab.

**Step 5** Select the Configuration Tab, then configure Unified CVP VXML Server properties.

**Step 6** In the VXML Applications Details: Filters pane, enter an inclusive filter that defines the VXML elements to include in data sent to the Reporting Server.

**Step 7** (Optional) Enter an exclusive filter that excludes some of the data specified by the inclusive filter.

**Step 8** Click Save to save the settings in the Operations Console database or click Save & Deploy to save and apply the changes to the Unified CVP VXML Server.

**Step 9** Restart the VXML Server and the primary and backup Call Servers.

**QoS for VXML Server**

Quality of Service (QoS) is the measure of transmission quality and service availability of a network (or internetworks).

**Note**

For more information about defining QoS criteria, see the latest Enterprise QoS Solution Reference Network Design Guide.

**Create Policy Based QoS**

To create a Windows-policy-based QoS, refer to the Microsoft site.
Procedure

Step 1 From the Local Group Policy Editor on Windows 2012 R2 Standard Edition server, select Computer Configuration > Windows Settings.

Step 2 In the Group Policy Object Editor window right-click the Policy-based QoS node, and click Create a new policy.

Step 3 On the Policy-based QoS wizard specify a policy name. Specify a DSCP value, and click Next.

Step 4 Select all application, and click Next.

Step 5 Check the Any source IP address and Any destination IP address check box, and click Next.

Step 6 If the policy is for Call Server QoS, then from the Select the protocol this QoS policy applies to drop-down list, select the same protocol that was set in the Outbound transport type on the Unified CVP Operations Console.

If the policy is for VXML Server QoS, then from the Select the protocol this QoS policy applies to drop-down list, select TCP.

Step 7 If the policy is for Call Server QoS, check the To destination port number or range check box. Assign the same port number as configured in the Port number for outgoing SIP requests in the Unified CVP Operations console. By default the port number is 5060.

If the policy is for VXML Server QoS, check the From this source port number or range check box. Assign the port number 7000.

Step 8 Click Finish.

VXML Server with Unified ICME

This section describes how to integrate VoiceXML and Unified ICME scripts.

Integrate VoiceXML Scripts with Unified ICME Scripts

This section describes how to integrate the Unified CVP VXML Server into the Unified CVP solution. This process involves:

• Creating a Unified ICME script with ECC variables configured for Unified CVP VXML Server.

• Creating a VRU Script to run in the Unified ICME script.

Procedure

Step 1 Specify the URL (remove and port number) of the Unified CVP VXML Server that you want to reach, for example:


In the example, 10.78.26.28 is the IP address of the Unified CVP VXML Server, 7000 is the port number, and the application name is HelloWorld. The values are delimited by a colon (:).
Note  
7000 is the default port number for a Unified CVP VXML Server. The new port for Unified CVP 4.0 and later is 7000 for Tomcat with Unified CVP VXML Server.

Step 2  
In the Unified ICME script, first set the media_server ECC variable to:

http://10.78.26.28:7000/CVP

Step 3  
Set the app_media_lib ECC Variable to "." (literally two periods in quotes).

Step 4  
Set the user.microapp.ToExtVXML[0] ECC variable to: application=HelloWorld

Note  
This example indicates that the Unified CVP VXML Server will execute the HelloWorld application. To execute a different application, change the value of user.microapp.ToExtVXML[0].

Step 5  
Set the UseVXMLParams ECC Variable to N.

Step 6  
Create a Run External Script node within the Unified ICME script with a VRU Script Name value of GS,Server,V.

Note  
Remember to link this node to the nodes configured in the previous steps.

- The timeout value set in the Network VRU Script should be substantially greater than the length of the timeout in the Unified CVP VXML Server application. Use this timeout only for recovery from a failed Unified CVP VXML Server.

- Always leave the Interruptible check box in the Network VRU Script Attributes tab checked. Otherwise, calls queued to a Unified CVP VXML Server application might stay in the queue when an agent becomes available.

Step 7  
After you configure the Unified ICME script, configure a corresponding Unified CVP VXML Server script with Call Studio.

The Unified CVP VXML Server script must:

- Begin with a Unified CVP Subdialog_Start element (immediately after the Call Start element)

- Contain a Unified CVP Subdialog_Return element on all return points (script must end with a Subdialog_Return element)

- The Unified CVP Subdialog_Return element must include a value for the call input

- To enable reporting, you must add Data Feed/SNMP loggers

---

**Correlate Unified CVP and Unified ICME Logs with Unified CVP VXML Server Logs**

When using the Unified CVP VXML Server option in the Unified CVP solution, you can correlate Unified CVP/Unified ICME logs with VoiceXML logs by passing the Call ID to the Unified CVP VXML Server by URL. Building upon the URL used in the previous example, the URL is as follows:

Unified CVP VXML Server (by default) receives callid (which contains the call GUID), _dnis, and _ani as session variables in comprehensive mode even if the variables are not configured as parameters in the ToExtVXML array. If the variables are configured in ToExtVXML then those values are used. These variables are available to VXML applications as session variables, and they are displayed in the Unified CVP VXML Server log. This change is backwards compatible with the following script. That is, if you have added the following script, you do not need to change it. However, if you remove this script, you save an estimated 40 bytes of ECC variable space.

To configure logging, in the Unified ICME script, use the formula editor to set ToExtVXML[1] variable. Set the value of ToExtVXML[1] variable to `concatenate("callid=".Call.user.media.id):`

**Note**

- Always include "callid" when sending the call to the Unified CVP VXML Server using the Comprehensive call flow model. The Call ID can also be used in Unified CVP VXML Server (standalone) solutions.

- When you concatenate multiple values, use a comma for the delimiter.

- The value of ICMInfoKeys must contain RouterCallKey, RouterCallDay, and RouterCallKeySequenceNumber separated by a "-".

  For example, `concatenate("ICMInfoKeys=".Call.RouterCallKey,"-",.Call.RouterCallDay,"-",.Call.RouterCallKeySequenceNumber).


### Error Codes for VXML Server

The following are some of the error codes that you may see with the VXML Server application:

- **Error Code 40 -- System Unavailable**
  This is returned if the VXML Server is unavailable (shutdown, network connection disabled, and so forth).

- **Error Code 41 -- App Error**
  This is returned if a Unified CVP VXML Server application error occurs (For example, a java exception).

- **Error Code 42 -- App Hangup**
  This is returned if the Hang Up element is used instead of the Unified CVP Subdialog_Return element.

  **Note**  
  If the application is configured correctly, this does not occur.

- **Error Code 43 -- Suspended**
  This is returned if the Unified CVP VXML Server application is suspended.

- **Error Code 44 -- No Session Error**
This is returned when an emergency error occurs (for example, an application is called that has not been loaded in the Unified CVP VXML Server application).

- **Error Code 45 -- Bad Fetch**
  This is returned when the Unified CVP VXML Server encounters a bad fetch situation. This code is returned when either a .wav file or an external grammar file is not found.
Error Codes for VXML Server
CHAPTER 6

Reporting Server Configuration

• Configure Reporting Server, on page 127
• Reporting Server Settings, on page 128

Configure Reporting Server

Before you begin

• Configure a Call Server to associate with a Reporting Server. To configure a Call Server, see Configure Call Server, on page 77.

You can associate a Call Server with only one Reporting Server.

Note

• Collect the following information about the Reporting Server and Reporting Database during the installation of Unified CVP software:
  • Hostname of the Call Servers that are associated with the Reporting Server.
  • Hostname and IP address of the server on which the Reporting Database resides.
  • Password for the Reporting Database user.

Procedure

Step 1

Step 2
Click Add New to add a new Reporting Server or click Use As Template to use an existing template to configure the new Reporting Server.

Step 3
Click the following tabs and configure the settings based on your call flow model:
  a) General tab. For more information, see General Settings, on page 128.
  b) Reporting Properties tab. For more information, see Reporting Properties Settings, on page 129.
  c) Device Pool tab. For more information about adding, deleting, and editing device pool, see Add or Remove Device From Device Pool, on page 98.
  d) Infrastructure tab. For more information, see Infrastructure Settings, on page 130.
Step 4  Click **Save and Deploy** to deploy the changes to the Reporting Server page. Click **Save** to save the settings in the Operations Server database and configure the Reporting Server later.

**Related Topics**

- **Configure Call Server**, on page 77
- **General Settings**, on page 128
- **Reporting Properties Settings**, on page 129
- **Add or Remove Device From Device Pool**, on page 98
- **Infrastructure Settings**, on page 130

# Reporting Server Settings

## General Settings

Configure settings that identify the Reporting Server, associate it with one or more Call Servers, and enable or disable security on the **General** tab.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
<th>Default</th>
<th>Value</th>
<th>Restart Required</th>
</tr>
</thead>
<tbody>
<tr>
<td>IP Address</td>
<td>The IP address of the Reporting Server.</td>
<td>None</td>
<td>Valid IP address</td>
<td>Yes</td>
</tr>
<tr>
<td>Hostname</td>
<td>The hostname of the Reporting Server machine.</td>
<td>None</td>
<td>Valid DNS name, which can include letters of the alphabet and numbers 0 through 9.</td>
<td>Yes</td>
</tr>
<tr>
<td>Description</td>
<td>An optional text description for the Reporting Server.</td>
<td>None</td>
<td>Up to 1024 characters.</td>
<td>No</td>
</tr>
<tr>
<td>Enable Secure Communication</td>
<td>Select to enable secure communications between the Operations Console and the Reporting Server component. The Reporting Server is accessed using SSH and files are transferred using HTTPS. You must configure secure communications <strong>before</strong> you enable this option. See Administration Guide for Cisco Unified Customer Voice Portal.</td>
<td>Off</td>
<td>On or Off</td>
<td>No</td>
</tr>
</tbody>
</table>
### Reporting Properties Settings

Configure Reporting Server settings on the **Reporting Properties** tab.

#### Table 22: Reporting Server—Reporting Properties Tab Configuration Settings

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
<th>Default</th>
<th>Range</th>
<th>Restart Required</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Configuration</strong></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Enable Reporting</td>
<td>Enables the Reporting Server to receive call data from the associated Call Server.</td>
<td>Yes</td>
<td>Yes or No</td>
<td>Yes</td>
</tr>
<tr>
<td>Max. File Size (MB):</td>
<td>Defines the maximum size of the file that is used to record the data feed messages during a database failover. This size can be limited by the amount of free disk space.</td>
<td>100</td>
<td>1 through 250 MB</td>
<td>No</td>
</tr>
<tr>
<td><strong>QoS</strong></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>
Infrastructure Settings

The Reporting Server publishes statistics on the number of reporting events that it receives from the Unified CVP VXML Server, the SIP Service, and the IVR Service. It also publishes the number of times the Reporting Server writes data to the Reporting Database. You can configure the interval at which the Reporting Server publishes these statistics, the maximum log file and directory size, and the details for recording syslog messages on the Reporting Server Infrastructure tab.

Table 23: Reporting Server—Infrastructure Tab Configuration Settings

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
<th>Default</th>
<th>Value</th>
<th>Restart Required</th>
</tr>
</thead>
<tbody>
<tr>
<td>Configuration: Thread Management</td>
<td>(Required) The maximum thread pool size in the Reporting Server Java Virtual Machine.</td>
<td>500</td>
<td>100 to1000</td>
<td>Yes</td>
</tr>
<tr>
<td>Advanced</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Statistics Aggregation Interval</td>
<td>The Reporting Server publishes statistics at this interval.</td>
<td>30 minutes</td>
<td>10 to1440</td>
<td>Yes</td>
</tr>
<tr>
<td>Log File Properties</td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Max Log File Size</td>
<td>(Required) Maximum size of the log file in megabytes.</td>
<td>10 MB</td>
<td>1 through 100 MB.</td>
<td>Yes</td>
</tr>
<tr>
<td>Note</td>
<td>To increase the log file size, go to C:\Cisco\CVP\conf, open log4j.xml file and update the MaxFileSize value as shown:</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>&lt;param name=&quot;MaxFileSize&quot; value=&quot;10000000&quot;/&gt;</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>Save the file and restart Reporting Server to deploy the changes.</td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

Configuration Guide for Cisco Unified Customer Voice Portal, Release 11.6(1)
**Reporting Server Configuration**

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
<th>Default</th>
<th>Value</th>
<th>Restart Required</th>
</tr>
</thead>
<tbody>
<tr>
<td>Max Log Directory Size</td>
<td>(Required) Maximum size of the directory containing Reporting Server log files.</td>
<td>20,000 MB</td>
<td>500 to 500,000 MB.</td>
<td>Yes</td>
</tr>
<tr>
<td></td>
<td><strong>Note</strong> If you modify the value to a setting that is below the default value, the log entries might be lost, which can affect troubleshooting.</td>
<td></td>
<td>Max Log File Size is less than Max Log Directory Size. Max Log Directory Size cannot be greater than 500,000 MB.</td>
<td></td>
</tr>
</tbody>
</table>

**Configuration: Primary Syslog Settings**

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
<th>Default</th>
<th>Value</th>
<th>Restart Required</th>
</tr>
</thead>
<tbody>
<tr>
<td>Primary Syslog Server</td>
<td>Hostname or IP address of Primary Syslog Server to send syslog events from a CVP Application.</td>
<td>None</td>
<td>Valid IP address or hostname.</td>
<td>No</td>
</tr>
<tr>
<td>Primary Syslog Server Port Number</td>
<td>Port number of Primary Syslog Server.</td>
<td>None</td>
<td>Any available port number. Valid port numbers are integers between 1 and 65,535.</td>
<td>No</td>
</tr>
<tr>
<td>Primary Backup Syslog Server</td>
<td>Hostname or IP address of the Primary Backup Syslog Server to send syslog events from a CVP Application when the Syslog Server cannot be reached.</td>
<td>None</td>
<td>Valid IP address or hostname.</td>
<td>No</td>
</tr>
<tr>
<td>Primary Backup Syslog Server Port Number</td>
<td>Port number of Primary Backup Syslog Server.</td>
<td>None</td>
<td>Any available port number. Valid port numbers are integers between 1 and 65,535.</td>
<td>No</td>
</tr>
</tbody>
</table>

**Configuration: Secondary Syslog Settings**

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
<th>Default</th>
<th>Value</th>
<th>Restart Required</th>
</tr>
</thead>
<tbody>
<tr>
<td>Secondary Syslog Server</td>
<td>Hostname or IP address of Secondary Syslog Server to send syslog events from a CVP Application.</td>
<td>None</td>
<td>Valid IP address or hostname.</td>
<td>No</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
<td>Default</td>
<td>Value</td>
<td>Restart Required</td>
</tr>
<tr>
<td>-------------------------------------------</td>
<td>-----------------------------------------------------------------------------</td>
<td>---------</td>
<td>-----------------------------------------------------------------------</td>
<td>-------------------</td>
</tr>
<tr>
<td>Secondary Syslog Server Port Number</td>
<td>Port number of Secondary Syslog Server.</td>
<td>None</td>
<td>Any available port number. Valid port numbers are integers between 1 and 65,535.</td>
<td>No</td>
</tr>
<tr>
<td>Secondary Backup Syslog Server</td>
<td>Hostname or IP address of the Secondary Backup Syslog Server to send syslog events from a CVP Application when the Syslog Server cannot be reached.</td>
<td>None</td>
<td>Valid IP address or hostname.</td>
<td>No</td>
</tr>
<tr>
<td>Secondary Backup Syslog Server Port Number</td>
<td>Port number of Secondary Backup Syslog Server.</td>
<td>None</td>
<td>Any available port number. Valid port numbers are integers between 1 and 65,535.</td>
<td>No</td>
</tr>
</tbody>
</table>
CHAPTER 7

Unified ICM Configuration

- Configure Unified ICM Server, on page 133
- ICM Server Settings, on page 134
- Configure ICM Settings for Standalone Call Flow Model, on page 134
- Configure ICM Settings for Comprehensive Call Flow Model for ICME and ICMH, on page 136
- Configure ICM Settings for Call Director Call Flow Model, on page 149
- Configure ICM Settings for VRU-Only Call Flow Model: Type 8, on page 151
- Configure ICM Settings for VRU-Only Call Flow Model: Type 7, on page 157
- Pass Data to Unified ICME, on page 160

Configure Unified ICM Server

Procedure

Step 1 Log in to Operations Console and click Device Management > Unified ICM.

Step 2 Click Add New.

Note To use an existing ICM Server as a template for configuring a new ICM Server, select an ICM Server from the list of available Unified ICM Servers and click Use As Template and perform Steps 3 to 6.

Step 3 Click the General tab and enter the field values. See General Settings, on page 134.

Step 4 (Optional) Click the Device Pool tab and add the Unified ICM Server to a device pool. See Add Unified ICM to Device Pool, on page 134.

Step 5 Click Save.

Related Topics
- General Settings, on page 134
- Add Unified ICM to Device Pool, on page 134
ICM Server Settings

General Settings

Unified CVP provides VoIP routing services for the Unified CCE and Unified CCX products. Unified ICM provides the services to determine where calls should be routed. These calls can be routed to ACDs, specific agents, or to VRUs. However, the routing services themselves must be provided by an external routing client.

A Unified ICM Server is required in Unified CVP Comprehensive, Call Director, and VRU-Only call flow models.

To configure General settings on an ICM Server, on the **General** tab, enter the field values, as listed in the following table:

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
<th>Default</th>
<th>Value</th>
<th>Restart Required</th>
</tr>
</thead>
<tbody>
<tr>
<td>IP Address</td>
<td>The IP address of a Unified ICM Server</td>
<td>None</td>
<td>Valid IP address</td>
<td>No</td>
</tr>
<tr>
<td>Hostname</td>
<td>The name of the Unified ICM Server</td>
<td>None</td>
<td>Valid DNS name. It includes alphanumeric characters and a dash.</td>
<td>No</td>
</tr>
<tr>
<td>Description</td>
<td>Additional information about the Unified ICM Server</td>
<td>None</td>
<td>Up to 1024 characters</td>
<td>No</td>
</tr>
<tr>
<td>Device Admin URL</td>
<td>The URL for the Unified ICM Web configuration application.</td>
<td>None</td>
<td>Valid URL</td>
<td>No</td>
</tr>
</tbody>
</table>

Add Unified ICM to Device Pool

See **Add or Remove Device From Device Pool, on page 98**.

**Related Topics**

Add or Remove Device From Device Pool, on page 98

Configure ICM Settings for Standalone Call Flow Model

You can convert a configuration from a nonreporting configuration (that is, no Call Server is defined) to a Reporting or ICM Lookup Configuration. If you have configured Unified CVP for a Standalone call flow model without reporting, the version of the VXML Server you defined cannot be associated with a Call Server. This VXML Server definition is required for reporting and for the ICM Lookup. Hence, delete the existing VXML Server definition and begin with Step 4 to incorporate a Call Server, a Reporting Server, and ICM Lookup Configuration steps.
### Variations and Applicable Steps

<table>
<thead>
<tr>
<th>Variations</th>
<th>Applicable steps</th>
</tr>
</thead>
<tbody>
<tr>
<td>Reporting</td>
<td>Steps 2, 5, and 6</td>
</tr>
<tr>
<td>Without Reporting</td>
<td>Not applicable</td>
</tr>
<tr>
<td>ICM lookup</td>
<td>Steps 1 to 7</td>
</tr>
<tr>
<td>All variations</td>
<td>Step 1</td>
</tr>
</tbody>
</table>

### Procedure

**Step 1**  
Create an application using Cisco Unified Call Studio and deploy it as a zip file.

**Note**  
- For ICM Lookup, use the **ReqICMLabel Element**. This element has two exit states: **error** and **done**. The **done** state must connect to a transfer element to transfer the caller to **ReqICMLabel** as referenced by the **ReqICMLabel Element**.
- For details on the **ReqICMLabel Element**, see the Element Specifications for Cisco Unified CVP VXML Server and Unified Call Studio.
- For information about Unified Call Studio, see the User Guide for Cisco Unified CVP VXML Server and Unified Call Studio.

**Step 2**  
Enable logging.

See the User Guide for Cisco Unified CVP VXML Server and Unified Call Studio for details on configuring loggers using Unified Call Studio.

**Step 3**  
Enable the **CVPSNMPLLogger** for SNMP monitoring.

**Note**  
By default, **CVPSNMPLLogger** is enabled when a new Unified Call Studio application is created and deployed to the VXML Server.

**Step 4**  
Add and configure a standard Call Server and enable the ICM service. See Configure Call Server, on page 77.

**Step 5**  
Configure the VXML Server.

a) Log in to Operations Console, select **Device Management > VXML Server** and add a VXML Server with an associated Primary Call Server.

b) To enable reporting for this VXML Server, in the Operations Console, click the **Configuration** tab and select **Enable Reporting for this VXML Server**.

c) Add appropriate filtering.

**Step 6**  
Deploy the Call Studio Application on the VXML Server.

a) Select **Device Management > VXML Server** in the Operations Console.

b) Select the VXML Server and click **Save and Deploy**.

**Step 7**  
Using the ICM Script Editor, create a Unified ICME script that returns a label.

To transfer information from Unified ICME to the VXML Server in addition to the label, use the **ToExtVXML 0 - 4 ECC Variables or Peripheral Variables 1 to 10**. The format for using the ToExtVXML 0 to 4 is with name-value pairs that are delimited by semicolons.

**Example:**
ToExtVXML0 = "company=Cisco Systems;state=MA"

Use the Peripheral Variables 1 to 10 to pass information to the VXML Server. The values in these variables will be taken as is.

For information about creating a Unified ICME script that returns a label in, see the Unified ICME documentation.

For information about using the ReqICMLabel element, see Pass Data to Unified ICME, on page 160.

Related Topics
Configure Call Server, on page 77
Pass Data to Unified ICME, on page 160

Configure ICM Settings for Comprehensive Call Flow Model for ICME and ICMH

Procedure

Step 1
Define Network VRUs, create an instance, and define a customer.

a) On Unified ICME or NAM, in the ICM Configuration Manager, select the Network VRU Explorer tool, define a Network VRU for the VRU leg and labels for each Call Server.

b) On the Cisco Intelligent Contact Manager (CICM) only, in the ICM Configuration Manager, select Network VRU Explorer tool, define a Network VRU for the VRU leg and labels for reaching the NAM.

For Steps 1(a) and 1(b), enter the following values:

- Type: 10
- Name: <Network VRU Name>. For example: cvp
- Define a label for each Unified CVP Call Server that is handling the switch leg:
  - Label: <Network Routing Number>
  - Type: Normal
- Routing client for Unified ICME or NAM: From the drop-down list, select the routing client configured for that Call Server peripheral.
- Routing client for CICM only: From the drop-down list, select the INCRP routing client.

Note
The Network VRU label in NAM and CICM must be same. Similarly, the Network VRU Names on the NAM and CICM should also be same.

Step 2
Configure the ICM VRU Label.

Step 3
Define network VRUs and peripheral gateways for the switch leg in the ICM Configuration Manager.

On Unified ICMH, on the NAM and CICMs, in the Network VRU Explorer tool, define one label for each Unified CVP Call Server or NIC routing client.
**Note** Use the same Type 10 Network VRU that you defined in the Step 1 for the VRU leg.

For more information, see the ICM Configuration Guide for Cisco ICM Enterprise Edition.

**Step 4**
Set the client type for the INCRP NIC. On the CICM, in the ICM Configuration Manager, NIC Explorer tool, set the client type for the INCRP NIC. Select the **Client Type** as **VRU**.

**Step 5**
Define a VRU that uses INCRP. On the CICM, in the ICM Configuration Manager, Network VRU Explorer tool:

a) Define a Network VRU with a label that uses INCRP as its routing client.

   Specify the following:
   - **Type**: 10
   - **Name**: *<name of Unified CVP VRU>*

**Example:**

   `cvpVRU`

b) Define a label for the NAM routing client.

   Specify the following:
   - **Type**: Normal
   - **Label**: *<Network Routing Number>*
   - **Routing client**: INCRP NIC

For more information, see the ICM Configuration Guide for Cisco ICM Enterprise Edition.

**Step 6**
Configure Peripheral Gateways.

On the NAM, ICM Configuration Manager, **PG Explorer** tool, configure a peripheral gateway (PG) for the Unified CVP. Configure a PG for each Unified CVP Call Server as follows:

In the tree view pane, select the applicable PG.

**Logical Controller** tab:
- **Client Type**: VRU
- **Name**: A name descriptive of this PG
  
  For example: *<location>_A* for side A of a particular location

**Peripheral** tab:
- **Peripheral Name**: Descriptive name of this Unified CVP peripheral. For example: *<location>_cvp1* or *<dns_name>*
  
  - **Client Type**: VRU
  
  - Check the **Enable Post-routing** check box.

**Advanced** tab: Select the name of the Unified CVP VRU from the Network VRU field drop-down list. For example: *cvpVRU*

**Routing Client** tab:
• Name: By convention, use the same name as the peripheral

• Client Type: VRU

• If you are in a Unified ICMH environment and configuring the CICM, then do the following:
  • Do not check the Network Transfer Preferred check box.
  • Routing client: INCRP NIC

**Step 7** Define a default network VRU on Unified ICME or the NAM, in the ICM Configuration Manager, the System Information tool:
  a) For Unified ICME or on the CICM only, define a default Network VRU.
     Define the Default Network VRU: <Network VRU Name>. For example: cvpVRU
  b) If there are Routing Scripts on the NAM, define a default Network VRU.

For more information, see the ICM Configuration Guide for Cisco ICM Enterprise Edition.

**Step 8** Configure dialed numbers, call types, and customers on the Unified ICME or Unified ICMH Server in the ICM Configuration Manager:
  a) **Dialled Number List Tool tab**: Configure the dialed numbers.
  b) **Call Type List Tool tab**: Configure the call types.
  c) **ICM Instance Explorer tool tab**: Configure the applicable customers.

For more information, see ICM Configuration Guide for Cisco ICM Enterprise Edition.

**Step 9** Install and configure one or multiple Call Servers.
Log in to the Operations Console and perform the following steps:
  a) Enable the ICM and SIP Services on the Call Server.
     • On the Operations Console, click **Device Management > Unified CVP Call Server**.
     • Check the ICM and SIP check boxes.

  b) Click **Device Management > Unified CVP Call Server > SIP**. Configure the SIP Service:
     • If you are using a SIP Proxy Server, enable the Outbound Proxy and select the SIP Proxy Server.
       Select the **SIP tab** and configure the following values:
       • Enable Outbound Proxy: Yes
       • Outbound Proxy Host: Select from drop-down list.
       • Configure Local Static Routes on the SIP Proxy Server itself.

     • If you are not using a SIP Proxy Server, configure Local Static Routes using the Dialed Number Pattern system configuration on the Operations Console. A Local Static Route must be configured for each SIP gateway or automatic call distributor (ACD) so that SIP endpoint can receive calls.

     Local Static Routes, Dialed Number (DN): Specify the dialed number pattern for the destination. Valid number patterns include the following characters:
     • Use the period or the X character for single-digit wildcard matching in any position.
• Use the greater than (>), asterisk (*), or exclamation mark (!) characters as a wildcard for zero or more digits at the end of the DN.

• Avoid the T character for wildcard matching.

• Dialed numbers must not exceed 24 characters.

• For valid format and precedence information about dialed numbers, see Valid Format for Dialed Numbers, on page 94.

Example: 9> (Errors are 9292 and ringtone is 9191)

For more information, see SIP Dialed Number Pattern Matching Algorithm, on page 9.

The following static route configuration is incorrect because the least explicit routes must appear at the end. Load balancing or failover of calls require DNS SRV domain names, not multiple routes with the same DN Pattern, but a single route to an SRV domain name.

Incorrect Example:

1>,10.2.6.1
2>,10.2.6.2
3>,10.2.6.20
2229191>,10.2.6.241
2229292>,10.2.6.241
2229191>,10.2.6.242
2229292>,10.2.6.242
2>,ccm-subscribers.cisco.com
3>,ccm-subscribers.cisco.com

Correct static route configuration example:

22291>,cvp-ringtone.cisco.com
22292>,cvp-error.cisco.com
1>,ccm-subscribers.cisco.com
2>,ccm-subscribers.cisco.com
3>,ccm-subscribers.cisco.com

Note “91919191>” pattern does not match the dialed number “91919191”.

• Check the default values for the SIP Service and change, if desired.

c) Configure the ICM Service. Select Device Management > CVP Call Server > ICM tab, In the Maximum Length of DNIS field, enter the length of the Network Routing Number.

Example: For the Gateway dial pattern as 1800******, the maximum DNIS length is 10.

Related Topics

Valid Format for Dialed Numbers, on page 94
Set Up Ingress Gateway to Use Redundant Proxy Servers, on page 167
Set Up Call Server with Redundant Proxy Servers, on page 167
Local SRV File Configuration Example for SIP Messaging Redundancy, on page 168
Load-Balancing SIP Calls, on page 168
Cisco Unified SIP Proxy (CUSP) Configuration, on page 168
Configure Custom Streaming Ringtones, on page 171
SIP Dialed Number Pattern Matching Algorithm, on page 9
Configure Common Unified ICMH for Unified CVP Switch Leg

Procedure

**Step 1**  
On the NAM, in the ICM Configuration Manager, Network VRU Explorer tool  
a) Define a Network VRU for Unified CVP for Type as 10 and Name as cvpVRU.  
b) Assign labels. Define one Label per Unified CVP or NIC routing client. Select the Type as Normal and Label as Network Routing Number.

**Step 2**  
Set the client type.  
On the CICM, using the ICM Configuration Manager, NIC Explorer tool:  
• Select the Routing Client tab for the INCRP NIC.  
• Enter the Client Type as VRU.

**Step 3**  
Define a Network VRU.  
On the CICM, using the ICM Configuration Manager, Network VRU Explorer tool, define a Network VRU with a label that uses INCRP as its routing client.  
Enter the following:  
• Type: 10  
• Name: cvpVRU  
• Define one Label for the NAM routing client:  
  • Label: Network Routing Number  
  • Type: Normal  
  • Routing client: INCRP NIC

**Step 4**  
Define the Peripheral Gateways (PGs).  
On the NAM, using the ICM Configuration Manager, PG Explorer tool, configure a peripheral gate for each ICM Service to be used for a switch leg that is connected to each PG.  
For each Unified CVP ICM Service connected to this PG, in the tree view pane, select the applicable PG.  
On the Logical Controller tab, enter the following:  
• Client Type: VRU  
• Name: A name descriptive of this PG.  
  For example: <location>_A, for side A of a particular location.  

On the Peripheral tab, enter the following:  
• Peripheral Name: A name descriptive of this Unified CVP peripheral, for example, <location>_cvp1 or <dns_name>  
• Client Type: VRU
• Check the **Enable Post-routing** checkbox

  On the **Advanced** tab, select the name **cvpVRU** from the Network VRU field drop-down list.

On the **Routing Client** tab, enter the following:

• Name: By convention, use the same name as the peripheral

• Client Type: **VRU**

• Do not check the **Network Transfer Preferred** check box.

---

### Define Unified CVP ECC Variables

Set up the ECC variables that Unified CVP uses to exchange information with Unified ICME/ICMH.

**Procedure**

**Step 1**

On the ICM Configuration Manager, select **Tools > Miscellaneous Tools > System Information** and check the **Enable expanded call context** check box.

**Step 2**

On the ICM Configuration Manager, select **Tools > List Tools > Expanded Call Variable List**.

**Step 3**

In the Expanded Call Variable List window, enable the **Add** button by clicking **Retrieve**.

**Step 4**

Click **Add**.

The Attributes property tab is enabled.

**Step 5**

Create each of the variables in the following table by clicking **Save** after defining each variable.

**Note**

If you change the configuration of any ECC variable with the Expanded Call Variable List tool, stop and restart the Unified CVP Call Server.

**Caution**

It is important that you enter the ECC's **Name** values listed in following table exactly as specified. If you do not, the Unified ICME/ICMH software does not communicate with the micro-applications on the ICM Service.

**Length** values are more flexible. Unless the values listed in following table are noted as "required," the value in the Length column is the maximum that Unified ICMH can handle for that ECC. Specify a value between 1 and the maximum length.

**Note**

In a Unified ICME/ICMH configuration, the ECC variable configuration, including the length, defined in the NAM must be defined same in the CICM.

If you change the length of the ECC variables while the Unified CVP ICM Service is running, restart the Unified CVP ICM Service so that it works properly.

**Step 6**

Click **Save** to apply your changes.
Table 25: Micro-Application ECCs

<table>
<thead>
<tr>
<th>Name</th>
<th>Length</th>
<th>Definition</th>
</tr>
</thead>
<tbody>
<tr>
<td>POD.ID</td>
<td>Length: 36</td>
<td>Unique identifier for use with Cisco Context Service to propagate call or task context data.</td>
</tr>
</tbody>
</table>
| user.CourtesyCallbackEnabled | Required for using Courtesy Callback. | Used to determine if Courtesy Callback must be offered to a caller. Valid values are:  
  "1" = Yes  
  "0" = No  
  Required for using Courtesy Callback. |
| user.cvp_server_info        | Length: 15 | Used by Unified CVP to send the IP address of the Call Server sending the request to Unified ICME.  
  Example: An IPv4 address like 192.168.150.181 |
| user.microapp.currency      | Value: 6 | Currency type.                                                                                                                             |
| user.microapp.error_code    | Value: 2 | Return status error code to be returned from the Unified CVP to Unified ICME/ICMH upon a False return code in the Run Script Result. |
| user.microapp.fetchaudio    | Recommended length: 20; but length depends on the filename. | Filename for audio to be played by the VXML gateway while the gateway loads and processes the requested resource when there is significant network latency.  
  Default: none  
  Example: "flash:holdmusic.wav"  
  Note: This feature is not supported in Cisco VVB. |
<table>
<thead>
<tr>
<th>Name</th>
<th>Length</th>
<th>Definition</th>
</tr>
</thead>
<tbody>
<tr>
<td>user.microapp.fetchdelay</td>
<td>Length: 1</td>
<td>The length of time (in seconds) to wait at the start of the fetch delay before playing the audio specified by <code>user.microapp.fetchaudio</code>. This setting only takes effect if the value of fetchaudio is not empty. Default: 2 seconds; used to avoid a &quot;blip&quot; sound heard in a normal network scenario. Setting this value to zero plays hold music immediately, for a minimum of five seconds. Values: 1 to 9</td>
</tr>
<tr>
<td>user.microapp.fetchminimum</td>
<td>Length: 1</td>
<td>The minimum length of time to play audio specified by <code>user.microapp.fetchaudio</code>, even if the requested resource arrives in the meantime. This setting only takes effect if value of fetchaudio is not empty. Default: 5 seconds Values: 1 to 9</td>
</tr>
<tr>
<td>user.microapp.isPostCallSurvey</td>
<td>Length: 1</td>
<td>Used to determine if post call survey must be offered to a caller after the agent hangs up. Valid values: &quot;y&quot; or &quot;Y&quot; is &quot;Yes&quot; &quot;n&quot; or &quot;N&quot; is &quot;No&quot; Default value is &quot;Yes&quot;</td>
</tr>
<tr>
<td>user.microapp.locale</td>
<td>Value: 5</td>
<td>Locale, a combination of language and country which defines the grammar and prompt set to use.</td>
</tr>
<tr>
<td>Name</td>
<td>Length</td>
<td>Definition</td>
</tr>
<tr>
<td>-------------------------------</td>
<td>--------</td>
<td>-------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
</tbody>
</table>
| user.microapp.media_server    | Required for any IVR scripting.  
Maximum length: 210 characters  
Recommended length: 30 | Root of the URL for all media files and external grammar files used in the script.  
HTTP and HTTPS schemes can be specified as:  
  • HTTP scheme is specified as "http://<servername>"  
  • HTTPS scheme is specified as "https://<servername>" |
| user.microapp.play_data       | 40     | Default storage area for data for Play Data micro-application.                                                                         |
| user.microapp.sys_media_lib   | 10     | Directory for all system media files, such as individual digits, months, default error messages, and so forth.                        |
| user.microapp.app_media_lib   | Maximum length: 210 characters  
Recommended length: 10 | Directory for all application-specific media files and grammar files.  
You can also set this value to ".." (literally two periods in quotes), which bypasses the user.microapp.app_media_lib and user.microapp.locale ECC Variables when writing a URL path. For example, if you set the user.microapp.app_media_lib to "..", the path:  
http://server/locale/../hello.wav  
would really be:  
http://server/hello.wav |

**Note**  
The system and application media libraries need message and prompt files created or recorded for each locale that is referenced. For more information, see Pass Data to Unified ICME, on page 160.

<table>
<thead>
<tr>
<th>Name</th>
<th>Length</th>
<th>Definition</th>
</tr>
</thead>
</table>
| user.microapp.grammar_choices | Configurable on Unified ICME.  
Maximum length: 210 characters. | Specifies the ASR choices that a caller can input for the Get Speech micro-application.  
Each option in the list of choices is delimited by a forward slash (/).  
**Note**  
If text is placed in this variable that is longer than the variable is configured to handle, only the first 210 characters are sent. |
<table>
<thead>
<tr>
<th>Name</th>
<th>Length</th>
<th>Definition</th>
</tr>
</thead>
<tbody>
<tr>
<td>user.microapp.inline_tts</td>
<td>Configurable on the ICM. Maximum length: 210 characters.</td>
<td>Specifies the text for inline Text To Speech (TTS).</td>
</tr>
<tr>
<td></td>
<td></td>
<td><strong>Note</strong> If text is placed in this variable that is longer than the variable is configured to handle, only the first 210 characters are sent.</td>
</tr>
<tr>
<td>user.microapp.input_type</td>
<td>Value: 1</td>
<td>Specifies the type of input that is allowed. Valid contents are:</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• D - DTMF</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• B - (Both, the default) DTMF and Voice</td>
</tr>
<tr>
<td></td>
<td></td>
<td>If you are not using an ASR, you can set this variable to D. If you are using an ASR, you can set the variable to either D or B.</td>
</tr>
<tr>
<td></td>
<td></td>
<td><strong>Note</strong> With input_mode set to &quot;B&quot; (both), either DTMF or speech is accepted, but mixed mode input is not. Once you begin entering with one mode, input using the other mode is ignored and has no effect.</td>
</tr>
<tr>
<td>user.microapp.caller_input</td>
<td>Configurable on Unified ICME/ICMH. Maximum length: 210 characters.</td>
<td>Storage area for any ASR input that is collected from Get Speech.</td>
</tr>
<tr>
<td></td>
<td></td>
<td><strong>Note</strong> Get Speech text results are written to this ECC variable. Results from Get Digits or Menu micro-applications are written to the CED.</td>
</tr>
<tr>
<td>user.microapp.pd_tts</td>
<td>Value: 1</td>
<td>Specifies whether Unified CVP’s Text To Speech (TTS) or media files must be played to the caller.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Valid contents are:</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Y - Yes, use TTS capabilities</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• N - No, do not use TTS capabilities; play media files instead.</td>
</tr>
<tr>
<td></td>
<td></td>
<td><strong>Note</strong> Used only with Play Data micro-application.</td>
</tr>
<tr>
<td>Name</td>
<td>Length</td>
<td>Definition</td>
</tr>
<tr>
<td>-------------------------------</td>
<td>--------</td>
<td>-----------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>user.microapp.UseVXMLParams</td>
<td>Value: 1</td>
<td>This parameter specifies the manner in which you pass information to the external VoiceXML. Set this parameter to either “Y” (for yes) or “N” (for no). Y uses the values in the user.microapp.ToExtVXML variable array. N appends the name/value pairs in user.microapp.ToExtVXML to the URL of the external VoiceXML. Default: &quot;N&quot;</td>
</tr>
<tr>
<td>user.microapp.ToExtVXML</td>
<td>210</td>
<td>This variable sends information to the external VoiceXML file. Must be configured as Array variables, not Scalar variables, even if the array length is set to 1. For more information on user.microapp.ToExtVXML variable length, see the Configure the CCE Script for Courtesy Callback section.</td>
</tr>
<tr>
<td>user.microapp.FromExtVXML</td>
<td>210</td>
<td>This variable array returns information from the external VoiceXML file. Must be configured as Array variables, not Scalar variables, even if the array length is set to 1. See Pass Data to Unified ICME, on page 160 for more information. For more information on user.microapp.FromExtVXML variable length, see the Configure the CCE Script for Courtesy Callback section.</td>
</tr>
<tr>
<td>user.microapp.override_cli</td>
<td>Configurable on Unified ICME/ICMH. Maximum length: 200 characters.</td>
<td>Used by system to override the CLI field on outgoing transfers.</td>
</tr>
<tr>
<td>user.microapp.metadata</td>
<td>The variable length would normally be configured as 62 bytes, but if ECC space is restricted, you can configure it as 21 bytes.</td>
<td>Following the Menu (M), Get Data (GD) and Get Speech (GS) micro-applications, Unified CVP returns information about the execution of that micro-application. The user.microapp.metadata ECC variable is structured as follows: m</td>
</tr>
</tbody>
</table>
### Metadata ECC Variable

Following the Menu (M), Get Data (GD) and Get Speech (GS) micro-applications, Unified CVP returns information about the execution of that micro-application. This information is returned in the **user.microapp.metadata** ECC variable. Its format is defined in terms of a number of subfields, each separated by a vertical bar character (‘|’). Also, the subfields are of fixed length in order to facilitate extraction either at reporting time or within the ICM routing script itself.

The **user.microapp.metadata** ECC variable is structured as follows:

```
m|con|tr|to|iv|duratn|vruscriptname
```

The following table shows the values for this variable:

<table>
<thead>
<tr>
<th>Metadata</th>
<th>ECC Variable Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>m</td>
<td>D, V or N - Indicates whether the user responded with Voice (V), DTMF (D), or not at all (N). (Note that for the Menu micro-application, any successful single digit entry will result in m being set to V or D, even if the entry was an invalid menu selection.)</td>
</tr>
</tbody>
</table>
### ECC Variable Value

<table>
<thead>
<tr>
<th>Metadata</th>
<th>ECC Variable Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>con</td>
<td>000 to 100 - Indicates the ASR percent confidence level at which the voice input was finally recognized. This field is only valid if m is Voice (V).</td>
</tr>
<tr>
<td>tr</td>
<td>00 to 99 - Indicates how many tries were required. 01 means user responded successfully after the first prompt.</td>
</tr>
<tr>
<td>to</td>
<td>00 to 99 - Indicates how many timeouts occurred. Does not include interdigit timeouts.</td>
</tr>
<tr>
<td>iv</td>
<td>00 to 99 - Indicates how many invalid entries were received, including interdigit timeouts.</td>
</tr>
<tr>
<td>duratn</td>
<td>000000 to 999999 - Indicates the micro-application duration in milliseconds. Duration is defined as the elapsed time between entering and exiting the RunExternalScript node, as measured in the IVR Service.</td>
</tr>
<tr>
<td>vruscriptname</td>
<td>Full name of the VRU script which was executed. This is the only variable length field.</td>
</tr>
</tbody>
</table>

This ECC variable is optional. If you have used it, you must define it in the Unified ICME Expanded Call Context Variables configuration tool. Generally, the variable length to be configured is 62 bytes, but if ECC space is restricted, you can configure it as 21 bytes. This configuration drops the vruscriptname subfield. If you do define this variable, its contents get written to the Unified ICME database with every termination record, and can be used to provide a record of meta-information about the execution of each input micro-application.

### Common Configuration for Differentiating VRUs Based on Dialed Number

As per the Network VRU configuration instructions, all callers are routed to the same VRUs (Unified CVPs) for VRU treatment purposes. Under this assumption, it is always simplest to rely on the system default Network VRU. However, it is sometimes necessary to differentiate the VRUs (Unified CVPs) based on dialed number.

**Note**

This section is only applicable to call flow models which use the SendToVRU node to transfer the call to Unified CVP’s VRU leg (it does not apply to Translation Route transfers).

For example, some calls need to assign different customers or applications to their own Unified CVP machines.

To configure Unified ICME to differentiate the VRUs, perform the following tasks:

- Configure more than one Network VRU.
- On Unified ICME, in the ICM Configuration Manager of the ICM Instance Explorer tool:
  - Configure one or multiple customers.
  - Configure the Network VRU for each customer if that customer wants to use in a Network VRU other than the default in future.
- Associate the dialed number(s) to the customer in the Dialed Number List tool.
• Since each configured VRU script is specific to one specified Network VRU, create a distinct set of VRU scripts for each Network VRU. Also, ensure that the ICM routing script calls the correct set of VRU scripts.

Configure ICM Settings for Call Director Call Flow Model

Procedure

Step 1
On the Unified CM server, CCMAdmin Publisher, perform the following SIP-specific action:

a) Add route patterns for outbound calls from the Unified CM devices using a SIP Trunk to the Unified CVP Call Server. Also, add a route pattern for error DN.

Select Call Routing > Route/Hunt > Route Pattern > Add New and add the following:

• Route Pattern: Specify the route pattern; for example: 3XXX for a TDM phone that dials 9+3xxx and all Unified ICME scripts are set up for 3xxx dialed numbers.

• Gateway/Route List: Select the SIP Trunk defined in the previous substep.

Note For warm transfers, the call from one agent to another does not typically use a SIP Trunk, but you must configure the CTI Route Point for that dialed number on the Unified CM server and associate that number with your peripheral gateway user (PGUSER) for the JTAPI gateway on the Unified CM peripheral gateway. An alternative is to use the Dialed Number Plan on Unified ICME to bypass the CTI Route Point.

Step 2
Configure the peripheral gateways for the switch leg.

On Unified ICME, ICM Configuration Manager, PG Explorer tool:

a) Configure each peripheral gateway (PG) to be used for the Switch leg. In the tree view pane, select the applicable peripheral gateway, and set the following:

1. On the Logical Controller tab:

   • Client Type: VRU

   • Name: A name descriptive of this PG

   For example: <location>_A for side A of a particular location

2. On the Peripheral tab:

   • Peripheral Name: A name descriptive of this Unified CVP peripheral

   For example: <location>_<cvp1> or <dns_name>

   • Client Type: VRU

   • Select the check box: Enable Post-routing

3. On the Routing Client tab:

   • Name: By convention, use the same name as the peripheral.
• Client Type: VRU

For more information, see the ICM Configuration Guide for Cisco ICM Enterprise Edition.

b) Configure a peripheral for each Unified CVP Call Server to be used for a Switch leg connected to each PG.

Step 3 Configure dialed numbers.

On the Unified ICME or Unified ICMH Server, in the ICM Configuration Manager, configure the following items:

a) Dialed Number List Tool tab: Configure the dialed numbers.
b) Call Type List tool tab: Configure the call types.
c) ICM Instance Explorer tool tab: Configure the applicable customers.

For more information, see the ICM Configuration Guide for Cisco ICM Enterprise Edition.

Step 4 Create a Routing Script.

On the Unified ICME or Unified ICMH Server in the ICM Script Editor tool:

Create a routing script that handles the incoming call. The routing script must execute a Label node or Select node (node that returns a label right away).

Note Do not use the Queue node in the routing script.

The label must be configured in the SIP Proxy Server to the IP address of the device that the label corresponds to. The Proxy Server is optional. If you do not have one, you must configure the Gateway dial-peer to point to the Call Server (refer to the first step in this process). Also, you must configure the destination labels in the SIP Service for the Call Server.

See the Scripting and Media Routing Guide for Cisco Unified ICM/Contact Center Enterprise & Hosted for more information.

Step 5 In the Operations Console, install and configure Call Servers.

a) Enable the ICM and SIP Services on the Call Server.

In the Operations Console, select Device Management > Unified CVP Call Server.

Select the check boxes: ICM and SIP

b) Configure the SIP Service:

Select Device Management > CVP Call Server > SIP tab.

• If you are using a SIP Proxy Server, enable the Outbound Proxy and select the SIP Proxy Server. If using a SIP Proxy Server, configure Local Static Routes on the SIP Proxy Server itself.

• If you are not using a SIP Proxy Server, configure Local Static Routes using the Dialed Number Pattern system configuration in the Operations Console. A local static route must be configured for each SIP gateway/ACD, SIP endpoint in order to receive calls.

• Check the default values for the SIP Service and change, if desired.

See the SIP Devices Configuration and SIP Dialed Number Pattern Matching Algorithm, on page 9 for detailed information.
c) Configure the ICM Service by setting the maximum length DNIS to the length of the Network Routing Number:

- Select Device Management > CVP Call Server > ICM tab.
- Set the Maximum Length of DNIS to length of the Network Routing Number.

Example: For the Gateway dial pattern as 1800******, the maximum DNIS length is 10.

For detailed information, see the Operations Console Online Help.

---

### Related Topics
- Set Up Ingress Gateway to Use Redundant Proxy Servers, on page 167
- Set Up Call Server with Redundant Proxy Servers, on page 167
- Local SRV File Configuration Example for SIP Messaging Redundancy, on page 168
- Load-Balancing SIP Calls, on page 168
- Cisco Unified SIP Proxy (CUSP) Configuration, on page 168
- Configure Custom Streaming Ringtones, on page 171
- SIP Dialed Number Pattern Matching Algorithm, on page 9

## Configure ICM Settings for VRU-Only Call Flow Model: Type 8

### Procedure

**Step 1** Perform Steps 1 to 4 of the Set Up Type 8 VRU-Only Call Flow Model for ICME and ICMH, on page 56 procedure.

**Step 2** Define a Network VRU on Unified ICME or (for Unified ICMH) on the NAM and each CICM.

Using the ICM Configuration Manager, the Network VRU Explorer tool, specify the following:

- Type: 8
- Name: cvpVRU

**Note** Although any name works, cvpVRU is used by convention, and is an example name referenced in this guide.

**Step 3** Configure the Peripheral Gates (PGs) on Unified ICME or (for Unified ICMH) on each CICM.

a) Configure each PG.

b) Configure a peripheral for each Unified CVP ICM Service connected to each PG.

Use the ICM Configuration Manager, the **PG Explorer** tool. For each Unified CVP ICM Service connected to this PG, in the tree view pane, select the applicable PG and configure the following items:

**Logical Controller** tab:

- Client Type: VRU
- Name: A name descriptive of this PG
Example: `<location>_A` for side A of a particular location

**Peripheral** tab:
- Peripheral Name: A name descriptive of this Unified CVP peripheral
  
  Examples: `<location>_<cvp1>` or `<dns_name>`
- Client Type: VRU
- Select the checkbox: **Enable Post-routing**

**Advanced** tab:
- From the Network VRU field drop-down list, select the name: `cvpVRU`

**Routing Client** tab:
- Name: By convention, use the same name as the peripheral.
- Client Type: VRU

---

**Step 4** Configure a Service and Route for each VRU on Unified ICME or (for Unified ICMH) on each CICM.

**Note** You can also use service arrays. See the Unified ICME documentation set for more information.

Using the ICM Configuration Manager, the **Service Explorer** tool, specify the following:
- Service Name: `cvpVRU`
- Route Name: `PeripheralName_cvpVRU`
- Peripheral Number: 2
  - Must match the "Pre-routed Call Service ID" in the Call Server configuration on the ICM tab in the Operations Console
- Select the **Enable Post-routing** checkbox.

---

**Step 5** Define trunk groups.

**Note** Configure one Network Transfer Group and one associated Trunk Group for each VRU leg Unified CVP ICM Service.

Define and configure the network trunk group on Unified ICME or (for Unified ICMH) on each CICM.

Using the ICM Configuration Manager, the Network **Trunk Group Explorer** tool:

a) Identify the network trunk group.
   - Network Trunk Group Name: A name descriptive of this trunk group

b) For each Unified CVP ICM Service for the VRU leg, configure an associated trunk group.
   - Peripheral Name: A name descriptive of this trunk group
   - Peripheral Number: 200
     - Must match the **Pre-routed Call Trunk Group ID** in the Call Server configuration on the ICM tab in the Operations Console
• Trunk Count: Select **Use Trunk Data** from the drop-down list

• Do not configure any trunks

**Step 6**

Define translation route(s).

Define and configure a Translation Route for each VRU Peripheral on Unified ICME or (for Unified ICMH) on each CICM.

On Unified ICME, ICM Configuration Manager, **Translation Route Explorer** tool:

a) Define a Translation Route for each VRU Peripheral. Specify the following:

*Translation Route* tab:

- Set the **Name** field to the name of the target VRU peripheral. (This is by convention; this value must be unique in the enterprise)

- Set the **Type** field to **DNIS** and select the Service defined in the previous step

b) Configure translation route and label information for each VRU peripheral. Complete the following:

*Route* tab:

- Set the **Name**: by convention, this is the name of the target VRU peripheral, followed by the DNIS that this route will use, for example, MyVRU_2000

  This value must be unique in the enterprise

- Service Name drop-down list, select: **PeripheralName.cvpVRU**

*Peripheral Target* tab:

- Enter the first DNIS that will be seen by the VRU that you will be using for this translation route.

  **Note** The DNIS pool used for each VRU peripheral must be unique

- From the drop-down list, select a **Network Trunk Group** which belongs to the target VRU

*Label* tab:

- Enter the translation route label (which might or might not be the same DNIS you entered on the Peripheral Target tab)

- **Type**: Normal

- Routing Client: Select the NIC Routing Client

  **Note**

  - You must create an additional label for each NIC routing client.
  - Repeat the Route and corresponding Peripheral Target and Label information for each DNIS in the pool.

**Step 7**

Create VRU and routing scripts.

Create VRU scripts and routing scripts for IVR treatment and agent transfer on Unified ICME or (for Unified ICMH) on each CICM.
Using the ICM Script Editor tool, create the VRU scripts and routing scripts to be used for IVR treatment and agent transfer, as described in other sections of this manual and in the ICM manuals.

The VRU scripts are associated with the applicable Network VRU.

For example, cvpVRU

Use the ICM Script Editor’s TranslationRouteToVRU node to connect the call to the Network VRU.

Step 8
Configure the ECC variables on Unified ICME or (for Unified ICMH) on the NAM and each CICM.

Using the ICM Configuration Manager, create the ECC variables.

For more information, see Define Unified CVP ECC Variables, on page 141.

Step 9
Configure dialed numbers and call types on Unified ICME or (for Unified ICMH) on the NAM and each CICM.

On Unified ICME, using the ICM Configuration Manager, configure dialed numbers and call types.

For more information, see ICM Configuration Guide for Cisco ICM Enterprise Edition.

Step 10
On Unified CM, configure Unified CM.

For more information, see the Unified CM user documentation.

Step 11
Install and configure the Call Servers.

Log in to the Operations Console, select Device Management > CVP Call Server and install and configure the Call Servers.

Check the ICM and IVR check boxes.

For detailed information, see the Operations Console online help.

Step 12
Configure the ICM service.

On the Operations Console, select Device Management > CVP Call Server > ICM tab. On each Unified CVP Call Server, configure the ICM Service by specifying the following required information:

a) VRU connection port number.

Set the VRU Connection Port to match the VRU connection Port defined in ICM Setup for the corresponding VRU peripheral gateway (PIM).

b) Maximum Length of DNIS.

Set the maximum length DNIS to a number which is at least the length of the translation route DNIS numbers.

Example: if the Gateway dial pattern is 1800******, the maximum DNIS length is 10.

c) Call service IDs: New Call and Pre-routed.

Enter the new and pre-routed call service IDs. Configure the ports for both groups according to the licenses purchased, call profiles, and capacity by completing the required fields on this tab.

d) Trunk group IDs: New Call and Pre-routed.

• Enter the new and pre-routed call trunk group IDs

• Configure the group number for the Pre-routed Call Trunk group. The group number must match the trunk group number in the Network Trunk group used for the translation route
• Configure the number of ports according to the licenses purchased and capacity

• Configure each of the numbers used for translation routes. (The “New Call” group is not used since the calls are being sent to the VRU (Unified CVP) after some initial processing by the NIC/Unified ICME)

e) Dialed numbers used in the translation route.
   Add the dialed numbers in the DNIS field.

f) Check the default values of the other settings and change, if desired.

**Step 13**
Configure the IVR Service.

On the Operations Console, select Device Management > CVP Call Server > IVR tab.
Check the default values and change, if desired.
Refer to the Operations Console online help for information about other settings you might want to adjust from their default values.

**Step 14**
(Optional) Configure the Reporting Server.

In the Operations Console, select Device Management > CVP Reporting Server > General tab:

1. Configure the Reporting Server.

2. Select a Call Server to associate with this Reporting Server.

3. Check the default values of the Reporting properties and change, if desired.

For more information, see Reporting Guide for Cisco Unified Customer Voice Portal

---

**VoiceXML Gateway Configuration Examples**

**Example Gateway Settings for Type 8 Call Flow Model**

The first part of the following example provides the basic configuration for setting a VoiceXML gateway:

• Applies a timestamp to debugging and log messages
• Turns on logging
• Turns off printing to the command line interface console
• Sends RTP packets
• Configures ASR/TTS Server
• Configures gateway settings

The last part of this example provides the following:

• Initiates the VoiceXML leg
• Plays a .wav file that enables caller to hear message from critical_error.wav
• Logs errors on the gateway when the call fails
Example of Dial-peer for ICM VRU Label for Type 8 Call Flow Model

The following example provides the configuration for an ICM VRU label dial-peer for the Type8 Unified CVP VRU-Only call flow model:

dial-peer voice 777 voip
description ICM VRU label
service bootstrap
voice-class codec 1
incoming called-number <your sendtovru label pattern here>
dtmf-relay rtp-nte
no vad
!

Related Topics
Set Up Type 8 VRU-Only Call Flow Model for ICME and ICMH, on page 56
Define Unified CVP ECC Variables, on page 141
Configure ICM Settings for VRU-Only Call Flow Model: Type 7

Procedure

Step 1  Perform Steps 1 to 4 of the Set Up Type 8 VRU-Only Call Flow Model for ICME and ICMH, on page 56 procedure.

Step 2  Configure each PG.

On the NAM, ICM Configuration Manager, PG Explorer tool:

a) Configure each PG to be used for the VRU Client leg.

b) Configure a peripheral for each Unified CVP ICM Service to be used as a VRU leg connected to each PG.

For each Unified CVP ICM Service connected to this PG, in the tree view pane, select the applicable PG.

Logical Controller tab, configure:

- Client Type: VRU
- Name: A name descriptive of this PG
  For example: \(<location>_A\) for side A of a particular location

Peripheral tab, configure:

- Peripheral Name: A name descriptive of this VRU peripheral.
  For example: \(<location>_cvp1\) or \(<dns_name>\)
- Client Type: VRU
- Select the checkbox: Enable Post-routing

Routing Client tab:

- Name: By convention, use the same name as the peripheral.
- Client Type: VRU

Step 3  Define a Network VRU and labels.

On the CICM, ICM Configuration Manager, Network VRU Explorer tool, define a Network VRU for the VRU leg and labels for reaching the NAM.

Specify the following:

- Type: 7
- Name: cvpVRU

Note  This name is used by convention. Although any name will do, since it is referenced elsewhere in this document, cvpVRU is assumed.

- Define a Label for the NAM.
• Label: Network routing number
• Type: Normal
• Routing client: Select the INCRP Routing Client from the drop-down list.

**Step 4** Define a Network VRU and a label for each NIC.

On the NAM, ICM Configuration Manager, Network VRU Explorer tool, define a Network VRU and a label for each NIC that is using this VRU.

Specify the following:
- Type: 7
- Name: cvpVRU

  **Note** This name is used by convention. Although any name will work, since it is referenced elsewhere in this document, cvpVRU is assumed.

- Define a Label for each NIC that is using this VRU:
  - Label: Network routing number
  - Type: Normal
  - Routing client: Select the Routing Client for that NIC from the drop-down list.

  **Note** Ensure the Network VRU label is identical in the NAM and CICM. The Network VRU Name must be same to avoid confusion.

**Step 5** If there are Routing Scripts on the NAM, define a default Network VRU.

On the NAM, ICM Configuration Manager, System Information tool, in the General section:
- Define the Default Network VRU: cvpVRU

**Step 6** Define a default VRU.

On the CICM, ICM Configuration Manager, System Information tool, in the General section:
- Define a default Network VRU: cvpVRU

**Step 7** Create the VRU and routing scripts.

On the CICM, ICM Script Editor tool:
Create the VRU scripts and routing scripts to be used for IVR treatment and agent transfer, as described in other sections of this manual and in the Unified ICME manuals. The VRU scripts are associated with the applicable Network VRU, that is, cvpVRU.

Use the ICM Script Editor’s SendToVRU node to connect the call to the Network VRU.

  **Note** A RunVRU Script or Queue node is an implicit SendToVRU node, although error handling will be easier if the explicit SendToVRU node is used.

**Step 8** Configure the ECC variables.

On the NAM and CICM, ICM Configuration Manager, configure the ECC variables.
For more information, see Define Unified CVP ECC Variables, on page 141.

**Step 9**  
Configure dialed numbers and call types.  
On the NAM and CICM, ICM Configuration Manager, configure dialed numbers and call types.  
For more information, see ICM Configuration Guide for Cisco ICM Enterprise Edition

**Step 10**  
Define customers.  
On the NAM and CICM, ICM Configuration Manager:  
   a) If necessary, differentiate VRUs (Unified CVPs) based on dialed number.  
   b) Define customers and their Network VRU.  
For more information, see Common Configuration for Differentiating VRUs Based on Dialed Number, on page 148.

**Step 11**  
On Cisco Unified CM, configure Unified CM.  
For more information, see the Unified CM user documentation.

**Step 12**  
Install and configure the Call Server.  
In the Operations Console, select Device Management > CVP Call Server.  
   a) Install and configure the Call Server.  
   b) To enable the ICM and IVR Services on the Call Server, select the ICM and IVR check boxes.

**Step 13**  
Configure the ICM Service for each Call Server.  
In the Operations Console, select Device Management > CVP Call Server > ICM tab. For each Unified CVP Call Server, configure the ICM Service by specifying the following required information:  
   a) VRU connection port number.  
      Set the VRU Connection Port to match the VRU connection Port defined in ICM Setup for the corresponding VRU peripheral gateway (PIM).  
   b) Set the maximum length DNIS to the length of the Network Routing Number.  
      Example: if the Gateway dial pattern is 1800******, the maximum DNIS length is 10.  
   c) Call service IDs: New Call and Pre-routed.  
      Enter the new and pre-routed call service IDs. Configure the ports for both groups according to the licenses purchased, call profiles, and capacity by completing the required fields on this tab  
   d) Trunk group IDs: New Call and Pre-routed.  
      Enter the new and pre-routed call trunk group IDs. Configure the group number for the Pre-routed Call Trunk group. The group number must match the trunk group number in the Network Trunk group used for the translation route.  
      Configure the number of ports according to the licenses purchased and capacity. Configure each of the numbers used for translation routes. (The New Call group is not used because the calls are sent to the VRU (Unified CVP) after an initial processing by the NIC/Unified ICME).  
   e) Check the default values of other settings and change, if desired.

**Step 14**  
Configure the IVR service.
In the Operations Console, select **Device Management** > **CVP Call Server** > **IVR** and configure the IVR Service.

Check the default values and change, if desired.

See the Operations Console online help for information about settings.

**Step 15**

(Optional) Configure the Reporting Server.

On the Operations Console, select **Device Management** > **CVP Reporting Server** > **General** and configure the Reporting Server.

a) Configure the Reporting Server.
b) Select a Call Server to associate with this Reporting Server.
c) Check the default values of the Reporting properties and change, if desired.


**Related Topics**

- Set Up Type 8 VRU-Only Call Flow Model for ICME and ICMH, on page 56
- Define Unified CVP ECC Variables, on page 141
- Common Configuration for Differentiating VRUs Based on Dialed Number, on page 148

**Pass Data to Unified ICME**

In the Unified CVP VXML Server (standalone) with ICM Lookup call flow model, Unified ICME sends a label to Unified CVP. This process requires the following configuration:

The Standalone with Request ICM Label variation of the Standalone call flow model performs a route request to Unified ICME, and then Unified ICME starts a script (new call). Unified ICME sees whatever the device puts in the new call message, then Unified ICME chooses a target, such as an agent, and sends a label back to the device. That route request to Unified ICME sends other information, such as ECC variables. Unified ICME can pass other ECC variables to Unified CVP. Also, you need to configure a Unified CVP VXML Server in the Unified CVP Call Server for the call flow model.

**Configure the Connections**

The following procedure describes how to set up a VXML Server that connects to a Call Server through the ICM Service, and the connection from the ICM Service to the peripheral gateway.

**Note**

The VRU PIM initiates the connection from the PG to the Call Server. The ICM Service listens for a connection from the VRU PIM.
Procedure

Step 1 Start the VXML Server. The VXML Server starts the VoiceXML Service using the DataFeed mechanism or the ReqICMLabelelement.

The ReqICMLabelelement allows a Call Studio script to pass caller input, call variables, and External Call Context (ECC) variables to a Unified ICME script. The ReqICMLabelelement must be inserted into a Call Studio script as a decision element. In Call Studio, the returned Unified ICME label contains a result which can be used by other elements in the same application, such as the Transfer or Audio element. The Transfer element sends instructions to the IOS Voice Browser to transfer the caller to the desired location.

After the VoiceXML Service starts, it starts communicating with the ICM Service.

Step 2 Log in to the Operations Console and configure a Call Server and ICM service. See Configure Call Server, on page 77. See the Unified ICME documentation for instructions on configuring the VRU PIM to connect to a VRU. For example, Unified CVP.

Related Topics
Configure Call Server, on page 77

Configure a Gateway for IP to TDM Calls

The following components are required for the gateway to process IP to TDM calls:

- Phones and numbers must be configured on the TDM switch.
- Gateway must be defined on Unified CM.
- Route pattern on the Unified CM that sends the call to the gateway.
- Dial peer on the gateway that sends calls that must be configured.
- Dial 88880605x on the IP phone (this is a specific physical phone extension).

Procedure

Step 1 Configure the gateway to send the call to a particular Unified CVP VXML Server application, as follows:

dial-peer voice 8888 voip
service [gateway application name]
incoming called-number 888800....
dtmf-relay rtp-nte
codec g711ulaw
no vad

Step 2 To match the number in the Unified CVP VXML Server transfer node and send it out the T1 port to the G3 to its destination, use the following configuration:

dial-peer voice 8880 pots
destination-pattern 888800....
incoming called-number
Configure a Cisco Multiservice IP-to-IP Gateway for Unified CM Connections

For information on configuring the Cisco IOS gateway for Unified CM connections, see the Cisco Multiservice IP-to-IP Gateway Software documentation.

Configure SNMP Monitoring for the Unified CVP VXML Server

When a Call Studio application is created, the simple network management protocol (SNMP) monitoring for the VXML Server is provided. CVPSNMPLogger is enabled when a new Call Studio application is created and deployed to the Unified CVP VXML Server. CVPSNMPLogger logs error events received from the VXML Server. For example, using this process you can configure to send a page to a technical support representative when a particular error alert is triggered on the customer site.

Procedure

<table>
<thead>
<tr>
<th>Step 1</th>
<th>To view CVPSNMPLogger for the Unified CVP VXML Server, access the Call Studio interface.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Step 2</td>
<td>From Call Studio for each Call Studio application, right-click the application and select Properties &gt; Cisco Unified CVP &gt; General Settings. CVPSNMPLogger appears in the Loggers drop-down box.</td>
</tr>
</tbody>
</table>

Caution

Do not remove CVPSNMPLogger because doing so disables viewing of SNMP events and alerts.
## Unified Communications Manager Configuration

- Configure Unified Communications Manager Server, on page 163
- Unified CM Settings, on page 164

### Configure Unified Communications Manager Server

**Procedure**

<table>
<thead>
<tr>
<th>Step 1</th>
<th>From the Operations Console, select <strong>Device Management &gt; Unified CM</strong>.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Step 2</td>
<td>Click <strong>Add New</strong> to add a new Unified CM or click <strong>Use As Template</strong> to use an existing template to configure the new Unified CM.</td>
</tr>
</tbody>
</table>
| Step 3 | Click the following tabs and configure the settings based on your call flow model:  
  a) **General** tab. For more information, see General Settings, on page 164.  
  b) **Device Pool** tab. For more information about adding, deleting, and editing a device pool, see Add or Remove Device From Device Pool, on page 98.  
  **Note** Enable Cisco AXL Web Service on the Unified CM for the synchronization to work. |
| Step 4 | To enable Cisco AXL Web Service on the Unified CM, perform the following steps:  
  a) Log on to Unified CM.  
  b) Open the Cisco Unified Serviceability dashboard and select **Tools > Service Activation**.  
  c) In the drop down menu, select the Unified CM server that is configured in this Operations Console, and click **Go**.  
  d) In the Database and Admin Services section, check the box next to Cisco AXL Web Service. |
| Step 5 | Click **Save**. |
# Unified CM Settings

## General Settings

### Table 27: Unified CM Server—General Tab Settings

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
<th>Default</th>
<th>Value</th>
<th>Restart Required</th>
</tr>
</thead>
<tbody>
<tr>
<td>IP Address</td>
<td>The IP address of the Unified CM Server</td>
<td>None</td>
<td>Valid IP address</td>
<td>No</td>
</tr>
<tr>
<td>Hostname</td>
<td>The name of the Unified CM Server</td>
<td>None</td>
<td>Valid DNS names, includes letters in the alphabet, the numbers 0 through 9, and a dash.</td>
<td>No</td>
</tr>
<tr>
<td>Description</td>
<td>The description of the Unified CM Server</td>
<td>None</td>
<td>Any text</td>
<td>No</td>
</tr>
<tr>
<td>Device Admin URL</td>
<td>The Administration URL for the Unified CM Server</td>
<td>None</td>
<td>A valid URL. The Operations Console validates the URL for syntax errors but does no validation for the existence of the URL.</td>
<td>No</td>
</tr>
</tbody>
</table>

### Enable Synchronization

<table>
<thead>
<tr>
<th>Enable synchronization</th>
<th>Select to enable synchronization for location. If enabled, the Operations Console extracts or synchronizes the Unified CM location information from the Unified CM server.</th>
<th>Disabled When you enable this service, the default value of the Port is 8443.</th>
<th>Enabled or Disabled</th>
<th>No</th>
</tr>
</thead>
<tbody>
<tr>
<td>Username</td>
<td>User name to access the Unified CM AXL interface.</td>
<td>None</td>
<td>Valid Unified CM AXL username.</td>
<td>No</td>
</tr>
<tr>
<td>Password</td>
<td>Password to access the Unified CM AXL interface.</td>
<td>None</td>
<td>Valid Unified CM AXL password.</td>
<td>No</td>
</tr>
<tr>
<td>Confirm Password</td>
<td>Retype the password to verify that you typed the password correctly.</td>
<td>None</td>
<td>Text must match the text entered in the Password field</td>
<td>No</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
<td>Default</td>
<td>Value</td>
<td>Restart Required</td>
</tr>
<tr>
<td>---------</td>
<td>-----------------------------------------------------------------------------</td>
<td>---------</td>
<td>------------------</td>
<td>------------------</td>
</tr>
<tr>
<td>Port</td>
<td>The port to which the Unified CM server connects while establishing initial contact.</td>
<td>8443</td>
<td>1 through 65,535</td>
<td>No</td>
</tr>
</tbody>
</table>
CHAPTER 9

SIP Devices Configuration

- Set Up Ingress Gateway to Use Redundant Proxy Servers, on page 167
- Set Up Call Server with Redundant Proxy Servers, on page 167
- Local SRV File Configuration Example for SIP Messaging Redundancy, on page 168
- Load-Balancing SIP Calls, on page 168
- Cisco Unified SIP Proxy (CUSP) Configuration, on page 168
- Configure Custom Streaming Ringtones, on page 171

Set Up Ingress Gateway to Use Redundant Proxy Servers

Configure the gateway with the following code to send calls to redundant proxy servers as resolved using DNS SRV lookup:

```
ip domain name <your domain name>
ip name-server <your DNS server>
sip-ua
sip-server dns:<your SRV cluster domain name>
dial-peer voice 1000 voip
session target sip-server
```

Set Up Call Server with Redundant Proxy Servers

Use redundant proxy servers for Unified CVP outbound calls by using a DNS-based SRV cluster name or a non-DNS SRV cluster name (also known as Server Group Name).

Local SRV File Configuration Example for SIP Messaging Redundancy

Load-Balancing SIP Calls

SIP calls can be load balanced across destinations in several different ways as outlined below:

- Using the CUSP server, define several static routes with the same route pattern, priorities, and weights.
- Using DNS, configure SRV records with priorities and weights. Both the DNS client and the server settings must be configured and operating successfully for DNS "A" and "SRV" type queries to work. Configure SRV queries to be used wherever outbound SIP calls are made, such as on the IOS Ingress gateway, on the Call Server itself, and on Unified CM.

Note

Refer to DNS Zone File Configuration for Comprehensive Call Flow Model, on page 30 for information about load balancing and failover without a Proxy Server. Only the DNS SRV method is supported for load balancing and failover without a Proxy Server.

Related Topics

DNS Zone File Configuration for Comprehensive Call Flow Model, on page 30

Cisco Unified SIP Proxy (CUSP) Configuration

The following configuration shows a CUSP proxy in Unified CVP. The highlighted lines are specific to a Unified CVP solution. For additional configuration details, refer to the Configuring Cisco Unified SIP Proxy Server guide.

Configuration Example:

```
server-group sip global-load-balance call-id
  server-group sip retry-after 0
  server-group sip element-retries udp 1
  server-group sip element-retries tls 1
  server-group sip element-retries tcp 1
  sip dns-srv
  no enable
  no naptr
  end dns

! no sip header-compaction
no sip logging

! sip max-forwards 70
sip network netA noicmp
non-invite-provisional 200
allow-connections
retransmit-count invite-server-transaction 9
retransmit-count non-invite-client-transaction 9
```
retransmit-count invite-client-transaction 2
retransmit-timer T4 5000
retransmit-timer T2 4000
retransmit-timer T1 500
retransmit-timer TU2 32000
retransmit-timer TU1 5000
retransmit-timer clientTn 64000
retransmit-timer serverTn 64000
end network
!
no sip peg-counting
!
sip privacy service
sip queue message
drop-policy head
low-threshold 80
size 2000
thread-count 20
end queue
!
sip queue radius
drop-policy head
low-threshold 80
size 2000
thread-count 20
end queue
!
sip queue request
drop-policy head
low-threshold 80
size 2000
thread-count 20
end queue
!
sip queue response
drop-policy head
low-threshold 80
size 2000
thread-count 20
end queue
!
sip queue st-callback
drop-policy head
low-threshold 80
size 2000
thread-count 10
end queue
!
sip queue timer
drop-policy none
low-threshold 80
size 2500
thread-count 8
end queue
!
sip queue xcl
drop-policy head
low-threshold 80
size 2000
thread-count 2
end queue
!
routerecursion
!
sip tcp connection-timeout 240
sip tcp max-connections 256
!
no sip tls
!
trigger condition in-netA
sequence 1
  in-network netA
  end sequence
end trigger condition
!
trigger condition mid-dialog
sequence 1
  mid-dialog
  end sequence
end trigger condition
!
trigger condition out-netA
sequence 1
  out-network netA
  end sequence
end trigger condition
!
accounting
no enable
no client-side
no server-side
end accounting
!
server-group sip group cucm-cluster.cisco.com netA
  element ip-address 10.86.129.219 5060 udp q-value 1.0 weight 10
  element ip-address 10.86.129.62 5060 udp q-value 1.0 weight 10
  element ip-address 10.86.129.63 5060 udp q-value 1.0 weight 10
  failover-resp-codes 503
  lbtype global
  ping
end server-group
!
server-group sip group cvp-call-servers.cisco.com netA
  element ip-address 10.86.129.220 5060 udp q-value 1.0 weight 10
  element ip-address 10.86.129.224 5060 udp q-value 0.9 weight 10
  failover-resp-codes 503
  lbtype global
  ping
end server-group
!
server-group sip group vxml-gws.cisco.com netA
  element ip-address 10.86.129.229 5060 udp q-value 1.0 weight 10
  element ip-address 10.86.129.228 5060 udp q-value 1.0 weight 10
  failover-resp-codes 503
  lbtype global
  ping
end server-group
!
route table cvp-route-table
  key 9 target-destination vxml-gws.cisco.com netA
  key 8 target-destination cvp-call-servers.cisco.com netA
  key 7 target-destination vxm-gws.cisco.com netA
  key 700699 target-destination cvp-call-servers.cisco.com netA
  key 2 target-destination cucm-cluster.cisco.com netA
  key 1 target-destination cucm-cluster.cisco.com netA
  key 7000 target-destination 172.19.151.41 netA
  key 777333 target-destination cvp-call-servers.cisco.com netA
  key 1004 target-destination 10.86.139.84 netA
Configure Custom Streaming Ringtones

You can configure custom ringtone patterns that enable you to play an audio stream to a caller in place of the usual ringtone. Customized streaming ringtones are based on the dialed number destination and, when configured, play an in-progress broadcast stream to the caller while the call is transferred to an agent.

Procedure

Step 1
Configure Helix for streaming audio.

The default installation and configuration of the Helix server is all that is required for use with Unified CVP. See the Helix Server Administration Guide for information about installing and configuring the Helix Server.

Step 2
In the Operations Console, perform the following steps to configure custom streaming ringtones:

a) Select System > Dialed Number Pattern.
b) Click Add New.
c) Complete the following fields to associate a dialed number pattern with a custom ringtone.

Table 28: Dialed Number Pattern Configuration Settings

<table>
<thead>
<tr>
<th>Property</th>
<th>Description</th>
<th>Default</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>General Configuration</td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>
### Configure Custom Streaming Ringtones

<table>
<thead>
<tr>
<th>Property</th>
<th>Description</th>
<th>Default</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Dialed Number Pattern</td>
<td>The actual Dialed Number Pattern.</td>
<td>None</td>
<td>Must be unique Maximum length of 24 characters Can contain alphanumeric characters, wildcard characters such as exclamation point (!) or asterisk (*), single digit matches such as the letter X or period (.) Can end with an optional greater than (&gt;) wildcard character</td>
</tr>
<tr>
<td>Description</td>
<td>Information about the Dialed Number Pattern.</td>
<td>None</td>
<td>Maximum length of 1024 characters</td>
</tr>
<tr>
<td>Enable Custom Ringtone</td>
<td>Enables customized ring tone.</td>
<td>Disabled</td>
<td>Maximum length of 256 characters Cannot contain whitespace characters</td>
</tr>
<tr>
<td></td>
<td><strong>Ringtone media filename</strong> - Enter the name of the file that is to be played for the respective dialed number pattern. Provide the URL for the stream name in the following format: rtsp://&lt;streaming server IP address&gt;::&lt;port&gt;/&lt;directory&gt;/&lt;filename&gt;.rm</td>
<td>none</td>
<td></td>
</tr>
</tbody>
</table>

**d)** Click **Save** to save the Dialed Number Pattern.

You are returned to the **Dialed Number Pattern** page. To deploy the Dialed Number Pattern configuration, click **Deploy** to deploy the configuration to all Unified CVP Call Server devices.

**e)** Access the IOS device in global configuration mode and add the following commands on your VXML Gateway:

```
rtsp client timeout 10
rtsp message timeout 10
```
The range is 1 to 20; the recommended value is 10 seconds.

**Step 3**
Add a Send to VRU node in your ICM script before any Queue node.
The explicit Send to VRU node is used to establish the VRU leg before the transfer to the agent; this is required to play streaming audio ringtones to a caller.
Configure Custom Streaming Ringtones
**Configure Media Server**

**Procedure**

**Step 1**  
From the Unified CVP Operations Console, select Device Management > Media Server.

**Step 2**  
Click Add New to add a new Media Server or click Use As Template to use an existing template to configure the new Media Server.

**Step 3**  
Click the following tabs and configure the settings based on your call flow:

- a) General tab. For more information, see General Settings, on page 176.
- b) Device Pool tab. For more information about adding, deleting and editing device pool, see Add or Remove Device From Device Pool, on page 98.

**Step 4**  
Click Save.

**What to do next**

All the configured Media Servers appear in the Default Media Server drop-down box. To set the default Media Server, select one of the listed Media Servers from the Default Media Server drop-down box, and click Set.

**Related Topics**

- General Settings, on page 176
- Add or Remove Device From Device Pool, on page 98
# Media Server Settings

## General Settings

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
<th>Default</th>
<th>Value</th>
<th>Restart Required</th>
</tr>
</thead>
<tbody>
<tr>
<td>IP Address</td>
<td>The IP address of Media Server</td>
<td>None</td>
<td>Valid IP address.</td>
<td>No</td>
</tr>
<tr>
<td>Hostname</td>
<td>The name of the Media Server</td>
<td>None</td>
<td>Follow naming conventions for hostnames.</td>
<td>No</td>
</tr>
<tr>
<td>Description</td>
<td>The description of the Media Server</td>
<td>None</td>
<td>Up to 1,024 characters.</td>
<td>No</td>
</tr>
<tr>
<td>FTP Enabled</td>
<td>Indicates whether a Media Server has FTP enabled. A Media Server, which has FTP enabled, is automatically populated as a session variable to the VXML Server. The default agent greeting recording application automatically uses the Media Servers defined in the Operations Console that have FTP enabled for the agent greeting recording. If Microsoft FTP Service is not enabled in Windows Services Control Panel, then set it to Automatic and start the service.</td>
<td>Disabled</td>
<td>Select the check box to enable this feature.</td>
<td>No Use <a href="#">Test Sign-in</a> button to verify the FTP credentials.</td>
</tr>
</tbody>
</table>

---

[176]: Configuration Guide for Cisco Unified Customer Voice Portal, Release 11.6(1)
### Media File Names and Types

A **media file name** is specified through Unified ICME Network VRU Script Configuration and used in the Run VRU Script request for the Play Media, Play Data, Get Digits, Menu, and Get Speech (in non-TTS applications) micro-applications. The media file naming convention allows alpha-numeric characters with the underbar character as a separator. (Spaces or hyphens are not allowed.) This naming convention provides a mechanism for an “understandable” naming convention as opposed to numeric media file names typically used by stand-alone VRUs.

**Caution**

The Unified Customer Voice Portal includes a library of media files/prompts for individual digits, months (referenced internally by Unified Customer Voice Portal software for a Play Data script type request), default error messages, and so on. **Creation of a full set of media/prompts for each locale referenced by the Unified CVP customer is the responsibility of the customer’s Media Administrator.**

The **media file types** Unified CVP supports are μ-Law 8-bit .wav files and A-law 8-bit .wav files. Media files specified with an extension are used “as is,” for example, hello.xxx. (The default file extension is .wav.)

**Caution**

Any unexpected (and unsupported) type of media file encountered generates the logging of an error and a result code of False is returned to Unified ICME along with the ECC **user.microapp.error_code** set appropriately. From the caller’s perspective, nothing was played, however it is the Script Editor developer’s responsibility to write the script to handle this error condition.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
<th>Default</th>
<th>Value</th>
<th>Restart Required</th>
</tr>
</thead>
<tbody>
<tr>
<td>Anonymous Access</td>
<td>Indicates that this Media Server uses anonymous FTP access. In this case, the username is specified by default as anonymous. The password field is not specified for anonymous access. The user can specify the port number or select the default port number (21).</td>
<td>Disabled</td>
<td>Select the check box to enable this feature. You must enable FTP to enable Anonymous Access.</td>
<td>No Use Test Sign-in button to verify the FTP credentials.</td>
</tr>
<tr>
<td>Username and Password</td>
<td>These fields apply if FTP is enabled and <strong>Anonymous Access</strong> is disabled. In this case, enter the username and password.</td>
<td>None</td>
<td>A valid username and password.</td>
<td>No Use Test Sign-in button to verify the FTP credentials.</td>
</tr>
<tr>
<td>Port</td>
<td>Enter a new port number or use the default port number (21).</td>
<td>21</td>
<td>Valid ports 1 to 65,535.</td>
<td>No Use Test Sign-in button to verify the FTP credentials.</td>
</tr>
</tbody>
</table>
Location of Media Files

The following figure displays the location of the media files if you choose to install System Media Files during Unified CVP installation.

Figure 13: Location of Media Files

Media File Address

The address for media files that reside on the Media Server(s) is generated by the Unified CVP. Unified ICME provides information about the file location or base URL address in the Unified ICME/IVR messages it passes when the Run VRU Script node is executed. The Unified ICME/IVR messages include ECC variables for: locale, media server set address, as well as optional system and application library name overrides. (For details about the Unified ICME/IVR messages passed to Unified CVP, see Feature Guide - Writing Scripts for Unified Customer Voice Portal.

The table below summarizes the data that combines to form the address of the media file:
### Table 30: Media File Address Components

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Location of Data</th>
<th>Description</th>
<th>Examples</th>
</tr>
</thead>
<tbody>
<tr>
<td>Media Server Set</td>
<td>ECC variable: user.microapp.media_server</td>
<td>File location or base URL for the Media Server. When the Media Server URL is the DNS name and the DNS Server is configured to return multiple IP addresses for a host name, the Unified CVP attempts to get the media files from each Media Server IP address in sequence with the priority given to those on the subnet.</td>
<td>Base URL example: <a href="http://www.machine1.com/dir1/dirs/cust1">http://www.machine1.com/dir1/dirs/cust1</a></td>
</tr>
<tr>
<td></td>
<td></td>
<td>Note Unified CVP supports playing prompts from flash on the GW. To play these prompts, set the media_server to &quot;flash:&quot; instead of the hostname or IP address of the media server.</td>
<td>Note By convention, the service provider may include their customer names at the end of the Media Server set.</td>
</tr>
<tr>
<td>Locale</td>
<td>ECC variable: user.microapp.locale</td>
<td>This field is a combination of language and country with a default of en-us for English spoken in the United States.</td>
<td>en-us</td>
</tr>
<tr>
<td><strong>Default</strong></td>
<td>en-us</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>
The Unified CVP supports the following locales: **en-us** (English, United States) and **en-gb** (English, United Kingdom), **es-es** (Spanish, Spain), and **es-mx** (Spanish, Mexico). The locale defines the grammar of a Play Data script type. If a date is to be played with a locale of **en-gb** (English, United Kingdom), the date would be played in the order of day, month, then year; for **en-us**, it is month, day, year.

### Media Library Type

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Location of Data</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Note</td>
<td>The Media Library Type value passed from the VRU Script Name field. Valid options are:</td>
<td>The media library (directory) for the prompt is either the application prompt library defined by ECC variable user.microapp.app_media_lib (default “app”) or the system prompt library defined by ECC variable user.microapp.sys_media_lib (default “sys”).</td>
</tr>
<tr>
<td></td>
<td>A - Application prompt library.</td>
<td></td>
</tr>
<tr>
<td></td>
<td>S - System prompt library.</td>
<td></td>
</tr>
<tr>
<td></td>
<td>V - External VXML.</td>
<td></td>
</tr>
<tr>
<td>Default: A</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

**Note** When the Media Library Type is **V** (external VXML), the VXML file will reside in the Application Prompt Library.

**Note** When the Media Library Type is **A** (Application prompt library), you must create the directory specified by this variable. For example, if you use the default “app” directory, you must create an app directory in `./wwwroot/en-us`.

**Examples**

A (user.microapp.app_media_lib=app_banking)
### Locale Backward Compatibility

The locale string values are compatible with current industry naming schemes:

- **en_US** has changed to **en-us**, which means that "en underscore US" (upper case) has changed to "en hyphen us" (lower case).

- **en_GB** has changed to **en-gb**, which means that "en underscore GB" (upper case) has changed to "en hyphen gb" (lower case).

Existing scripts from previous versions of Unified CVP will continue to work with the current version of Unified CVP:

- **en_US** and **en-us** both map to U.S. English in the Application Server for use by the Application Server’s internal grammar

- **en_GB** and **en-gb** both map to U.K. English in the Application Server for use by the Application Server’s internal grammar.

---

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Location of Data</th>
<th>Description</th>
<th>Examples</th>
</tr>
</thead>
<tbody>
<tr>
<td>Media File Name</td>
<td>The Media File Name value passed from the VRU Script Name field. Valid options</td>
<td>Name of media file or external VXML file to be played.</td>
<td>Main_menu</td>
</tr>
<tr>
<td></td>
<td>are the name of the .wav file to be played, or external VXML file name, or &lt;blank&gt;, which translates to playing no media. This file name is ignored if TTS is being used (that is, if the user.microapp.inline_tts ECC variable contains a value.)</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Default:</td>
<td>none</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Note</td>
<td>There are four possible reasons for using &lt;blank&gt; as the Media File Name: (1) For Get Digits, a prompt may not be necessary, (2) the customer may want to have a “placeholder” in the script for playing a prompt which may or may not be there (for example, an emergency conditions message), (3) change the value of barge-in to indicate a buffer flush, and (4) TTS is being used and this field is ignored.</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

Based on the examples shown in the table above, a valid address for the Media File might be: http://www.machine1.com/dirl/dirs/cust1/en-us/app_banking/main_menu.wav
• The base URL for media prompts uses the locale that is specified, without making modifications. For example, if the locale is set to EN_US, the base URL contains EN_US. If the locale is set to XX, the base URL contains XX.

To use the Unified CVP Version 1.1 default locale directory (for example, en_US), you must explicitly set it. When you upgrade to the current version of Unified CVP, only the new files are installed under the Unified CVP default locale directory, en-us. You want to have all your system prompts under one directory and all your application prompts and, optionally, external VXML in another directory. Use the user.microapp.locale ECC variable to set the locale directory to use, such as en_US.

**Note**
Do not set the user.microapp.locale ECC variable if you used the default en-us. Also, remember that all locale values are case-sensitive.

### System Media Files

The following tables describe the English System Media Files installed by Unified CVP. These system media files are intended as samples only. It is the Customer/Media Administrator’s responsibility to record all the system prompts for all the locales.

The table that follows lists the System Media File information for cardinal numbers.

**Table 31: System Media Files, Cardinal Numbers**

<table>
<thead>
<tr>
<th>Symbol (where applicable)</th>
<th>Decimal Value</th>
<th>Media File Name</th>
<th>Media File Content</th>
<th>Data Play Back Types / When Media File Is Used</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td></td>
<td>point</td>
<td>point</td>
<td>Number</td>
</tr>
<tr>
<td></td>
<td></td>
<td>minus</td>
<td>minus</td>
<td>Number</td>
</tr>
<tr>
<td>0</td>
<td>48</td>
<td>0</td>
<td>zero</td>
<td>All except DOW</td>
</tr>
<tr>
<td>1</td>
<td>49</td>
<td>1</td>
<td>one (masculine version), uno (es-mx and es-es)</td>
<td>All except DOW</td>
</tr>
<tr>
<td>2</td>
<td>50</td>
<td>2</td>
<td>two</td>
<td>All except DOW</td>
</tr>
<tr>
<td>3</td>
<td>51</td>
<td>3</td>
<td>three</td>
<td>All except DOW</td>
</tr>
<tr>
<td>4</td>
<td>52</td>
<td>4</td>
<td>four</td>
<td>All except DOW</td>
</tr>
<tr>
<td>5</td>
<td>53</td>
<td>5</td>
<td>five</td>
<td>All except DOW</td>
</tr>
<tr>
<td>6</td>
<td>54</td>
<td>6</td>
<td>six</td>
<td>All except DOW</td>
</tr>
<tr>
<td>7</td>
<td>55</td>
<td>7</td>
<td>seven</td>
<td>All except DOW</td>
</tr>
<tr>
<td>8</td>
<td>56</td>
<td>8</td>
<td>eight</td>
<td>All except DOW</td>
</tr>
<tr>
<td>9</td>
<td>57</td>
<td>9</td>
<td>nine</td>
<td>All except DOW</td>
</tr>
<tr>
<td>Symbol (where applicable)</td>
<td>Decimal Value</td>
<td>Media File Name</td>
<td>Media File Content</td>
<td>Data Play Back Types/When Media File Is Used</td>
</tr>
<tr>
<td>--------------------------</td>
<td>---------------</td>
<td>----------------</td>
<td>--------------------</td>
<td>--------------------------------------------</td>
</tr>
<tr>
<td></td>
<td>10</td>
<td>ten</td>
<td></td>
<td>Same for the rest of all the numbers</td>
</tr>
<tr>
<td></td>
<td>11</td>
<td>eleven</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>12</td>
<td>twelve</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>13</td>
<td>thirteen</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>14</td>
<td>fourteen</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>15</td>
<td>fifteen</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>16</td>
<td>sixteen</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>17</td>
<td>seventeen</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>18</td>
<td>eighteen</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>19</td>
<td>nineteen</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>20</td>
<td>twenty</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>21</td>
<td>twenty-one</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>22</td>
<td>twenty-two</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>23</td>
<td>twenty-three</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>24</td>
<td>twenty-four</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>25</td>
<td>twenty-five</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>26</td>
<td>twenty-six</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>27</td>
<td>twenty-seven</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>28</td>
<td>twenty-eight</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>29</td>
<td>twenty-nine</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>30</td>
<td>thirty</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>31</td>
<td>thirty-one</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>32</td>
<td>thirty-two</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>33</td>
<td>thirty-three</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>34</td>
<td>thirty-four</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>35</td>
<td>thirty-five</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Symbol (where applicable)</td>
<td>Decimal Value</td>
<td>Media File Name</td>
<td>Media File Content</td>
<td>Data Play Back Types / When Media File Is Used</td>
</tr>
<tr>
<td>---------------------------</td>
<td>---------------</td>
<td>-----------------</td>
<td>-------------------</td>
<td>---------------------------------------------</td>
</tr>
<tr>
<td></td>
<td>36</td>
<td>thirty-six</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>37</td>
<td>thirty-seven</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>38</td>
<td>thirty-eight</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>39</td>
<td>thirty-nine</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>40</td>
<td>forty</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>41</td>
<td>forty-one</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>42</td>
<td>forty-two</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>43</td>
<td>forty-three</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>44</td>
<td>forty-four</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>45</td>
<td>forty-five</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>46</td>
<td>forty-six</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>47</td>
<td>forty-seven</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>48</td>
<td>forty-eight</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>49</td>
<td>forty-nine</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>50</td>
<td>fifty</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>51</td>
<td>fifty-one</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>52</td>
<td>fifty-two</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>53</td>
<td>fifty-three</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>54</td>
<td>fifty-four</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>55</td>
<td>fifty-five</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>56</td>
<td>fifty-six</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>57</td>
<td>fifty-seven</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>58</td>
<td>fifty-eight</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>59</td>
<td>fifty-nine</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>60</td>
<td>sixty</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>61</td>
<td>sixty-one</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>62</td>
<td>sixty-two</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Symbol (where applicable)</td>
<td>Decimal Value</td>
<td>Media File Name</td>
<td>Media File Content</td>
<td>Data Play Back Types / When Media File Is Used</td>
</tr>
<tr>
<td>---------------------------</td>
<td>--------------</td>
<td>----------------</td>
<td>-------------------</td>
<td>-----------------------------------------------</td>
</tr>
<tr>
<td></td>
<td>63</td>
<td>sixty-three</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>64</td>
<td>sixty-four</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>65</td>
<td>sixty-five</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>66</td>
<td>sixty-six</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>67</td>
<td>sixty-seven</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>68</td>
<td>sixty-eight</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>69</td>
<td>sixty-nine</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>70</td>
<td>seventy</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>71</td>
<td>seventy-one</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>72</td>
<td>seventy-two</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>73</td>
<td>seventy-three</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>74</td>
<td>seventy-four</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>75</td>
<td>seventy-five</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>76</td>
<td>seventy-six</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>77</td>
<td>seventy-seven</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>78</td>
<td>seventy-eight</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>79</td>
<td>seventy-nine</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>80</td>
<td>eighty</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>81</td>
<td>eighty-one</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>82</td>
<td>eighty-two</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>83</td>
<td>eighty-three</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>84</td>
<td>eighty-four</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>85</td>
<td>eighty-five</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>86</td>
<td>eighty-six</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>87</td>
<td>eighty-seven</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>88</td>
<td>eighty-eight</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>89</td>
<td>eighty-nine</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Symbol (where applicable)</td>
<td>Decimal Value</td>
<td>Media File Name</td>
<td>Media File Content</td>
<td>Data Play Back Types / When Media File Is Used</td>
</tr>
<tr>
<td>---------------------------</td>
<td>---------------</td>
<td>-----------------</td>
<td>--------------------</td>
<td>-----------------------------------------------</td>
</tr>
<tr>
<td></td>
<td>90</td>
<td>ninety</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>91</td>
<td>ninety-one</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>92</td>
<td>ninety-two</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>93</td>
<td>ninety-three</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>94</td>
<td>ninety-four</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>95</td>
<td>ninety-five</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>96</td>
<td>ninety-six</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>97</td>
<td>ninety-seven</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>98</td>
<td>ninety-eight</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>99</td>
<td>ninety-nine</td>
<td></td>
<td></td>
</tr>
<tr>
<td>oh</td>
<td></td>
<td>oh</td>
<td></td>
<td>24TOD, Date</td>
</tr>
<tr>
<td>hundred</td>
<td></td>
<td>hundred</td>
<td></td>
<td>Number, 24TOD, Date, Currency</td>
</tr>
<tr>
<td>thousand</td>
<td></td>
<td>thousand</td>
<td></td>
<td>Number, Date, Currency</td>
</tr>
<tr>
<td>million</td>
<td></td>
<td>million</td>
<td></td>
<td>Number, Currency</td>
</tr>
<tr>
<td>billion</td>
<td></td>
<td>billion</td>
<td></td>
<td>Number, Date, Currency</td>
</tr>
<tr>
<td>trillion</td>
<td></td>
<td>trillion</td>
<td></td>
<td>Number, Currency</td>
</tr>
</tbody>
</table>

The table that follows lists the System Media File information for ordinal numbers.

**Note**

If ordinal system prompts are to be used in a script for a purpose other than dates, they should be recorded as application prompts with the true ordinal values.

**Table 32: System Media Files, Ordinal Numbers**

<table>
<thead>
<tr>
<th>Symbol (where applicable)</th>
<th>Decimal Value</th>
<th>Media File Name</th>
<th>Media File Content</th>
<th>Data Play Back Types / When Media File Is Used</th>
</tr>
</thead>
<tbody>
<tr>
<td>1ord</td>
<td></td>
<td>first</td>
<td></td>
<td>Date</td>
</tr>
<tr>
<td>Symbol (where applicable)</td>
<td>Decimal Value</td>
<td>Media File Name</td>
<td>Media File Content</td>
<td>Data Play Back Types / When Media File Is Used</td>
</tr>
<tr>
<td>--------------------------</td>
<td>---------------</td>
<td>----------------</td>
<td>--------------------</td>
<td>-----------------------------------------------</td>
</tr>
<tr>
<td></td>
<td>2ord</td>
<td>second</td>
<td></td>
<td>Date for all ordinal numbers</td>
</tr>
<tr>
<td></td>
<td>3ord</td>
<td>third</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>4ord</td>
<td>fourth</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>5ord</td>
<td>fifth</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>6ord</td>
<td>sixth</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>7ord</td>
<td>seventh</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>8ord</td>
<td>eighth</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>9ord</td>
<td>nineth</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>10ord</td>
<td>tenth</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>11ord</td>
<td>eleventh</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>12ord</td>
<td>twelveth</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>13ord</td>
<td>thirteenth</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>14ord</td>
<td>fourteenth</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>15ord</td>
<td>fifteenth</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>16ord</td>
<td>sixteenth</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>17ord</td>
<td>seventeenth</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>18ord</td>
<td>eighteenth</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>19ord</td>
<td>nineteenth</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>20ord</td>
<td>twentieth</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>21ord</td>
<td>twenty-first</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>22ord</td>
<td>twenty-second</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>23ord</td>
<td>twenty-third</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>24ord</td>
<td>twenty-fourth</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>25ord</td>
<td>twenty-fifth</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>26ord</td>
<td>twenty-sixth</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>27ord</td>
<td>twenty-seventh</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>
### Table 3: System Media Files, Measurements

<table>
<thead>
<tr>
<th>Symbol (where applicable)</th>
<th>Decimal Value</th>
<th>Media File Name</th>
<th>Media File Content</th>
<th>Data Play Back Types / When Media File Is Used</th>
</tr>
</thead>
<tbody>
<tr>
<td>½</td>
<td>189</td>
<td>one_half</td>
<td>one half</td>
<td>Char</td>
</tr>
<tr>
<td>¼</td>
<td>188</td>
<td>one_quarter</td>
<td>one quarter</td>
<td>Char</td>
</tr>
<tr>
<td>¾</td>
<td>190</td>
<td>three_quarters</td>
<td>three quarters</td>
<td>Char</td>
</tr>
<tr>
<td>A, a</td>
<td>65,97</td>
<td>a</td>
<td>A</td>
<td>Char</td>
</tr>
<tr>
<td>B, b</td>
<td>66,98</td>
<td>b</td>
<td>B</td>
<td>Char</td>
</tr>
<tr>
<td>C, c</td>
<td>67,99</td>
<td>c</td>
<td>C</td>
<td>Char</td>
</tr>
<tr>
<td>D, d</td>
<td>68,100</td>
<td>d</td>
<td>D</td>
<td>Char</td>
</tr>
<tr>
<td>E, e</td>
<td>69,101</td>
<td>e</td>
<td>E</td>
<td>Char</td>
</tr>
<tr>
<td>F, f</td>
<td>70,102</td>
<td>f</td>
<td>F</td>
<td>Char</td>
</tr>
<tr>
<td>G, g</td>
<td>71,103</td>
<td>g</td>
<td>G</td>
<td>Char</td>
</tr>
<tr>
<td>H, h</td>
<td>72,104</td>
<td>h</td>
<td>H</td>
<td>Char</td>
</tr>
<tr>
<td>I, I</td>
<td>73,105</td>
<td>i</td>
<td>i</td>
<td>Char</td>
</tr>
<tr>
<td>J, j</td>
<td>74,106</td>
<td>j</td>
<td>J</td>
<td>Char</td>
</tr>
<tr>
<td>K, k</td>
<td>75,107</td>
<td>k</td>
<td>K</td>
<td>Char</td>
</tr>
<tr>
<td>L, l</td>
<td>76,108</td>
<td>l</td>
<td>L</td>
<td>Char</td>
</tr>
<tr>
<td>M, m</td>
<td>77,109</td>
<td>m</td>
<td>M</td>
<td>Char</td>
</tr>
<tr>
<td>N, n</td>
<td>78,110</td>
<td>n</td>
<td>N</td>
<td>Char</td>
</tr>
<tr>
<td>O, o</td>
<td>79,111</td>
<td>o</td>
<td>O</td>
<td>Char</td>
</tr>
<tr>
<td>Symbol (where applicable)</td>
<td>Decimal Value</td>
<td>Media File Name</td>
<td>Media File Content</td>
<td>Data Play Back Types / When Media File Is Used</td>
</tr>
<tr>
<td>---------------------------</td>
<td>---------------</td>
<td>-----------------</td>
<td>--------------------</td>
<td>-----------------------------------------------</td>
</tr>
<tr>
<td>P, p</td>
<td>80,112</td>
<td>p</td>
<td>P</td>
<td>Char</td>
</tr>
<tr>
<td>Q, q</td>
<td>81,113</td>
<td>q</td>
<td>Q</td>
<td>Char</td>
</tr>
<tr>
<td>R, r</td>
<td>82,114</td>
<td>r</td>
<td>R</td>
<td>Char</td>
</tr>
<tr>
<td>S, s</td>
<td>83,115</td>
<td>s</td>
<td>S</td>
<td>Char</td>
</tr>
<tr>
<td>T, t</td>
<td>84,116</td>
<td>t</td>
<td>T</td>
<td>Char</td>
</tr>
<tr>
<td>U, u</td>
<td>85,117</td>
<td>u</td>
<td>U</td>
<td>Char</td>
</tr>
<tr>
<td>V, v</td>
<td>86,118</td>
<td>v</td>
<td>V</td>
<td>Char</td>
</tr>
<tr>
<td>W, w</td>
<td>87,119</td>
<td>w</td>
<td>W</td>
<td>Char</td>
</tr>
<tr>
<td>X, x</td>
<td>88,120</td>
<td>x</td>
<td>X</td>
<td>Char</td>
</tr>
<tr>
<td>Y, y</td>
<td>89,121</td>
<td>y</td>
<td>Y</td>
<td>Char</td>
</tr>
<tr>
<td>Z, z</td>
<td>90,122</td>
<td>z</td>
<td>Z</td>
<td>Char</td>
</tr>
<tr>
<td>œ, œ</td>
<td>140,156</td>
<td>oe_140_156</td>
<td>Ligature OE</td>
<td>Char</td>
</tr>
<tr>
<td>Å, å</td>
<td>192,224</td>
<td>a_192_224</td>
<td>A grave</td>
<td>Char</td>
</tr>
<tr>
<td>À, à</td>
<td>193,225</td>
<td>a_193_225</td>
<td>A acute</td>
<td>Char</td>
</tr>
<tr>
<td>Æ, æ</td>
<td>194,226</td>
<td>a_194_226</td>
<td>A circumflex</td>
<td>Char</td>
</tr>
<tr>
<td>Ä, ä</td>
<td>195,227</td>
<td>a_195_227</td>
<td>A tilde</td>
<td>Char</td>
</tr>
<tr>
<td>Ä, ä</td>
<td>196,228</td>
<td>a_196_228</td>
<td>A umlaut</td>
<td>Char</td>
</tr>
<tr>
<td>Ä, ä</td>
<td>197,229</td>
<td>a_197_229</td>
<td>A with ring above</td>
<td>Char</td>
</tr>
<tr>
<td>ÄE, æe</td>
<td>198,230</td>
<td>ae_198_230</td>
<td>Ligature AE</td>
<td>Char</td>
</tr>
<tr>
<td>È, è</td>
<td>200,232</td>
<td>e_200_232</td>
<td>E grave</td>
<td>Char</td>
</tr>
<tr>
<td>É, é</td>
<td>201,233</td>
<td>e_201_233</td>
<td>E acute</td>
<td>Char</td>
</tr>
<tr>
<td>È, è</td>
<td>202,234</td>
<td>e_202_234</td>
<td>E circumflex</td>
<td>Char</td>
</tr>
<tr>
<td>È, è</td>
<td>203,235</td>
<td>e_203_235</td>
<td>E umlaut</td>
<td></td>
</tr>
<tr>
<td>I, i</td>
<td>204,236</td>
<td>i_204_236</td>
<td>I grave</td>
<td>Char</td>
</tr>
<tr>
<td>Í, í</td>
<td>205,237</td>
<td>i_205</td>
<td>I acute</td>
<td>Char</td>
</tr>
<tr>
<td>Í, í</td>
<td>206,238</td>
<td>i_206</td>
<td>I circumflex</td>
<td>Char</td>
</tr>
<tr>
<td>Í, í</td>
<td>207,239</td>
<td>i_207</td>
<td>I umlaut</td>
<td>Char</td>
</tr>
</tbody>
</table>
The table that follows lists the System Media File information for month values.

**Table 34: System Media Files, Months**

<table>
<thead>
<tr>
<th>Symbol (where applicable)</th>
<th>Decimal Value</th>
<th>Media File Name</th>
<th>Media File Content</th>
<th>Data Play Back Types / When Media File Is Used</th>
</tr>
</thead>
<tbody>
<tr>
<td>Ð</td>
<td>208</td>
<td>char_208</td>
<td>character 208</td>
<td>Char</td>
</tr>
<tr>
<td>ð</td>
<td>240</td>
<td>char_240</td>
<td>character 240</td>
<td></td>
</tr>
<tr>
<td>Ő,ô</td>
<td>210,242</td>
<td>o_210_242</td>
<td>O grave</td>
<td>Char</td>
</tr>
<tr>
<td>Ő,ô</td>
<td>211,243</td>
<td>o_211_243</td>
<td>O acute</td>
<td>Char</td>
</tr>
<tr>
<td>Ő,ô</td>
<td>212,244</td>
<td>o_212_244</td>
<td>O circumflex</td>
<td>Char</td>
</tr>
<tr>
<td>Ő,ô</td>
<td>213,245</td>
<td>o_213_245</td>
<td>O tilde</td>
<td>Char</td>
</tr>
<tr>
<td>Ő,ô</td>
<td>214,246</td>
<td>o_214_246</td>
<td>O umlaut</td>
<td>Char</td>
</tr>
<tr>
<td>x</td>
<td>215</td>
<td>multiply</td>
<td>multiplication sign</td>
<td>Char</td>
</tr>
<tr>
<td>Ø,ø</td>
<td>216,248</td>
<td>o_216_248</td>
<td>oh stroke</td>
<td>Char</td>
</tr>
<tr>
<td>Ū,û</td>
<td>217,249</td>
<td>u_217_249</td>
<td>U grave</td>
<td>Char</td>
</tr>
<tr>
<td>Ū,û</td>
<td>218,250</td>
<td>u_218_250</td>
<td>U acute</td>
<td>Char</td>
</tr>
<tr>
<td>Ū,û</td>
<td>219,251</td>
<td>u_219_251</td>
<td>U circumflex</td>
<td>Char</td>
</tr>
<tr>
<td>Ū,û</td>
<td>220,252</td>
<td>u_220_252</td>
<td>U umlaut</td>
<td>Char</td>
</tr>
<tr>
<td>Ŷ,ŷ</td>
<td>221,253</td>
<td>y_221_253</td>
<td>Y acute</td>
<td>Char</td>
</tr>
<tr>
<td>¶</td>
<td>222</td>
<td>char_222</td>
<td>character 222</td>
<td>Char</td>
</tr>
<tr>
<td>ß</td>
<td>223</td>
<td>ss</td>
<td>double s</td>
<td>Char</td>
</tr>
<tr>
<td>†</td>
<td>247</td>
<td>divide</td>
<td>division sign</td>
<td>Char</td>
</tr>
<tr>
<td>Ÿ</td>
<td>254</td>
<td>char_254</td>
<td>character 254</td>
<td>Char</td>
</tr>
<tr>
<td>Ŷ,ŷ</td>
<td>159,255</td>
<td>y_159_255</td>
<td>character 159 or 255</td>
<td>Char</td>
</tr>
<tr>
<td>Symbol (where applicable)</td>
<td>Decimal Value</td>
<td>Media File Name</td>
<td>Media File Content</td>
<td>Data Play Back Types / When Media File Is Used</td>
</tr>
<tr>
<td>---------------------------</td>
<td>---------------</td>
<td>-----------------</td>
<td>-------------------</td>
<td>-----------------------------------------------</td>
</tr>
<tr>
<td></td>
<td></td>
<td>April</td>
<td>April</td>
<td>Date</td>
</tr>
<tr>
<td></td>
<td></td>
<td>May</td>
<td>May</td>
<td>Date</td>
</tr>
<tr>
<td></td>
<td></td>
<td>June</td>
<td>June</td>
<td>Date</td>
</tr>
<tr>
<td></td>
<td></td>
<td>July</td>
<td>July</td>
<td>Date</td>
</tr>
<tr>
<td></td>
<td></td>
<td>August</td>
<td>August</td>
<td>Date</td>
</tr>
<tr>
<td></td>
<td></td>
<td>September</td>
<td>September</td>
<td>Date</td>
</tr>
<tr>
<td></td>
<td></td>
<td>October</td>
<td>October</td>
<td>Date</td>
</tr>
<tr>
<td></td>
<td></td>
<td>November</td>
<td>November</td>
<td>Date</td>
</tr>
<tr>
<td></td>
<td></td>
<td>December</td>
<td>December</td>
<td>Date</td>
</tr>
</tbody>
</table>

The table that follows lists the System Media File information for month values.

**Table 35: System Media Files, Days**

<table>
<thead>
<tr>
<th>Symbol (where applicable)</th>
<th>Decimal Value</th>
<th>Media File Name</th>
<th>Media File Content</th>
<th>Data Play Back Types / When Media File Is Used</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td></td>
<td>Sunday</td>
<td>Sunday</td>
<td>DOW</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Monday</td>
<td>Monday</td>
<td>DOW</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Tuesday</td>
<td>Tuesday</td>
<td>DOW</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Wednesday</td>
<td>Wednesday</td>
<td>DOW</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Thursday</td>
<td>Thursday</td>
<td>DOW</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Friday</td>
<td>Friday</td>
<td>DOW</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Saturday</td>
<td>Saturday</td>
<td>DOW</td>
</tr>
</tbody>
</table>

The table that follows lists the System Media File information for month values.

**Table 36: System Media Files, Time**

<table>
<thead>
<tr>
<th>Symbol (where applicable)</th>
<th>Decimal Value</th>
<th>Media File Name</th>
<th>Media File Content</th>
<th>Data Play Back Types / When Media File Is Used</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>hour</td>
<td>hour</td>
<td></td>
<td>Etime, 24TOD per locale, TOD per locale</td>
</tr>
</tbody>
</table>
The table that follows lists the System Media File information for currency values.

The customer’s Media Administrator may want to replace the contents of “currency_minus” (for the negative amount) and “currency_and” (the latter can even be changed to contain silence).

### Table 37: System Media Files, Currency

<table>
<thead>
<tr>
<th>Symbol (where applicable)</th>
<th>Decimal Value</th>
<th>Media File Name</th>
<th>Media File Content</th>
<th>Data Play Back Types / When Media File Is Used</th>
</tr>
</thead>
<tbody>
<tr>
<td>currency_minus</td>
<td></td>
<td>minus</td>
<td></td>
<td>Currency</td>
</tr>
<tr>
<td>currency_and</td>
<td></td>
<td>and</td>
<td></td>
<td>Currency</td>
</tr>
<tr>
<td>$</td>
<td>36</td>
<td>USD_dollar</td>
<td>dollar</td>
<td>Currency</td>
</tr>
<tr>
<td></td>
<td></td>
<td>USD_dollars</td>
<td>dollars</td>
<td>Currency</td>
</tr>
<tr>
<td>Note</td>
<td></td>
<td></td>
<td></td>
<td>Unified CVP uses the USD_dollar.wav and USD_dollars.wav media files; the dollar.wav and dollars.wav used by ISN Version 1.0 are no longer installed.</td>
</tr>
<tr>
<td>$</td>
<td>36</td>
<td>CAD_dollar</td>
<td>dollar</td>
<td>Currency</td>
</tr>
<tr>
<td>Symbol (where applicable)</td>
<td>Decimal Value</td>
<td>Media File Name</td>
<td>Media File Content</td>
<td>Data Play Back Types / When Media File Is Used</td>
</tr>
<tr>
<td>---------------------------</td>
<td>---------------</td>
<td>----------------</td>
<td>-------------------</td>
<td>-----------------------------------------------</td>
</tr>
<tr>
<td></td>
<td></td>
<td>CAD_dollars</td>
<td>dollars</td>
<td>Currency</td>
</tr>
<tr>
<td></td>
<td></td>
<td>HKD_dollar</td>
<td>dollar</td>
<td>Currency</td>
</tr>
<tr>
<td></td>
<td></td>
<td>HKD_dollars</td>
<td>dollars</td>
<td>Currency</td>
</tr>
<tr>
<td>€</td>
<td>162</td>
<td>cent</td>
<td>cent</td>
<td>Currency</td>
</tr>
<tr>
<td></td>
<td></td>
<td>cents</td>
<td>cents</td>
<td>Currency</td>
</tr>
<tr>
<td></td>
<td></td>
<td>euro</td>
<td>euro</td>
<td>Currency</td>
</tr>
<tr>
<td>£</td>
<td>163</td>
<td>GBP_pound</td>
<td>pound</td>
<td>Currency</td>
</tr>
<tr>
<td></td>
<td></td>
<td>GBP_pounds</td>
<td>pounds</td>
<td>Currency</td>
</tr>
<tr>
<td></td>
<td></td>
<td>penny</td>
<td>penny</td>
<td>Currency</td>
</tr>
<tr>
<td></td>
<td></td>
<td>pence</td>
<td>pence</td>
<td>Currency</td>
</tr>
<tr>
<td></td>
<td></td>
<td>MXN_peso</td>
<td>peso</td>
<td>Currency</td>
</tr>
<tr>
<td></td>
<td></td>
<td>MXN_pesos</td>
<td>pesos</td>
<td>Currency</td>
</tr>
<tr>
<td></td>
<td></td>
<td>centavo</td>
<td>centavo</td>
<td>Currency</td>
</tr>
<tr>
<td></td>
<td></td>
<td>centavos</td>
<td>centavos</td>
<td>Currency</td>
</tr>
</tbody>
</table>

The table that follows lists the System Media File information for gaps of silence and miscellaneous phrases.

**Table 38: System Media Files, Silence and Miscellaneous Phrases**

<table>
<thead>
<tr>
<th>Symbol (where applicable)</th>
<th>Decimal Value</th>
<th>Media File Name</th>
<th>Media File Content</th>
<th>Data Play Back Types / When Media File Is Used</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td></td>
<td>silence_.1_.sec</td>
<td>(.1 second of silence)</td>
<td>Used for pauses where needed</td>
</tr>
<tr>
<td></td>
<td></td>
<td>silence_.25_.sec</td>
<td>(.25 second of silence)</td>
<td>Used for pauses where needed</td>
</tr>
<tr>
<td></td>
<td></td>
<td>silence_.5_.sec</td>
<td>(.5 second of silence)</td>
<td>Used for pauses where needed</td>
</tr>
<tr>
<td></td>
<td></td>
<td>silence_1_sec</td>
<td>(1 second of silence)</td>
<td>Used for pauses where needed</td>
</tr>
<tr>
<td></td>
<td></td>
<td>and</td>
<td>and</td>
<td>Et ime,TOD,25TOD</td>
</tr>
</tbody>
</table>

The table that follows lists the System Media File information for ANSI characters.
<table>
<thead>
<tr>
<th>Symbol (where applicable)</th>
<th>Decimal Value</th>
<th>Media File Name</th>
<th>Media File Content</th>
<th>Data Play Back Types / When Media File Is Used</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>32</td>
<td>space</td>
<td>space</td>
<td>Char</td>
</tr>
<tr>
<td></td>
<td>33</td>
<td>exclamation_mark</td>
<td>exclamation mark</td>
<td>Char</td>
</tr>
<tr>
<td></td>
<td>34</td>
<td>double_quote</td>
<td>double quote</td>
<td>Char</td>
</tr>
<tr>
<td></td>
<td>35</td>
<td>pound</td>
<td>pound</td>
<td>Char</td>
</tr>
<tr>
<td></td>
<td>37</td>
<td>percent</td>
<td>percent</td>
<td>Char</td>
</tr>
<tr>
<td></td>
<td>38</td>
<td>ampersand</td>
<td>ampersand</td>
<td>Char</td>
</tr>
<tr>
<td></td>
<td>39</td>
<td>apostrophe</td>
<td>apostrophe</td>
<td>Char</td>
</tr>
<tr>
<td></td>
<td>40</td>
<td>open_parenthesis</td>
<td>open parenthesis</td>
<td>Char</td>
</tr>
<tr>
<td></td>
<td>41</td>
<td>close_parenthesis</td>
<td>close parenthesis</td>
<td>Char</td>
</tr>
<tr>
<td></td>
<td>42</td>
<td>asterisk</td>
<td>asterisk</td>
<td>Char</td>
</tr>
<tr>
<td></td>
<td>43</td>
<td>plus</td>
<td>plus</td>
<td>Char</td>
</tr>
<tr>
<td></td>
<td>44</td>
<td>comma</td>
<td>comma</td>
<td>Char</td>
</tr>
<tr>
<td></td>
<td>45</td>
<td>hyphen</td>
<td>hyphen</td>
<td>Char</td>
</tr>
<tr>
<td></td>
<td>46</td>
<td>period</td>
<td>period</td>
<td>Char</td>
</tr>
<tr>
<td></td>
<td>47</td>
<td>slash</td>
<td>slash</td>
<td>Char</td>
</tr>
<tr>
<td></td>
<td>58</td>
<td>colon</td>
<td>colon</td>
<td>Char</td>
</tr>
<tr>
<td></td>
<td>59</td>
<td>semicolon</td>
<td>semicolon</td>
<td>Char</td>
</tr>
<tr>
<td></td>
<td>60</td>
<td>less_than</td>
<td>less than</td>
<td>Char</td>
</tr>
<tr>
<td></td>
<td>61</td>
<td>equal</td>
<td>equal</td>
<td>Char</td>
</tr>
<tr>
<td></td>
<td>62</td>
<td>greater_than</td>
<td>greater than</td>
<td>Char</td>
</tr>
<tr>
<td></td>
<td>63</td>
<td>question_mark</td>
<td>question mark</td>
<td>Char</td>
</tr>
<tr>
<td></td>
<td>64</td>
<td>at_symbol</td>
<td>at</td>
<td>Char</td>
</tr>
<tr>
<td></td>
<td>91</td>
<td>left_square_bracket</td>
<td>left square bracket</td>
<td>Char</td>
</tr>
<tr>
<td></td>
<td>92</td>
<td>backslash</td>
<td>backslash</td>
<td>Char</td>
</tr>
<tr>
<td></td>
<td>93</td>
<td>right_square_bracket</td>
<td>right square bracket</td>
<td>Char</td>
</tr>
<tr>
<td></td>
<td>94</td>
<td>caret</td>
<td>caret</td>
<td>Char</td>
</tr>
<tr>
<td>Symbol (where applicable)</td>
<td>Decimal Value</td>
<td>Media File Name</td>
<td>Media File Content</td>
<td>Data Play Back Types / When Media File Is Used</td>
</tr>
<tr>
<td>--------------------------</td>
<td>---------------</td>
<td>---------------------</td>
<td>--------------------</td>
<td>-----------------------------------------------</td>
</tr>
<tr>
<td>_</td>
<td>95</td>
<td>underscore</td>
<td>underscore</td>
<td>Char</td>
</tr>
<tr>
<td>`</td>
<td>96</td>
<td>single_quote</td>
<td>single quote</td>
<td>Char</td>
</tr>
<tr>
<td>{</td>
<td>123</td>
<td>open_brace</td>
<td>open brace</td>
<td>Char</td>
</tr>
<tr>
<td></td>
<td></td>
<td>124</td>
<td>pipe</td>
<td>pipe</td>
</tr>
<tr>
<td>}</td>
<td>125</td>
<td>close_brace</td>
<td>close brace</td>
<td>Char</td>
</tr>
<tr>
<td>~</td>
<td>126</td>
<td>tilde</td>
<td>tilde</td>
<td>Char</td>
</tr>
<tr>
<td>’</td>
<td>130</td>
<td>char_130</td>
<td>low single quote</td>
<td>Char</td>
</tr>
<tr>
<td>f</td>
<td>131</td>
<td>char_131</td>
<td>F with hook</td>
<td>Char</td>
</tr>
<tr>
<td>&quot;</td>
<td>132</td>
<td>low double quote</td>
<td>low double quote</td>
<td>Char</td>
</tr>
<tr>
<td>…</td>
<td>133</td>
<td>ellipsis</td>
<td>ellipsis</td>
<td>Char</td>
</tr>
<tr>
<td>†</td>
<td>134</td>
<td>char_134</td>
<td>character 134</td>
<td>Char</td>
</tr>
<tr>
<td>‡</td>
<td>135</td>
<td>char_135</td>
<td>character 135</td>
<td>Char</td>
</tr>
<tr>
<td>‼</td>
<td>136</td>
<td>char_136</td>
<td>character 136</td>
<td>Char</td>
</tr>
<tr>
<td>%0</td>
<td>137</td>
<td>per_mille</td>
<td>per mile</td>
<td>Char</td>
</tr>
<tr>
<td>§</td>
<td>138</td>
<td>char_138</td>
<td>character 138</td>
<td></td>
</tr>
<tr>
<td>&lt;</td>
<td>139</td>
<td>left_pointing_angle</td>
<td>left pointing angle</td>
<td>Char</td>
</tr>
<tr>
<td>’</td>
<td>145</td>
<td>left_single_quote</td>
<td>left single quote</td>
<td>Char</td>
</tr>
<tr>
<td>’</td>
<td>146</td>
<td>right_single_quote</td>
<td>right single quote</td>
<td>Char</td>
</tr>
<tr>
<td>“</td>
<td>147</td>
<td>left_double_quote</td>
<td>left double quote</td>
<td>Char</td>
</tr>
<tr>
<td>”</td>
<td>148</td>
<td>right_double_quote</td>
<td>right double quote</td>
<td>Char</td>
</tr>
<tr>
<td>·</td>
<td>149</td>
<td>bullet</td>
<td>bullet</td>
<td>Char</td>
</tr>
<tr>
<td>–</td>
<td>150</td>
<td>en_dash</td>
<td>en dash</td>
<td>Char</td>
</tr>
<tr>
<td>---</td>
<td>151</td>
<td>em_dash</td>
<td>em dash</td>
<td></td>
</tr>
<tr>
<td>‼</td>
<td>152</td>
<td>small_tilde</td>
<td>small tilde</td>
<td>Char</td>
</tr>
<tr>
<td>™</td>
<td>153</td>
<td>trade_mark</td>
<td>trade mark</td>
<td>Char</td>
</tr>
<tr>
<td>§</td>
<td>154</td>
<td>char_154</td>
<td>character 154</td>
<td>Char</td>
</tr>
<tr>
<td>›</td>
<td>155</td>
<td>char_155</td>
<td>character 155</td>
<td>Char</td>
</tr>
<tr>
<td>Symbol (where applicable)</td>
<td>Decimal Value</td>
<td>Media File Name</td>
<td>Media File Content</td>
<td>Data Play Back Types / When Media File Is Used</td>
</tr>
<tr>
<td>---------------------------</td>
<td>---------------</td>
<td>----------------</td>
<td>-------------------</td>
<td>-----------------------------------------------</td>
</tr>
<tr>
<td>i</td>
<td>161</td>
<td>exclamation_mark_inverted</td>
<td>inverted exclamation mark</td>
<td>Char</td>
</tr>
<tr>
<td>☰</td>
<td>164</td>
<td>char_164</td>
<td>character 164</td>
<td>Char</td>
</tr>
<tr>
<td>‼</td>
<td>166</td>
<td>broken_pipe</td>
<td>broken pipe</td>
<td>Char</td>
</tr>
<tr>
<td>§</td>
<td>167</td>
<td>section</td>
<td>section</td>
<td>Char</td>
</tr>
<tr>
<td>&quot;</td>
<td>168</td>
<td>char_168</td>
<td>character 168</td>
<td>Char</td>
</tr>
<tr>
<td>©</td>
<td>169</td>
<td>copyright</td>
<td>copyright</td>
<td>Char</td>
</tr>
<tr>
<td>a</td>
<td>170</td>
<td>char_170</td>
<td>character 170</td>
<td>Char</td>
</tr>
<tr>
<td>«</td>
<td>171</td>
<td>left_double_angle_quote</td>
<td>left double angle quote</td>
<td>Char</td>
</tr>
<tr>
<td>¬</td>
<td>172</td>
<td>not</td>
<td>not</td>
<td>Char</td>
</tr>
<tr>
<td>-</td>
<td>173</td>
<td>char_173</td>
<td>character 173</td>
<td>Char</td>
</tr>
<tr>
<td>®</td>
<td>174</td>
<td>registered</td>
<td>registered</td>
<td>Char</td>
</tr>
<tr>
<td>‐</td>
<td>175</td>
<td>char_175</td>
<td>character 175</td>
<td>Char</td>
</tr>
<tr>
<td>°</td>
<td>176</td>
<td>degree</td>
<td>degree</td>
<td>Char</td>
</tr>
<tr>
<td>±</td>
<td>177</td>
<td>plus_minus</td>
<td>plus or minus</td>
<td>Char</td>
</tr>
<tr>
<td>°</td>
<td>178</td>
<td>superscript_2</td>
<td>superscript two</td>
<td>Char</td>
</tr>
<tr>
<td>³</td>
<td>179</td>
<td>superscript_3</td>
<td>superscript three</td>
<td>Char</td>
</tr>
<tr>
<td>′</td>
<td>180</td>
<td>acute_accent</td>
<td>acute accent</td>
<td>Char</td>
</tr>
<tr>
<td>µ</td>
<td>181</td>
<td>micro</td>
<td>micro</td>
<td>Char</td>
</tr>
<tr>
<td>¶</td>
<td>182</td>
<td>paragraph</td>
<td>paragraph</td>
<td>Char</td>
</tr>
<tr>
<td>.</td>
<td>183</td>
<td>middle_dot</td>
<td>middle dot</td>
<td>Char</td>
</tr>
<tr>
<td>,</td>
<td>184</td>
<td>cedilla</td>
<td>cedilla</td>
<td>Char</td>
</tr>
<tr>
<td>⁑</td>
<td>185</td>
<td>superscript_1</td>
<td>superscript one</td>
<td>Char</td>
</tr>
<tr>
<td>″</td>
<td>186</td>
<td>char_186</td>
<td>character 186</td>
<td>Char</td>
</tr>
<tr>
<td>»</td>
<td>187</td>
<td>right_double_angle_quote</td>
<td>right double angle quote</td>
<td>Char</td>
</tr>
<tr>
<td>‡</td>
<td>191</td>
<td>question_mark_inverted</td>
<td>inverted question mark</td>
<td>Char</td>
</tr>
</tbody>
</table>
The table that follows lists files that are not used by Unified CVP micro-applications; these files are included for use in customer scripts.

**Table 40: Miscellaneous Media Files**

<table>
<thead>
<tr>
<th>Symbol (where applicable)</th>
<th>Decimal Value</th>
<th>Media File Name</th>
<th>Media File Content</th>
<th>Data Play Back Types / When Media File Is Used</th>
</tr>
</thead>
<tbody>
<tr>
<td>Error</td>
<td>v</td>
<td>invalid_entry_error</td>
<td>Your entry is invalid.</td>
<td>Error message</td>
</tr>
<tr>
<td></td>
<td>v</td>
<td>no_entry_error</td>
<td>Please make a selection.</td>
<td>Error message</td>
</tr>
<tr>
<td></td>
<td>v</td>
<td>system_error</td>
<td>We are currently experiencing technical difficulties with this site. Please try again later when we can service you much better.</td>
<td>Error message</td>
</tr>
<tr>
<td></td>
<td>v</td>
<td>critical_error</td>
<td>We are currently experiencing technical difficulties with this site. Please try again later when we can service you much better.</td>
<td>Error message</td>
</tr>
<tr>
<td></td>
<td>v</td>
<td>critical_error_ULaw</td>
<td>We are currently experiencing technical difficulties with this site. Please try again later when we can service you much better.</td>
<td>Error message</td>
</tr>
<tr>
<td></td>
<td>v</td>
<td>critical_error_ALaw</td>
<td>We are currently experiencing technical difficulties with this site. Please try again later when we can service you much better.</td>
<td>Error message</td>
</tr>
<tr>
<td></td>
<td>v</td>
<td>440beep</td>
<td>&lt;single beep tone&gt;</td>
<td>Unused</td>
</tr>
<tr>
<td></td>
<td>v</td>
<td>busy_tone</td>
<td>&lt;single busy tone&gt;</td>
<td>Unused</td>
</tr>
<tr>
<td></td>
<td>v</td>
<td>busy_tone30</td>
<td>&lt;busy tone 1 per second for 30 seconds&gt;</td>
<td>Unused</td>
</tr>
<tr>
<td></td>
<td>v</td>
<td>central</td>
<td>Central</td>
<td>Unused</td>
</tr>
<tr>
<td></td>
<td>v</td>
<td>credit_of</td>
<td>Credit Of</td>
<td>Unused</td>
</tr>
<tr>
<td>Symbol (where applicable)</td>
<td>Decimal Value</td>
<td>Media File Name</td>
<td>Media File Content</td>
<td>Data Play Back Types / When Media File Is Used</td>
</tr>
<tr>
<td>---------------------------</td>
<td>---------------</td>
<td>-----------------</td>
<td>--------------------</td>
<td>-----------------------------------------------</td>
</tr>
<tr>
<td>v</td>
<td>dash</td>
<td>dash</td>
<td>Unused</td>
<td></td>
</tr>
<tr>
<td>v</td>
<td>daylight</td>
<td>daylight</td>
<td>Unused</td>
<td></td>
</tr>
<tr>
<td>v</td>
<td>dialtone</td>
<td>&lt;4 seconds of dial tone&gt;</td>
<td>Unused</td>
<td></td>
</tr>
<tr>
<td>v</td>
<td>dialtone2fastbusy60</td>
<td>&lt;9 seconds of dialtone&gt; followed by &lt;30 seconds of fast busy tone&gt;</td>
<td>Unused</td>
<td></td>
</tr>
<tr>
<td>v</td>
<td>dot</td>
<td>dot</td>
<td>Unused</td>
<td></td>
</tr>
<tr>
<td>v</td>
<td>eastern</td>
<td>Eastern</td>
<td>Unused</td>
<td></td>
</tr>
<tr>
<td>v</td>
<td>ENTER_PHONE_NUMBER</td>
<td>Please enter the phone number.</td>
<td>Unused</td>
<td></td>
</tr>
<tr>
<td>v</td>
<td>fastbusy</td>
<td>&lt;a single fastbusy tone + silence (total of 1 second)&gt;</td>
<td>Unused</td>
<td></td>
</tr>
<tr>
<td>v</td>
<td>fastbusy60</td>
<td>30 seconds of &lt;fastbusy tone&gt;</td>
<td>Unused</td>
<td></td>
</tr>
<tr>
<td>v</td>
<td>FINISHED</td>
<td>When you have finished, press</td>
<td>Unused</td>
<td></td>
</tr>
<tr>
<td>v</td>
<td>goodbye</td>
<td>Goodbye</td>
<td>Unused</td>
<td></td>
</tr>
<tr>
<td>v</td>
<td>Mountain</td>
<td>Mountain</td>
<td>Unused</td>
<td></td>
</tr>
<tr>
<td>v</td>
<td>negative</td>
<td>negative</td>
<td>Unused</td>
<td></td>
</tr>
<tr>
<td>v</td>
<td>of</td>
<td>of</td>
<td>Unused</td>
<td></td>
</tr>
<tr>
<td>v</td>
<td>pmgr_sys</td>
<td>pmgr_sys</td>
<td>Unused</td>
<td></td>
</tr>
<tr>
<td>v</td>
<td>pacific</td>
<td>Pacific</td>
<td>Unused</td>
<td></td>
</tr>
<tr>
<td>v</td>
<td>positive</td>
<td>positive</td>
<td>Unused</td>
<td></td>
</tr>
<tr>
<td>v</td>
<td>ringback</td>
<td>&lt;ring back tone for 1 second followed by 2 seconds of silence&gt;</td>
<td>Unused</td>
<td></td>
</tr>
<tr>
<td>v</td>
<td>savings</td>
<td>savings</td>
<td>Unused</td>
<td></td>
</tr>
<tr>
<td>v</td>
<td>standard</td>
<td>Standard</td>
<td>Unused</td>
<td></td>
</tr>
<tr>
<td>v</td>
<td>Star</td>
<td>star</td>
<td>Unused</td>
<td></td>
</tr>
<tr>
<td>v</td>
<td>thankyou</td>
<td>Thank you</td>
<td>Unused</td>
<td></td>
</tr>
</tbody>
</table>
### System Media File Error Messages

Three error messages are included with the System Media files:

- **Critical error.** Message played when system problem exists and the SIP Service cannot process the call. (Example content for en-us: “We are currently experiencing technical difficulties with the site, please try again later and we can serve you much better.”)

  **Note** If you do not want an English spoken critical media, you need to copy the language specific files to the location specified in this section.

Critical error messages are *not* located on the Media Server:

- For **SIP Service**, the critical_error.wav media file is located in `<install path>` \OpsConsoleServer\GWDownloads (for example, C:\Cisco\CVP\OpsConsoleServer\GWDownloads).

- For **non-Unified CVP SIP Service**, an error.wav media file is located in `<install path>`\CVP\audio (for example, C:\Cisco\VXMLServer\Tomcat\webapps\CVP\audio).

  **Note** You can record “override” prompts to replace the critical media files. However, you must save them with their original hard-coded names and place them in their original locations.

- **no_entry_error.** Message played when the caller does not respond to a menu prompt. (Example content for en-us: “Please make a selection.”) The original prompt is then repeated.

- **invalid_entry_error.** Message played when the caller enters an incorrect response to a menu prompt. (Example content for en-us: “Your entry is invalid.”) The original prompt is then repeated.

  **Note** These files are shared by all applications.

If a dialogue needs to be altered for a specific Get Digits, Get Speech or Menu request in the Unified ICME script, override flags can be set in the Network VRU Script Configuration Parameters.

<table>
<thead>
<tr>
<th>Symbol (where applicable)</th>
<th>Decimal Value</th>
<th>Media File Name</th>
<th>Media File Content</th>
<th>Data Play Back Types / When Media File Is Used</th>
</tr>
</thead>
<tbody>
<tr>
<td>v</td>
<td>the</td>
<td>the</td>
<td>Unused</td>
<td></td>
</tr>
<tr>
<td>v</td>
<td>time</td>
<td>time</td>
<td>Unused</td>
<td></td>
</tr>
<tr>
<td>v</td>
<td>try_again</td>
<td>Please try again</td>
<td>Unused</td>
<td></td>
</tr>
</tbody>
</table>
Override flags are available for the Get Digits, Get Speech, and Menu micro-applications, only. See Feature Guide - Writing Scripts for Cisco Unified Customer Voice Portal for details.

You must record the “override” prompts, save them with the hardcoded names `<prompt name>_no_entry_error.wav` and `<prompt name>_invalid_entry_error.wav`, and place them with other application-specific media files in the Application Media library.

This override will not work when there is not a specific file name used (for instance, when Unified CVP is using the TTS feature).

### Unified CVP Microapplication Configuration

The VoiceXML Gateway sends HTTP requests to an HTTP media server to obtain audio files. It uses the following VoiceXML Gateway configuration parameters to locate a server when not using a ACE:

```
  ip host mediaserver <ip-address-of-primary-media-server>
  ip host mediaserver-backup <ip-address-of-secondary-media-server>
```

The backup server is invoked only if the primary server is not accessible, and this is not a load-balancing method. Each new call attempts to connect to the primary server. If failover occurs, the backup server is used for the duration of the call; the next new call will attempt to connect to the primary server.

Note that the Media Server is not a fixed name, and it needs to match whatever name was assigned to the `media_server` ECC variable in the ICM script.

The VoiceXML Gateway also uses the following VoiceXML Gateway configuration parameters to locate a server when using a ACE:

```
  ip host mediaserver <ip-address-of-ACE-VIP-for-media-server>
  ip host mediaserver-backup <ip-address-of-ACE-VIP-for-media-server>
```

Because the ACE almost always locates a Media Server on the first request, a backup server is rarely invoked. However, you can configure the backup server when using a ACE for deployments where there are multiple data centers with ACE.

This feature is not required for Cisco VVB as DNS is used to resolve the hostname.
Configure Speech Server

Before you begin
Install the Remote Operations in the Speech Server before you add the Speech Server to the Operations console.

Procedure

**Step 1**
From the Operations Console, select **Device Management > Speech Server**.

**Step 2**
Click **Add New** to add a new Speech Server or click **Use As Template** to use an existing template to configure the new Speech Server.

**Step 3**
Click the following tabs and configure the settings based on your call flow model:

a) **General** tab. For more information, see **General Settings**, on page 202.

b) **Device Pool** tab. Add the Speech Server to a device pool by moving the device pool from **Available** pane to the **Selected** pane. For more information about adding, deleting, and editing device pool, see **Add or Remove Device From Device Pool**, on page 98.

**Step 4**
Click **Save** to save the settings in the Operations Server database. Click **Save and Deploy** to deploy the changes to the Speech Server page later.

Related Topics

- **Add or Remove Device From Device Pool**, on page 98
- **General Settings**, on page 202
## Speech Server Settings

### General Settings

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
<th>Default</th>
<th>Value</th>
<th>Reboot/Restart Required</th>
</tr>
</thead>
<tbody>
<tr>
<td>IP Address</td>
<td>The IP address of the Speech Server.</td>
<td>None</td>
<td>Valid IP address</td>
<td>Yes - Reboot Speech Server</td>
</tr>
<tr>
<td>Hostname</td>
<td>The host name of the Speech Server.</td>
<td>None</td>
<td>Valid DNS name, includes letters, the numbers 0 through 9, and a dash</td>
<td>Yes - Reboot Speech Server</td>
</tr>
<tr>
<td>Description</td>
<td>The description of the Speech Server.</td>
<td>None</td>
<td>Up to 1024 characters</td>
<td>No</td>
</tr>
<tr>
<td>License File Location</td>
<td>The path of the license file on the Speech Server. The Operations Console transfers the license file to this location.</td>
<td>None</td>
<td>Any text</td>
<td>Yes - Restart</td>
</tr>
</tbody>
</table>

**Note**: The license file is the license file for the respective Speech Server. The location must be the path to where the license file exists on the Speech Server. The license file must exist at that path before you can successfully save and deploy.

Enable secure communication with the Ops console: Select **On** to enable secure communications between the Operations Server and this component. Access the device using SSH and files are transferred using HTTPS. None | On or Off | No
Generate G729 Prompts for Unified CVP

To generate the G.729 prompts for Unified CVP, perform the following procedure:

- Convert the audio files from G.711 to G.729 format using the Music on Hold (MOH) audio translator.
- Change the G.729 compression identifier in the file header.

Convert the Audio Files from G.711 to G.729 Format

**Procedure**

<table>
<thead>
<tr>
<th>Step</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Step 1</td>
<td>Log in to the Cisco Unified CM Administration portal and select <strong>Media Resources &gt; MOH Audio File Management</strong>.</td>
</tr>
<tr>
<td>Step 2</td>
<td>Click <strong>Upload File</strong> and select the G.711 audio files individually.</td>
</tr>
<tr>
<td>Step 3</td>
<td>Click <strong>Media Resources &gt; MOH Audio File Management</strong> and check whether the audio files have been converted to G.729 format. If the conversion was successful, the recording length of audio files has a nonzero value.</td>
</tr>
</tbody>
</table>
| Step 4 | Copy the converted audio files to your Windows server using the Secure File Transfer Protocol (SFTP) Server.  
**Note** Do not add spaces when you rename the audio files. |
| Step 5 | Use putty to sign in to the Unified Communications Manager Server as an administrator. |
| Step 6 | From the command prompt, run **file get activelog mohprep/*g729.wav** and provide the SFTP prompts. |

Change the G.729 Compression Identifier in the File Header

The G.729 files that the Unified Communications Manager generates have a non-standard compression codec tag in the file header. The VXML Gateway cannot play these audio files, as it does not recognize the codec type. Change the compression codec type value to convert the audio files into the standard G729r8 format.

Use the following procedure to change the compression codec type number in the file header from 0x0133 to the standard 0x14db, G729r8 format.

**Procedure**

| Step 1 | Create a folder in the Unified CVP directory. Copy the G.729 audio files that have a nonstandard compression codec tag in the file header into the new folder location. |
| Step 2 | From the command prompt, navigate to the C:\Cisco\CVP\bin folder. |
| Step 3 | Perform one of these steps:  
- To convert audio files individually, from the command prompt, run **<UCMHeaderFixer.exe Audio file Name>\*.**.
To perform bulk conversion of audio files, from the command prompt, run `UCMHeaderFixer.exe` folder path.

The script runs and the audio file is converted from `name.g729.wav` file into `name.wav` format.

**Step 4**

Use the Operations Console to upload the converted audio files to the IOS Gateway.

---

**Configuration**

No additional configuration is required for SIP service to use IVR service. By default, the SIP service uses the IVR service that resides on the VXML server. It is also no longer necessary to configure the VoiceXML Gateway with the IP address of the VXML Server’s IVR service. When SIP is used, the SIP service inserts the URL of the VXML Server's IVR service into a header in the SIP INVITE message when the call is sent to the VoiceXML Gateway. The VoiceXML Gateway extracts this information from the SIP INVITE and use this information to determine which Call Server to use. The VoiceXML Gateway examines the source IP address of the incoming call from the Call Server. This IP address is used as the address for the VXML Server's IVR service.

The following example illustrates the IOS VoiceXML Gateway bootstrap service that is invoked when a call is received:

```
service bootstrap flash:bootstrap.tcl
paramspace english index 0
paramspace english language en
paramspace english location flash
paramspace english prefix en
```

**Note**

For configuring the same feature in Cisco VVB, see section “Cisco VVB configuration for Comprehensive Call Flows”.

With Unified CVP 4.0 and later releases, you have to configure the IP address of the Call Server. The bootstrap.tcl learns the IP address of the source Call Server and uses it as its Call Server. There is no need for backup Call Server configuration, because receiving a call from the Call Server means that the server is operational.

The following files in flash memory on the IOS Voice Gateway are also involved with high availability: handoff.tcl, survivability.tcl, recovery.vxml, and several .wav files. Use Trivial File Transfer Protocol (TFTP) to load the proper files into flash. Configuration information for each file can be found within the file itself. For information, see the latest version of the *Configuration Guide for Cisco Unified Customer Voice Portal*, available at:

Configuring Gateway

Chapter 12

Gateway Configuration

- Configure Gateway, on page 205
- Gateway Settings, on page 206
- Configure Gateway Settings for Standalone Call Flow Model, on page 207
- Configure Gateway Settings for Comprehensive Call Flow Model, on page 210
- Configure Gateway Settings for Call Director Call Flow Model, on page 220
- Configure Gateway Settings for VRU-Only Call Flow Model: Type 8, on page 224
- Configure Gateway Settings for VRU-Only: Type 7, on page 226
- Transfer Script and Media File to Gateway, on page 228
- VoiceXML Gateway, on page 229

Configure Gateway

Procedure

Step 1 Log in to Operations Console and click Device Management > Gateway. The Find, Add, Delete, Edit Gateways window opens.

Step 2 Click Add New.

Note To use an existing Gateway as a template for configuring a new Gateway, select a Gateway from the list of available Gateways and click Use As Template and perform Steps 3 to 5.

Step 3 Click the General tab, enter the field values, and click Save. See General Settings, on page 206.

Step 4 (Optional) Click the Device Pool tab, enter the field values, and click Save. See Add or Remove Device From Device Pool, on page 98.

Step 5 Click Save.

Step 6 (Optional) If the call control client placed the Correlation ID in a GTD parameter other than uus.dat, specify the following parameters to configure a gateway to enable incoming UUI to be used as the Correlation ID.

```
conf t
application
service <your-cvp-service-name>
param use-uui-as-corrid Y (Refer to Note 1)
```
Gateway Settings

General Settings

After adding an IOS Gateway, you can execute a subset of IOS Gateway commands on the Gateway from the Operations Console.

The Ingress Gateway is the point at which an incoming call enters the Unified CVP solution. It terminates Time Division Multiplexing (TDM) phone lines on one side and implements VoIP on the other side. It also provides for sophisticated call routing capabilities at the command of other Unified solution components. It works with SIP and also supports Media Gateway Control Protocol (MGCP) for use with Unified CM.

The VXML Gateway hosts the IOS voice browser, the component which interprets VXML pages from either the Unified CVP IVR service or the VXML Server, plays .wav files and Text-to-Speech (TTS), inputs voice and Dual Tone Multi Frequency (DTMF), and sends results back to the VXML requestor. It also mediates between Media Servers, Unified CVP VXML Servers, ASR and TTS Servers, and the interactive voice response (IVR) service.

You can deploy the Ingress Gateway separately from the VXML Gateway, but in most implementations they are the same: one Gateway performs both functions. Gateways are often deployed in farms, for centralized deployment models. In Branch deployment models, one combined Gateway is usually located at each branch office.

The service configuration parameters for the Call Server host and port are meant for the VRU-Only call flow model for IOS VoiceXML Gateway. These parameters are optional and you can use them to override the IP address or port number of the Call Server that comes through the SIP app-info header.

```
application
service vru-leg flash:bootstrap.tcl
param cvpserverhost xxx.xxx.xxx.xxx <IP of primary Call Server>
param cvpserverbackup xxx.xxx.xxx.xxx <IP of backup Call Server>
param cvpserverport 7000 <TCP Port # of Call Server>
```

An Egress Gateway is typically used in Call Director model to provide access to a call center automatic call distributor (ACD) or third-party IVR.

To configure General settings on a Gateway, on the General tab, enter the field values, as listed in the following table:
Table 42: Unified ICM—General Tab Configuration Settings

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
<th>Default</th>
<th>Value</th>
<th>Restart Required</th>
</tr>
</thead>
<tbody>
<tr>
<td>IP Address</td>
<td>The IP address of a Unified ICM Server</td>
<td>None</td>
<td>Valid IP address</td>
<td>No</td>
</tr>
<tr>
<td>Hostname</td>
<td>The name of the Unified ICM Server</td>
<td>None</td>
<td>Valid DNS name. It includes alphanumeric characters and a dash.</td>
<td>No</td>
</tr>
<tr>
<td>Description</td>
<td>Additional information of the Unified ICM Server</td>
<td>None</td>
<td>Up to 1024 characters</td>
<td>No</td>
</tr>
<tr>
<td>Device Admin URL</td>
<td>The URL for the Unified ICM Web configuration application.</td>
<td>None</td>
<td>Valid URL</td>
<td>No</td>
</tr>
</tbody>
</table>

Activate Gateway Configuration

Activate the gateway configuration by entering these commands:

Procedure

- **Step 1**: call application voice load CVPSelfService
- **Step 2**: call application voice load HelloWorld

Add Gateway to Device Pool

See Device Pool, on page 97 and Add or Remove Device From Device Pool, on page 98.

Related Topics
- Device Pool, on page 97
- Add or Remove Device From Device Pool, on page 98

Configure Gateway Settings for Standalone Call Flow Model

After you configure a gateway through Operations Console, configure settings on the gateway.

Procedure

- **Step 1**: All Versions: Transfer the following script, configuration, and .wav files using the Operations Console or through the Unified CVP CD:
  - CVPSelfService.tcl
This file contains a gateway configuration example.

- CVPSelfServiceBootstrap.vxml
- critical_error.wav

a) Select **Bulk Administration** > **File Transfer** > **Scripts and Media**.
b) From the **Select device type** drop-down list, select **Gateway**.
c) Select the required file from the **Available** list, and click the right arrow to move the device to the **Selected** list.
d) Click **Transfer**.

**Note** Ensure to check the transfer status after you click **Transfer**, because sometimes transfer may fail.

### Step 2

**All Versions**: Perform Steps from the Configure VXML Server Standalone Call Flow Model, on page 16 procedure.

### Related Topics

Configure VXML Server Standalone Call Flow Model, on page 16

### Example: Gateway Settings for Standalone Call Flow Model

The first part of the following example provides the basic configuration for setting a VoiceXML Standalone gateway:

- Applies a timestamp to debugging and log messages
- Turns on logging
- Turns off printing to the command line interface console
- Sends RTP packets
- Configures ASR/TTS Server
- Configures gateway settings

The last part (**application**) of this example provides the following information:

- Standalone Service settings for hello_world application on the VXML Server
- Service requirements for configuring self-service call flow models

```plaintext
service timestamps debug datetime msec localtime
service timestamps log datetime msec localtime
!
service internal
logging buffered 99999999 debugging
no logging console
!
ip cef
!
voice rtp send-recv

ip host tts-en-us <IP of TTS or MRCP Server>
```
ip host asr-en-us <IP of ASR or MRCP Server>

voice class codec 1
codec preference 1 g711ulaw
codec preference 2 g729a8

voice service voip
signaling forward unconditional
h323
!
gateway
timer receive-rtcp 6
!
ip rtcp report interval 3000
!
ivr prompt memory 15000
ivr prompt streamed none
ivr asr-server rtsp://asr-en-us/recognizer
ivr tts-server rtsp://tts-en-us/synthesizer

mrcp client timeout connect 10
mrcp client timeout message 10
mrcp client rtpsetup enable
rtsp client timeout connect 10
rtsp client timeout message 10
vxml tree memory 500
http client cache memory pool 15000
http client cache memory file 500
http client connection timeout 60
http client response timeout 30
http client connection idle timeout 10

application
service hello_world flash:CVPSelfService.tcl
param CVFPrimaryVXMLServer <ip address>
param CVFBackupVXMLServer <ip address>
param CVPSelfService-port 7000
param CVPSelfService-SSL 0
-OR-
param CVPSelfService-port 7443
param CVPSelfService-SSL 1
param CVPSelfService-app HelloWorld

service CVPSelfService
flash:CVPSelfServiceBootstrap.vxml
!

The optional param CVPSelfService-SSL 1 line enables HTTPS.

Calls may be rejected with a 403 Forbidden response if Toll Fraud security is not configured correctly. The solution is to add the IP address as a trusted endpoint, or else disable the IP address trusted list authentication altogether using the voice service voip -> "no ip address trusted authenticate" configuration entry.
Example: Dial-Peer for Standalone Call Flow Model

The following example provides the configuration for an incoming Pots and VoIP call for the VXML Server (standalone) call flow model:

```
dial-peer voice 8 pots
   description Example incoming POTS dial-peer calling HelloWorld VXML
   Server app
   service hello_world
   incoming called-number <your DN pattern here>
   direct-inward-dial

```

```
dial-peer voice 800 voip
   description Example incoming VOIP dial-peer calling HelloWorld VXML
   Server app
   service hello_world
   incoming called-number 800....... 
   voice-class codec 1
   dtmf-relay rtp-nte
   no vad
   !
```

Configure Gateway Settings for Comprehensive Call Flow Model

**Procedure**

**Step 1**
Install the IOS image on the Ingress Gateway.
For detailed information, see the Cisco IOS documentation.

**Step 2**
Transfer the following script, configuration, and .wav files to the Ingress gateway through the Operations Console or the Unified CVP product CD:

- bootstrap.tcl
- handoff.tcl
- survivability.tcl
- bootstrap.vxml
- recovery.vxml
- ringtone.tcl
• cv perror.tcl
• ringback.wav
• critical_error.wav

Step 3  Configure the Ingress Gateway base settings.
Step 4  Configure the Ingress Gateway service settings.
Step 5  Configure an Ingress Gateway incoming Pots Dial-peer.
Step 6  For **SIP without a Proxy Server**, complete the following steps:
   a)  If you are using DNS query with SRV or A types from the gateway, configure the gateway to use DNS.
       Also, if you are using DNS query with SRV or A types from the gateway, use CLI as shown below:

       **Note**  Generally, a non-DNS setup is: `sip-server ipv4:xx.xx.xxx.xxx:5060`.

       ```
       ip domain name pats.cisco.com
       ip name-server 10.86.129.16
       sip=ua
       sip-server dns:cvp.pats.cisco.com
       OR:
       ipv4:xx.xx.xxx.xxx:5060
       ```
   b)  Configure the DNS zone file for the separate DNS server that displays how the Service (SRV) records are configured.

       **Note**  SRV with DNS can be used in any of the SIP call flow models, with or without a Proxy server. Standard A type DNS queries can be used as well for the calls, without SRV, but they lose the load balancing and failover capabilities.

       See DNS Zone File Configuration for Call Director Call Flow Model, on page 52.

Step 7  For **SIP with a Proxy Server**, if you are using the DNS Server, you can set your SIP Service as the Host Name (either A or SRV type).

   You can also configure the Gateway statically instead of using DNS. The following example shows how both the A and SRV type records could be configured:

   ```
   ip host cvp4cc2.cisco.com 10.4.33.132
   ip host cvp4cc3.cisco.com 10.4.33.133
   ip host cvp4cc1.cisco.com 10.4.33.131
   ```

   For SIP/TCP:

   ```
   ip host _sip._tcp.cvp.cisco.com srv 50 50 5060 cvp4cc3.cisco.com
   ip host _sip._tcp.cvp.cisco.com srv 50 50 5060 cvp4cc2.cisco.com
   ip host _sip._tcp.cvp.cisco.com srv 50 50 5060 cvp4cc1.cisco.com
   ```

   For SIP/UDP:

   ```
   ip host _sip._udp.cvp.cisco.com srv 50 50 5060 cvp4cc3.cisco.com
   ip host _sip._udp.cvp.cisco.com srv 50 50 5060 cvp4cc2.cisco.com
   ip host _sip._udp.cvp.cisco.com srv 50 50 5060 cvp4cc1.cisco.com
   ```

   **Note**  The DNS Server must be configured with all necessary A type or SRV type records.

   See the **SIP Devices Configuration** and the **Operations Console Online Help, Managing devices > Configuring a SIP Proxy Server** for details.
Step 8  Transfer files to the VXML Gateway using Step 2.
Step 9  Configure the VXML Gateway base settings.
Step 10 Configure the VXML Gateway service settings.
Step 11 If using ASR and TTS Servers, specify IP addresses for those servers for each locale using the applicable name resolution system for the Gateway (DNS or “ip host” commands).

**Note** If ASR and TTS use the same server, the MRCP server might allocate one license for the ASR session and a second license for the TTS section. If you are hosting both ASR and TTS on the same speech server, you must select the **ASR/TTS use the same MRCP server** option in the IVR Service configuration tab in the Operations Console and follow the instructions in the step below.

Do one of the following:

- If you are using ACE, the server name is configured to the virtual IP (VIP) of the Call Server on ACE. For more information, see the *Configure High Availability for Unified CVP* section.

- The primary and backup servers must be configured. If using name resolution local to the Gateway (rather than DNS) specify:
  
  ip host asr-<locale> <ASR server for locale>
  ip host asr-<locale>-backup <backup ASR server for locale>
  ip host tts-<locale> <TTS server for locale>
  ip host tts-<locale>-backup <backup TTS server for locale>

  Example for English US, use:
  
  ip host asr-en-us 10.86.129.215

Step 12 If you want the ASR and TTS to use the same MRCP server option, you must configure the gateway as follows.

a) In the IVR Service in the Operations Console, select the **ASR/TTS use the same MRCP server** option.
b) Add the following two host names to the gateway configuration:

  - ip host asrtts-<locale> <IP Address Of MRCP Server>
  - ip host asrtts-<locale>-backup <IP Address Of MRCP Server>

  Where the locale might be something like en-us or es-es, resulting in asrtts-en-us or asrtts-es-es.

c) Change the `ivr asr-server` and `ivr tts-server` lines as follows for MRCPV1:

  - iver asr-server rtsp://asr-en-server/recognizer
  - iver tts-server rtsp://tts-en-server/synthesizer

d) Change the `ivr asr-server` and `ivr tts-server` lines as follows for MRCPV2:

  - iver asr-server sip:asr@10.78.26.103
  - iver tts-server sip:tts@10.78.26.103

Step 13 Configure the speech servers to work with Unified CVP.

**Caution** The Operations Console can only manage speech servers installed on Windows, not on Linux. If the speech server is installed on Linux, the server cannot be managed.
To ensure that the speech servers work with Unified CVP, you must make the following changes on each speech server as part of configuring the Unified CVP solution.

If you are using Nuance SpeechWorks MediaServer (SWMS), the configuration file is osserver.cfg. If you are using Nuance Speech Server (NSS), the configuration file is NSSserver.cfg.

Make the following changes to the Nuance configuration file:

- **Change:** `server.resource.2.url VXIString media/speechrecognizer`
  
  **To:** `server.resource.2.url VXIString recognizer`

- **Change:** `server.resource.4.url VXIString media/speechsynthesizer`
  
  **To:** `server.resource.4.url VXIString synthesizer`

- **Change:** `server.mrcp1.resource.3.url VXIString media/speechrecognizer`
  
  **To:** `server.mrcp1.resource.3.url VXIString /recognizer`

- **Change:** `server.mrcp1.resource.2.url VXIString media/speechsynthesizer`
  
  **To:** `server.mrcp1.resource.2.url VXIString media/synthesizer`

- **Change:** `server.mrcp1.transport.port VXIInteger 4900`
  
  **To:** `server.mrcp1.transport.port VXIInteger 554`

If you are using Nuance Speech Server 5 and Nuance Vocalizer for Network 5, then make changes to the configuration files for each application. Make the following changes to the Nuance Speech Server 5 configuration file (NSSserver.cfg):

- **Change:** `server.mrcp1.resource.3.url VXIString media/speechrecognizer`
  
  **To:** `server.mrcp1.resource.3.url VXIString /recognizer`

- **Change:** `server.mrcp1.resource.2.url VXIString media/speechsynthesizer`
  
  **To:** `server.mrcp1.resource.2.url VXIString /synthesizer`

- **Change:** `server.mrcp1.transport.port VXIInteger 4900`
  
  **To:** `server.mrcp1.transport.port VXIInteger 554`

- **Change:** `server.mrcp1.transport.dtmfPayloadType VXIInteger 96`
  
  **To:** `server.mrcp1.transport.dtmfPayloadType VXIInteger 101`

- **Uncomment the following:** `server.rtp.dtmfTriggerLeading VXIInteger 0`

If you are using the Nuance Vocalizer for Network 5 TTS System, the following configuration files will need to be updated:

- **Change:** `<ssml_validation>strict</ssml_validation>`
  
  **To:** `<ssml_validation>warn</ssml_validation>`

- **Change:** `<ssml_validation>strict</ssml_validation>`
  
  **To:** `<ssml_validation>warn</ssml_validation>`
If you are using NuanceRecognizer 10.0 and Nuance Speech Server 6.2, make the following changes to the Nuance configuration file (NSSserver.cfg - C:\Program Files (x86)\Nuance\Speech Server\Server\config):

- **Change**: server.mrcp1.resource.3.url VXIString media/speechrecognizer  
  **To**: server.mrcp1.resource.3.url VXIString /recognizer

- **Change**: server.mrcp1.resource.2.url VXIString media/speechsynthesizer  
  **To**: server.mrcp1.resource.2.url VXIString /synthesizer

- **Change**: server.mrcp1.transport.port VXIInteger 4900  
  **To**: server.mrcp1.transport.port VXIInteger 554

- **Change**: server.mrcp1.transport.dtmfPayloadType VXIInteger 96  
  **To**: server.mrcp1.transport.dtmfPayloadType VXIInteger

Make the following change to the Baseline.xml file C:\Program Files\Nuance\Recognizer\config:

- **Change**: <ssml_validation>strict</ssml_validation>  
  **To**: <ssml_validation>warn</ssml_validation>.

**Note** If you are using NuanceRecognizer 10.5 and Nuance Speech Server 6.5, then refer to the relevant Nuance Speech Suite Install Guide available at https://network.nuance.com/portal/server.pt/directory/nuance_speech_suite_10_5/16535.

**Step 14** Configure SIP-Specific Actions.

On the Unified CM server, CCMAdmin Publisher, configure **SIP-specific actions**:

a) Create SIP trunks:

- If you are using a SIP Proxy Server, set up a SIP trunk to the SIP Proxy Server.

- Add a SIP Trunk for the Unified CVP Call Server.

- Add a SIP Trunk for each Ingress gateway that will send SIP calls to Unified CVP that might be routed to Unified CM.

Select **Device > Trunk > Add New** and add the following:

- **Trunk Type**: **SIP trunk**

- **Device Protocol**: **SIP**

- **Destination Address**: IP address or host name of the SIP Proxy Server (if using a SIP Proxy Server). If not using a SIP Proxy Server, enter the IP address or host name of the Unified CVP Call Server.

- **DTMF Signaling Method**: **RFC 2833**

- Do **not** check the **Media Termination Point Required** checkbox.

- If you are using UDP as the outgoing transport on Unified CVP, also set the outgoing transport to **UDP** on the SIP Trunk Security Profile.

b) Add route patterns for outbound calls from Unified CM devices using a SIP Trunk to the Unified CVP Call Server. Also, add a route pattern for error DN.
CVP solution does not support 100rel. On the SIP profile for the Trunk, confirm that SIP Rel1xx Options are disabled.

For warm transfers, the call from Agent 1 to Agent 2 does not typically use a SIP Trunk, but you must configure the CTI Route Point for that dialed number on the Unified CM Server and associate that number with your peripheral gateway user (PGUSER) for the JTAI gateway on the Unified CM peripheral gateway. An alternative is to use the Dialed Number Plan on Unified ICME to bypass the CTI Route Point.

c) Select Call Routing > Route/Hunt > Route Pattern > Add New.
   • Route Pattern: Specify the route pattern; for example: 3xxx for a TDM phone that dials 9+3xxx and all Unified ICME scripts are set up for 3xxx dialed numbers.
   • Gateway/Route List: Select the SIP Trunk defined in Step 2.

d) If you are sending calls to Unified CM using an SRV cluster domain name, configure the cluster domain name.
   • Select Enterprise Parameters > Clusterwide Domain Configuration.
   • Add the Cluster fully qualified domain name: FQDN.

For detailed instructions about using Unified CM and the CUSP Server, see the Cisco Unified SIP Proxy Server documentation.

Step 15 (Optional) Configure the SIP Proxy Server.

From the CUSP Server Administration web page (http://<CUSP server>/admin):

a) Configure the SIP static routes to the Unified CVP Call Server(s), Unified CM SIP trunks, and Gateways.
   Configure the SIP static routes for intermediary transfers for ring tone, playback dialed numbers, and error playback dialed numbers.
   Note For failover and load balancing of calls to multiple destinations, configure the CUSP Server static route with priority and weight.

   See the SIP Devices Configuration and SIP Dialed Number Pattern Matching Algorithm, on page 9 for detailed information.

b) Configure Access Control Lists for Unified CVP calls.
   • Select Proxy Settings > Incoming ACL.
   • Set address pattern: all

c) Configure the service parameters.

Select Service Parameters, and set the following:
   • Add record route: off
   • Maximum invite retransmission count: 2
   • Proxy Domain and Cluster Name: if using DNS SRV, set to the FQDN of your Proxy Server SRV name.
d) Write down the IP address and host name of the SIP Proxy Server. You need this information when configuring the SIP Proxy Server in Unified CVP.

e) If using redundant SIP Proxy Servers (primary and secondary or load balancing), decide whether to use DNS server lookups for SRV records or non-DNS based local SRV record configuration.

The Comprehensive call flow model with SIP calls will typically be deployed with dual CUSP Servers for redundancy. In some cases, you might want to purchase a second CUSP Server. Regardless, the default transport for deployment will be UDP. Make sure you always set the AddRecordRoute setting to Off with CUSP Servers.

Configure the SRV records on the DNS server or locally on Unified CVP with an .xml file (local xml configuration avoids the overhead of DNS lookups with each call).

Step 16 Configure Peripheral Gateways (PGs).

On the NAM, ICM Configuration Manager, PG Explorer tool, configure a peripheral gateway (PG) for the Unified CVP. Configure a PG for each Unified CVP Call Server as follows:

In the tree view pane, select the applicable PG.

Logical Controller tab:

- Client Type: VRU
- Name: A name descriptive of this PG
  For example: `<location>_A for side A of a particular location

Peripheral tab:

- Peripheral Name: Descriptive name of this Unified CVP peripheral
  For example: `<location>_<cvp1> or <dns_name>
- Client Type: VRU
- Select: Enable Post-routing

Advanced tab:

- Select the name of the Unified CVP VRU from the Network VRU field drop-down list.
  For example: cvpVRU

Routing Client tab:

- Name: By convention, use the same name as the peripheral
- Client Type: VRU
- If you are in a Unified ICMH environment and configuring the CICM, then do the following:
  - Do not select the Network Transfer Preferred checkbox
  - Routing client: INCRP NIC
If you are using a VXML gateway that is not co-located, then configure the following dial-peer to handle the error case:

**Example:**

```plaintext
dial-peer voice 9292 voip
description SIP error dial-peer
session protocol sipv2
session target ipv4:<destination IP_address for the VXML gateway>
session transport tcp
codec g711ulaw
destination-pattern 929292T
dtmf-relay rtp-nte
no vad
```

This may vary depending on the type of deployment.

---

**Ingress and VoiceXML Gateway Configuration Examples**

**Example Gateway Settings for Comprehensive Call Flow Model**

The first part of the following example provides the basic configuration for setting an Ingress gateway:

- Applies a timestamp to debugging and log messages
- Turns on logging
- Turns off printing to the command line interface console
- Sends RTP packets
- Configures gateway settings

The last part of this example provides the following:

- Allows SIP to play a .wav file that enables caller to hear message from critical_error.wav
- Performs survivability
- Enables SIP to play ringtone to caller while caller is being transferred to an agent
- Logs errors on the gateway when the call fails
- Defines requirements for SIP Call Server

**Note**

CVP solution does not support 100rel. It can be disabled on the dial-peer level or on a global level under the voice service VoIP section.

```plaintext
service timestamps debug datetime msec localtime
service timestamps log datetime msec localtime
!
service internallogging buffered 99999999 debugging
no logging console
!
```
ip cef
!voice rtp send-recv

!voice service voip
signaling forward unconditional
sip
min-se 360
header-passing
!voice class codec 1
codec preference 1 g711ulaw
codec preference 2 g729r8
!application
service cvpererror flash:cvpererror.tcl
!service cvp-survivability flash:survivability.tcl
!service ringtone flash:ringtone.tcl
!service handoff flash:handoff.tcl
!gateway
timer receive-rtcp 4
!ip rtcp report interval 2000
!sip ua
retry invite 2
timers expires 60000
sip-server ipv4:<IP of CUSP server or Call Server>:5060
reason-header override
!

VoiceXML: Example Gateway Settings for Comprehensive Call Flow Model

The first part of the following example provides the basic configuration for setting a VoiceXML gateway:

- Applies a timestamp to debugging and log messages
- Turns on logging
- Turns off printing to the command line interface console
- Sends RTP packets
- Configures ASR/TTS Server
- Configures gateway settings

The last part of this example provides the following:

- Initiates the VoiceXML leg
- Initiates the switch leg of the call
- Plays a .wav file that enables caller to hear message from critical_error.wav
- Logs errors on the gateway when the call fails
ip host tts-en-us <IP of TTS or MRCP Server>
ip host asr-en-us <IP of ASR or MRCP Server>
voice rtp send-receive

! voice service voip
signaling forward unconditional
sip
min-se 360
header-passing
voice class
codec 1 codec preference 1 g711ulaw
codec preference 2 g729r8

ivr prompt memory 15000
ivr prompt streamed none
ivr asr-server rtsp://asr-en-us/recognizer
ivr tts-server rtsp://tts-en-us/synthesizer
mrcp client timeout connect 10
mrcp client timeout message 10
mrcp client rtpsetup enable
rtsp client timeout connect 10
rtsp client timeout message 10
vxml tree memory 500
http client cache memory pool 15000
http client cache memory file 500
http client connection timeout 60
http client response timeout 30
http client connection idle timeout 10
gateway
timer receive-rtcp 6
!
ip rtcp report interval 3000
application
service new-call flash:bootstrap.vxml
service cvperror flash:cvperror.tcl
service handoff flash:handoff.tcl
service bootstrap flash:bootstrap.tcl
param cvpserverss1 1
!

Note
The optional param cvpserverss1 1 line enables HTTPS.

Related Topics
- DNS Zone File Configuration for Comprehensive Call Flow Model, on page 30
- Set Up Ingress Gateway to Use Redundant Proxy Servers, on page 167
- Set Up Call Server with Redundant Proxy Servers, on page 167
- Local SRV File Configuration Example for SIP Messaging Redundancy, on page 168
- Load-Balancing SIP Calls, on page 168
- Cisco Unified SIP Proxy (CUSP) Configuration, on page 168
- Configure Custom Streaming Ringtones, on page 171
- Configure High Availability for Unified CVP
- SIP Dialed Number Pattern Matching Algorithm, on page 9
Configure Gateway Settings for Call Director Call Flow Model

Procedure

Step 1 Perform Steps 1 to 4 of the Configure Gateway Settings for Comprehensive Call Flow Model, on page 210 procedure.

Step 2 Configure the Ingress Gateway:
   a) Configure the Ingress Gateway dial-peer for the Unified CVP Call Server.
   b) Configure a dial-peer for ringtone and error.
   c) If you are using a Proxy Server, configure your session target in the outbound dial peer to point to the Proxy Server.
   d) If you are using the sip-server global configuration, then configure the sip-server in the sip-ua section to be your Proxy Server and point the session target of the dial-peer to the sip-server global variable.

Note Make sure your dial plan includes this information. You will need to see the Dial plan when you configure the SIP Proxy Server for Unified CVP.

The SIP Service voip dial peer and the destination pattern on the Ingress Gateway must match the DNIS in static routes on the SIP Proxy Server or Unified CVP Call Server.

Step 3 For SIP without a Proxy Server, complete the following steps:
   a) If you are using DNS query with SRV or A types from the gateway, configure the gateway to use DNS.

   See the SIP Devices Configuration and Operations Console online help for detailed instructions. If you are using DNS query with SRV or A types from the gateway, use the gateway configuration CLI as shown below:

   Non-DNS Setup:

   sip-ua
   sip-server ipv4:xx.xx.xxx.xxx:5060
   !

   DNS Setup:

   ip domain name patz.cisco.com
   ip name-server 10.10.111.16
   !
   sip-ua
   sip-server dns:cvp.pats.cisco.com
   !

   b) Configure the DNS zone file for the separate DNS server that displays how the Service (SRV) records are configured.

   Note SRV with DNS can be used in any of the SIP call flow models, with or without a Proxy server. Standard A type DNS queries can be used as well for the calls, without SRV, but they lose the load balancing and failover capabilities.

   See the DNS Zone File Configuration for Call Director Call Flow Model, on page 52 for more information.
Step 4  
For SIP with a Proxy Server, use one of the following methods:

**Note**  
You can configure the Gateway statically instead of using DNS.

The following example shows how both the A and SRV type records could be configured:

```
ip host cvp4cc2.cisco.com 10.4.33.132
ip host cvp4cc3.cisco.com 10.4.33.133
ip host cvp4cc1.cisco.com 10.4.33.131
```

For **SIP/TCP**:

```
ip host _sip._tcp.cvp.cisco.com srv 50 50 5060 cvp4cc3.cisco.com
ip host _sip._tcp.cvp.cisco.com srv 50 50 5060 cvp4cc2.cisco.com
ip host _sip._tcp.cvp.cisco.com srv 50 50 5060 cvp4cc1.cisco.com
```

For **SIP/UDP**:

```
ip host _sip._udp.cvp.cisco.com srv 50 50 5060 cvp4cc3.cisco.com
ip host _sip._udp.cvp.cisco.com srv 50 50 5060 cvp4cc2.cisco.com
ip host _sip._udp.cvp.cisco.com srv 50 50 5060 cvp4cc1.cisco.com
```

**Note**  
The DNS Server must be configured with all necessary A type or SRV type records.

If you are using the DNS Server, you can set your SIP Service as the Host Name (either A or SRV type).

Step 5  
On the Unified CM server, CCMAdmin Publisher, complete the following SIP-specific actions:

a)  Create SIP trunks.
   
   •  If you are using a SIP Proxy Server, set up a SIP trunk to the SIP Proxy Server.
   
   •  Add a SIP Trunk for the Unified CVP Call Server.
   
   •  Add a SIP Trunk for each Ingress gateway that will send SIP calls to Unified CVP that might be routed to Unified CM.
   
   To add an SIP trunk, select **Device > Trunk > Add New** and use the following parameters:
   
   • Trunk Type: **SIP trunk**
   
   • Device Protocol: **SIP**
   
   • Destination Address: IP address or host name of the SIP Proxy Server (if using a SIP Proxy Server). If not using a SIP Proxy Server, enter the IP address or host name of the Unified CVP Call Server.
   
   • DTMF Signaling Method: **RFC 2833**
   
   • **Do not** check the **Media Termination Point Required** check box.
   
   • If you are using UDP as the outgoing transport on Unified CVP, also set the outgoing transport to **UDP** on the SIP Trunk Security Profile.
   
   • Connection to CUSP Server: use 5060 as the default port.
   
   b)  Add route patterns for outbound calls from the Unified CM devices using a SIP Trunk to the Unified CVP Call Server. Also, add a route pattern for error DN.
   
   Select **Call Routing > Route/Hunt > Route Pattern > Add New**
Add the following:

- Route Pattern: Specify the route pattern; for example: 3XXX for a TDM phone that dials 9+3xxx and all Unified ICME scripts are set up for 3xxx dialed numbers.

- Gateway/Route List: Select the SIP Trunk defined in the previous substep.

**Note**  For warm transfers, the call from Agent 1 to Agent 2 does not typically use a SIP Trunk, but you must configure the CTI Route Point for that dialed number on the Unified CM server and associate that number with your peripheral gateway user (PGUSER) for the JTAPI gateway on the Unified CM peripheral gateway. An alternative is to use the Dialed Number Plan on Unified ICME to bypass the CTI Route Point.

c) If you are sending calls to Unified CM using an SRV cluster domain name, select Enterprise Parameters > Clusterwide Domain Configuration and add the Cluster fully qualified domain name FQDN.

**Step 6**  (Optionally) Configure the **SIP Proxy Server**.

a) Configure the SIP static routes to the Unified CVP Call Servers, Unified CM SIP trunks, and Gateways.

Configure the SIP static routes for intermediary transfers for ringtone, playback dialed numbers, and error playback dialed numbers.

**Note**  For failover and load balancing of calls to multiple destinations, configure the CUSP server static route with priority and weight.

b) Configure Access Control Lists for Unified CVP calls.

Select **Proxy Settings > Incoming ACL**.

Address pattern: all

c) Configure the service parameters.

Select **Service Parameters**, then set the following:

- Add record route: off

- Maximum invite retransmission count: 2

- Proxy Domain and Cluster Name: if using DNS SRV, set to the FQDN of your Proxy Server SRV name

d) Write down the IP address and host name of the SIP Proxy Server. (You need this information when configuring the SIP Proxy Server in Unified CVP.)

e) If using redundant SIP Proxy Servers (primary and secondary or load balancing), then decide whether to use DNS server lookups for SRV records or non-DNS based local SRV record configuration.

**Note**  If a single CUSP Server is used, then SRV record usage is not required.

Configure the SRV records on the DNS server or locally on Unified CVP with a .xml file (local xml configuration avoids the overhead of DNS lookups with each call).

**Note**  See the Local SRV File Configuration Example for SIP Messaging Redundancy, on page 168 section for details.
The Call Director call flow model with SIP calls will typically be deployed with dual CUSP servers for redundancy. In some cases, you might want to purchase a second CUSP server. Regardless, the default transport for deployment will be UDP; make sure you always disable the record-route in a CUSP server as this advanced feature is not supported in Contact Center deployments.

For the required settings in the Unified CM Publisher configuration, see the Cisco Unified SIP Proxy documentation.

**Step 7** Configure the PGs for the switch leg.

On Unified ICME, ICM Configuration Manager, **PG Explorer** tool:

a) Configure each peripheral gateway (PG) to be used for the Switch leg. In the tree view pane, select the applicable PG, and set the following:

1. **Logical Controller** tab:
   - Client Type: VRU
   - Name: A name descriptive of this PG
     For example: `<location>_A` for side A of a particular location

2. **Peripheral** tab:
   - Peripheral Name: A name descriptive of this Unified CVP peripheral
     For example: `<location>_<cvp1>` or `<dns_name>`
   - Client Type: VRU
   - Select the check box: **Enable Post-routing**

3. **Routing Client** tab:
   - Name: By convention, use the same name as the peripheral.
   - Client Type: VRU

For more information, see the ICM Configuration Guide for Cisco ICM Enterprise Edition.

b) Configure a peripheral for each Unified CVP Call Server to be used for a Switch leg connected to each peripheral gateway.

**Related Topics**
- Configure Gateway Settings for Comprehensive Call Flow Model, on page 210
- Set Up Ingress Gateway to Use Redundant Proxy Servers, on page 167
- Set Up Call Server with Redundant Proxy Servers, on page 167
- Local SRV File Configuration Example for SIP Messaging Redundancy, on page 168
- Load-Balancing SIP Calls, on page 168
- Cisco Unified SIP Proxy (CUSP) Configuration, on page 168
- Configure Custom Streaming Ringtones, on page 171
- SIP Dialed Number Pattern Matching Algorithm, on page 9
- DNS Zone File Configuration for Comprehensive Call Flow Model, on page 30
Configure Gateway Settings for VRU-Only Call Flow Model: Type 8

Procedure

Step 1 Using the Unified CVP Operations Console or the Unified CVP product CD, transfer the following script, configuration, and .wav files to the VoiceXML Gateway used for the VRU leg. Perform Step 2 of the Configure Gateway Settings for Comprehensive Call Flow Model, on page 210 procedure.

Step 2 Configure the VXML gateway base settings.

Step 3 Configure the VXML gateway service settings.

Step 4 Configure the ICM service.

Using the Operations Console, select Device Management > CVP Call Server > ICM tab. On each Unified CVP Call Server, configure the ICM Service by specifying the following required information:

a) VRU connection port number.
   
   Set the VRU Connection Port to match the VRU connection Port defined in ICM Setup for the corresponding VRU peripheral gateway (PIM).

b) Maximum Length of DNIS.
   
   Set the maximum length DNIS to a number which is at least the length of the translation route DNIS numbers.

   Example: if the Gateway dial pattern is 1800******, the maximum DNIS length is 10.

c) Call service IDs: New Call and Pre-routed.

   Enter the new and pre-routed call service IDs. Configure the ports for both groups according to the licenses purchased, call profiles, and capacity by completing the required fields on this tab.

d) Trunk group IDs: New Call and Pre-routed.

   • Enter the new and pre-routed call trunk group IDs

   • Configure the group number for the Pre-routed Call Trunk group. The group number must match the trunk group number in the Network Trunk group used for the translation route

   • Configure the number of ports according to the licenses purchased and capacity

   • Configure each of the numbers used for translation routes. (The “New Call” group is not used since the calls are being sent to the VRU (Unified CVP) after some initial processing by the NIC/Unified ICME)

e) Dialed numbers used in the translation route.

   Add the dialed numbers in the DNIS field.
f) Check the default values of the other settings and change, if desired.

VoiceXML Gateway Configuration Examples

Example Gateway Settings for Type 8 Call Flow Model

The first part of the following example provides the basic configuration for setting a VoiceXML gateway:

- Applies a timestamp to debugging and log messages
- Turns on logging
- Turns off printing to the command line interface console
- Sends RTP packets
- Configures ASR/TTS Server
- Configures gateway settings

The last part of this example provides the following:

- Initiates the VoiceXML leg
- Plays a .wav file that enables caller to hear message from critical_error.wav
- Logs errors on the gateway when the call fails

```
service timestamps debug datatime msec
service timestamps log datatime msec
service internal
logging buffered 99999999 debugging
no logging console
ip cef
no ip domain lookup
ip host tts-en-us <IP of TTS or MRCP Server>
ip host asr-en-us <IP of ASR or MRCP Server>
voice rtp send-recv
!
voice service voip
allow-connections h323 to h323
signaling forward unconditional
h323
sip
min-se 360
header-passing
voice class codec 1
codec preference 1 g711ulaw
codec preference 2 g729r8
!
ivr prompt memory 15000
ivr prompt streamed none
ivr asr-server rtsp://asr-en-us/recognizer
ivr tts-server rtsp://tts-en-us/synthesizer
mrcp client timeout connect 10
mrcp client timeout message 10
mrcp client rtpsetup enable
rtsp client timeout connect 10
rtsp client timeout message 10
vxml tree memory 500
```
http client cache memory file 500
http client connection timeout 60
http client response timeout 30
http client connection idle timeout 10
gateway
timer receive-rtcp 6
!
ip rtcp report interval 3000
application
service new-call flash:bootstrap.vxml
service cvperror flash:cvperror.tcl
service handoff flash:handoff.tcl

Example of Dial-peer for ICM VRU Label for Type 8 Call Flow Model

The following example provides the configuration for an ICM VRU label dial-peer for the Type 8 Unified CVP VRU-Only call flow model:

dial-peer voice 777 voip
description ICM VRU label
service bootstrap
voice-class codec 1
incoming called-number <your sendtovru label pattern here>
dtmf-relay rtp-nte
no vad
!

Related Topics
Configure Gateway Settings for Comprehensive Call Flow Model, on page 210

Configure Gateway Settings for VRU-Only: Type 7

Procedure

Step 1 Transfer the following script, configuration, and .wav files to the VoiceXML Gateway used for the VRU leg, using the Unified CVP Operations Console. Perform Step 2 of the Configure Gateway Settings for Comprehensive Call Flow Model, on page 210 procedure.

Step 2 Configure the VoiceXML gateway base settings.

Step 3 Configure the VoiceXML gateway service settings.

Step 4 Configure the ICM Service for each Call Server.

In the Operations Console, select Device Management > CVP Call Server > ICM tab. For each Unified CVP Call Server, configure the ICM Service by specifying the following required information:

a) VRU connection port number.
   - Set the VRU Connection Port to match the VRU connection Port defined in ICM Setup for the corresponding VRU peripheral gateway (PIM).

b) Set the maximum length DNIS to the length of the Network Routing Number.
   - Example: if the Gateway dial pattern is 1800******, the maximum DNIS length is 10.

c) Call service IDs: New Call and Pre-routed.
Enter the new and pre-routed call service IDs. Configure the ports for both groups according to the licenses purchased, call profiles, and capacity by completing the required fields on this tab.

d) Trunk group IDs: New Call and Pre-routed.

Enter the new and pre-routed call trunk group IDs. Configure the group number for the Pre-routed Call Trunk group. The group number must match the trunk group number in the Network Trunk group used for the translation route.

Configure the number of ports according to the licenses purchased and capacity. Configure each of the numbers used for translation routes. (The “New Call” group is not used since the calls are being sent to the VRU (Unified CVP) after some initial processing by the NIC/Unified ICME.)

e) Check the default values of other settings and change, if desired.

---

**VoiceXML Gateway Configuration: Example Gateway Settings for Type 7**

**VoiceXML Gateway Configuration: Example of Dial-Peer for ICM VRU Label for Type 7**

---

**Note** While using ASR/TTS, use a single version of MRCP (v1/v2) instead of using it in mixed mode.

The first part of the following example provides the basic configuration for setting a VoiceXML gateway:

- Applies a timestamp to debugging and log messages
- Turns on logging
- Turns off printing to the command line interface console
- Sends RTP packets
- Configures ASR/TTS Server
- Configures gateway settings

The last part of this example provides the following:

- Initiates the VoiceXML leg
- Plays a .wav file that enables caller to hear message from critical_error.wav
- Logs errors on the gateway when the call fails

```plaintext
service timestamps debug datetime msec
service timestamps log datetime msec
service internal
logging buffered 99999999 debugging
no logging console
ip cef
no ip domain lookup
ip host tts-en-us <IP of TTS or MRCP Server>
ip host asr-en-us <IP of ASR or MRCP Server>
voice rtp send-recv
!```
voice service voip
allow-connections h323 to h323
signaling forward unconditional
h323
sip
min-se 360
header-passing
voice class codec 1
  codec preference 1 g711ulaw
  codec preference 2 g729r8
!
ivr prompt memory 15000
ivr prompt streamed none
ivr asr-server rtsp://asr-en-us/recognizer
ivr tts-server rtsp://tts-en-us/synthesizer
mrscp client timeout connect 10
mrscp client timeout message 10
mrscp client rtpsetup enable
rtsp client timeout connect 10
rtsp client timeout message 10
vxml tree memory 500
http client cache memory pool 15000
http client cache memory file 500
http client connection timeout 60
http client response timeout 30
http client connection idle timeout 10
gateway
timer receive-rtcp 6
!
ip rtcp report interval 3000
application
  service new-call flash:bootstrap.vxml
  service cvperror flash:cvperror.tcl
  service handoff flash:handoff.tcl
  service bootstrap flash:bootstrap.tcl
!

The following example provides the configuration for an ICM VRU label dial-peer for the Type 7 Unified CVP VRU-Only call flow model:

dial-peer voice 777 voip
description ICM VRU label
description bootstrap
description codec 1
incoming called-number <your sendtovru label pattern here>
dtmf-relay rtp-nte
no vad
!

Related Topics
  Configure Gateway Settings for Comprehensive Call Flow Model, on page 210

Transfer Script and Media File to Gateway

Transfer a single script or media file at a time from the Operations Console.
Procedure

Step 1 Log in to the Operations Console and from the Device Management menu, select the type of server to which to transfer the script file.

Example:
To transfer a script or a media file to a Gateway, select Device Management > Gateway.

The Find, Add, Delete, Edit window lists any servers that have been added to the Operations Console.

Step 2 Select a server by clicking the link in its Hostname field or by clicking the radio button preceding it and then clicking Edit.

Step 3 Select File Transfer in the toolbar, and then click Scripts and Media.

The Scripts and Media File Transfer page appears, listing the host name and IP address for the selected device. Script and Media files currently stored in the Operations Server database are listed in the Select From available Script Files drop box.

Step 4 If the script or media file is not listed in the Select From Available Script Files drop box:

a) Click Select a Script or Media File from Your Local PC.

b) Enter the file name in the text box or click Browse to search for the script or media file on the local file system.

Step 5 If the script or media file is listed in the Select From Available Script Files drop box, select the script or media file.

Step 6 Click Transfer to send the file to the device.

VoiceXML Gateway

The VoiceXML Gateway parses and renders VoiceXML documents obtained from the Unified CVP Call Server (from its IVR Service), the Unified CVP VXML Servers, or some other external VoiceXML source. Rendering a VoiceXML document consists of retrieving and playing prerecorded audio files, collecting and processing user input, or connecting to an ASR/TTS Server for voice recognition and dynamic text-to-speech conversion.

For a discussion of using mixed codecs in CVP deployments, see Mixed G.729 and G.711 Codec Support, on page 392. For a discussion of the benefits and drawbacks of each codec, refer to Voice Traffic section of Solution Design Guide for Cisco Unified Contact Center Enterprise.

Note
VoiceXML Gateway must not have a load balanced path because this route on the VoiceXML Gateway will cause a call HTTP Client Error. If the VoiceXML Gateway has a load balancing route to the CVP Call Server, it may use a different source address to send HTTP message to the CVP Call Server. CVP would return a 500 Server Error address to send HTTP message to CVP Call Server, which would cause CVP to return a 500 Server Error message.

Related Topics
Mixed G.729 and G.711 Codec Support, on page 392
Configuration

The high-availability configuration for VoiceXML Gateways is controlled by the SIP proxy for SIP, or the Unified CVP Call Server (Call Server). Whether the VoiceXML Gateways are distributed or centralized also influences how high availability is achieved.

If a Call Server is unable to connect to a VoiceXML Gateway, an error is returned to the ICM script. In the ICM script, the Send to VRU node is separate from the first Run External script node in order to catch the VoiceXML Gateway connection error. If an END script node is used off the X-path of the Send to VRU node, the call is default-routed by survivability on the originating gateway. (Survivability does not apply in VRU-only models.) A Queue to Skill group node is effective only if there is an agent available. Otherwise, ICM tries to queue the caller, and that attempt fails because the Call Server is once again unable to connect to a VoiceXML Gateway. An END node could then also be used off the X-path of the Queue to Skill Group node to default-route the call.

Note

VoiceXML Server uses two features that assist with load balancing:

- Limiting load balancer involvement
- Enhanced HTTP probes for load balancers


Centralized VoiceXML Gateways

In this configuration, the VoiceXML Gateways reside in the same data center as the Unified CVP Call Server.

SIP VoiceXML Gateways

If you are using SIP static routes on the Unified CVP Call Server, under the SIP Service configuration for the Call Server, configure a static route for each Network VRU label and gateway. If the VRU label is 5551000, the static route pattern would be 5551000$. The $ is a wildcard representing one or more digits, and it is needed so that the correlation-id appended to the DNIS number can be passed to the VoiceXML Gateway correctly.

Note

Other wildcard characters can be used. See the topic Valid Formats for Dialed Numbers in the Ops Console online help for complete wildcard format and precedence information.

In the case of both SIP proxy or Unified CVP static routes, the next-hop address of the route can be either the IP address of the gateway or a DNS SRV record. If you are using an IP address, you must create multiple static routes, one for each VoiceXML Gateway. In the case of DNS SRV, only one route for each Network VRU label is needed, and the SRV record provides for load balancing and redundancy.

High-Availability Hardware Configuration on Voice Gateways

The individual hardware components have the following high-availability options:
- Redundant power supplies
- Separate components for higher availability
- Dedicated components, which have fewer interaction issues

**Example 1:** Separate PSTN Gateway and VoiceXML Gateway

A PSTN Gateway and a separate VoiceXML Gateway provide greater availability for a combined PSTN and VoiceXML Gateway.

**Example 2:** Duplicate components for higher availability

- Two 8-T1 PSTN Gateways provide greater availability than one 16-T1 PSTN Gateway.
- Two 96-port Unified CVP VXML Servers provide greater availability than one 192-port Unified CVP VXML Server.
- Larger designs can use N+1 spares for higher availability.

**Example 3:** Geographic redundancy for higher availability

Geographical redundancy and high availability can be achieved by purchasing duplicate hardware for Side A and Side B.

**Distributed VoiceXML Gateways**

In this configuration, the gateway that processes the incoming call from the PSTN is separated from the Unified CVP servers by a low-bandwidth connection such as a WAN. The VoiceXML Gateway is different from the Ingress Gateway and can be located at the same site. The configuration keeps the media stream at the same site and without consuming bandwidth on the WAN and optimizes VoiceXML Gateway sizing when it is appropriate to separate Ingress and VoiceXML Gateways. In this case, setTransferLabel and Send to Originator cannot be used because you do not want the IVR leg of the call to go back to the Ingress Voice Gateway. It is also impractical to use a SIP Proxy to control the call routing because you would have to configure separate Network VRUs, Network VRU labels, and customers in ICM for each remote site. Instead, use SetSigDigits functionality.

With this method, the Call Server strips the leading significant digits from the incoming DNIS number. The value that is stripped is saved and prepended when subsequent transfers for the call occur.

**SIP VoiceXML Gateways**

When SIP is used, the significant digits are prepended to the DNIS number, and a SIP Proxy can be configured to route calls based on those prepended digits. The static routes in the SIP Proxy for the VoiceXML Gateway should have the digits prepended. Because these prepended digits were originally populated by the Ingress Gateway, the SIP Proxy can use them to determine which VoiceXML Gateway to use based on the incoming gateway. In this way, calls arriving at a particular site can always be sent back to VoiceXML treatment, with the result that no WAN bandwidth is used to carry the voice RTP stream. The Unified CVP indiscriminately prepends the `sigdigits` value to all transfers, including those to Unified CM. Therefore, when using Unified CM in this scenario, it is necessary to strip the prepended digits when the call arrives, so that the real DNIS number of the phone can be used by Unified CM to route the call, as illustrated in the following example.

---

**Note**

The configurations mentioned below are only applicable to IOS Voice Gateway.
Configuration of Ingress Voice Gateway:

Apply a translation rule to the incoming DNIS to prepend the value 3333:

```plaintext
translation-rule 99
rule 1 8002324444 33338002324444
dial-peer voice 1000 voip
translate-outgoing called 99
```

Assuming the DNIS number is 8002324444, the final DNIS string routed to Unified CVP is 33338002324444.

**Configuration of Unified CVP SIP service:**

To configure the SIP service, in the Operations Console, select Call Server > SIP. Many of the settings are in the Advanced Configuration window.

**Configuration of IOS VoiceXML Gateway:**

Configure the VoiceXML Gateway to match the DNIS string, including the prepended digits:

```plaintext
dial-peer voice 3000 voip
incoming-called number 33335551000T
service bootstrap
...
```

Configure the Unified CVP bootstrap.tcl application with the sigdigits parameter, indicating how many digits to strip off of the incoming DNIS string:

```plaintext
application
service bootstrap flash:bootstrap.tcl
param sigdigits 4
...
```

**Cisco Unified CM configuration (if used):**

Configure Unified CM to strip the prepended digits, either by using the Significant Digits configuration on the SIP Trunk configuration page or by using translation patterns.

**SIP Proxy configuration:**

Define static routes on the SIP Proxy, with the prepended digit present, to be sent to the appropriate VoiceXML Gateway. Because transfers to agents on a Unified CM cluster have prepended digits, the static routes for agent phones must also contain the prepended digits.

**Summary of call routing:**

1. A call arrives at Unified CVP with a DNIS number of 33338002324444.
2. Unified CVP removes four digits (3333) from the beginning of the DNIS string, leaving 8002324444.
3. The number 8002324444 is passed to ICM for call routing.
4. When it is time to transfer, ICM returns the label 5551000102. Unified CVP prepends 3333, resulting 33335551000102.
5. The SIP Service then resolves the address using the SIP Proxy or local static routes, and it sends the call to the VoiceXML Gateway.
6. The VoiceXML Gateway bootstrap.tcl removes 3333, leaving 5551000102 for the destination address.
Cache Types

There are two types of cache involved in storing media files: the IVR Media Player cache and the HTTP Client cache.

The HTTP Client cache is used for storing files that are downloaded from the HTTP server. In nonstreaming mode, the entire media file is stored inside the HTTP Client cache. In streaming mode, the first chunk of the media file is stored in the HTTP Client cache and in the IVR cache, and all subsequent chunks of the file are saved in the IVR cache only. The HTTP Client cache can store 100 MB of prompts, while the IVR cache is limited to 32 MB.

Use only nonstreaming mode, so that the IVR prompt cache is never used and the HTTP Client cache is the primary cache. In nonstreaming mode, the HTTP Client cache can also store 100 MB of prompts, while the IVR cache is limited to 16 MB.

To configure the HTTP Client cache, use the following Cisco IOS commands:

**http client cache memory file 1-10000**

The 1–10000 value is the file size in kilobytes. The default maximum file size is 50 KB, but you can also have a file size up to 600 KB file size. Any file that is larger than the configured HTTP Client memory file size will not be cached.

**http client cache memory pool 0-100000**

The 0–100000 value is the total memory size available for all prompts, expressed in kilobytes. A value of zero disables HTTP caching. The default memory pool size for the HTTP Client cache is 10 MB. The memory pool size is the total size of all prompts stored on the media server, which is up to 100 MB.
Gateway Configuration

Cache Types
Cisco VVB Configuration

- Configure Cisco VVB on Unified CVP, on page 235
- Configure Cisco VVB Call Flow, on page 237
- Configure Cisco VVB Settings for Standalone Call Flow Model, on page 238
- Configure Cisco VVB Settings for Comprehensive Call Flow Model, on page 239
- Configure Cisco VVB Settings for VRU-Only Call Flow Model, on page 241
- Configure Error Application, on page 243
- Configure SIP Triggers, on page 244
- Configure SIP Properties, on page 245
- Configure SIP RAI, on page 246
- Configure Speech Servers, on page 246
- Configure Prompt Management, on page 249
- Configure System Parameters, on page 251
- IP Address and Hostname Management, on page 254
- Configure Reporting and Monitoring Services, on page 257
- Cisco VVB Real-Time Reports, on page 259

Configure Cisco VVB on Unified CVP

**Procedure**

**Step 1**
Log in to CVP Operations Console and click **Device Management** > **Virtualized Voice Browser**.

**Step 2**
Click **Add New**.

**Note**
To use an existing Virtualized Voice Browser (VVB) as a template for configuring a new VVB, select a VVB from the list of available VVB and click **Use As Template** and perform Steps 3 to 5.

**Step 3**
In the **General** tab, enter the field values, and click **Save**.

To configure General settings on a VVB, on the **General** tab, enter the field values, as listed in the following table:
### Table 43: General Settings

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
<th>Default</th>
<th>Range</th>
</tr>
</thead>
<tbody>
<tr>
<td>IP Address</td>
<td>The IP address of the VVB.</td>
<td>None</td>
<td>Valid IP address</td>
</tr>
<tr>
<td>Hostname</td>
<td>The name of the VVB.</td>
<td>None</td>
<td>Valid DNS name, which can include letters in the alphabet, the numbers 0 to 9, and a hyphen</td>
</tr>
<tr>
<td>Description</td>
<td>The description of the VVB.</td>
<td>None</td>
<td>Up to 1024 characters</td>
</tr>
<tr>
<td>Enable secure communication with the Ops console</td>
<td>Select to enable secure communications between the Operations Console and VVB.</td>
<td>Off</td>
<td>On or Off</td>
</tr>
</tbody>
</table>

### Table 44: Administration Credentials Settings

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Username</td>
<td>Username to access the device (VVB Operations Console password). If specified, the username must be configured on the device.</td>
</tr>
<tr>
<td>User Password</td>
<td>Password to access the device (VVB Operations Console password). The password must be configured on the device.</td>
</tr>
</tbody>
</table>

### Table 45: Cisco VVB Serviceability Fields

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
<th>Data Range</th>
<th>Default</th>
</tr>
</thead>
<tbody>
<tr>
<td>Enable Serviceability</td>
<td>Check to enable this feature.</td>
<td>N/A</td>
<td>Not Checked</td>
</tr>
<tr>
<td>Username</td>
<td>The username (ssh or system CLI credentials) required to sign in as system CLI credentials. For Cisco VVB, the username is typically a VVB CLI Platform credentials.</td>
<td>Valid names contain uppercase and lowercase alphanumeric characters, period, dash and underscore.</td>
<td>N/A</td>
</tr>
<tr>
<td>Password/Confirm Password</td>
<td>The password required to sign in (VVB CLI Platform credentials).</td>
<td>Any text that follows the requirements for choosing secure passwords.</td>
<td>N/A</td>
</tr>
</tbody>
</table>
Port on which Serviceability is configured on Cisco VVB.

**Note**
- In the **Username and Passwords** panel there is a button labeled **Test Sign-In**. Clicking **Test Sign In** attempts to verify the operations console credentials by connecting to the Cisco VVB. A message appears with the test result.
- To use an existing VVB as a template for creating the new VVB, select the VVB by clicking the radio button preceding it, and then click **Use As Template**.

**Step 4** (Optional) On the **Device Pool** tab, select the field values and move to **Selected**.

**Step 5** Click **Save**.

**Related Topics**
- Add or Remove Device From Device Pool, on page 98

## Configure Cisco VVB Call Flow

Cisco VVB provides the standard list of scripts that require you to configure for the Unified CVP call flow to work. The primary steps are to create application and assign corresponding SIP trigger.

Log in to Cisco VVB Administration Console and follow these tasks:

**Procedure**

**Step 1** Create an application to define the call flow through the scripts.

To configure standalone application, see Configure Cisco VVB Settings for Standalone Call Flow Model, on page 238.

To configure comprehensive and ringtone application, see Configure Cisco VVB Settings for Comprehensive Call Flow Model, on page 239.

To configure error application, see Configure Error Application, on page 243.

**Step 2** Create triggers to invoke an application using the incoming directory number.

To configure the trigger, see Configure SIP Triggers, on page 244.

**Step 3** Cisco VVB can play recorded audio prompts and detect DTMF tones. To recognize speech and play text, configure Automatic Speech Recognition (ASR) and Text-To-Speech (TTS).

To configure ASR and TTS, see Configure Speech Servers, on page 246.

**Step 4** Manage prompt files to add custom ringtone for comprehensive call flow or to use custom prompts.
To configure and manage prompts, see Configure Prompt Management, on page 249.

Related Topics
- Configure Cisco VVB Settings for Standalone Call Flow Model, on page 238
- Configure Cisco VVB Settings for Comprehensive Call Flow Model, on page 239
- Configure Error Application, on page 243
- Configure SIP Triggers, on page 244
- Configure Speech Servers, on page 246
- Configure Prompt Management, on page 249

Configure Cisco VVB Settings for Standalone Call Flow Model

Procedure

Step 1  From Cisco VVB Administration menu bar, choose **Applications > Application Management**.

Step 2  Click the **Add New** icon that is displayed in the toolbar in the upper left corner of the window or the **Add New** button that is displayed at the bottom of the window.

Step 3  (Mandatory) Type the application name in the **Name** field.

Step 4  The **Maximum Number of Sessions** field is prepopulated based on the OVA profile. You can edit this field. **Note** This number must not exceed the maximum number of ports supported for Cisco VVB profile. For more information, see [Virtualization for Cisco Virtualized Voice Browser](https://www.cisco.com/c/dam/en/us/td/docs/voice_ip_comm/uc_system/virtualization/virtualization-cisco-virtualized-voice-browser.html) available at https://www.cisco.com/c/dam/en/us/td/docs/voice_ip_comm/uc_system/virtualization/virtualization-cisco-virtualized-voice-browser.html.

Step 5  Select the **SelfService.aef** script from the drop-down list for a standalone application.

The following table describes the parameters:

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Description</th>
<th>Default</th>
<th>Base Type</th>
</tr>
</thead>
<tbody>
<tr>
<td>Application Name</td>
<td>Application name that is present on the VXML server. Mandatory field to enter.</td>
<td>&quot;HelloWorld&quot;</td>
<td>Alphanumeric</td>
</tr>
<tr>
<td>Port</td>
<td>Port on which the VXML server or load balancer is running. <strong>Note</strong> Ports 7000/7443 must be configured for interworking with CVP Release 11.5 and later. For earlier versions of CVP, configure ports 8000/8443.</td>
<td>&quot;7000&quot;</td>
<td>Numeric</td>
</tr>
<tr>
<td>PrimaryVXMLServer</td>
<td>VXML server or load balancer IP address. <strong>Note</strong> VXML server backup server IP address.</td>
<td>***</td>
<td>Alphanumeric</td>
</tr>
<tr>
<td>BackupVXMLServer</td>
<td>VXML server backup server IP address. <strong>Note</strong> VXML server backup server IP address.</td>
<td>***</td>
<td>Alphanumeric</td>
</tr>
<tr>
<td>Parameter</td>
<td>Description</td>
<td>Default</td>
<td>Base Type</td>
</tr>
<tr>
<td>-----------</td>
<td>-------------</td>
<td>---------</td>
<td>-----------</td>
</tr>
<tr>
<td>Secured</td>
<td>If enabled, HTTPS is used while fetching VXML application from Unified CVP. By default it is not enabled.</td>
<td>false</td>
<td>Boolean</td>
</tr>
</tbody>
</table>

**Note**
If you have enabled secure communication, then ensure to:

1. Change the port number in the above field to 7443.
2. Upload the relevant certificate. To upload certificate, see *Upload certificate or certificate trust list* topic in *Cisco Unified Communications Operating System Administration Guide*.
3. Restart Tomcat server and Engine from command line.

**Step 6**
Use the Tab key to automatically populate the **Description** field.

**Step 7**
Enable the application by selecting the radio button. You can choose to disable the application to retain the configurations for later use.

**Step 8**
Click **Add**.

The Cisco Script Application page refreshes and the **Add New Trigger** hyperlink appears in the left navigation bar. The following message is displayed in the status bar on top:

*The operation has been executed successfully.*

**Step 9**
Create a trigger using the **Add New Trigger** hyperlink or follow the procedure Configure SIP Triggers, on page 244.

**Related Topics**
Configure SIP Triggers, on page 244

---

**Configure Cisco VVB Settings for Comprehensive Call Flow Model**

This topic provides information about comprehensive and ringtone applications.

---

**Note**
Cisco VVB is prepopulated with comprehensive application (also called bootstrap) and the ringtone application.

To create a custom comprehensive (CVP/VRU comprehensive) or ringtone application, follow the steps:
Procedure

Step 1 From Cisco VVB Administration menu bar, choose Applications > Application Management.

Step 2 Click Add New.

Step 3 (Mandatory) Type the application name in the Name field.

Step 4 The Maximum Number of Sessions field is prepopulated based on the OVA profile. You can edit this field.

Note This number must not exceed the maximum number of ports supported for Cisco VVB profile. For more information, see Virtualization for Cisco Virtualized Voice Browser available at https://www.cisco.com/c/dam/en/us/td/docs/voice_ip_comm/uc_system/virtualization/virtualization-cisco-virtualized-voice-browser.html.

Step 5 Select the script from the drop-down list.

The following scripts are provided for comprehensive call flow:

- CVPComprehensive.aef (bootstrap)
- Ringtone.aef

The following table describes the parameters:

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Description</th>
<th>Default</th>
<th>Base Type</th>
</tr>
</thead>
<tbody>
<tr>
<td>Secured</td>
<td>If enabled, HTTPS is used while fetching VXML application from Unified CVP. By default, it is not enabled.</td>
<td>false</td>
<td>Boolean</td>
</tr>
<tr>
<td></td>
<td>Note: If you have enabled secure communication, then ensure to:</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>1. Upload the relevant certificate. To upload certificate, see Upload certificate or certificate trust list topic in Cisco Unified Communications Operating System Administration Guide.</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>2. Restart Tomcat server and Engine from command line. If you are using a coresident VXML and Call Server, use CA-signed certificate.</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>
**Configure Cisco VVB Settings for VRU-Only Call Flow Model**

This topic provides information to create VRU-Only applications.

Use the `VRUComprehensive.aef` script if your CVP implementation needs to support non-reference VRU call flows or VRU-Only call flows. For more details on non-reference call flows, see Solution Design Guide for Cisco Unified Contact Center Enterprise.

To support the comprehensive call flow in addition to the non-reference VRU call flows, add relevant options to this script. The `CVPComprehensive` script must not be separately configured to handle a mixed implementation.

To create a VRU-Only application, follow the steps:

**Procedure**

<table>
<thead>
<tr>
<th>Step</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>From Cisco VVB Administration menu bar, choose <strong>Applications &gt; Application Management.</strong></td>
</tr>
<tr>
<td>2</td>
<td>Click <strong>Add New</strong>.</td>
</tr>
<tr>
<td>3</td>
<td>(Mandatory) Type the application name in the <strong>Name</strong> field.</td>
</tr>
<tr>
<td>4</td>
<td>The <strong>Maximum Number of Sessions</strong> field is prepopulated based on the OVA profile. You can edit this field.</td>
</tr>
</tbody>
</table>

**Related Topics**
- Configure SIP Triggers, on page 244
**Note**: This number must not exceed the maximum number of ports supported for Cisco VVB profile. For more information, see Virtualization for Cisco Virtualized Voice Browser available at https://www.cisco.com/c/dam/en/us/td/docs/voice_ip_comm/uc_system/virtualization/virtualization-cisco-virtualized-voice-browser.html.

**Step 5**: From the **Script** drop-down list, select the `VRUComprehensive.aef` script.

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Description</th>
<th>Default</th>
<th>Base Type</th>
</tr>
</thead>
<tbody>
<tr>
<td>PrimaryVXMLServer</td>
<td>VXML server or load balancer IP address</td>
<td>***</td>
<td>Alphanumeric</td>
</tr>
<tr>
<td>BackupVXMLServer</td>
<td>VXML backup server or load balancer IP address</td>
<td>***</td>
<td>Alphanumeric</td>
</tr>
<tr>
<td>Port</td>
<td>Port on which VXML server or load balancer is running.</td>
<td>&quot;7000&quot;</td>
<td>Numeric</td>
</tr>
<tr>
<td></td>
<td><strong>Note</strong>: Ports 7000/7443 must be configured for interworking with CVP Release 11.5 and later. For earlier versions of CVP, configure ports 8000/8443.</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Secured</td>
<td>If enabled, HTTPS is used while fetching VXML application from Unified CVP. By default, Secured is not enabled.</td>
<td>false</td>
<td>Boolean</td>
</tr>
<tr>
<td></td>
<td><strong>Note</strong>: If you have enabled secure communication, then ensure to:</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>1. Change the port number to 7443.</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>2. Upload the relevant certificate. To upload certificate, see Upload certificate or certificate trust list topic in Configuration Guide for Cisco Unified Customer Voice Portal.</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>3. Restart Tomcat server and engine from command line.</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>If you are using a co-resident VXML and Call Server, use a CA-signed certificate.</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>
### Configure Error Application

To create a comprehensive application, follow the steps:

**Procedure**

<table>
<thead>
<tr>
<th>Step</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Step 1</strong></td>
<td>From Cisco VVB Administration menu bar, choose <strong>Applications &gt; Application Management.</strong></td>
</tr>
<tr>
<td><strong>Step 2</strong></td>
<td>Click <strong>Add New.</strong></td>
</tr>
<tr>
<td><strong>Step 3</strong></td>
<td>(Mandatory) Type the application name in the Name field.</td>
</tr>
<tr>
<td><strong>Step 4</strong></td>
<td>The Maximum Number of Sessions field is prepopulated based on the OVA profile. You can edit this field. <strong>Note</strong> This number must not exceed the maximum number of ports supported for Cisco VVB profile. For more information, see <a href="https://www.cisco.com/c/dam/en/us/td/docs/voice_ip_comm/uc_system/virtualization/virtualization-cisco-virtualized-voice-browser.html">Virtualization for Cisco Virtualized Voice Browser</a> available at <a href="https://www.cisco.com/c/dam/en/us/td/docs/voice_ip_comm/uc_system/virtualization/virtualization-cisco-virtualized-voice-browser.html">https://www.cisco.com/c/dam/en/us/td/docs/voice_ip_comm/uc_system/virtualization/virtualization-cisco-virtualized-voice-browser.html</a>.</td>
</tr>
<tr>
<td><strong>Step 5</strong></td>
<td>Select the Error.aef script from the drop-down list. This script is used to play error tone.</td>
</tr>
</tbody>
</table>
The following table describes the parameter details:

<table>
<thead>
<tr>
<th>Parameter</th>
<th>Default</th>
<th>Base Type</th>
</tr>
</thead>
<tbody>
<tr>
<td>CVPErrorPrompt—Select and associate custom wav file from VVB application. To override system default wav file, upload custom wav file from Prompt Management menu.</td>
<td>92929292</td>
<td>Numeric</td>
</tr>
</tbody>
</table>

**Note**
You can upload custom wav files only for Error.aef script.

**Step 6**
Use the Tab key to automatically populate the Description field.

**Step 7**
Enable the application by selecting the radio button. You can choose to disable the application to retain the configurations for later use.

**Step 8**
Click Add.

Cisco Script Application page is refreshed and the Add New Trigger hyperlink appears in the left navigation bar. The following message is displayed in the status bar on top:

The operation has been executed successfully.

**Step 9**
Create a trigger using the Add New Trigger hyperlink or follow the procedure Configure SIP Triggers, on page 244.

**Related Topics**
Configure SIP Triggers, on page 244

### Configure SIP Triggers

A SIP trigger responds to calls that arrive on a specific route point, and uses telephony and media resources to complete the call and to invoke the application script.

You must add SIP triggers to invoke Cisco applications in response to incoming contacts.

### Add SIP Trigger

To add a SIP trigger:

**Procedure**

**Step 1**
From Cisco VVB Administration menu bar, choose Subsystems > SIP Telephony > SIP Triggers.

**Step 2**
Click Add New and enter the following fields:

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Directory Information</td>
<td></td>
</tr>
</tbody>
</table>
A unique phone number. The value includes digits and optionally includes wildcard character "." to mask a single digit or "*" to mask multiple digits.

Examples of valid Directory Numbers: 9191* or 5755*!>T.X

Examples for valid triggers:
- 10.919191 where 10. is the same as 101, 102
- *12* or 12*23 where *12* is the same as "*" and 12*23 is the same as 12*

### Trigger Information

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
</table>
| Dial Number Pattern          | A unique phone number. The value includes digits and optionally includes wildcard character "." to mask a single digit or "*" to mask multiple digits. Examples of valid Directory Numbers: 9191* or 5755*!>T.X
| Trigger Information          | From the drop-down list, choose the application to associate with the trigger. |

#### Advanced Trigger Information (available only if you click Show More)

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Enabled</td>
<td>Click a radio button to choose the required option:</td>
</tr>
<tr>
<td></td>
<td>- Yes—Enable the trigger (default)</td>
</tr>
<tr>
<td></td>
<td>- No—Disable the trigger</td>
</tr>
<tr>
<td>Idle Timeout (in ms)</td>
<td>The number of milliseconds (ms) the system waits before rejecting the SIP request for this trigger.</td>
</tr>
<tr>
<td>Override Media Termination</td>
<td>Click a radio button to choose the required options:</td>
</tr>
<tr>
<td></td>
<td>Yes—Override media termination.</td>
</tr>
<tr>
<td></td>
<td>No—Enable media termination (default).</td>
</tr>
<tr>
<td>Description</td>
<td>Click the Tab key to populate it.</td>
</tr>
</tbody>
</table>

The new trigger is created and listed on the SIP Trigger page.

### Configure SIP Properties

Cisco VVB does not send 180 Ringing Provisional Response for an incoming SIP INVITE. To enable SIP 180 Ringing Provisional Response:
**Configure SIP RAI**

The Resource Available Indication (RAI) feature supports:
- Monitoring of CPU and memory resources
- Reporting of VVB resource status to an externally configured device

To configure RAI to a server:

**Procedure**

**Step 1** From the Cisco VVB Administration menu bar, choose **Subsystems > SIP Telephony > SIP RAI**.
**Step 2** On the SIP RAI Configuration page, click **Add New**.
**Step 3** Enter the following fields:

<table>
<thead>
<tr>
<th>Field</th>
<th>Default Value / Range</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Server Name</td>
<td></td>
<td>Hostname or IP address of SIP server.</td>
</tr>
<tr>
<td>Port</td>
<td>5060 Range: 1 to 65535</td>
<td>SIP server port number for communication.</td>
</tr>
<tr>
<td>Interval</td>
<td>60 Range: 30 to 86400 (in seconds)</td>
<td>Interval time to send RAI reports.</td>
</tr>
</tbody>
</table>

**Step 4** Click **Add** to add a SIP server.
**Step 5** (Optional) To update a server port or interval time, click the server name and update the **Port** and **Interval** fields.
**Step 6** (Optional) To delete a server, click the **Delete** icon present on the SIP RAI List or from the update server page.

**Configure Speech Servers**

Cisco VVB supports ASR and TTS through two subsystems:
ASR
This subsystem allows users to navigate through a menu of options by speaking instead of pressing keys on a touch-tone telephone.

TTS
This subsystem converts plain text into spoken words to provide a user with information, or prompt a user to respond to an action.

---

**Note**
Only G711 codec is supported for ASR and TTS integrations.

---

### Prepare to Provision ASR/TTS

The customer must perform the following tasks:

- Order ASR and TTS speech servers from Cisco-supported vendors.

**Note**

- Work with the ASR and TTS vendor to size the solutions.
- Provision, install, and configure the ASR and TTS vendor software on a different server (in the same LAN) and not where the Cisco VVB runs.

### Provision ASR Servers

Use the Automatic Speech Recognition Server Configuration web page to specify information about the speech server name and port location.

**Procedure**

**Step 1**
From the Cisco VVB Administration menu bar, choose **Subsystems > Speech Servers > ASR Servers**.

<table>
<thead>
<tr>
<th>Column</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Server Name</strong></td>
<td>Hostname or IP address of the ASR server.</td>
</tr>
<tr>
<td><strong>Note</strong></td>
<td>ASR server deployment over WAN is not supported in Cisco VVB. Place the ASR server in the same LAN as Cisco VVB. You need to specify the ASR server hostname or IP address that is local with Cisco VVB node while installing the ASR server software in this field.</td>
</tr>
<tr>
<td><strong>Port</strong></td>
<td>Port number used to connect to a Speech server.</td>
</tr>
<tr>
<td><strong>Status</strong></td>
<td>Status or state of the server.</td>
</tr>
</tbody>
</table>
Step 2  Click the Add New button to provision a new ASR Server.

Step 3  Enter the following fields:

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Server Name</td>
<td>Hostname or IP address of the ASR server.</td>
</tr>
<tr>
<td>Port Number</td>
<td>Port numbers that are used to connect to a Speech server. The default value for MRCPv1 is 4900 and for MRCPv2 is 5060.</td>
</tr>
<tr>
<td><strong>Note</strong></td>
<td>If the administrator has configured any other the port value for MRCP/ASR servers, then use the same port value here. Do not use these default values. Whenever the administrator changes from MRCP protocol, ensure ASR server is deleted and re-created with the appropriate port values.</td>
</tr>
</tbody>
</table>

Step 4  Click Add to apply the changes.

Step 5  (Optional) Click the Refresh button to refresh the status of the server.

---

**Provision TTS Servers**

Use the Text-to-Speech Server Configuration web page to configure the TTS server name and port location.

**Procedure**

Step 1  From the Cisco VVB Administration menu bar, choose Subsystems > Speech Servers > TTS Servers.

The TTS Server Configuration web page opens displaying a list of previously configured servers, if applicable, with the following information:

<table>
<thead>
<tr>
<th>Column</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Server Name</td>
<td>Hostname or IP address of the TTS server.</td>
</tr>
<tr>
<td><strong>Note</strong></td>
<td>TTS server deployment over WAN is not supported in Cisco VVB. In other words, the TTS servers must be in the same LAN as Cisco VVB. Therefore, you need to specify the TTS server hostname or IP address that is local with Cisco VVB node while installing the TTS server software in this field.</td>
</tr>
<tr>
<td>Port Number</td>
<td>Port number used to connect to a Speech server.</td>
</tr>
<tr>
<td>Status</td>
<td>Status or state of the server.</td>
</tr>
</tbody>
</table>

Step 2  Click the Add New button to provision a new TTS Server.

Step 3  Enter the following fields:
Configure Prompt Management

Several system-level prompt files are loaded during Cisco VVB installation. However, any file you create must be made available to Cisco VVB Engine before Cisco VVB application can use it. Files are made available through Cisco VVB Repository datastore, where the prompt files are created, stored, and updated.

Manage Prompt Files

Many applications make use of prerecorded prompts. These are stored as .wav or .au files, and are played back to the callers to provide information and elicit caller response.

To access the Prompt Management page:

Procedure

Step 1 From Cisco VVB Administration menu bar, choose Applications > Prompt Management.
Step 2 The Prompt Management page opens to display the following fields.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Name of the folder.</td>
</tr>
<tr>
<td>Size</td>
<td>The size of the prompt file in kilobytes (KB).</td>
</tr>
<tr>
<td>Date Modified</td>
<td>The date and time when the document was last uploaded or changed along with the time zone.</td>
</tr>
</tbody>
</table>

Note: This column is usually blank on the root page because the items on this page are usually folders.

The maximum limit for the uploaded prompt file is 20MB.
### Local Audio Files Stored on VVB

**Local Audio Files Stored on VVB**

Local audio files that are uploaded to default prompt folder of VVB can be accessed by setting the audio source path starting with "flash:" in microapps or VXML application. The audio files must be pre-uploaded to default folder.

**Example:** "flash:holdmusic.wav"

If you are creating a custom folder in prompt management and uploading an audio file, then mention the folder name in the URL.

**Example:** flash://<folder_name>/<file_name>

### Overriding Default Ringtone using CVP

Follow these steps to override default ringtone:

1. Go to **System > Dialed Number Pattern**.
2. From the listed patterns, click **Pattern** for which custom ringtone needs to be added.
3. From **Dialed Number Pattern Types**, check the **Enable Custom Ringtone** check box.
4. Specify the custom ringtone filename in the text box.

**Note**

- Custom ringtone cannot be named to ringback.wav.
- The audio file in Cisco VVB and the filename you entered in CVP under DNP is case-sensitive (should be same with .wav extension)
Configure System Parameters

Use the System Parameters web page to configure system parameters such as port settings and locale settings and to default session timeout.

The parameters in the System Parameters Configuration page are grouped logically into sections with headings. Each parameter has a corresponding suggested or default value on the right side of the page. Where applicable, radio buttons are used to toggle between the parameter options.

Choose System > System Parameters from the Cisco VVB Administration menu bar to access the System Parameters Configuration web page.

Manage System Parameters

Procedure

Step 1
From Cisco VVB Administration menu bar, choose System > System Parameters.

Step 2
To update, click the Update icon in the toolbar or the Update button at the bottom of the window.

The System Parameters Configuration web page displays the following fields.

Table 46: System Parameters Configuration

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Generic System Parameter</strong></td>
<td></td>
</tr>
<tr>
<td>System Time Zone</td>
<td>The system time zone of Cisco VVB server configured during installation.</td>
</tr>
<tr>
<td><strong>Media Parameters</strong></td>
<td></td>
</tr>
<tr>
<td>Codec</td>
<td>G711 and G729 audio codecs with sampling rate 8K are supported.</td>
</tr>
<tr>
<td></td>
<td>Default: G711U</td>
</tr>
<tr>
<td>MRCP Version</td>
<td>Default: MRCPv2</td>
</tr>
<tr>
<td><strong>Note</strong></td>
<td></td>
</tr>
<tr>
<td></td>
<td>• The default value for ASR/TTS server port for MRCPv1 is 4900 and for MRCPv2 is 5060. Whenever the administrator changes from MRCP protocol, ensure ASR/TTS server is deleted and re-created with appropriate port values.</td>
</tr>
<tr>
<td></td>
<td>• ASR-TTS service is not supported using G729 codec; therefore, MRCP is not applicable.</td>
</tr>
<tr>
<td>Field</td>
<td>Description</td>
</tr>
<tr>
<td>------------------------------</td>
<td>-------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>User Prompts override System Prompts</td>
<td>When enabled, custom recorded prompt files can be uploaded to the appropriate language directory under <strong>Prompt Management</strong>. The custom prompts override the system default prompt files for that language. By default, this feature is disabled.</td>
</tr>
<tr>
<td>Note</td>
<td>For overriding the system default prompt files for ringtone application:</td>
</tr>
<tr>
<td></td>
<td>• Create a new folder named <em>vb</em>, select <strong>Applications &gt; Prompt Management</strong> and click <strong>Create New Folder</strong>.</td>
</tr>
<tr>
<td></td>
<td>• Upload the custom ringtone, choose <strong>Applications &gt; Prompt Management</strong> and click <strong>Upload Prompt</strong>. Upload custom ringtone wav file (named same as <em>ringback.wav</em>) under folder <em>vb</em>.</td>
</tr>
</tbody>
</table>

**Security Parameters**

| Note                       | Cisco VVB Engine restart is required after a change to this configuration.                                                                                                                                 |

<p>| Supported TLS(SIP) Versions | This allows you to select one or more versions of TLS (SIP). TLS (SIP) versions supported are TLSv1.0, TLSv1.1, and TLSv1.2. When you select a given TLS (SIP) version, Cisco VVB will support SIP TLS requests for this version and the higher supported versions. The default TLS (SIP) version is TLSv1.2. |
| Note                       | • Supported TLS (SIP) Versions is available only if TLS (SIP) is enabled. Cisco VVB Engine restart is required after a change to this configuration. The supported TLS (SIP) versions as client or server for securing SIP signaling in the IVR leg can alternatively be specified via the CLI command <strong>set tls server min-version</strong> as documented in the Cisco Unified Contact Center Express Administration and Operations Guide, Release 11.6(1) available at <a href="https://www.cisco.com/c/en/us/support/customer-collaboration/unified-contact-center-express/products-installation-and-configuration-guides-list.html">https://www.cisco.com/c/en/us/support/customer-collaboration/unified-contact-center-express/products-installation-and-configuration-guides-list.html</a>. |</p>
<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
</table>
| Cipher Configuration  | This field defines the ciphers, which is supported by Cisco VVB, with key size lesser than or equal to 2048 bits.  
                          The default cipher is TLS_RSA_WITH_AES_128_CBC_SHA, which is pre-populated and cannot be deleted as it is mandatory for TLSv1.2.  
                          **Note**  
                          • Cipher configuration is available only if TLS (SIP) is enabled.  
                          • Cisco VVB Engine restart is required after a change to this configuration.  
                          • If you are using CUBE version 16.6 and higher, you must manually change the crypto suite to 128 by enabling CLI on the dial-peer towards CVP as shown:  
                          ```  
                          voice class srtp-crypto 1  
                          crypto 1 AES_CM_128_HMAC_SHA1_32  
                          dial-peer voice xxxx voip (Dial-peer to CVP)  
                          ...  
                          voice-class sip srtp-crypto 1  
                          ```  
                          • VVB does not support 256-bit ciphers.  

| SRTP                  | • SRTP is disabled by default. When SRTP is disabled, the media is not encrypted.  
                          • When SRTP is enabled, it secures the IVR leg. SRTP uses Crypto-Suite AES_CM_128_HMAC_SHA1_32 for encrypting the media stream.  
                          • When **Allow RTP (Mixed mode)** check box is checked, the system accepts both SRTP and RTP call flows. This check box can be checked only when SRTP is enabled.  
                          **Note**  
                          • SRTP is available only if TLS (SIP) is enabled.  
                          • Check the **Allow RTP (Mixed mode)** check box if device is configured to work in the RTP mode and interacts with MRCP ARS-TTS servers.  
                          • Cisco VVB engine restart is required after a change to this configuration.  
                          • The VVB export unrestricted software image does not support SRTP.  

*System Port Parameter*
The port number used by Cisco VVB to serve Remote Method Invocation (RMI) requests. This field is mandatory.

Default: 6999

HTTPS Client TLS Configuration

The supported TLS versions as client for securing HTTPS signaling to fetch the VXML applications from VXML server use the CLI command `set tls client min-version` as documented in the Cisco Unified Contact Center Express Administration and Operations Guide, Release 11.6(1) https://www.cisco.com/c/en/us/support/customer-collaboration/unified-contact-center-express/

### IP Address and Hostname Management

This section provides the steps you need to follow whenever there is a change in IP address or hostname for Cisco VVB deployment.

### IP Address Modification

This section describes how to change the IP address.

#### Caution

Changing the IP address can interrupt call processing and other system functions. Also, changing the IP address can cause the system to generate certain alarms and alerts such as ServerDown. Because of this potential impact to the system, you must perform IP address changes during a planned maintenance window.

#### Note

As a prerequisite ensure that the DNS is reachable and the DNS record exists for the server if DNS is enabled.

### Change IP Address using CLI Commands

#### Before you begin

Use this procedure to change the IP address of Cisco VVB.

#### Procedure

1. **Step 1**
   
   If DNS is enabled, change the DNS record of the server to point to the new IP address.

   **Step 2**
   
   If you want to change the IP address of the server on the same subnet or a different subnet that requires a new default gateway address, then use either of the CLI Commands or Cisco Unified Operating System Administration interface.

   **Step 3**
   
   To change the default gateway, enter the following CLI command: `set network gateway <IP Address>`
The following is a sample output:

```
admin: set network gateway 10.10.10.1
*** W A R N I N G ***
This will cause the system to temporarily lose network connectivity
Continue (y/n)?
```

**Caution** Ensure that the server is moved to the new subnet and has access to the default gateway before proceeding to the following sub-step.

**Note** Skip this step if you want to change only the IP address of the server.

**Step 4**
To change the IP address of the server, enter the following CLI command: `set network ip eth0 <ip_address> <netmask> <default gateway>`

The following sample output displays:

```
admin:set network ip eth0 10.10.10.170 255.255.255.0 10.10.10.1
*** W A R N I N G ***
This command will restart system services
=======================================================================
Note: Please verify that the new ip address is unique across the cluster and, if DNS services are utilized, any DNS configuration is completed before proceeding.
=======================================================================
Continue (y/n)?
```

Enter `y` and press `Enter` to continue.

**Step 5**
Reboot the system using the CLI command `utilssystem restart`.

---

**Change IP Address using OS Administration interface**

**Procedure**

**Step 1**
Login to the Cisco Unified OS Administration using administrator login.

**Step 2**
Go to **Settings > IP > Ethernet**.

**Step 3**
Change the Port (IP Address and Subnet Mask) and Gateway information and click **Save**.

**Step 4**
The server restarts automatically with the new IP address.

**Step 5**
Reboot the system using the CLI command `utilssystem restart`.

---

**Hostname Modification**

This section describes how to change the hostname.
Caution
Changing the hostname can interrupt call processing and other system functions. Changing the hostname can also cause the system to generate certain alarms and alerts such as ServerDown. Because of this potential impact to the system, you must perform hostname changes during a planned maintenance window.

Note
If DNS is enabled, as a prerequisite ensure that the DNS is reachable and the DNS record exists for the server.

Change Hostname

Procedure

Step 1 Change the DNS record of the server to point to the new hostname. Ensure that you correctly update both the forward (A) and reverse (PTR) records, and there are no duplicate PTR records.

Step 2 You can change the hostname of the server either using the CLI (command line interface) command or using Cisco Unified OS Administration interface. To change the hostname using CLI command, go to Step 3 or to change the hostname using Cisco Unified OS Administration interface, go to Step 4.

Step 3 At the CLI prompt, enter `set network hostname` and press Enter key.

The following is a sample output:

```
*** WARNING ***
Do not close this window without first canceling the command.
This command will automatically restart system services.
The command should not be issued during normal operating hours.
=================================================================================================
Note:
Please verify that the new hostname is a unique name across the cluster and, if DNS services are utilized, any DNS configuration is completed before proceeding.
=================================================================================================
Security Warning :
This operation will regenerate all UCCX Certificates including any third party signed Certificates that have been uploaded.
Enter the hostname: 
```

Step 4 Enter the hostname and press Enter.
Step 5 Reboot the system using the CLI command `utils system restart`.

Change Hostname using OS Administration interface

Procedure

Step 1 Login to the Cisco Unified OS Administration using administrator login.

Step 2 Go to Settings > IP > Ethernet.

Step 3 Change the hostname and click Save.
Configure Reporting and Monitoring Services

Real-Time Monitoring Tool

Cisco VVB system includes software components called plug-in to enhance Cisco VVB Engine. You can download Real-Time Monitoring Tool (RTMT) plug-in from the web page.

To access the Plug-in web page, choose Tools > Plug-in from Cisco VVB Administration menu bar.

The Plug-in web page contains the following hyperlink:

- Cisco Unified Real-Time Monitoring Tool for Windows—Click this hyperlink to install client-side Cisco Unified Serviceability RTMT for Windows. RTMT uses HTTP/HTTPS and TCP to monitor device status, system performance, device discovery, and CTI applications. It also connects directly to devices by using HTTP/HTTPS for troubleshooting system problems. This plug-in is available only for users with administrator capability.

To download, click the Download hyperlink and select Save File.

Real-Time Reporting

Caution

The Real-Time Reporting (RTR) tool is a Java applet that can generate various reports that provide detailed information about the status of your Cisco VVB system. You use the Application Reporting web page to access the RTR tool.

To access the Application Reporting web page, choose Tools > Real-Time Reporting from the Cisco VVB Administration menu bar.

Note

To access RTR tool, ensure to add Cisco VVB IP address under Exception Site List in Java Control Panel > Security. Example IP address entry is as follows: https://10.10.10.10.

For more information, see Cisco VVB Real-Time Reports, on page 259.

Related Topics

- Cisco VVB Real-Time Reports, on page 259

Step 4

Reboot the system using the CLI command `utilssystem restart`. 
Logging

A trace file is a log file that records activity from the Cisco VVB component subsystems and steps. Trace files let you obtain specific, detailed information about the system that can help you troubleshoot problems. This information is stored in a trace file. To help you control the size of the trace file, you specify the components for which you want to collect information and the level of information that you want to collect.

The Cisco VVB server stores the trace files in the Log directory. You can collect and view trace information using the Real-Time Monitoring Tool (RTMT).

To activate and turn off logging, follow this procedure:

**Procedure**

**Step 1**
From the Cisco VVB Serviceability menu bar, choose **Trace > Configuration**.

**Step 2**
From the **Select Service** drop-down list box, choose **Engine** and click **Go**.

The debug levels for different Cisco VVB services might vary depending on the selected service. The Cisco VVB-related services are listed in the following table:

<table>
<thead>
<tr>
<th>Component Code</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>JASMIN</td>
<td>Java Signaling and Monitoring Interface</td>
</tr>
<tr>
<td>SIP_STACK</td>
<td>SIP Stack logging</td>
</tr>
<tr>
<td>SS_SIP</td>
<td>SIP Subsystem</td>
</tr>
<tr>
<td>SS_VB</td>
<td>Voice Browser Subsystem</td>
</tr>
<tr>
<td>SS_MRCP_ASR</td>
<td>MRCP ASR Subsystem</td>
</tr>
<tr>
<td>SS_MRCP_TTS</td>
<td>MRCP TTS Subsystem</td>
</tr>
</tbody>
</table>

**Note**
To enable XDebugging for any of the components, check the appropriate check boxes.

**Step 3**
To limit the number and size of the trace files, you can specify the trace output setting using the following two fields. See the following table for description and default values for these two fields:

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Maximum No. of Files</td>
<td>The maximum number of trace files to be retained by the system. This field specifies the total number of trace files for a given service. Cisco VVB Serviceability automatically appends a sequence number to the filename to indicate which file it is; for example, Cisco001MADM14.log. When the last file in the sequence is full, the trace data begins writing over the first file. The default value varies by service.</td>
</tr>
<tr>
<td>Maximum File Size</td>
<td>This field specifies the maximum size of the trace file in kilobytes or megabytes depending on the selected service. The default value varies by service.</td>
</tr>
</tbody>
</table>
Step 4  
Update the debug level for one or more components for the selected service of Cisco VVB by performing these steps:

1. To activate traces for a specific component or logging for a server, check the check box for the service for which you need to enable logging.

2. To turn off logging for a server, uncheck the check box.

Step 5  
Click the Save icon that displays in the toolbar in the upper left corner of the window or the Save button that displays at the bottom of the window to save your trace parameter configuration. The settings are updated in the system and the trace files are generated as per the saved settings. Click the Restore Defaults icon or button to revert to the default settings for the selected service.

Important  
Activate logging only for debugging, and remember to turn off logging after the debugging session is complete.

Service Management  
Installed automatically, network services include services that the system requires to function; for example, system services. Because these services are required for basic functionality, you cannot activate them in the Service Activation window. After the installation of your application, network services start automatically.

To start, stop, or restart Cisco VVB services, follow these steps:

Procedure

Step 1  
From the Navigation drop-down list, select Cisco VVB Serviceability.

Step 2  
Select Tools > Control Center - Network Services.

Step 3  
Select the Engine radio button and click your desired operation button.

The page displays the following information for the network services:

- Name of the network services, their dependent subsystems, managers, or components
- Status of the service (IN SERVICE, PARTIAL SERVICE, or SHUT DOWN; for individual subsystems, the status can be OUT OF SERVICE or NOT CONFIGURED)
- Start Time of the service
- Up Time of the service

Cisco VVB Real-Time Reports

Related Topics

Report Menu, on page 264
Available Cisco VVB Real-Time Reports

Cisco VVB real-time reporting provides real-time reports you can use to monitor Cisco VVB system activity. The following table briefly describes each of these reports.

<table>
<thead>
<tr>
<th>Report</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Application Tasks</td>
<td>Provides information about currently active applications.</td>
</tr>
<tr>
<td>Application Tasks Summary</td>
<td>Provides a summary of specific application activity.</td>
</tr>
<tr>
<td>Applications</td>
<td>Provides a list of all applications loaded on the Cisco VVB server.</td>
</tr>
<tr>
<td>Contacts Summary</td>
<td>Provides information for call contacts and total number of contacts.</td>
</tr>
<tr>
<td>Contacts</td>
<td>Provides information about currently active contacts.</td>
</tr>
<tr>
<td>Engine Tasks</td>
<td>Provides information about currently active Engine tasks.</td>
</tr>
<tr>
<td>Sessions</td>
<td>Provides information on all active sessions.</td>
</tr>
</tbody>
</table>

Related Topic

Report Menu, on page 264

Open Real-Time Reports

Real-Time reporting is available from the Cisco VVB Administration web interface.

Real-Time Reporting requires the Java plug-in. If the Java plug-in is not already installed on the PC on which you are viewing the reports, the Cisco VVB system automatically installs it when you choose Tools > Real Time Reporting.

Note

- Use Mozilla Firefox and Internet Explorer for Real Time Reporting.
- If you are using Mozilla Firefox, you must manually install the correct version of JRE to use real-time reports.

The Application Reporting web page is a stand-alone component of the Cisco VVB Administration interface. It has its own menu bar, which replaces the Cisco VVB Administration menu bar.

To open real-time reporting, complete the following steps.
Procedure

Step 1 If you are running Real-Time Reporting for the first time on this system, log into Cisco VVB Administration as an Administrator.

The system prompts you to download the Java plug-in; follow the prompt instructions.

Note After you perform the initial download of the Real-Time Reporting Java plug-in, non-Administrative users can access Real-Time Reporting on this system.

Step 2 Choose Tools > Real-Time Reporting from the Cisco VVB Administration menu bar.

The Application Reporting web page opens in a new window. The real-time reporting tool requires a Java plug-in. If the plug-in is not installed on the machine you are using, the Cisco VVB system prompts you to accept the automatic installation of the plug-in. If you do not accept the installation, you cannot use real-time reporting.

Run Reports

Open the real-time reporting tool from the Cisco VVB Administration web interface to run reports.

To run a real-time report, complete the following steps.

Procedure

Step 1 From the Application Reporting menu bar, choose Reports.

Step 2 From the Reports menu, choose the report to run.

The report opens in the Application Reporting window.

View Detailed Subreports

You can view more detailed information for selected items in these four reports:

• Application Tasks report
• Contacts report
• Applications report
• Sessions report

To view detailed subreports, complete the following steps.

Procedure

Step 1 Run the Application Tasks, Contacts, Applications, or Sessions report.
Step 2  Click a line in the report for which you want to view more detailed information. For example, click an email address in the Contacts report.

Step 3  From the Application Reporting menu bar, choose Views and click the subreport that you want to run. You can also open a subreport by right-clicking the selected item and choosing a subreport. The subreport opens.

---

**Print Reports**

To facilitate printing, you can open a printable version of a report.

To print a report, complete the following steps.

**Procedure**

**Step 1**  Run a report.

**Step 2**  From the Application Reporting menu, choose **Tools > Open Printable Report**.

A printable version of the report opens in a separate window.

**Step 3**  Print the report using your browser print functionality.

---

**Reset Report Statistics**

The Cisco VVB system automatically resets all statistics each day at midnight. You can reset the accumulated statistics manually at any time. Resetting statistics does not reset active statistics, such as active contacts and active tasks.

To reset report statistics, complete the following steps.

**Procedure**

**Step 1**  From the Application Reporting menu bar, choose **Tools > Reset All Stats**.

The Reset Stats dialog box opens for you to confirm the reset.

**Step 2**  Click **Yes**.

Accumulated statistics are reset.

---

**Set Report Options**

You can set the following reporting options:
To set report options, complete the following steps.

**Procedure**

**Step 1** From the Application Reporting menu bar, choose **Settings > Options**.

The Options dialog box opens.

**Step 2** From the Polling Interval drop-down menu, choose the refresh rate in seconds.

**Step 3** From the Server Connect Retry Count drop-down menu, choose the number of times that the Cisco VVB Administration web interface should attempt to reconnect to the Cisco VVB server.

**Step 4** Click **Apply** to apply the settings.

---

### Set Report Appearance

You can select from three report appearances:

- **Windows**, which displays reports in colors based on your Windows settings
- **Motif**, which displays reports in purple and menu items in brown
- **Metal**, which displays reports in grey and menu items in black

To set the report appearance:

**Procedure**

Choose **Settings** from the Application Reporting menu bar and click the appearance that you want.

---

### Application Reporting User Interface

When you choose **Tools > Real-Time Reporting** from the Cisco VVB Administration menu, the Application Reporting tool opens a web page in a new window.

The Application Reporting tool menu bar contains the following options:

- **Report**—Choose this option to display a list of the available top-level real-time reports.

- **Tools**—Choose this option to reset all the statistics and refresh connections.

- **Settings**—Choose this option to set the look and feel of the real-time Reporting client, set the polling (refresh) interval times, and set the amount of times the server will attempt to reconnect.

- **Help**—Choose this option to display system information and to access Cisco VVB online help.
Report Menu

The Report menu provides access to a variety of top-level reports. It contains the following menu options:

Related Topics

Call Contacts Detailed Info Report, on page 267

Contacts Summary Real-Time Report

Use the Contacts Summary report to view specific contact information for call contacts, email contacts, HTTP contacts, and total number of contacts.

To access the Contacts Summary real-time report, choose Reports > Contacts Summary from the Application Reporting menu bar.

Note

You display the data on this report as numbers or percentages by clicking the Display Value/Display % toggle button.

The following fields are displayed on the Contacts Summary report.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Active</td>
<td>Active contacts that are currently running.</td>
</tr>
<tr>
<td>Inbound</td>
<td>Number of inbound contacts since the statistics were last reset.</td>
</tr>
<tr>
<td>Connected</td>
<td>Number of connected contacts since the statistics were last reset.</td>
</tr>
<tr>
<td></td>
<td>Provides a total for contacts that are connected to resources.</td>
</tr>
<tr>
<td>Terminated</td>
<td>Number of terminated contacts since the statistics were last reset.</td>
</tr>
<tr>
<td>Rejected</td>
<td>Number of rejected contacts since the statistics were last reset.</td>
</tr>
<tr>
<td>Aborted</td>
<td>Number of aborted contacts since the statistics were last reset.</td>
</tr>
</tbody>
</table>

Application Tasks Summary

Use the Application Tasks Summary report to display statistics that summarize the activity of specific applications.

To access the Application Tasks Summary real-time report, choose Reports > Application Tasks Summary from the Application Reporting menu bar.

The following fields are displayed on the Application Tasks Summary report.
<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Application Name</td>
<td>Names of the applications that are running or have run.</td>
</tr>
<tr>
<td>Running</td>
<td>Currently running applications.</td>
</tr>
<tr>
<td>Completed</td>
<td>Applications that have stopped running.</td>
</tr>
<tr>
<td>Total</td>
<td>Number of times an application was invoked since the statistics were last reset.</td>
</tr>
</tbody>
</table>

**Application Tasks Real-Time Report**

Use the Application Tasks real-time report to view information about currently active applications.

To access the Application Tasks report, choose **Reports > Application Tasks** from the Application Reporting menu bar. The following fields are displayed on the Application Tasks report.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>ID</td>
<td>Unique application task ID.</td>
</tr>
<tr>
<td>Node ID</td>
<td>Unique ID for a server in the cluster.</td>
</tr>
<tr>
<td>Note</td>
<td>As Cisco VVB does not support clustering, you can ignore the value.</td>
</tr>
<tr>
<td>Application</td>
<td>Name of the application.</td>
</tr>
<tr>
<td>Start Time</td>
<td>Time when the application task started.</td>
</tr>
<tr>
<td>Duration</td>
<td>Length of time that the application has been active.</td>
</tr>
</tbody>
</table>

**Note**

If this report indicates that an application is running for an unusually long time, there may be a problem with the application. The application script may not include error handling that prevents infinite retries if a call is no longer present. If the application does not receive a disconnect signal after a call, the application repeatedly retries to locate the call, and causes the application to run for an unusually long time. To prevent this problem, include the proper error handling in the application script.

**Engine Tasks Real-Time Report**

Use the Engine Tasks real-time report to view information about currently active Engine tasks.

To access the Engine Tasks report, choose **Reports > Engine Tasks** from the Application Reporting menu bar.

The following fields are displayed on the Engine Tasks report.
Contacts Report

Use the Contacts real-time report to view information for all the active contacts for all servers.

To access the Contacts report, choose Reports > Contacts from the Application Reporting menu bar.

You can access detailed information about specific contacts listed on the Contacts web page by performing one of the following procedures:

- Call Contacts Detailed Info Report, on page 267

The following fields are displayed on the Contacts report.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>ID</td>
<td>Unique identifier representing a contact.</td>
</tr>
<tr>
<td>Type</td>
<td>Type of contact:</td>
</tr>
<tr>
<td>Impl ID</td>
<td>Unique identifier provided by the particular type of contact.</td>
</tr>
<tr>
<td>Node ID</td>
<td>Unique identifier for a server in the cluster.</td>
</tr>
<tr>
<td>Note</td>
<td>As Cisco VVB does not support clustering, you can ignore the value.</td>
</tr>
<tr>
<td>Start Time</td>
<td>Time stamp when the contact was created.</td>
</tr>
</tbody>
</table>
**Field** | **Description**
--- | ---
Duration | Length of time that the contact is active.
Handled | If True, the contact is handled; if False, the contact is not handled.
Aborting | If True, the contact is aborted with a default treatment; if False, the contact is not aborted.
Application | Name of the application currently managing the contact.
Task | Unique identifier of the application task that is currently responsible for the contact.
Session | Unique identifier of the session currently managing the contact (if any).

---

**Note**
The information displayed is dependent on the type of contact selected. Depending on the type of call, some fields may not be supported and will appear blank.

---

**Call Contacts Detailed Info Report**

Use the Call Contacts Detailed Info real-time report to view all information related to the call contact. To access the Call Contacts Detailed Info report, right-click a specific call contact record on the Contacts report; information for that specific record displays.

The following fields are displayed on the Call Contacts Detailed Info report.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>State</td>
<td>Current state of the contact.</td>
</tr>
<tr>
<td>Inbound</td>
<td>If True, this call was received by the Cisco VVB server; if False, this call was placed as an outbound call by an application.</td>
</tr>
<tr>
<td>Language</td>
<td>The selected language context of the call.</td>
</tr>
<tr>
<td>Application ID</td>
<td>Unique identifier of the associated application.</td>
</tr>
<tr>
<td>Called Number</td>
<td>Called number for this call leg from the perspective of the called party.</td>
</tr>
<tr>
<td>Dialed Number</td>
<td>Dialed number for this call leg from the perspective of the calling party.</td>
</tr>
<tr>
<td>Calling Number</td>
<td>Calling number of the originator of this call.</td>
</tr>
<tr>
<td>ANI</td>
<td>Automatic number identification.</td>
</tr>
</tbody>
</table>
### Field Description

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>DNIS</td>
<td>Dialed number identification service.</td>
</tr>
<tr>
<td>CLID</td>
<td>Caller ID.</td>
</tr>
<tr>
<td>Arrival Type</td>
<td>Information on how the call contact arrived in the system.</td>
</tr>
<tr>
<td>Last Redirected Number</td>
<td>Number from which the last call diversion or transfer was invoked.</td>
</tr>
<tr>
<td>Original Called Number</td>
<td>Originally called number.</td>
</tr>
<tr>
<td>Original Dialed Number</td>
<td>Originally dialed number.</td>
</tr>
<tr>
<td>ANI Digits</td>
<td>Automatic Number Identification information indicator digit codes.</td>
</tr>
<tr>
<td>CED</td>
<td>Entered digits that were gathered by the network before the call was received.</td>
</tr>
</tbody>
</table>

#### Applications Report

Use the Applications real-time report to view all the applications loaded on the server.

To access the Applications report, choose **Reports > Applications** from the Application Reporting menu bar.

The following fields are displayed on the Applications report.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Unique name of the currently loaded application.</td>
</tr>
<tr>
<td>ID</td>
<td>Application ID.</td>
</tr>
<tr>
<td>Type</td>
<td>Type of application that is currently running (for example, a Cisco Script Application).</td>
</tr>
<tr>
<td>Description</td>
<td>Description of the application as entered on the Cisco VVB Administration web site.</td>
</tr>
<tr>
<td>Enabled</td>
<td>If True, the application is enabled; if False, the application is disabled.</td>
</tr>
<tr>
<td>Max. Sessions</td>
<td>Maximum number of simultaneous task instances that can run simultaneously on the Cisco VVB server.</td>
</tr>
<tr>
<td>Valid</td>
<td>If True, the application is valid; if False, the application is invalid.</td>
</tr>
</tbody>
</table>

Note: Calls running Unified ICME applications are also reported here.
An application is valid if it was successfully loaded and initialized from its configuration. At any time, an application can become invalid if it internally fails to be refreshed.

Sessions Report

Use the Sessions real-time report to view real-time information on all the active sessions. To access the Sessions report, choose Reports > Sessions from the Application Reporting menu bar.

The following fields are displayed on the Sessions report.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>ID</td>
<td>Session ID. This identifier is guaranteed to remain unique for a period of 12 months.</td>
</tr>
<tr>
<td>Note</td>
<td></td>
</tr>
<tr>
<td>Mapping ID</td>
<td>User- or system-defined identifier that maps to this session.</td>
</tr>
<tr>
<td>Note</td>
<td></td>
</tr>
<tr>
<td>Node ID</td>
<td>Unique identifier for a server in the cluster.</td>
</tr>
<tr>
<td>Note</td>
<td>As Cisco VVB does not support clustering, you can ignore the value.</td>
</tr>
<tr>
<td>Parent</td>
<td>Sessions that were created as a result of consult calls propagated in the system.</td>
</tr>
<tr>
<td>Creation Time</td>
<td>Current state of the session.</td>
</tr>
<tr>
<td>State</td>
<td>Current state of the session.</td>
</tr>
<tr>
<td>Note</td>
<td>When marked IDLE, the session is subject to being “garbage collected” by the system after a specified period of time. In addition, a session is IN_USE if it still has a contact associated or a child session.</td>
</tr>
</tbody>
</table>

Tools Menu

The Tools menu gives you access to the following Application Reporting tools:

- **Reset All Stats**—Choose this option to reset all statistics.
- **Open Printable Report**—Choose this option to get a printable report of all currently active contacts in the system.
- **Refresh Connections**—Choose this option to refresh connections with the Cisco VVB system.

Reset All Statistics

Use the Reset All Stats option to reset all statistics accumulated since the last time the statistics were reset. It will not reset active statistics, such as active contacts, tasks, and so on.
**Procedure**

Choose **Tools > Reset All Statistics** from the Application Reporting menu bar.

---

**Open Printable Report**

Use the option to get a printable report of all currently active contacts in the system.

To get a printable report:

**Procedure**

Choose a real-time report from the Report menu option and then **Tools > Open Printable Report** from the Application Reporting menu bar.

---

**Refresh Connections**

To refresh connections with the Cisco VVB system:

**Procedure**

Choose **Tools > Refresh Connections** from the Application Reporting menu bar.

The Cisco VVB system refreshes all connections.

---

**Views Menu**

The Views menu allows you to access more detailed information for the following reports:

The Views menu contains different options, depending on the report you have chosen. Possible options are:

- **Contacts by Application Task ID**—Choose this option to view contacts according to Application Task ID numbers.

- **Engine Tasks by Application Task ID**—Choose this option to view Engine tasks according to Application Task ID numbers.

- **Detailed Info**—Choose this option to view more detailed information on selected reports.

- **Application Tasks by Application Name**—Choose this option to view application tasks by application name.

- **Contacts by Session ID**—Choose this option to view contacts by session ID.

---

**Application Tasks**

You can obtain reports based on the application task ID associated with application tasks.
Contacts by Application Task ID

This report displays the same report as the Contact report with the exception that the Contacts by Application Task ID report has been filtered using only the contact currently being managed by the selected application task.

Engine Tasks by Application Task ID

This report displays the same report as the Engine Task reports except that the Engine Tasks by Application Task ID report has been filtered to display only the engine tasks that are associated with the application task.

Contacts

When you use the Views options with the Contacts report, the Views menu contains only the Detailed Info option.

The Detailed Info option provides various detailed information, depending on the type of contact selected. For example, if the contact is a call, the Calling Party number, the Called Number, and so on, are displayed for that particular call.

Applications

When you use the Views options with the Application reports, the Views menu contains only the Application Tasks by Application Name option.

The Application Task By Application Name report displays the same report as the Application Task report except that the Application Task By Application Name report is filtered using only the active application tasks associated with this application.

Sessions

You can obtain reports based on the session ID associated with a session.

Contacts by Session ID

This report displays the same report as the Contact report with the exception that the Contacts By Session ID report is filtered using only the contacts associated with the selected session.

Detailed Info

Detailed info displays the time the session was created and its current state.

Settings Menu

The Settings menu of the Application Reporting menu bar allows you to adjust various settings of the Real Time Reporting tool.

The Settings menu contains the following menu options:

- **Options**—Choose this option to set the polling (refresh) interval times and to set the amount of times the server will attempt to reconnect and to enable the reset statistics at midnight.
- **Window**—Choose this option to display reports in colors based on your Windows settings.
- **Motif**—Choose this option to display reports in purple and menu items in brown.
- **Metal**—Choose this option to display reports in grey and menu items in black.
Options Menu

Choose **Settings** and click **Options** to access the Options dialog box. Use the Options dialog box to set the polling (refresh) interval time, set the number of times the server will attempt to reconnect.

The following fields are displayed in the Options dialog box.

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Polling Interval</td>
<td>Time between two requests to the server for new statistics by the client.</td>
</tr>
<tr>
<td>Server Connect Retry Count</td>
<td>The number of times that the Cisco VVB Administration web interface should attempt to reconnect to the Cisco VVB server.</td>
</tr>
<tr>
<td></td>
<td><strong>Note</strong> If an error occurs, an Error dialog box opens to alert you that the server is not communicating with the web interface.</td>
</tr>
<tr>
<td>Reset Statistics at Midnight</td>
<td>The statistics data gets cleared at midnight if enabled.</td>
</tr>
<tr>
<td></td>
<td><strong>Note</strong> This option is disabled either when client is not connected to the server or report is not selected. To connect to the server, select an option from Report menu.</td>
</tr>
</tbody>
</table>

Click **Apply** to submit configuration changes.
CHAPTER 14

SIP Proxy Server Configuration

- Configure SIP Proxy Server, on page 273
- SIP Proxy Server Settings, on page 273
- Configuration, on page 276

Configure SIP Proxy Server

Procedure

Step 1 Log in to Operations Console and click Device Management > SIP Proxy Server.
Step 2 Click Add New to add a new SIP Proxy server or click Use As Template to use the existing SIP Proxy server from the list of available SIP Proxy servers.
Step 3 Click the following tabs and modify the default values of fields, if required:
   a) General. See General Settings, on page 273.
   b) Device Pool. See Add or Remove Device From Device Pool, on page 98. For information on Device Pool, see Device Pool, on page 97.
Step 4 Click Save.

Related Topics
   - General Settings, on page 273
   - Add or Remove Device From Device Pool, on page 98
   - Device Pool, on page 97

SIP Proxy Server Settings

General Settings

To configure the general settings of SIP Proxy server, on the General tab, enter or modify the field values, as listed in the following table:
### Table 47: SIP Proxy Server General Tab Configuration Settings

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
<th>Default</th>
<th>Range</th>
<th>Restart Required</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>General</strong></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>IP Address</td>
<td>The IP address of a SIP Proxy server.</td>
<td>None</td>
<td>Valid IP address</td>
<td>Not Applicable</td>
</tr>
<tr>
<td>Hostname</td>
<td>The host name of the SIP Proxy server.</td>
<td>None</td>
<td>Valid DNS name includes uppercase and lowercase letters, the numbers 0 through 9, and a dash.</td>
<td>Not Applicable</td>
</tr>
<tr>
<td>Device Type</td>
<td>The type of proxy server.</td>
<td>Cisco Unified SIP Proxy</td>
<td>Cisco Unified SIP Proxy and Cisco Unified Presence.</td>
<td>Not Applicable</td>
</tr>
<tr>
<td>Description</td>
<td>The description of the SIP Proxy server.</td>
<td>None</td>
<td>Up to 1,024 characters.</td>
<td>Not Applicable</td>
</tr>
<tr>
<td>Device Admin URL</td>
<td>The Administration URL of SIP Proxy server.</td>
<td>None</td>
<td>A valid URL.</td>
<td>Not Applicable</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td><strong>Note</strong></td>
<td></td>
</tr>
<tr>
<td></td>
<td>Depending on the option selected, the Enable Serviceability fields change. See the Enable Serviceability options for details.</td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

### Enable Serviceability

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
<th>Default</th>
<th>Range</th>
<th>Restart Required</th>
</tr>
</thead>
<tbody>
<tr>
<td>Enable Serviceability</td>
<td>Check this check box to enable serviceability for SIP Proxy server.</td>
<td>Not Applicable</td>
<td>Unchecked</td>
<td>Not Applicable</td>
</tr>
</tbody>
</table>
Add SIP Proxy Server to Device Pool

See Add or Remove Device From Device Pool, on page 98. For information on Device Pool, see Device Pool, on page 97.

### Field Description

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
<th>Default</th>
<th>Range</th>
<th>Restart Required</th>
</tr>
</thead>
<tbody>
<tr>
<td>Username</td>
<td>The username required to log in to the proxy server Serviceability.</td>
<td>Valid names containing uppercase and lowercase alphanumeric characters, period, dash and underscore.</td>
<td>Not Applicable</td>
<td>Not Applicable</td>
</tr>
<tr>
<td>Port</td>
<td>The port on which Serviceability is configured on the SIP Proxy.</td>
<td>1 to 65535</td>
<td>8443</td>
<td>Not Applicable</td>
</tr>
</tbody>
</table>

**For Device Type: Cisco Unified SIP Proxy**

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
<th>Default</th>
<th>Range</th>
<th>Restart Required</th>
</tr>
</thead>
<tbody>
<tr>
<td>User Password</td>
<td>Enter a password. This is the first level of authentication for IOS.</td>
<td>Valid names containing uppercase and lowercase alphanumeric characters, period, dash and underscore.</td>
<td>Not Applicable</td>
<td>Not Applicable</td>
</tr>
<tr>
<td>Enable Password</td>
<td>The password required to log in to SIP Proxy Serviceability. This is the second level of authentication for IOS.</td>
<td>Must be same as password on the SIP Proxy.</td>
<td>Not Applicable</td>
<td>Not Applicable</td>
</tr>
</tbody>
</table>

**For Device Type: Cisco Unified SIP Presence**

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
<th>Default</th>
<th>Range</th>
<th>Restart Required</th>
</tr>
</thead>
<tbody>
<tr>
<td>Password</td>
<td>Enter a password.</td>
<td>Valid names containing uppercase and lowercase alphanumeric characters, period, dash and underscore.</td>
<td>Not Applicable</td>
<td>Not Applicable</td>
</tr>
<tr>
<td>Confirm Password</td>
<td>The password required to log in to SIP Proxy Serviceability.</td>
<td>Must be same as password on the SIP Proxy.</td>
<td>Not Applicable</td>
<td>Not Applicable</td>
</tr>
</tbody>
</table>
Configuration

If only a single SIP Proxy Server is needed for outbound call routing from the Call Server, choose the SIP Proxy configuration when configuring the SIP Service. In the Unified CVP Operations Console Server, configure the following:

- Add a SIP Proxy Server and specify the IP address of the server.

Under the Call Server SIP Service settings, configure the following:

- Enable Outbound Proxy = True
- Use DNS SRV type query = False
- Outbound Proxy Host = SIP Proxy Server configured above

When using multiple SIP Proxy Servers for outbound redundancy from the Call Server, configure the SIP Proxy with a DNS name and configure DNS SRV records in order to reach the SIP Proxy Servers. The DNS SRV records can exist on an external DNS Server, or they can be configured in a local DNS SRV record on each CVP server. In the OAMP Console, configure the following:

- Add a SIP Proxy Server and specify DNS name of the server.

Under SIP Service configuration, configure the following:

- Enable Outbound Proxy = True
- Use DNS SRV type query = True

The DNS SRV record should then be configured with the list of SIP Proxy Servers.

To configure the Local DNS SRV record on each server, under the SIP service configuration, check Resolve SRV records locally.

To use a server group for redundant Proxy Servers:

1. Select resolve SRV records locally and enter the name of the server group for the outbound proxy domain name.

2. Under System > Server Groups, create a new server group with two proxy servers that have priority 1 and 2.

3. Deploy the server group configuration to the Call Server.
Unified CM SME Configuration

- Enable Session Refresh, on page 277
- Enable Session Timer, on page 277
- Configure Media Inactivity Timer in Cisco IOS Gateway, on page 278
- Configure SIP Trunk from SME to Unified CM Leaf Cluster, on page 278
- Configure SIP Trunk from Unified CM Leaf Cluster to SME, on page 278

Enable Session Refresh

Periodic session refresh helps to determine the downlink status and to trigger clear sessions from the gateway to release Unified CVP call server ports in case of Unified CM SME failures.

Perform the following steps to enable SIP session refresh globally.

**Procedure**

**Step 1**
Use putty or telnet to log in to the IOS gateway.

**Step 2**
From the command prompt, run the following command:

```
>enable
>configure terminal
>voice service voip
>sip
>session refresh
```

Enable Session Timer

To enable SIP session timer globally, set the `min-se` command in SIP configuration mode using the following steps.
Configure Media Inactivity Timer in Cisco IOS Gateway

During Unified SME failure, the IOS (Cisco UBE or PSTN Gateway) does not receive a BYE message for any type of call flow. To avoid this scenario, you must use the following procedure to configure Media Inactivity Timer in the IOS Gateway.

Procedure

**Step 1** Use Putty or Telnet to log in to the IOS gateway.

**Step 2** From the command prompt, run the following command:

```plaintext
>enable  
>configure terminal  
>voice service voip  
>sip  
>min-se <seconds> session-expires <seconds>
```

**Step 3** Check the min-se set value by typing the following command: `show sip-ua min-se`.

Configure SIP Trunk from SME to Unified CM Leaf Cluster


Configure SIP Trunk from Unified CM Leaf Cluster to SME

System Configuration

- System Tab Options, on page 279
- Import System Configuration, on page 280
- Export System Configuration, on page 281
- Location Configuration, on page 282
- SIP Server Group Configuration, on page 287
- Dialed Number Pattern Configuration, on page 293
- Web Services Configuration, on page 296
- IOS Configuration, on page 297
- Courtesy Callback, on page 305
- Courtesy Callback Configuration, on page 307

System Tab Options

Table 48: System Tab Options

<table>
<thead>
<tr>
<th>System tab options</th>
<th>Use To</th>
</tr>
</thead>
<tbody>
<tr>
<td>Control Center</td>
<td>View the status of the Cisco Unified Customer Voice Portal environment in a network control center. View the status and statistics by Device Type or Device Pools, logical groups of devices in the Cisco Unified Customer Voice Portal solution. Initiate Start, Shutdown, or Graceful Shutdown actions on devices in the control center.</td>
</tr>
<tr>
<td>Device Pool</td>
<td>Create, modify, and delete device pool names and descriptions for logical groups of devices (for example, all devices located in a geographical region). For details, see Device Pool, on page 97 and Add or Remove Device From Device Pool, on page 98.</td>
</tr>
<tr>
<td>Import System Configuration</td>
<td>Import a previously-saved Operations Console Server configuration file and apply it to the current system. For details, see Import System Configuration, on page 280.</td>
</tr>
</tbody>
</table>
### System tab options

<table>
<thead>
<tr>
<th>System tab options</th>
<th>Use To</th>
</tr>
</thead>
<tbody>
<tr>
<td>Export System Configuration</td>
<td>Save and export all configuration information for the Operations Console Server to a single file on your local computer. You can later use this file to restore an Operations Console Server during disaster recovery. For details on this option, see Export System Configuration, on page 281.</td>
</tr>
<tr>
<td>Location</td>
<td>Add, edit, synchronize, and delete Unified CM location information.</td>
</tr>
<tr>
<td>SIP Server Groups</td>
<td>Configure server groups for SIP and view Call Server deployment status. For details, see Location Configuration, on page 282.</td>
</tr>
<tr>
<td>Web Services</td>
<td>Configure Diagnostic Portal servlet credentials. For details, see Deploy Web Services, on page 297.</td>
</tr>
<tr>
<td>Dialed Number Pattern</td>
<td>Configure the Dialed Number Patterns for a destination. You can define the dialed numbers for the Error Tone, Ring Tone, and other destinations. For details, see Add and Deploy Dialed Number Pattern, on page 294.</td>
</tr>
</tbody>
</table>
| IOS Configuration         | **IOS Template Management** - Add, Delete, Edit, Copy, and View an IOS template configuration pushed to an IOS gateway. The template contains the IOS commands required for use in a Unified CVP deployment.  
**IOS Template Deployment** - Deploy a gateway configuration template to an IOS gateway. The template provisions the gateway and substitutes any variables in the template with the source devices that are chosen when it is deployed. For details, see IOS Configuration, on page 297. |
| Courtesy Callback         | For details, see Configure Courtesy Callback, on page 307.                                                                 |

### Related Topics
- Add or Remove Device From Device Pool, on page 98
- Device Pool, on page 97
- Import System Configuration, on page 280
- Export System Configuration, on page 281
- Location Configuration, on page 282
- Deploy Web Services, on page 297
- Add and Deploy Dialed Number Pattern, on page 294
- IOS Configuration, on page 297
- Configure Courtesy Callback, on page 307

### Import System Configuration

For disaster recovery, import the saved Operations Console configuration to your computer. To back up and restore Operations Console configuration, see the Installation and Upgrade Guide for Cisco Unified Customer Voice Portal.
• Operations Console supports the import of system-level configuration data.

• Operations Console cannot export the sip.properties file. To export the sip.properties file, manually copy the sip.properties file along with the CVP Operations Console configuration.

• When you import a database which was exported from an older version, the imported database is automatically upgraded to the latest version, as indicated in the confirmation message.

Procedure

Step 1 Stop the **Cisco CVP Resource Manager** Windows Service by performing the following steps:
   a) Select **Start > All Programs > Control Panel Programs > Administrative Tools > Services**.
   b) Click **Cisco CVP Resource Manager**.
   c) Click **Stop**.

Step 2 Select **System > Import System Configuration**.

Step 3 Enter the file name in the **Enter Configuration File** text box or click **Browse to** to search for the file to import.

Step 4 Select **Import**.

Step 5 Perform Step 1(a).

Step 6 Perform the following steps:
   a) Select **Cisco CVP OPSConsoleServer**, and click **Restart**.
   b) Select **Cisco CVP Resource Manager**, and click **Restart**.
   c) Select **Cisco CVP WebServicesManager**, and click **Restart**.

Step 7 Log in to the Operations Console.

Export System Configuration

For back up, save and export the Operations Console configuration to a single file on your computer. This file can later be used to configure another Operations Console Server without having to individually reconfigure each module. For details, see the *Installation and Upgrade Guide for Cisco Unified Customer Voice Portal*. You can export the database on a regular basis and also when you make major configuration changes to a device.
• All Operations Console configuration data is exported, except for any files you have uploaded, including licenses and application scripts. The Operations Console supports the export of system-level configuration data.

• Import and export operations do not back up or restore the CVP configuration of the VoiceBrowser or the SIP.properties files. If the backup and record of the Unified CVP configuration is required, manually back up the SIP.properties file and the result of the VoiceBrowser `sall` command along with the export of system configuration through the Operations Console.

---

**Procedure**

**Step 1** Select **System > Export System Configuration**.
**Step 2** On the **Export System Configuration** page, click **Export**.
**Step 3** In the **Save As** dialog box, select a location to save the file.

---

**Note**
You may save the configuration multiple times. Choose a naming convention that helps you identify the configuration, for example, include the current date and time in the file name.

---

**Location Configuration**

Configure a location to route calls locally to the agent available in the branch office instead of routing calls to centralized or non-geographical numbers. Use the location configuration feature to select a Unified Communication Manager (CM) Server and extract the Unified CM location information (location provider). After an administrator initiates the synchronization, the system retrieves the location information for all available Unified CM servers which have been identified as sources for location information.

After you enable synchronization for a Unified CM server, information can be retrieved from any of the Unified CM servers that have been identified as sources for location information.

**Note**
All Unified CM servers enabled for synchronization are used during the synchronization task. If you do not want a particular Unified CM to be used when the synchronization task is performed, then disable synchronization for that Unified CM.

The following table lists the location configuration settings:
Table 49: Location Configuration Settings

<table>
<thead>
<tr>
<th>Property</th>
<th>Description</th>
<th>Default</th>
<th>Value</th>
<th>Restart Required</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>General</strong></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Insert Site Identifier</td>
<td>Select one of the following options to identify the site information:</td>
<td>Insert site identifier between the Network VRU label and the correlation ID</td>
<td>Not applicable</td>
<td>No</td>
</tr>
<tr>
<td></td>
<td>• Insert site identifier between the Network VRU label and the correlation ID</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>• Insert site identifier at the beginning of the Network VRU label</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>• Do not insert site identifier</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td><strong>Location</strong></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Location Name (required)</td>
<td>This is a user defined field.</td>
<td>Not applicable</td>
<td>a-z, A-Z, 0-9, -_</td>
<td>No</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>Max length 128 characters</td>
<td></td>
</tr>
<tr>
<td>Site ID (required)</td>
<td>The Site ID is a unique user-defined field.</td>
<td>Null</td>
<td>0-9, #</td>
<td>No</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>Max length 128 characters</td>
<td></td>
</tr>
<tr>
<td>Location ID (required)</td>
<td>The Location ID is a unique user-defined field.</td>
<td>Null</td>
<td>a-z, A-Z, 0-9</td>
<td>No</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>Max length 128 characters</td>
<td></td>
</tr>
<tr>
<td>Unified CM IP Address</td>
<td>Ensure to check the Enable Synchronization check box in the Unified CM Server Configuration screen's General tab to select Unified CM as a Unified CM location information provider.</td>
<td>Not applicable</td>
<td>Not applicable</td>
<td>No</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

Ensure to check the Enable Synchronization check box in the Unified CM Server Configuration screen's **General** tab to select Unified CM as a Unified CM location information provider.

If a Unified CM server is removed from the Operations Console configuration, if the Unified CM server is unreachable, or if the synchronization check box is deselected, all locations stored in the Operations Console are automatically marked as invalid.
### Associated Gateway

You can select Gateways from the Available list to deploy location information. You can configure multiple Gateways per location. An instance of a Gateway can only be assigned to one location. When a Gateway is associated with a location, the Gateway configuration window displays the location as a read-only field.

<table>
<thead>
<tr>
<th>Property</th>
<th>Description</th>
<th>Default</th>
<th>Value</th>
<th>Restart Required</th>
</tr>
</thead>
<tbody>
<tr>
<td>Associated Gateway</td>
<td>You can select Gateways from the Available list to deploy location information. You can configure multiple Gateways per location. An instance of a Gateway can only be assigned to one location. When a Gateway is associated with a location, the Gateway configuration window displays the location as a read-only field.</td>
<td>Not applicable</td>
<td>Not applicable</td>
<td>No</td>
</tr>
</tbody>
</table>
## Location Configuration

<table>
<thead>
<tr>
<th>Property</th>
<th>Description</th>
<th>Default</th>
<th>Value</th>
<th>Restart Required</th>
</tr>
</thead>
<tbody>
<tr>
<td>Status</td>
<td>The status indicates if the location information is valid or invalid:</td>
<td>Not applicable</td>
<td>Valid or Invalid</td>
<td>No</td>
</tr>
<tr>
<td></td>
<td>• <strong>Invalid</strong>: The location is invalid if any of the following scenarios apply:</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>• The location was previously synchronized with a Unified CM server. Later, you delete this location from the Unified CM server. When you perform the next synchronization with the Unified CM server, this location becomes invalid.</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>• The Unified CM server's Enable Synchronization check box remains unchecked. You can select and remove &quot;Invalid&quot; locations at any time. If a unified CM is deselected from the synchronization list after synchronizing with that Unified CM server, then all the locations synchronized from this Unified CM server become invalid.</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>• If a Unified CM server is not reachable when the next synchronization occurs, then all the locations associated with that Unified CM become invalid.</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>• <strong>Valid</strong>: The location is valid if any of the following scenarios apply:</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>• the Enable Synchronization check box is checked</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>• the location is exists in a Unified CM server configuration, the last synchronization was successful with the Unified CM, and if that Unified CM is still selected.</td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

### Call Server Deployment

| Associate Call Servers | Select call servers from the Available list to deploy location information. One or more call servers can be selected and designated as Selected/Available. | Configuration is deployed to all selected call servers | Not applicable | No |

---

**Configuration Guide for Cisco Unified Customer Voice Portal, Release 11.6(1)**
Prerequisites for Location Configuration

- Configure the device type as a gateway.

**Note**

- If a location is associated with more than one Gateway, the system displays multiple rows of the same location information for each associated device.
- If the device location ID information is configured on the Location configuration page, ensure that it is displayed as a read-only field.
- Ensure that any configurable fields remain blank if they are not configured by a user.

Deploy Location Information

By default, location information is deployed to all associated Call Servers. However, you can choose to deploy location information to one or more Call Servers.

**Procedure**

**Step 1**
Select System > Location and make the enter or modify the location configuration field values.

**Step 2**
Click Save & Deploy to save the location information and initiate a deployment request to the selected Call Servers. Or, click Save to save the settings three components to the database: the location information, information in the General tab, and the associated Call Servers and deploy the location information later.

**Caution** The Deployment Status screen displays a warning message if you have:
- Saved only the configuration details and have not deployed them.
- Edited or deleted an existing configuration and have not deployed the changes.
- Changed the call server association.

Add Location

You can manually add location information for locations that do not exist in the Unified CM database.

**Procedure**

**Step 1**
Log in to the Operations Console and select System > Location.

**Step 2**
On the Location tab, select Add New.

The Location Configuration window appears.

**Step 3**
Enter the Location, Site ID, Location ID, and the Unified CM IP Address as applicable to your configuration.
Step 4 (Optional) Select the required Gateway by moving it to the Selected column.
Step 5 Click Save.

SIP Server Group Configuration

A SIP Server Group consists of one or more destination addresses (endpoints) and is identified by a Server Group domain name. This domain name is also known as the SRV cluster name, or Fully Qualified Domain Name (FQDN). Server Groups contain Server Group Elements.

In Unified CVP, you can add server groups at the system level to perform SIP dynamic routing.

Add SIP Server Groups

Procedure

Step 1 Log in to the Operations Console and select System > SIP Server Groups. The SIP Server Groups window appears.
Step 2 Select Add New.
Step 3 Click the following tabs and enter or modify the default values of fields, if required:
   a) General. See General Settings, on page 288.
   b) Heartbeat Properties. See Heartbeat Properties Settings, on page 288.
   c) Call Server Deployment. See Deploy Call Server, on page 292.
Step 4 (Optional) To remove an element from the group, select it and click Remove. To replace a selected element with a new element, edit the SIP Server Group Elements properties, select an existing element, and then click Replace.
Step 5 Click Save & Deploy.

Note Click Save to save the changes on the Operations Console and configure the SIP Server group later.

Related Topics
   General Settings, on page 288
   Heartbeat Properties Settings, on page 288
   Deploy Call Server, on page 292
General Settings

Table 50: SIP Server Group General Settings

<table>
<thead>
<tr>
<th>Column</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>The name of the SIP Server Group. Nested under the SIP Server Group are the SIP Server Group Elements. Click the expand/collapse (+/-) icon to expand and collapse the elements within the group. Additionally, you can click <strong>Collapse all</strong> and <strong>Expand all</strong> to collapse/expand all the elements within the server groups listed on the page.</td>
</tr>
<tr>
<td>Number of Elements</td>
<td>The number of elements contained in the group.</td>
</tr>
<tr>
<td>Port</td>
<td>Port number of the element in the server group.</td>
</tr>
<tr>
<td>Priority</td>
<td>Priority of the element in relation to the other elements in the server group. Specifies whether the server is a primary or backup server. Primary servers are specified as 1.</td>
</tr>
<tr>
<td>Weight</td>
<td>Weight of the element in relation to the other elements in the server group. Specifies the frequency with which requests are sent to servers in that priority group.</td>
</tr>
</tbody>
</table>

Heartbeat Properties Settings

These properties enable Heartbeat communication between the SIP Server Group and the elements of the SIP Server Group. In case of element not responding to Heartbeat messages, the element is marked as unavailable; on receiving a successful response, it is marked as available again.

Table 51: SIP Server Group Heartbeat Properties Settings

<table>
<thead>
<tr>
<th>Property</th>
<th>Description</th>
<th>Default</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>Use Heartbeats to Endpoints</td>
<td>Select to enable the heartbeat mechanism. Heartbeat properties are editable only when this option is enabled.</td>
<td>Disabled (unchecked)</td>
<td>Enabled or Disabled</td>
</tr>
<tr>
<td></td>
<td><strong>Note</strong> Endpoints that are not in a Server Group can not use the heartbeat mechanism.</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td><strong>Note</strong> Enable Heartbeat for high-availability and quick recovery of element in case of a failover.</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Property</td>
<td>Description</td>
<td>Default</td>
<td>Value</td>
</tr>
<tr>
<td>---------------------------------------------------------------</td>
<td>-----------------------------------------------------------------------------</td>
<td>--------------------------</td>
<td>----------------------------</td>
</tr>
<tr>
<td>Number of failed Heartbeats for unreachable status</td>
<td>The number of failed heartbeats before marking the destination as unreachable.</td>
<td>1</td>
<td>1 through 5</td>
</tr>
<tr>
<td>Heartbeat Timeout (ms)</td>
<td>The amount of time, in milliseconds, before timing out the heartbeat.</td>
<td>500 milliseconds</td>
<td>100 through 3000</td>
</tr>
<tr>
<td>Up Endpoint Heartbeat Interval (ms)</td>
<td>The ping interval for heart beating an endpoint (status) that is up.</td>
<td>5000 milliseconds</td>
<td>5000 through 3600000</td>
</tr>
<tr>
<td>Down Endpoint Heartbeat Interval (ms)</td>
<td>The ping interval for heart beating an endpoint (status) that is down.</td>
<td>5000 milliseconds</td>
<td>5000 through 3600000</td>
</tr>
<tr>
<td>Heartbeat Local Listen Port</td>
<td>The heartbeat local socket listen port. Responses to heartbeats are sent to this port on CVP by endpoints.</td>
<td>5067</td>
<td>0 through 65000</td>
</tr>
<tr>
<td>Heartbeat SIP Method</td>
<td>The heartbeat SIP method.</td>
<td>OPTIONS</td>
<td>OPTIONS or PING</td>
</tr>
<tr>
<td><strong>Note</strong></td>
<td>PING is an alternate method; however, some SIP endpoints do not recognize PING and will not respond at all.</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Property</td>
<td>Description</td>
<td>Default</td>
<td>Value</td>
</tr>
<tr>
<td>--------------------------------</td>
<td>------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
<td>---------</td>
<td>-----------</td>
</tr>
<tr>
<td>Heartbeat Transport Type</td>
<td>During transportation, Server Group heartbeats are performed with a UDP or TCP socket connection. If the Operations Console encounters unreachable or overloaded callbacks invoked in the Server Group, that element is marked as being down for both UDP and TCP transports. When the element is up again, it is routable for both UDP and TCP. Note: TLS transport is not supported.</td>
<td>UDP</td>
<td>UDP or TCP</td>
</tr>
<tr>
<td>Overloaded Response Codes</td>
<td>The response codes are used to mark an element as overloaded when received. If more than one code is present, it is presented as a comma delimited list. An OPTIONS message is sent to an element and if it receives any of those response codes, then this element is marked as overloaded.</td>
<td>503,480,600</td>
<td>1 through 128 characters. Accepts numbers 0 through 9 and commas (,).</td>
</tr>
<tr>
<td>Property</td>
<td>Description</td>
<td>Default</td>
<td>Value</td>
</tr>
<tr>
<td>----------------------</td>
<td>-----------------------------------------------------------------------------</td>
<td>--------------------</td>
<td>------------------------------------------------</td>
</tr>
<tr>
<td>Options Override Host</td>
<td>The contact header hostname to be used for a heartbeat request (SIP OPTIONS). The given value is added to the name of the contact header of a heartbeat message. Thus, a response to a heartbeat would contain gateway trunk utilization information.</td>
<td>cvp.cisco.com</td>
<td>Valid hostname, limited to 128 characters.</td>
</tr>
</tbody>
</table>

**Server Group Heartbeat Settings**

The Server Group heartbeat default setting tracks the ping interval between any two pings; it is not the interval between pings to the same endpoint. The Server Group does not ping at a specific interval and ping all elements because this approach would introduce a fluctuation on CPU usage. Also, it takes more resources when the system has to ping many endpoints. For example, to ping 3 elements across all groups at 30-second intervals, you have to set the ping interval at 10 seconds.

It is less deterministic for reactive mode because elements that are currently down can fluctuate, so the ping interval fluctuates with it.

---

**Note**

- **Heartbeat Behavior Settings for Server Groups.** To turn off pinging when the element is up, set the Up Endpoint Heartbeat Interval to zero (reactive pinging). To turn off pinging when the element is down, set the Down Endpoint Heartbeat Interval to zero (proactive pinging). To ping when the element is either up or down, set the heartbeat intervals to greater than zero (adaptive pinging).

- **Heartbeat Response Handling.** Any endpoint that CVP may route calls to should respond to OPTIONS with some response, either a 200 OK or some other response. Any response to a heartbeat indicates the other side is alive and reachable. A 200 OK is usually returned, but CUSP Server may return a 483 Too Many Hops response, because the max-forwards header is set to zero in an OPTIONS message. Sometimes the endpoints may not allow OPTIONS or PING, and may return 405 Method Not Allowed.

---

By default, Server Group heartbeats are monitored using a UDP socket connection. The transport type can be changed to TCP from the Operations Console Server Groups window.

Whenever an element has an unreachable or overloaded status, that element is marked as down completely, that is for both UDP and TCP transports. When the element is up again, transports are routed for both UDP and TCP.

---

**Note**

TLS transport is not supported.

Duplicate Server Group Elements is not monitored because the primary element is already monitored.

## Deploy Call Server

**Procedure**

### Step 1
Log in to the Operations Console and select **System > SIP Server Groups**.

The SIP Server Groups Configuration window appears.

### Step 2
Click the **Call Server Deployment** tab.

### Step 3
From the **Associate Unified CVP Call Servers** screen, in the **Available** list box, select one or multiple Call Servers and click the **Add** arrow.

The added Call Servers appear in the **Selected** list box.

**Note**

- Add and deploy at least one Call Server before you configure a SIP Server group. A warning message is displayed if you try to add a SIP Server group without deploying a Call Server. For details on how to configure a Call Server, see *Configure Call Server*, on page 77.

- The Deployment Status screen displays a warning message in the following cases:
  - If you have only saved the SIP server details and have not deployed them.
  - If you have edited or deleted an existing configuration and have not deployed the changes.
  - If you changed the call server association.

- Only one deployment process can run at a time. If one process is already running, you cannot initiate another process and receive an error message.

- A message displays to indicate the successful start of deployment process. The Operations Console saves the Call Server configuration to the Operations Console database and returns to display the new configuration in the list page.

### Step 4
Click **Save & Deploy**.

**Note** Click **Save** to save the changes on the Operations Console and deploy a Call Server for the SIP Server group later.

**Related Topics**

- *Configure Call Server*, on page 77
Dialled Number Pattern Configuration

A dial plan essentially describes the number and pattern of digits that a user dials to reach a particular telephone number. Access codes, area codes, specialized codes, and combinations of the number of digits dialed are all part of a dial plan. For example, the North American Public Switched Telephone Network (PSTN) uses a 10-digit dial plan that includes a 3-digit area code and a 7-digit telephone number. Most PBXs support variable length dial plans that use 3 to 11 digits. Dial plans must comply with the telephone networks to which they connect. A Dialled Number (DN) pattern is dial plan configured on one or multiple Call Servers and provides details on the call flow of dialed digits.

Dial plans on Cisco routers are manually defined using dial peers. Dial peers are similar to static routes; they define where calls originate and terminate and what path the calls take through the network. Attributes within the dial peer determine which dialed digits the router collects and forwards to telephony devices. For more information on Dial plans, see https://www.cisco.com/en/US/docs/ios/12_2/voice/configuration/guide/vcf_bk.pdf.

Use the System menu to configure a DN pattern. Select the Display Pattern Type to display the configured SN patterns in a tree-hierarchy view. The Display Pattern Type list box includes the following options:

- **Display All** (default)
- **Local Static Route**
- **Send Calls to Originator**
- **RNA Timeout for Outbound Calls**
- **Custom Ringtone**
- **Post Call Survey for Incoming Calls**

After you select a view, a table containing the Dialled Number Patterns for the respective, selected type appear. The current view for the dialled number system-level configuration list page is maintained until the user session expires, either by timeout or by signing out from the Operations Console or until the dialled number pattern view type selection changes.

Each dialled number pattern appears as a row. Each dialled number pattern column type can be sorted alphabetically in ascending or descending order. The Dialled Number list is in hierarchical format that lets you collapse or expand individual entries. One or more root hierarchical rows can be selected using the check boxes. All table entries are expanded by default or after certain operations, such as sorting, filtering, and pagination.

The column types are as follows:

**Dialled Number Pattern** - The actual dialled number pattern.

**Description** - The dialled number pattern description.

You may also use the filtering function to filter for specific Dialled Number Patterns. Only the Dialled Number Pattern itself is filterable by the standard constraint criteria (that is, begins with, contains, ends with, is exactly, is empty). The Dialled Number Pattern list also has sortable columns.
Add and Deploy Dialed Number Pattern

Procedure

Step 1 Log in to the Operations Console and select System > Dialed Number Pattern.
Step 2 Click Add New.
Step 3 Enter or modify the Dialed Number pattern configuration settings, as listed in the following table:

Table 52: Dialed Number Pattern Configuration Settings

<table>
<thead>
<tr>
<th>Property</th>
<th>Description</th>
<th>Default</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>General Configuration</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Dialed Number Pattern</td>
<td>The actual Dialed Number Pattern.</td>
<td>None</td>
<td>Must be unique</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>Maximum length of 24 characters</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>Can contain alphanumeric characters, wildcard characters such as exclamation point (!) or asterisk (*), single digit matches such as the letter X or period (.)</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>Can end with an optional greater than (&gt;) wildcard character</td>
</tr>
<tr>
<td>Description</td>
<td>Information about the Dialed Number Pattern.</td>
<td>None</td>
<td>Maximum length of 1024 characters</td>
</tr>
<tr>
<td>Property</td>
<td>Description</td>
<td>Default</td>
<td>Value</td>
</tr>
<tr>
<td>----------------------------------</td>
<td>-----------------------------------------------------------------------------</td>
<td>---------</td>
<td>-----------------------------------------------------------------------</td>
</tr>
<tr>
<td>Enable Local Static Route</td>
<td>Enable local static routes on this Dialed Number Pattern.</td>
<td>Disabled</td>
<td>Maximum length of 128 characters</td>
</tr>
<tr>
<td></td>
<td>If Local Static Routes are enabled:</td>
<td></td>
<td>Must be a valid IP address, hostname, or fully qualified domain name</td>
</tr>
<tr>
<td></td>
<td>• <strong>Route to Device</strong> - Select the device from the drop-down list which</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>contains a list of configured, supported devices. Once a selection is made,</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>the IP Address/Hostname/Server Group Name field is automatically updated</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>with the IP Address of the selected device.</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>• <strong>Route to SIP Server Group</strong> - Select the device from the drop-down list</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>which contains a list of configured, support devices. Once a selection is</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>made, the IP Address/Hostname/Server Group Name field is automatically</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>updated with the IP Address of the selected device.</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>• <strong>IP Address/Hostname/Server Group Name</strong> - If you have not selected a</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td><strong>Route to Device</strong> or <strong>Route to SIP Server Group</strong>, enter the IP address,</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>hostname, or the server group name of the route.</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Enable Send Calls to Originator</td>
<td>Enables calls to be sent to originator.</td>
<td>Disabled</td>
<td>n/a</td>
</tr>
<tr>
<td>Enable RNA Timeout for Outbound Calls</td>
<td>Enables Ring No Answer (RNA) timer for outbound calls.</td>
<td>Disabled</td>
<td>n/a</td>
</tr>
<tr>
<td></td>
<td>• <strong>Timeout</strong> - Enter the timeout value in seconds.</td>
<td></td>
<td>Valid integer in the inclusive range from 5 to 60</td>
</tr>
<tr>
<td>Enable Custom Ringtone</td>
<td>Enables customized ring tone.</td>
<td>Disabled</td>
<td>Maximum length of 256 characters</td>
</tr>
<tr>
<td></td>
<td>• <strong>Ringtone media filename</strong> - Enter the name of the file that contains the</td>
<td></td>
<td>Cannot contain whitespace characters</td>
</tr>
<tr>
<td></td>
<td>ringtone.</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Property</td>
<td>Description</td>
<td>Default</td>
<td>Value</td>
</tr>
<tr>
<td>----------------------------------</td>
<td>------------------------------------------------------------------------------</td>
<td>----------</td>
<td>----------------------------------------------------------------------</td>
</tr>
<tr>
<td>Enable Post Call Survey for In</td>
<td>Enables post call survey for incoming calls.</td>
<td>Disabled</td>
<td>n/a</td>
</tr>
<tr>
<td>coming Calls</td>
<td></td>
<td></td>
<td>Maximum length of 24 characters</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>Can contain alphanumeric characters, wildcard characters such as</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>exclamation point (!) or asterisk (*), single digit matches</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>such as period (.) or X, and can end with an optional greater than</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>(&gt; ) wildcard character</td>
</tr>
</tbody>
</table>

**Step 4**  Click **Save**.

The **Dialed Number Pattern** page appears.

**Step 5**  To deploy the Dialed Number Pattern configuration to all the Call Servers, click **Deploy**.

**Note**  Click **Deployment Status** to view the status of DN pattern deployment.

---

**Web Services Configuration**

Unified CVP offers a Web Services-based framework to deliver a common user experience across all Cisco Unified Communications applications for features, such as setting up preferences, directories, and communication logs, setting serviceability parameters, and collecting, analyzing, and reporting on information necessary to manage and troubleshoot the Cisco Unified Communications solution. This centralized framework enables consistency between Cisco Unified Communications applications and ensures a unified view of common serviceability operations.

The Web Services application interfaces with the Web Services application in following two ways:

- **Web Services User Management**: The Operation Console administrator can configure new Web Services users (users with the Web Services user role type). The Operations Console administrator can also manually push any configured Web Services users using the procedure identified in **Deploy Web Services**, on page 297.

When you make Web Services user information changes and when you successfully deploy a device, all Web Services users are automatically pushed to the deployed Unified CVP devices listed below:

- CVP Call Server
- CVP Reporting Server
- CVP VXML Server
- Unified CVP VXML Server (standalone)
- CVP Remote Operations device

External clients may connect to the Web Services application and authenticate themselves with these credentials.
• **List Application Servers**: The Operations Console currently stores configuration details for all devices in the database. The Operations Console writes this information to a device file which the Web Services application uses to reply to queries from external clients.

**Related Topics**
- Deploy Call Server, on page 292

## Deploy Web Services

### Before you begin

Install Remote Operations on the third-party device.

### Procedure

**Step 1**
Log in to the Operations Console and select **System > Web Services**.

**Step 2**
Click the **Remote Operations Deployment** tab and perform the following steps:

a) Enter the IP Address and Hostname.

b) (Optional) Enter the description of the third-party device.

c) Click **Add** to add the device to the list of devices associated with the Unified CVP deployment Web services.

**Step 3**
Click **Save & Deploy** to save and deploy the configuration to the impacted devices in the Operations Console database.

## IOS Configuration

Configure IOS gateways using templates through Operations Console. Templates are text files that contain the IOS commands required for use in a Unified CVP deployment. You can edit the templates locally and then upload it to the Operation Console. You can deploy the configuration defined in the template to a gateway right from the Operations Console. You can also rollback the configuration on the gateway to the point immediately before the template was deployed.

**Note**
There is only one level of rollback. If you deploy a template (Template A) and then deploy another template (Template B), you can only roll back to Template A.

IOS Configuration consists of:

- Template Management. See **IOS Template Management**, on page 300
- Template Deployment. See **IOS Template Deployment**, on page 302.

You can use the default templates or create custom templates.
The templates contain variables that are placeholders for configuration data. The variables can reference data that is in the Operations Console database as well as reference data that is outside of the Operations Console database, if it is accessible to the Operations Console (such as some portions of the Unified ICM database). The variables are replaced with the actual values of the data when the template is sent to the IOS Gateway.

Templates are located in the following directories on the Operations Console server:

- **Default Templates** - %CVP_HOME%\OpsConsoleServer\IOSTemplates\default
- **Custom Templates** - %CVP_HOME%\OpsConsoleServer\IOSTemplates\custom

**Related Topics**
- IOS Template Management, on page 300
- IOS Template Deployment, on page 302

**IOS Template Format**

The IOS template must have a specific format to be accepted by the Operations Console:

- The first line of the template must be a comment that exactly matches the following format:
  
  ```
  ! Customer Voice Portal 9.0(1) IOS Template
  ```

- The second should be a configure terminal command, such as:
  
  ```
  conf t
  ```

With the exception of variables, all of the commands use standard IOS syntax. The variables that can be used are listed in the following table:
<table>
<thead>
<tr>
<th>Component</th>
<th>Variables</th>
</tr>
</thead>
<tbody>
<tr>
<td>CVP Call Server</td>
<td>• %CVP.Device.CallServer.General.IP Address%</td>
</tr>
<tr>
<td></td>
<td>• %CVP.Device.CallServer.ICM.Maximum Length of DNIS%</td>
</tr>
<tr>
<td></td>
<td>• %CVP.Device.CallServer.ICM.New Call Trunk Group ID%</td>
</tr>
<tr>
<td></td>
<td>• %CVP.Device.CallServer.ICM.Pre-routed Call Trunk Group ID%</td>
</tr>
<tr>
<td></td>
<td>• %CVP.Device.CallServer.SIP.Outbound SRV Domain Name/Server Group Domain Name (FQDN)%</td>
</tr>
<tr>
<td></td>
<td>• %CVP.Device.CallServer.SIP.Outbound Proxy Port%</td>
</tr>
<tr>
<td></td>
<td>• %CVP.Device.CallServer.SIP.Port number for Incoming SIP Requests%</td>
</tr>
<tr>
<td></td>
<td>• %CVP.Device.CallServer.SIP.DN on the Gateway to play the ringtone%</td>
</tr>
<tr>
<td></td>
<td>• %CVP.Device.CallServer.SIP.DN on the Gateway to play the error tone%</td>
</tr>
<tr>
<td></td>
<td>• %CVP.Device.CallServer.SIP.Generic Type Descriptor (GTD) Parameter Forwarding%</td>
</tr>
<tr>
<td></td>
<td>• %CVP.Device.CallServer.SIP.PrependDigits - Number of Digits to Strip and Prepend%</td>
</tr>
<tr>
<td></td>
<td>• %CVP.Device.CallServer.SIP.UDP Retransmission Count%</td>
</tr>
<tr>
<td></td>
<td>• %CVP.Device.CallServer.IVR.Media Server Retry Attempts%</td>
</tr>
<tr>
<td></td>
<td>• %CVP.Device.CallServer.IVR.IVR Service Timeout%</td>
</tr>
<tr>
<td></td>
<td>• %CVP.Device.CallServer.IVR.Call Timeout%</td>
</tr>
<tr>
<td></td>
<td>• %CVP.Device.CallServer.IVR.Media Server Timeout%</td>
</tr>
<tr>
<td></td>
<td>• %CVP.Device.CallServer.IVR.ASR/TTS Server Retry Attempts%</td>
</tr>
<tr>
<td></td>
<td>• %CVP.Device.CallServer.IVR.IVR Service Retry Attempts%</td>
</tr>
<tr>
<td>CVP Reporting Server</td>
<td>%CVP.Device.ReportingServer.General.IP Address%</td>
</tr>
<tr>
<td>Unified CVP VXML Server</td>
<td>%CVP.Device.VXMLServer.General.IP Address%</td>
</tr>
<tr>
<td>Gateway</td>
<td>• %CVP.Device.Gateway.Target.IP Address%</td>
</tr>
<tr>
<td></td>
<td>• %CVP.Device.Gateway.Target.Trunk Group ID%</td>
</tr>
<tr>
<td></td>
<td>• %CVP.Device.Gateway.Target.Location ID%</td>
</tr>
<tr>
<td>SIP Proxy Server</td>
<td>%CVP.Device.SIPProxyServer.General.IP Address%</td>
</tr>
<tr>
<td>Speech Server</td>
<td>%CVP.Device.Speech Server.General.IP Address%</td>
</tr>
<tr>
<td>Component</td>
<td>Variables</td>
</tr>
<tr>
<td>----------------------------</td>
<td>------------------------------------------------</td>
</tr>
<tr>
<td>Unified Communications</td>
<td>%CVP.Device.Unified CM.General.IP Address%</td>
</tr>
<tr>
<td>Manager</td>
<td></td>
</tr>
<tr>
<td>Media Server</td>
<td>%CVP.Device.Media Server.General.IP Address%</td>
</tr>
</tbody>
</table>

**IOS Template Management**

Manage IOS templates by adding, deleting, editing, copying, and viewing details about templates.

**Add New Template**

**Procedure**

**Step 1**
Select System > IOS Configuration > IOS Template Management.

**Step 2**
From the toolbar, select Add New.

The IOS Template Configuration page opens.

**Step 3**
Click Browse to browse to a template file on your local computer. Provide a name for the template and an optional description. Click Save to upload the template file to the Operations Console.

**Note**
The file you select to upload must be of a valid file format or the upload fails. See the IOS Template Format, on page 298 section for details on the format required and the variables that you can use in your template.

A message is displayed confirming successful upload if the file is valid.

**Delete Template**

**Note**
You cannot delete default templates. Only custom templates can be deleted.

**Procedure**

**Step 1**
Select System > IOS Configuration > IOS Template Management.

The IOS Template Management page opens.

**Step 2**
Select the check boxes next to the templates you want to delete.

**Step 3**
From the toolbar, select Delete.

A confirmation appears. Select OK to proceed and delete any custom templates selected.
Edit Templates

You can change the description of any template and edit the body of custom templates from within the browser. However, you cannot edit the body of default templates.

Procedure

Step 1  Select System > IOS Configuration > IOS Template Management.
The IOS Template Management window opens.

Step 2  Select the check box next to the template you want to edit.

Step 3  From the toolbar, select Edit.
The IOS Template Configuration page appears.

Step 4  (Optional) Edit the description field.

Step 5  If this is a custom template, then you can check the Enable template modification check box to allow for editing of the template body. See IOS Template Format, on page 298 for details about template syntax. You can cancel any unsaved changes you made to the body by clicking Undo Template Body Changes.

Step 6  Click Save.

Related Topics
  IOS Template Format, on page 298

Copy Templates

You can copy templates to create a new template to which you can make modifications. It is not possible to edit the body of a default template. However, you can copy a default template and then edit the body of the copy.

Procedure

Step 1  Select System > IOS Configuration > IOS Template Management.
The IOS Template Management window opens.

Step 2  Select the check box next to the template that you want to copy

Step 3  From the toolbar, select Copy.

Step 4  Edit the name and description for the copy.

Step 5  (Optional) Check the Enable template modification check box and make changes to the copy. You can also make changes later. See Edit Templates, on page 301.

Step 6  Select Save.

Related Topics
  Edit Templates, on page 301
**IOS Template Deployment**

Use the IOS Template Deployment page to deploy a gateway configuration template to a gateway. The template provisions the gateway and substitutes any variables in the template with source devices that you choose when you deploy.

From this page, you can:

- Preview the body of the template (and validate the template) and deploy to a gateway.
- Check the status of the template deployment.
- Rollback the configuration sent to a gateway to its previous state.

**Related Topics**

IOS Template Format, on page 298

**Preview and Deploy Template**

To preview (validate) and deploy a template:

**Procedure**

<table>
<thead>
<tr>
<th>Step</th>
<th>Action</th>
</tr>
</thead>
<tbody>
<tr>
<td>Step 1</td>
<td>Log in to the Operations Console and select System &gt; IOS Configuration &gt; IOS Template Deployment.</td>
</tr>
<tr>
<td>Step 2</td>
<td>In the Select Template panel, select the template that you want to deploy.</td>
</tr>
<tr>
<td>Step 3</td>
<td>In the Associate Source Device(s) panel, select the devices to be replaced with device variables in the template.</td>
</tr>
<tr>
<td>Step 4</td>
<td>In the Associated Gateways panel, deselect any of the gateways that will not receive the template deployment. By default, all gateways are selected.</td>
</tr>
<tr>
<td>Step 5</td>
<td>Click Preview and Deploy to validate and preview the template to the selected gateways with the selected settings.</td>
</tr>
</tbody>
</table>

After clicking Preview and Deploy, the script is validated. If there is an error in the script, or if there is a variable in the script for which a device is required with no device selected from the Associate Source Device(s) panel, then errors are listed on the IOS Template Preview Page. Clicking Deploy at this point does not deploy the template, and the status page shows a failure due to an invalid template.

Once the preview screen appears, you can perform one of three actions:

- If the template is valid or invalid, click Enable template modification and edit the template on this screen. Click Verify to verify your changes as valid, or click Undo All Changes to revert the template to the way it was before you began editing.

- If the template is valid, click Deploy to deploy the template to the selected gateways,

- If the template is valid, click Save and Deploy to save the template and deploy the template to the selected gateways. If this is an existing custom template, then any changes you made are saved to this custom template. If this is a default template, then the template is copied to a new custom template and saved.
Check Deployment Status

To check the status of a template deployment:

**Procedure**

**Step 1**
Log in to the Operations Console and select **System > IOS Configuration > IOS Template Deployment**.

**Step 2**
From the toolbar, select **Deployment Status**.

The IOS Template Deployment - Deployment Status window opens.

The status page lists information about the attempted deployment. Click the status message for any deployment for additional details.

Roll Back Deployment

**Note**
There is only one level of rollback. If you deploy a template (Template A) and then deploy another template (Template B), you can only roll back to Template A.

**Procedure**

**Step 1**
Log in to the Operations Console and select **System > IOS Configuration > IOS Template Deployment**.

**Step 2**
From the toolbar, click **Deployment Status**.

The IOS Template Deployment - Deployment Status window opens.

**Step 3**
Check the check box next to the deployment you want to rollback and click **Rollback**.

- A confirmation dialog opens. Read the warning message and click **OK** to continue the rollback.

- A status message is displayed stating that the rollback is in progress. Refresh the status page by clicking **Refresh** to see the status of the rollback.

IOS Gateway Configuration

With Cisco IOS Gateways, dial peers are used to match phone numbers, and the destination can be a SIP Proxy Server, DNS SRV, or IP address. The following example shows a Cisco IOS Gateway configuration to send calls to a SIP Proxy Server using the SIP Proxy's IP address.

```
sip-ua
sip-server ipv4:10.4.1.100:5060

 dial-peer voice 1000 voip
 session target sip-server
 ```
The `sip-server` command on the dial peer tells the Cisco IOS Gateway to use the globally defined SIP Server that is configured under the `sip-ua` settings. In order to configure multiple SIP Proxies for redundancy, you can change the IP address to a DNS SRV record, as shown in the following example. The DNS SRV record allows a single DNS name to be mapped to multiple Reporting Servers.

```
sip-ua
dsip-server dns:cvp.cisco.com

dial-peer voice 1000 voip
  session target sip-server
  ...
```

Alternatively, you can configure multiple dial peers to point directly at multiple SIP Proxy Servers, as shown in the following example. This configuration allows you to specify IP addresses instead of relying on DNS.

```
dial-peer voice 1000 voip
  session target ipv4:10.4.1.100
  preference 1
  ...
dial-peer voice 1000 voip
  session target ipv4:10.4.1.101
  preference 1
  ...
```

In the preceding examples, the calls are sent to the SIP Proxy Server for dial plan resolution and call routing. If there are multiple Unified CVP Call Servers, the SIP Proxy Server would be configured with multiple routes for load balancing and redundancy. It is possible for Cisco IOS Gateways to provide load balancing and redundancy without a SIP Proxy Server. The following example shows a Cisco IOS Gateway configuration with multiple dial peers so that the calls are load balanced across three Unified CVP Call Servers.

```
dial-peer voice 1001 voip
  session target ipv4:10.4.33.131
  preference 1
  ...
dial-peer voice 1002 voip
  session target ipv4:10.4.33.132
  preference 1
  ...
dial-peer voice 1003 voip
  session target ipv4:10.4.33.133
  preference 1
  ...
```

DNS SRV records allow an administrator to configure redundancy and load balancing with finer granularity than with DNS round-robin redundancy and load balancing. A DNS SRV record allows you to define which hosts should be used for a particular service (the service in this case is SIP), and it allows you to define the load balancing characteristics among those hosts. In the following example, the redundancy provided by the three dial peers configured above is replaced with a single dial peer using a DNS SRV record. Note that a DNS server is required in order to do the DNS lookups.

```
  ip name-server 10.4.33.200
  dial-peer voice 1000 voip
  session target dns:cvp.cisco.com
```

With Cisco IOS Gateways, it is possible to define DNS SRV records statically, similar to static host records. This capability allows you to simplify the dial peer configuration while also providing DNS SRV load balancing and redundancy. The disadvantage of this method is that if the SRV record needs to be changed, it must be changed on each gateway instead of on a centralized DNS Server. The following example shows the configuration of static SRV records for SIP services handled by cvp.cisco.com, and the SIP SRV records for cvp.cisco.com are configured to load balance across three servers:
ip host cvp4cc2.cisco.com 10.4.33.132
ip host cvp4cc3.cisco.com 10.4.33.133
ip host cvp4cc1.cisco.com 10.4.33.131

(SRV records for SIP/TCP)
ip host _sip._tcp.cvp.cisco.com srv 1 50 5060 cvp4cc3.cisco.com
ip host _sip._tcp.cvp.cisco.com srv 1 50 5060 cvp4cc2.cisco.com
ip host _sip._tcp.cvp.cisco.com srv 1 50 5060 cvp4cc1.cisco.com

(SRV records for SIP/UDP)
ip host _sip._udp.cvp.cisco.com srv 1 50 5060 cvp4cc3.cisco.com
ip host _sip._udp.cvp.cisco.com srv 1 50 5060 cvp4cc2.cisco.com
ip host _sip._udp.cvp.cisco.com srv 1 50 5060 cvp4cc1.cisco.com

Courtesy Callback

The Courtesy Callback feature, available in Unified CVP, reduces the time callers have to wait on hold/in queue. The feature allows the system to offer callers who meet certain criteria. For example, callers with the possibility of being in queue for more than X minutes, the option to be called back by the system when the wait time would be considerably shorter.

If the caller decides to be called back by the system, then they leave their name and phone number. When the system determines that an agent is available (or will be available soon), then a call is placed back to the caller. The caller must answer the call and indicate that they are the caller. The caller is connected to the agent after a short wait.

Use this page to identify the required Unified CVP Reporting Server for which Courtesy Callback data is stored and deploy them to the selected Unified CVP Call Servers. The configured values for Courtesy Callback are stored as cached attributes.

Configure the Courtesy Callback feature on the following servers/gateways:

- Ingress Gateway (IOS configuration)
- VXML Gateway (IOS configuration)
- Reporting Server (through the Unified CVP Operations Console)
- Media Server (upload of Courtesy Callback media files)
- Unified CVP VXML Server (upload of Call Studio Scripts)
- Unified ICM (through the ICM script)

Note

Callback Criteria

In your callback script, you can establish criteria for offering a caller a courtesy callback. Examples of callback criteria include:

- Number of minutes a customer is expected to wait in queue that exceeds a maximum number of minutes (based on your average call handling time per customer)
The included example scripts use this method for determining callback eligibility.

• Assigned status of a customer (for example, a callback can be given on the basis of status of a customer).
• The service a customer has requested (sales calls, or system upgrades, for example, may be established as callback criteria).

Modifiable Example Scripts and Sample Audio Files

The courtesy callback feature is implemented using Unified CCE scripts. Modifiable example scripts are provided. These scripts determine whether or not to offer the caller a callback, depending on the callback criteria. Sample audio files are also provided.

The example scripts and audio files are located on the CVP installation media in the \CVP\Downloads and Samples\ folder.

Following files are provided:

• CourtesyCallback.ICMS, the ICM script, in the ICMDownloads subfolder.
• CourtesyCallbackStudioScripts.zip, a collection of Call Studio scripts, in the helloStudio Samples subfolder.

Following example scripts are provided:

• BillingQueue: Plays queue music to callers. Can be customized.
• Callback Engine: Keeps the VoIP leg of the call alive when the caller elects to receive the callback (and hangs up) and when the caller actually receives the callback. Cannot be customized or modified.
• CallbackEntry: Initial IVR when caller enters the system and is presented with opportunity for a callback. Can be customized.
• CallbackQueue: Handles the keepalive mechanism for the call when callers are in queue and listening to the music played by BillingQueue. Do not modify this script.
• CallbackWait: Handles IVR portion of call when caller is called back. Can be customized.

• CCBAudioFiles.zip, in the CCBDownloads subfolder, contains sample audio files that accompany the sample studio scripts.
Courtesy Callback Configuration

Configure Courtesy Callback

Procedure

Step 1 Log in to the Operations Console and select System > Courtesy Callback.

Step 2 Select the required Unified CVP Reporting Server, if configured, from the drop-down list.

Note If you leave the selection blank, no Reporting Server is associated with the Courtesy Callback deployment.

Step 3 (Optional) Check the Enable secure communication with the Courtesy Callback database check box to secure the communication between the Call Server and Reporting Server used for Courtesy Callback.

Step 4 In the Dialed Number Configuration section:

The Dialed Number Configuration of Courtesy Callback allows you to restrict the dialed numbers that callers can enter when they are requesting a callback. For example, it can stop a malicious caller from having Courtesy Callback dial 911. The following table lists the configuration options for the Dialed Number Configuration:

<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
<th>Default</th>
</tr>
</thead>
<tbody>
<tr>
<td>Allow Unmatched Dialed Numbers</td>
<td>This checkbox controls whether or not dialed numbers that do not exist in the Allowed Dialed Numbers field can be used for a callback. By default, this is unchecked. If no dialed numbers are present in the Allowed Dialed Numbers list box, then Courtesy Callback does not allow any callbacks.</td>
<td></td>
</tr>
</tbody>
</table>
| Allowed Dialed Numbers | The list of allowed dialed numbers to which callbacks can be sent. You can use dialed number patterns; for example, 978> allows callbacks to all phone numbers in the area code 978. To Add/Remove Dialed Numbers:
• To Add a number to the list of allowed dialed numbers - Enter the dialed number pattern in the Dialed Number (DN) field and click Add.
• To remove a number from the list - Highlight the number and click Remove. |
<p>| | | Unchecked - Callbacks can only be sent to dialed numbers listed in the Allowed Dialed Numbers list. |
| | | Empty - If Allow Unmatched Dialed Numbers is not checked, and this list remained empty, then no callbacks can be made. |</p>
<table>
<thead>
<tr>
<th>Field</th>
<th>Description</th>
<th>Default</th>
</tr>
</thead>
<tbody>
<tr>
<td>Denied Dialed Numbers</td>
<td>The list of denied dialed numbers to which callbacks are never sent. You can use dialed number patterns; for example, 555&gt; allows callbacks to all phone numbers in the area code 555.</td>
<td>The Denied Dialed Numbers window is prepopulated if your local language is &quot;en-us&quot; (United States, English). Be sure to add any additional numbers you want to deny.</td>
</tr>
<tr>
<td></td>
<td>To Add/Remove Dialed Numbers:</td>
<td></td>
</tr>
<tr>
<td></td>
<td>• To Add a number to the list of denied dialed numbers - Enter the dialed number pattern in the Dialed Number (DN): field and click Add.</td>
<td></td>
</tr>
<tr>
<td></td>
<td>• To remove a number from the list - Highlight the number and click Remove.</td>
<td></td>
</tr>
<tr>
<td>Denied numbers takes precedence over allowed numbers.</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>• Wildcarded DN patterns can contain &quot;.&quot; and &quot;X&quot; in any position to match a single wildcard character.</td>
<td></td>
</tr>
<tr>
<td></td>
<td>• Any of the wildcard characters in the set &quot;&gt;*!T&quot; match multiple characters but can only be used as trailing values because they always match all remaining characters in the string.</td>
<td></td>
</tr>
<tr>
<td></td>
<td>• The highest precedence of pattern matching is an exact match, followed by the most specific wildcard match.</td>
<td></td>
</tr>
<tr>
<td></td>
<td>• When the number of characters are matched equally by wildcarded patterns in both the Allowed Dialed Numbers and Denied Dialed Numbers lists, precedence is given to the one in the Denied Dialed Numbers list.</td>
<td></td>
</tr>
<tr>
<td>maximum Number of Calls Per Calling Number</td>
<td>The default value is 0, which is equivalent to an unlimited number of callbacks offered per calling number. The maximum value is 1000.</td>
<td>0</td>
</tr>
<tr>
<td></td>
<td>This setting allows you to limit the number of calls, from the same calling number that are eligible to receive a callback when there are outstanding callbacks already waiting for the same number. If this field is set to a positive number (X), then the courtesy callback “Validate” element only allows X callbacks per calling number to go through the “preemptive” exit state at any time. If there are already X callbacks offered for a calling number, new calls go through the “none” exit state of the “Validate” element. In addition, if no calling number is available for a call, the call always goes through the “none” exit state of the “Validate” element.</td>
<td></td>
</tr>
</tbody>
</table>

**Step 5**  
Click the **Call Server Deployment** tab to view a list of available call servers and to select a Unified CVP Call Server to associate with Courtesy Callback.

**Step 6**  
Click **Save & Deploy**.
Configure Ingress Gateway for Courtesy Callback

The ingress gateway where the call arrives is the gateway that processes the pre-emptive callback for the call, if the caller elects to receive a callback.

Note
A sip-profile configuration is needed on ISR for the courtesy callback feature, only when deploying an IOS-XE version affected by CSCts00930. For more information on the defect, access the Bug Search Tool at https://sso.cisco.com/autho/forms/CDClogin.html.


Procedure

Step 1 Login to the CVP OAMP Operations Console (from the CVP OAMP VM), using this syntax:

Step 2 Copy survivability.tcl from the Operations Console to the flash memory of the gateway. Using the Operations Console, perform the following:
a) Select: Bulk Administration > File Transfer > Scripts and Media.
b) In Device Association, for Select Device Type select: Gateway.
c) Select all the Ingress gateways.
d) From the default gateway files, highlight: survivability.tcl.
e) Click Transfer.

Step 3 Log into the ingress gateway.

Step 4 Configure Call Survivability. See Call Survivability, on page 374 for details.

Step 5 To add services to the gateway, ensure that the enabled-config application mode is turned on. Type these commands at the gateway console:

```
GW81#en
GW81#config
Configuring from terminal, memory, or network [terminal]?
Enter configuration commands, one per line. End with CNTL/Z.
GW81(config)#application
GW81(config-app)#
```

Step 6 Add the following to the survivability service:

```
param ccb id:<host name or ip of this gateway>;loc:<location name>;trunks:<number of callback trunks>
```

Where the definitions of the preceding fields are:
Configure Ingress Gateway for Courtesy Callback

- **id**: A unique identifier for this gateway and is logged to the database to show which gateway processed the original callback request.

- **loc**: An arbitrary location name specifying the location of this gateway.

- **trunks**: The number of DS0's reserved for callbacks on this gateway. Limit the number of T1/E1 trunks to enable the system to limit the resources allowed for callbacks.

The Courtesy Callback (CCB) **trunks** param configuration on the ingress gateway should be calculated based on CCB call parameters by including the average **CCB call duration** and the **fixed throttling period**, to ensure effective utilization of trunks between CCB and non-CCB calls.

The trunk value is given by the equation: Number of DS0 channels * (Throttling period/Average call duration)

**Example**

To dedicate a maximum of 10 DS0 channels for CCB calls, if you consider the following:

- The concurrent CCB calls at any given point is 10.
- The average CCB call duration is 900 seconds which includes the callback registration, callback offered, and talk time of called back user.
- The fixed throttling period is 1800 seconds.

Then, the trunk value will be 10 * (1800/900) = 20

The following example shows a basic configuration:

```
service cvp-survivability flash:survivability.tcl
param ccb id:10.86.132.177;loc:doclab;trunks:1
!
```

If you are updating the survivability service, or if this is the first time you created the survivability service, remember to load the application using the command:

```
call application voice load cvp-survivability
```

**Step 7**
Create the incoming dial peer, or verify that the survivability service is being used on your incoming dial peer. For example:

```
dial-peer voice 978555 pots
service cvp-survivability
incoming called-number 9785551234
direct-inward-dial
!
```

**Note**: We support both POTS and VoIP dial peers that point to a service provider.

**Step 8**
Create outgoing dial peers for the callbacks. These are the dial peers that place the actual call back out to the PSTN. For example:

```
dial-peer voice 978554 pots
destination-pattern 978554....
no digit-strip
port 0/0/1:23
!
```
Step 9 Use the following configuration to ensure that SIP is set up to forward SIP INFO messaging:

```
voice service voip
signaling forward unconditional
```

**Note**  Courtesy Callback supports expected wait time up to 90 minutes. You must set the SIP session expiration timer to a maximum value (7200) to support courtesy call back with call back time more than 30 minutes (default session expiration timer set in the gateway). The ICM router MaxTimeInQueue must be increased to an EWT of 90 minutes or 5400 seconds. The following set of configuration steps are to achieve the same.

---

**Related Topics**

- [Call Survivability](#), on page 374

---

**Configure VXML Gateway for Courtesy Callback**

**Procedure**

**Step 1** Copy `cvp_ccb_vxml.tcl` from the Operations Console to the flash memory of the gateway. Using the Operations Console:

- a) Select **Bulk Administration > File Transfer > Scripts and Media**.
- b) On the **General** tab, select a device association by selecting **Gateway** from the Select Device drop-down box **Gateway**.
- c) From the default gateway files, highlight `cvp_ccb_vxml.tcl`.
- d) Click **Transfer**.

**Step 2** To add services to the gateway, ensure that the enabled-config application mode is turned on. Type the following commands at the gateway console:

```
GW81#en
GW81#config
Configuring from terminal, memory, or network [terminal]? Enter configuration commands, one per line. End with CNTRL/Z.
GW81(config)#application
GW81(config-app)#
```

**Step 3** Add the `cvp_cc` service to the configuration:

```
service cvp_cc flash:cvp_ccb_vxml.tcl
```

The service does not require any parameters.

Load the application with the command:

```
call application voice load cvp_cc
```
The media-activity detection feature should be turned off in the VXML Gateway to successfully callback the caller. With media-activity enabled on the VXML Gateway, the `cvp_cc` service disconnects the waiting callback calls after 'ip rtcp report interval' * 1000 milliseconds interval. This configuration becomes important in a co-located Ingress/VXML setup where media inactivity timers are always enabled. In such scenarios, the 'ip rtcp report interval' has to be increased to support the maximum allowable waiting for a callback call as defined by the solution requirements.

**Step 4** On the VoIP dial-peer that defines the VRU leg from Unified ICM, verify that the codec can be used for recording. The following example shows that g711ulaw can be used for recording in Courtesy Callback:

```
dial-peer voice 123 voip
service bootstrap
incoming called-number 123T
dtmf-relay rtp-nte
codec g711ulaw
no vad
```

In other words, this example shows the g711ulaw codec set on the 123 voip dial-peer. Note that the codec must be specified explicitly. A codec class cannot be used because recording will not work.

**Step 5** Use the following configuration to ensure that SIP is setup to forward SIP INFO messaging:

```
voice service voip
signaling forward unconditional
```

**Step 6** VXML 2.0 is required to play the beep to prompt the caller to record their name in the BillingQueue example script. Add the following text to the configuration so the VXML Server uses VXML 2.0:

```
vxml version 2.0
```

Whenever `vxml version 2.0` is enabled on the gateway, `vxml audioerror` is off by default. When an audio file cannot be played, `error.badfetch` will not generate an audio error event. To have the gateway generate an `error.badfetch` event when a file cannot be played, enable `vxml audioerror` in your gateway configuration. The following example uses config terminal mode to add both commands:

```
config t
vxml version 2.0
vxml audioerror
exit
```

---

**Configure Reporting Server for Courtesy Callback**

**Before you begin**

Install and configure a Reporting Server.
To install Reporting Server, see *Installation and Upgrade Guide for Cisco Unified Customer Voice Portal*. To configure Reporting Server, see Reporting Server Configuration chapter.

### Procedure

**Step 1**
On the Operations Console page, select **System > Courtesy Callback**.

On the **General** tab, you can:

- Select the Reporting Server for Courtesy Callback.
- Enable secure communication with the Courtesy Callback database.
- Configure allowed and disallowed dialed numbers.

**Step 2**
On the Courtesy Callback Configuration page, select the **Unified CVP Reporting Server** drop-down list, and select the Reporting Server to use for storing Courtesy Callback data.

**Note** If you leave the selection blank, no Reporting Server is associated with the Courtesy Callback deployment.

**Step 3**
(Optional) Enable secure communication with the callback reporting database. Check the **Enable secure communication with the Courtesy Callback database** check box.

**Step 4**
Configure allowed and denied dialed numbers. These are the numbers that the system *should* and *should not* call when it is making a courtesy callback to a caller. Also, configure the Maximum Number of Calls Per Calling Number.

Use the following table to configure these fields:

Initially, there are **no** allowed dialed numbers for the Courtesy Callback feature, which means:

- **Allow Unmatched Dialed Numbers** is deselected.
- And, the **Allowed Dialed Numbers window** is empty.

This initial configuration is intentional; you must specifically enable the dialed numbers allowed for your deployment.

If you wish to allow **all** dialed numbers *except* those that are specifically listed in the Denied Dialed Numbers box, check **Allow Unmatched Dialed Numbers**.

Otherwise, add specific allowed number to the Allowed Dialed Numbers box. Refer to the Operations Console online help for detailson how to add specific allowed numbers, and for allowed valid dialed number shortcut patterns.

**Note**

- The Denied Dialed Numbers window is prepopulated if your local language is "en-us" (United States, English). Be sure to add any additional numbers you want to deny.

- Wildcarded DN patterns can contain "." and "X" in any position to match a single wildcard character.

- Any of the wildcard characters in the set "*!T" will match multiple characters but can only be used for trailing values because they will always match all remaining characters in the string.
• The highest precedence of pattern matching is an exact match, followed by the most specific wildcard match.

• When the number of characters are matched equally by wildcarded patterns in both the Allowed Dialed Numbers and Denied Dialed Numbers lists, precedence is given to the one in the Denied Dialed Numbers list.

Step 5  Adjust the “Maximum Number of Calls per Calling Number” to the desired number. By default, this is set to 0 and no limit is imposed.

This setting allows you to limit the number of calls, from the same calling number, that are eligible to receive a callback. If this field is set to a positive number (X), then the courtesy callback “Validate” element only allows X callbacks per calling number to go through the “preemptive” exit state at any time. If there are already X callbacks offered for a calling number, new calls go through the “none” exit state of the “Validate” element. In addition, if no calling number is available for a call, the call always goes through the “none” exit state of the “Validate” element."

Step 6  Click the Call Server Deployment tab and move the Call Server you want to use for courtesy callbacks from the Available box to the Selected box, as shown in the following screen shot:

Step 7  Click Save & Deploy to deploy the new Reporting Server configuration immediately.

If you click Save, the configuration is saved and is deployed after the Reporting Server restarts.

Note  If you are updating the courtesy callback configuration (for example, changing to a different Reporting Server), perform deployment during a scheduled maintenance period. Otherwise, restarting the Reporting Server could cause the cancellation of currently scheduled courtesy callbacks.

Configure Media Server for Courtesy Callback

Several Courtesy-Callback-specific media files are included with the sample scripts for Courtesy Callback. During the Operations Console installation, the media files are placed in the following directory:

%CVP_HOME%\OPSConsoleServer\CCBDownloads\CCBAudioFiles.zip

After CVP installation, the media files are located on the Operations Console in %CVP_Home%\OPSConsoleServer\. A typical value for %CVP_Home% is C:\Cisco\CVP.

CCBAudioFiles.zip has callback-specific application media files in C:\inetpub\wwwroot\en-us\app and the media files for Say it Smart in C:\inetpub\wwwroot\en-us\sys.

Unzip the special audio file copy to a Media Server.

Note  If you selected the Media File installation option, during the Unified CVP installation, the audio files are unzipped and copied to C:\inetpub\wwwroot\en-us\app on the installation server.

Note  CCBAudioFiles.zip also contains media files for Say It Smart. During installation, these files are copied to C:\inetpub\wwwroot\en-us\sys. Copy these files to your media server, if you do not have them there already.
Configure Call Studio Scripts for Courtesy Callback

The Courtesy Callback feature is controlled by a combination of Call Studio scripts and ICM scripts. See the Configuration Guide for Cisco Unified Customer Voice Portal for details of the script logic.

Procedure

Step 1
Extract the example Call Studio Courtesy Callback scripts contained in CourtesyCallbackStudioScripts.zip to a folder on the computer that has Call Studio installed.

You can access the .zip file from the following two locations:

• From the Unified CVP install media in \CVP\Downloads and Samples\StudioSamples\CourtesyCallbackStudioScripts.

• From the Operations Console server in %CVP_HOME%\OPSConsoleServer\StudioDownloads.

Step 2
Each folder contains a Call Studio project having the same name as the folder. The five individual projects comprise the Courtesy Callback feature.

Do not modify the following scripts.

• CallbackEngine: Keeps the VoIP leg of the call alive when the caller elects to receive the callback (and hangs up) and when the caller actually receives the callback.

• CallbackQueue: Handles the keepalive mechanism for the call when callers are in queue and listening to the music played by BillingQueue.

Modify the following scripts to suit your business needs:

• BillingQueue: Determines the queue music played to callers.

• CallbackEntry: Modify the initial IVR treatment a caller receives when entering the system and is presented with an opportunity for a callback.

• CallbackWait: Modify the IVR treatment a caller receives when they respond to the callback.

Note: Do not change the CCB application names.

Step 3
Start Call Studio by selecting Start > Programs > Cisco > Cisco Unified Call Studio.

Step 4
In Call Studio, select File > Import.
Configure Call Studio Scripts for Courtesy Callback

Step 5  In the **Import** dialog box, expand the Call Studio folder and select **Existing Call Studio Project Into Workspace**.

Step 6  Click **Next**.

Step 7  In the **Import Call Studio Project From File System** dialog, browse to the location where you extracted the call studio projects. For each of the folders that are unzipped, select the folder (for example BillingQueue), and click **Finish**.

The project is imported into Call Studio. Repeat this action for each of the five folders.

When you have imported the five folders, you should see five projects in the **Navigator** window in the upper left corner.

Step 8  Update the Default Audio Path URI field in Call Studio to contain the IP address and port value for your Media Server.

For each of the Call Studio projects previously unzipped, complete the following steps:

a)  Select the project in the Navigator window of Call Studio.
b)  Click **Project > Properties > Call Studio > Audio Settings**.
c)  On the Audio Settings window, modify the Default Audio Path URI field by supplying your server IP address and port number for the `<Server>` and `<Port>` placeholders.
d)  Click **Apply**, and then click **OK**.

Step 9  (Optional) Billing Queue Project: Change the music played to the caller while on hold.

You can also create multiple instances of this project if you want to have different hold music for different clients, for example, BillingQueue with music for people waiting for billing, and SalesQueue with music for people waiting for sales. You also need to point to the proper version (BillingQueue or SalesQueue) in the ICM script. In the ICM script, the parameter queueapp=BillingQueue would also have a counterpart, queueapp=SalesQueue.

The CallbackEntry Project (in the following step) contains a node called SetQueueDefaults. This node contains the value Keepalive Interval which must be greater than the length of the queue music you use.

Step 10 Callback Entry Project: If desired, in the CallbackEntry project, modify the caller interaction settings in the SetQueueDefaults node.

This step defines values for the default queue. You can insert multiple SetQueueDefaults elements here for each queue name, if it is necessary to customize configuration values for a particular queue. If you do not have a SetQueueDefaults element for a given queue, the configuration values in the default queue are used.

**Note**  You can define a Callback_Set_Queue_Defaults node with Queue Name parameter set to default. Configuration defined in this default node will be picked whenever a queue type is encountered for which there are no explicitly defined values.

a)  In the Call Studio Navigator panel, open the CallbackEntry project and double click **app.callflow** to show the application elements in the script window.
b)  Open the Start of Call page of the script using the tab at the bottom of the script display window.
c)  Select the SetQueueDefaults node.
d)  In the **Element Configuration panel**, select the Setting tab and modify the following default settings as desired:

   For the SetQueueDefaults element, the caller interaction values in the Start of Call and the Wants Callback elements, may be edited. For more information on the caller interaction values, see the Settings table in Chapter 10, Callback_Set_Queue_Defaults, in the *Element Specifications for Cisco Unified CVP VXML Server and Cisco Unified Call Studio* guide.
Step 11  Perform the following steps.

1. Set the path for the storage of recorded caller names.
2. Select app.callflow.
3. In the CallbackEntry project, on the Wants Callback page, highlight the Record Name node and click the Settings tab in the Element Configuration window of Call Studio.
4. In the Path setting, change the path to the location where you want to store the recorded names of the callers.

By default, Call Studio saves the path string in your VXML Server audio folder. If you are using the default path, you can create a new folder called Recordings in the \%CVP_HOME\%VXMLServer\Tomcat\webapps\CVP\audio\ folder on the VXML Server. If you are using IIS as your Media Server, create a new folder called Recordings in C:\Inetpub\wwwroot\en-us\app and set that as the path for recordings.

Step 12  Set the name of the Record name file.

From the CallbackEntry project on the Wants Callback page, highlight the Add Callback to DB node and select the Settings tab in the Element Configuration window of Call Studio.

Change the Recorded name file setting to match the location of the recording folder you created.

This setting references the URL of the recordings folder, whereas the Path setting references the file system path.

The AddCallback element setting in the CallbackEntry project is configured to do automatic recorded file deletions. If automatic recorded file deletion is not desired, then remove the value of the Recorded name path setting in the AddCallback element. This removal action assumes that you will be doing the deletion or management of the recorded file yourself.

Step 13  In the CallbackEntry project on the Callback_Set_Queue_Defaults node, be sure the keepalive value (in seconds) is greater than the length of the queue music being played. The default is 120 seconds.

Step 14  Save the CallbackEntry project.

Step 15  CallbackWait Project: Modifying values in the CallbackWait application.

In this application, you can change the IVR interaction that the caller receives at the time of the actual callback. The caller interaction elements in CallbackWait > AskIfCallerReady (page) may be modified. Save the project after you modify it. The WaitLoop retry count can also be modified from the default of six retries in the Check Retry element. This will allow a larger window of time to pass before the call is dropped from the application. It is used in a failure scenario when the CallbackServlet on the reporting server cannot be reached. For instance, in a reboot or a service restart, this allows more time for the reporting server to reload the entry from the database when it is initializing. If the reporting server is not online within the retry window, then the entry will not be called back.

Step 16  Validate each of the five projects associated with the Courtesy Callback feature by right-clicking each Courtesy Callback project in the Navigator window and selecting Validate.

Step 17  Validate each of the five projects associated with the Courtesy Callback feature and deploy them to your VXML Server.

a) Right-click each Courtesy Callback project in the Navigator window and select Validate.

b) Right-click each of the projects and click Deploy, then click Finish.

Step 18  Using windows explorer, navigate to \%CVP_HOME\%VXMLServer\applications.
Step 19  For each of the five Courtesy Callback applications, open the project's admin folder in %CVP_Home%\VXMLServer\applications, and double-click deployApp.bat to deploy the application to the VXML Server.

Step 20  Verify that all the applications are running by going into %CVP_HOME%\VXMLServer\admin and double-clicking status.bat. All five applications should be listed under Application Name, and the status for each one should be Running.

---

Note  As an alternative to following steps 16-19 above, to deploy a VXML application to the VXML Server, you can also use the Bulk Administration VXML Applications feature. This way, you can deploy all the applications into a single archive, and then deploy them from OAMP in one click. This process is simpler and saves time. Bulk Administration deploys the application to the VXML Server, and then executes update-all-apps batch file, then executes deploy-all-new-apps batch file.

---

CCE Script forCourtesy Callback

This section describes of the scripts used for the courtesy callback feature. There are nine numbered blocks or sets of blocks as identified below.

Note  In the following example, the yellow comment blocks describe the value being set and the location where the value is being sent.
The numbered blocks in the above figure as described as follows:

- **Block 1**: Enable callback or shut it off.

- **Block 2**: Compute average wait time. Once the caller is in queue, calculate the Estimated Wait Time (EWT) for that queue and place the value in ToExtVXML[0].

If there is poor statistical sampling because of sparse queues and the wait time cannot be calculated in the VXML Server, use the ICM-calculated estimated wait time.

One method of calculating EWT (the method used in this example) is:

```
ValidValue((SkillGroup.%1%.RouterCallsQNow+1) * (ValidValue(SkillGroup.%1%.AvgHandledCallsTimeTo5,20)) /max(SkillGroup.%1%.Ready, (SkillGroup.%1%.TalkingIn + SkillGroup.%1%.TalkingOut + SkillGroup.%1%.TalkingOther)))
```
Modify this method if you are looking at multiple skill groups (when queuing to multiple skills).

- Block 3: Set up parameters to be passed.
- Block 4: Run this block and prompt the caller. If the caller does not accept the offer for a callback, keep the caller in the queue and provide queue music.
- Block 5: Set up variables. Call flow returns to this block if the caller elects to receive a callback. Otherwise, the call remains queuing in the queuing application (BillingQueue in this example) on the VXML Server.
- Block 6: Run external to Callback engine to keep the call alive. If the agent becomes available and there is no caller, then agent can't interrupt (do not want an agent to pick up and have no one there).
- Block 7: Has the caller rejected the callback call? If no, then go to block 8.
- Block 8: Set up variables.
- Block 9: Put caller briefly into queue (after caller accepts the actual callback call)

**Overview of CCE Script Configuration for Courtesy Callback**

The CCE script elements needed to enable Courtesy Callback are on the CVP Installation CD in CVP\Downloads and Samples\ICM Downloads. The script sample found there (CourtesyCallback) contains the necessary sample elements for the courtesy callback feature. However you must merge this script into your existing CCE scripts.

As a starting point and to run a simple test, import the script into the CCE script editor, validate it with the CCE script editor validation tool to locate nodes that need extra configuration (such as for Network VRU scripts and expanded call variables), and then modify the script according to your existing CCE environment.

1. Locate each queue point in every CCE script. For example: Queue To Skill Group, Queue to Enterprise Skill Group, Queue to Scheduled Target or Queue to Agent.

2. Categorize each queue point according to the pool of resources that it is queuing for. Each unique pool of resources will ultimately require a queue in VXML Server if Courtesy Callback is going to be offered for that resource pool. For example, using the following example, QueueToSkill X and QueueToSkill Z are queuing for the exact same resource pool (despite the different queuing order). Queue to Skill Y, however, is queuing to a different pool because it includes Skill Group D.

   - QueueToSkillGroup X is queuing for Skill Group A, B, C in that order.
   - QueueToSkillGroup Y is queuing for Skill Group A, C and D in that order.
   - QueueToSkillGroup Z is queuing for Skill Group C, B, A in that order.

3. Assign a unique name to each unique resource pool. In the above example, we can use names ABC and ACD as example names.

4. For each resource pool, decide whether callbacks will be allowed in that resource pool. If yes, then every occurrence of that resource pool in all ICM scripts must be set up to use VXML Server for queuing. This is to ensure that the Courtesy Callback mechanism in the VXML Server gets a full, accurate picture of each resource pool's queue.
5. For any queue point where Courtesy Callback will be offered, modify all CCE scripts that contain this queue point according to the guidelines in the following CCE script examples.

**Configure the CCE Script for Courtesy Callback**

Many of the configuration items below relate to the numbered blocks in the diagram and provide understanding for CCE Script for Courtesy Callback. See [CCE Script for Courtesy Callback](#) on page 318 for details. Steps that refer to specific blocks are noted at the beginning of the each step.

To configure CCE to use the sample Courtesy Callback CCE script, perform the following steps:

**Procedure**

| Step 1 | Copy the CCE example script, **CourtesyCallback.ICMS** to the CCE Admin Workstation.  
The example CCE script is available in the following locations:  
- On the CVP install media in \CVPMedia\ToDeploy\Developer\UnifiedCVP\Samples\CCE\Custom.  
- From the Operations Console in %CVP_HOME%\OPSConsoleServer\ICMDownloads |
|--------|--------------------------------------------------------------------------------------------------|
| Step 2 | Map the route and skill group to the route and skill group available for courtesy callback.  
a) In Script Editor, select **File > Import Script...**  
b) In the script location dialog, select the **CourtesyCallback.ICMS** script and click **Open**.  
c) In the Import Script - Manual Object Mapping window, map the route and skill group to the route and skill group available for courtesy callback (identified previously). |
| Step 3 | Once the script is open in Script Editor, open the **Set media server** node and specify the URL for your VXML Server.  
For example: [http://10.86.132.139:7000/CVP](http://10.86.132.139:7000/CVP) |
| Step 4 | Refer to Block #1: A new ECC variable is used when determining if a caller is in queue and can be offered a callback. Define the **user.CourtesyCallbackEnabled** ECC variable for courtesy callback.  
a)  
b) On the CCE Admin Workstation, in the ICM Configuration Manager, use the Expanded Call Variable List tool.  
c) Create **user.CourtesyCallbackEnabled**.  
d) Set **Maximum Length** to 1.  
e) Check **Enabled**.  
f) Check **Persistent**.  
This step assumes you have already created the standard ECC variables required for any Unified CVP installation. See [Define Unified CVP ECC Variables](#) on page 141. |
| Step 5 | Block #2: If you wish to use a different estimated wait time (EWT), modify the calculation in block #2; you will need to do this if you use a different method for calculating EWT or if you are queuing to multiple skill groups. |
| Step 6 | Block #3: Set up the parameters that will be passed to CallbackEntry (VXML application). |
Configure the CCE Script for Courtesy Callback

Note

This step assumes you have already configured the CCE and expanded call variables not related to Courtesy Callback.

Variable values specific to Courtesy callback include:

ToExtVXML[0] = concatenate("application=CallbackEntry",";ewt=",Call.user.microapp.ToExtVXML[0])

ToExtVXML[1] = "qname=billing";

ToExtVXML[2] = "queueapp=BillingQueue;"

ToExtVXML[3] = concatenate("ani=",Call.CallingLineID,";")

Definitions related to these variables are:

• CallbackEntry is the name of the VXML Server application that will be executed.
• ewt is calculated in Block #2.
• qname is the name of the VXML Server queue into which the call will be placed. There must be a unique qname for each unique resource pool queue.
• queueapp is the name of the VXML Server queuing application that will be executed for this queue.
• ani is the caller's calling Line Identifier.

Step 7

Create Network VRU Scripts.

Using the ICM Configuration Manager, Network VRU Script List tool, create the following Network VRU Scripts:

Block #4: Interruptible Script (agent can interrupt the caller on hold):

• Name: VXML_Server_Interruptible
• Network VRU: Select your Type 10 CVP VRU
• VRU Script Name: GS,Server,V,interrupt
• Timeout: 9000 seconds
• Interruptible: Checked

Block #6: Noninterruptible Script (agent cannot interrupt because no caller is available):

• Name: VXML_Server_Noninterruptible
• Network VRU: Select your Type 10 CVP VRU
• VRU Script Name: GS,Server,V,nointerrupt
• Timeout: 9000 seconds (must be greater than the maximum possible call life in Unified CVP)
• Interruptible: Not Checked

Step 8

Verify that the user.microapp.ToExtVXML ECC variable is Enabled, Persistent, with at least 60 (chars) for the maximum length setting, set up as an array with a maximum array size of 5 elements.

Check Array and then a subfield for Maximum array size appears.
Step 9  Verify that the `user.microapp.FromExtVXML` variable is Enabled, Persistent, with at least 60 (chars) for the maximum length setting, set up as an array with a maximum array size of 4 elements.

Check **Array** and then a subfield for **Maximum array size** appears.

Step 10  Verify that you have at least one available route and skill group to map to the route and skill group in the example script.

Step 11  Save the script, then associate the call type and schedule the script.

**Note**  For an example of scheduling the script refer to *Getting Started with Cisco Unified Customer Voice Portal*, the *Create a Call Type Manager Entity Routing Script and Call Schedule* topic.

---

**Related Topics**

- CCE Script for Courtesy Callback, on page 318
- Define Unified CVP ECC Variables, on page 141
Configure the CCE Script for Courtesy Callback
Unified CVP Security

This chapter describes security considerations for Unified CVP call flow model deployments.

- Secure JMX Communication between CVP Components, on page 325
- Secure JMX Communication between OAMP and Call Server using Mutual Authentication, on page 330
- Secure SIP Communication between Call Server and Cisco VVB, on page 336
- Secure HTTPS Communication between VXML Server and Cisco VVB, on page 339
- Secure HTTPS Communication between Media Server and Cisco VVB, on page 343
- Secure Communication on CUCM, on page 343
- Secure Communication between Ingress Gateway and Call Server, on page 345
- Secure Communication on CUSP, on page 351

Secure JMX Communication between CVP Components

You can secure JMX communication by:

- Exchanging the self-signed certificates between the components.
- Signing the certificates by a Certificate Authority.

Self-Signed Certificates

On OAMP

Log in to the Operations Console Server. Retrieve the keystore password from the security.properties file.

Note

At the command prompt, enter more %CVP_HOME%\conf\security.properties.

Secure.keystorePW = <Returns the keystore password>

Enter the keystore password when prompted.
Procedure

Step 1  Import the copied ORM certificate by running

```
%CVP_HOME%\jre\bin\keytool.exe -import -trustcacerts -keystore
%CVP_HOME%\conf\security\.keystore -storetype JCEKS -alias
orm_orm_certificate -file %CVP_HOME%\conf\security\orm_security.cer>.
```

Step 2  Enter the keystore password when prompted.

Step 3  Trust this certificate? [no]: yes

Step 4  Restart OAMP service.

Step 5  Log into OAMP. To enable secure communication between OAMP and Call Server or VXML Server, navigate to Device Management > Call Server. Check the Enable secure communication with the Ops console check box. Save and deploy both Call Server and VXML Server.

On Call Server or VXML Server or Reporting Server

**Procedure**

**On Call Server or VXML Server or Reporting Server**

**Procedure**

Step 1  Export the ORM certificate by running

```
%CVP_HOME%\jre\bin\keytool.exe -export -v -keystore %CVP_HOME%\conf\security\.ormkeystore -storetype JCEKS -alias
orm_orm_certificate -file %CVP_HOME%\conf\security\orm_security.cer>.
```

Step 2  Enter the keystore password when prompted.

Step 3  Copy the generated ORM certificate to %CVP_HOME%\conf\security\ on the OAMP machine.

**On Call Server or VXML Server or Reporting Server**

**Procedure**

Step 1  Configure ORM in CVP:

a)  Go to c:/cisco/cvp/conf/orm_jmx.properties.

Add or update the file as shown and save it:

```
javax.net.debug = all
com.sun.management.jmxremote.ssl.need.client.auth = false
com.sun.management.jmxremote.authenticate = false
com.sun.management.jmxremote.port = 2099
com.sun.management.jmxremote.ssl = true
com.sun.management.jmxremote.rmi.port = 3000
javax.net.ssl.keyStore = C:/Cisco/CVP/conf/security/ormKeystore
javax.net.ssl.keyStorePassword = <keystore_password>
```

b)  Go to c:/cisco/cvp/conf/wrapper.conf.

Update the keystore password as shown and save the file:
### Step 2

**Configure JMX of callserver in CVP:**

a) **Go to c:/cisco/cvp/conf/jmx_callserver.conf.**

Update the file as shown and save the file:

```java
com.sun.management.jmxremote.ssl.need.client.auth = false
com.sun.management.jmxremote.authenticate = false
com.sun.management.jmxremote.port = 2098
com.sun.management.jmxremote.ssl = true
javax.net.ssl.keyStore = C:/Cisco/CVP/conf/security/.ormKeystore
javax.net.ssl.keyStorePassword = <Keystore password>
```

### Step 3

**Configure JMX of VXMLServer in CVP:**

a) **Go to c:/cisco/cvp/conf/jmx_vxml.conf**

Edit the file as shown and save the file:

```java
com.sun.management.jmxremote.ssl.need.client.auth = false
com.sun.management.jmxremote.authenticate = false
com.sun.management.jmxremote.port = 9696
com.sun.management.jmxremote.ssl = true
javax.net.ssl.keyStore = C:/Cisco/CVP/conf/security/.ormKeystore
javax.net.ssl.keyStorePassword = <keystore password>
```

### Step 4

**Restart Cisco CVP Call Server and VXML Server.**

### Step 5

**Repeat the steps for the Reporting Server.**

---

**On Call Server or VXML Server or Reporting Server**

**Procedure**

### Step 1

Import the certificate to the callserver keystore by running `%CVP_HOME%\jre\bin\keytool.exe -import -trustcacerts -keystore %CVP_HOME%\conf\security\keystore -storetype JCEKS -alias wsm_oamp_certificate -file %CVP_HOME%\conf\security\<oamp_security.cer>.

### Step 2

Enter the keystore password when prompted.

### Step 3

Restart the Operation Console Server and the Call Server.
CA-Signed Certificates

On OAMP

Log in to the Operations Console Server. Retrieve the keystore password from the security.properties file.

Note

At the command prompt, enter `more %CVP_HOME%\conf\security.properties`.

Security.keystorePW = <Returns the keystore password>

Enter the keystore password when prompted.

Procedure

Step 1  Generate CSR on OAMP by running `%CVP_HOME%\jre\bin\keytool.exe -storetype JCEKS -keystore %CVP_HOME%\conf\security\keystore -certreq -alias oamp_certificate -file %CVP_HOME%\conf\security\oamp.csr`.

Step 2  Enter the keystore password when prompted.

Step 3  Sign the certificate on a CA.

Step 4  Copy the root CA certificate and the CA-signed certificate to %CVP_HOME%\conf\security\. 

Step 5  Import the root CA certificate by running `%CVP_HOME%\jre\bin\keytool.exe -storetype JCEKS -keystore %CVP_HOME%\conf\security\keystore -import -v -trustcacerts -alias root -file %CVP_HOME%\conf\security\<filename_of_root_cert>`. 

Step 6  Enter the keystore password when prompted.

Step 7  Import the CA-signed certificate by running `%CVP_HOME%\jre\bin\keytool.exe -storetype JCEKS -keystore %CVP_HOME%\conf\security\keystore -import -v -trustcacerts -alias oamp_certificate -file %CVP_HOME%\conf\security\<filename_of_CA_signed_cert>`.

On Call Server or VXML Server or Reporting Server

Log in to the Call Server or VXML Server or Reporting Server. Retrieve the keystore password from the security.properties file.

Note

At the command prompt, enter `more %CVP_HOME%\conf\security.properties`.

Security.keystorePW = <Returns the keystore password>

Enter the keystore password when prompted.

Procedure

Step 1  Generate CSR on Call Server or VXML Server or Reporting Server by running `%CVP_HOME%\jre\bin\keytool.exe -storetype JCEKS -keystore`. 

Step 2  Enter the keystore password when prompted.

Step 3  Sign the certificate on a CA.

Step 4  Copy the root CA certificate and the CA-signed certificate to %CVP_HOME%\conf\security\. 

Step 5  Import the root CA certificate by running `%CVP_HOME%\jre\bin\keytool.exe -storetype JCEKS -keystore %CVP_HOME%\conf\security\keystore -import -v -trustcacerts -alias root -file %CVP_HOME%\conf\security\<filename_of_root_cert>`. 

Step 6  Enter the keystore password when prompted.

Step 7  Import the CA-signed certificate by running `%CVP_HOME%\jre\bin\keytool.exe -storetype JCEKS -keystore %CVP_HOME%\conf\security\keystore -import -v -trustcacerts -alias oamp_certificate -file %CVP_HOME%\conf\security\<filename_of_CA_signed_cert>`.
Step 2  Sign the certificate on a CA.

Step 3  Copy the root CA certificate and the CA-signed certificate to %CVP_HOME%\conf\security\.  

Step 4  Import the root CA certificate by running %CVP_HOME%\jre\bin\keytool.exe -storetype JCEKS -keystore %CVP_HOME%\conf\security\.ormkeystore -import -v -trustcacerts -alias root -file %CVP_HOME%\conf\security\\filename_of_root_cert\.

Step 5  Enter the keystore password when prompted.

Step 6  Import the CA-signed certificate by running %CVP_HOME%\jre\bin\keytool.exe -storetype JCEKS -keystore %CVP_HOME%\conf\security\.ormkeystore -import -v -trustcacerts -alias orm_certificate -file %CVP_HOME%\conf\security\\filename_of_CA_signed_cert\.

Step 7  Configure ORM in CVP:

a) Go to c:/cisco/cvp/conf/orm_jmx.properties.

Add or update the file as shown and save it:

javax.net.debug = all
com.sun.management.jmxremote.ssl.need.client.auth = false
com.sun.management.jmxremote.authenticate = false
com.sun.management.jmxremote.port = 2099
com.sun.management.jmxremote.ssl = true
com.sun.management.jmxremote.rmi.port = 3000
javax.net.ssl.keyStore= C:/Cisco/CVP/conf/security/.ormKeystore
javax.net.ssl.keyStorePassword= <keystore_password>

b) Go to c:/cisco/cvp/conf/wrapper.conf.

Update the keystore password as shown and save the file:

# Java Additional Parameters
wrapper.java.additional.1= -Djavax.net.ssl.keyStore=C:/Cisco/CVP/conf/security/.ormKeystore
wrapper.java.additional.2= -Djavax.net.ssl.keyStorePassword= <Keystore password>
wrapper.java.additional.3= -Djavax.net.ssl.keyStoreType=JCEKS
wrapper.java.additional.4= -Djavax.net.ssl.trustStore=C:/Cisco/CVP/conf/security/.ormKeystore
wrapper.java.additional.5= -Djavax.net.ssl.trustStorePassword= <Keystore password>
wrapper.java.additional.6= -Djavax.net.ssl.trustStoreType=JCEKS
wrapper.java.additional.7= -DCom.sun.management.config.file=../conf/orm_jmx.properties
wrapper.java.additional.8= -Dcom.sun.management.config.file=log4j_orm.xml
wrapper.java.additional.9= -Djava.rmi.server.hostname=<IP address of ORM server>

Step 8  Configure JMX of callserver in CVP:

a) Go to c:/cisco/cvp/conf/jmx_callserver.conf.

Update the file as shown and save the file:

com.sun.management.jmxremote.ssl.need.client.auth = false
com.sun.management.jmxremote.authenticate = false
com.sun.management.jmxremote.port = 2098
com.sun.management.jmxremote.ssl = true
com.sun.management.jmxremote.rmi.port = 2097
javax.net.ssl.keyStore = C:/Cisco/CVP/conf/security/.ormKeystore
javax.net.ssl.keyStorePassword = <keystore_password>

Step 9  Configure JMX of VXMLServer in CVP:

a) Go to c:/cisco/cvp/conf/jmx_vxml.conf
Secure JMX Communication between OAMP and Call Server using Mutual Authentication

You can secure JMX communication by:

- Exchanging the CA-signed certificates between the components.
- Signing the certificates by a Certificate Authority.

Edit the file as shown and save the file:

```
com.sun.management.jmxremote.ssl.need.client.auth = false
com.sun.management.jmxremote.authenticate = false
com.sun.management.jmxremote.port = 9696
com.sun.management.jmxremote.ssl = true
javax.net.ssl.keyStore = C:/Cisco/CVP/conf/security/.ormKeystore
javax.net.ssl.keyStorePassword = <keystore_password>
```

**Step 10**

Restart the Operation Console Server and the CVP server.

**Note**

To enable Courtesy Callback feature in the secure mode, add the CA root certificate to Tomcat trust store. Keytool in %CVP_HOME%/jre/bin>keytool.exe
- keytool in %CVP_HOME%/jre\bin\keytool.exe
  - keystore%CVP_HOME%/jre/lib/security/cacerts -storepass changeit
  - importcert -file %CVP_HOME%/conf/security/CA_Root.cer.


Generate CA-Signed Certificate for ORM Service in Call Server/VXML Server/Reporting Server

Log into the Call Server or VXML Server or Reporting Server. Retrieve the keystore password from the security.properties file.

Note
At the command prompt, enter more %CVP_HOME%\conf\security.properties.

Security.keystorePW = <Returns the keystore password>
Enter the keystore password when prompted.

Procedure

Step 1
Go to %CVP_HOME%\conf\security and delete the ORM certificate from by running %CVP_HOME%\jre\bin\keytool.exe -storetype JCEKS -keystore %CVP_HOME%\conf\security\ormkeystore -delete -alias orm_certificate. Enter the keystore password when prompted.

Step 2
Generate a CA-signed certificate for ORM server by running %CVP_HOME%\jre\bin\keytool.exe -storetype JCEKS -keystore %CVP_HOME%\conf\security\ormkeystore -genkeypair -alias orm_certificate -v -keysize 2048 -keyalg RSA.

a) Enter the details at the prompts and type Yes to confirm.
b) Enter the keystore password when prompted.

Note
The CN provided here while generating the key is referred to as <CN of Callserver ORM certificate> in the following steps. Note the CN name for future reference.

Step 3
Generate the certificate request for the alias by running the following command and saving it to a file (for example, orm.csr): %CVP_HOME%\jre\bin\keytool.exe -storetype JCEKS -keystore %CVP_HOME%\conf\security\ormkeystore -certreq -alias orm_certificate -file %CVP_HOME%\conf\security\orm.csr.

a) Enter the keystore password when prompted.
b) Verify that the CSR was generated successfully by running dir orm.csr.

Step 4
Sign the certificate on a CA.

Note
Follow the procedure to create a CA-signed certificate using the CA authority. Download the certificate and the root certificate of the CA authority.

Step 5
Copy the root certificate and the CA-signed ORM certificate to %CVP_HOME%\conf\security\.

Step 6
Import the root certificate by running %CVP_HOME%\jre\bin\keytool.exe -storetype JCEKS -keystore %CVP_HOME%\conf\security\ormkeystore -import -v -trustcacerts -alias root -file %CVP_HOME%\conf\security\<filename_of_root_cer>.

a) Enter the keystore password when prompted.
b) At Trust this certificate prompt, type Yes.
Step 7  Import the CA-signed ORM certificate by running

```bash
%CVP_HOME%\jre\bin\keytool.exe -storetype JCEKS -keystore %CVP_HOME%\conf\security\.ormkeystore -import -v -trustcacerts -alias orm_certificate -file %CVP_HOME%\conf\security\<filename_of_your_signed_cert_from_CA>. Enter the keystore password when prompted.
```

Step 8  Configure ORM in CVP:

a) Go to c:\cisco\cvp\conf\orm_jmx.properties.

Add or update the file as shown and save it:

```bash
javax.net.debug = all
com.sun.management.jmxremote.ssl.need.client.auth = true
com.sun.management.jmxremote.authenticate = false
com.sun.management.jmxremote.ssl = true
com.sun.management.jmxremote.rmi.port = 2099
javax.net.ssl.keyStore=C:\Cisco\CVP\conf\security\.ormKeystore
javax.net.ssl.keyStorePassword=<keystore_password>
```

b) Go to c:\cisco\cvp\conf\wrapper.conf.

Update the keystore password as shown and save the file:

```bash
# Java Additional Parameters
wrapper.java.additional.1= -Djavax.net.ssl.keyStore=C:/Cisco/CVP/conf/security/.ormKeystore
wrapper.java.additional.2= -Djavax.net.ssl.keyStorePassword=<Keystore password>
wrapper.java.additional.3= -Djavax.net.ssl.keyStoreType=JCEKS
wrapper.java.additional.4= -Djavax.net.ssl.trustStore=C:/Cisco/CVP/conf/security/.ormKeystore
wrapper.java.additional.5= -Djavax.net.ssl.trustStorePassword=<Keystore password>
wrapper.java.additional.6= -Djavax.net.ssl.trustStoreType=JCEKS
```

```
wrapper.java.additional.7= -Dcom.sun.management.config.file=../conf/orm_jmx.properties
wrapper.java.additional.8= -Dccbu.logging.config.file=log4j_orm.xml
wrapper.java.additional.9= -Djava.rmi.server.hostname=<IP address of ORM server>
```

Re-kid you C C V P Resource Manager service.

Step 9  Configure JMX of callserver in CVP:

a) Go to c:\cisco\cvp\conf\jmx_callserver.conf.

Update the file as shown and save the file:

```bash
com.sun.management.jmxremote.ssl.need.client.auth = true
com.sun.management.jmxremote.authenticate = false
com.sun.management.jmxremote.ssl = true
com.sun.management.jmxremote.rmi.port = 2097
javax.net.ssl.keyStore = C:\Cisco\CVP\conf\security\.ormKeystore
javax.net.ssl.keyStorePassword = <Keystore password>
```

b) Run the regedit command.

Navigate to HKEY_LOCAL_MACHINE\SOFTWARE\Wow6432Node\Apache Software Foundation\Procrun 2.0\CallServer\Parameters\Java\Options.

Append the following to the file:

```bash
-Djavax.net.ssl.trustStore=C:\Cisco\CVP\conf\security\.ormKeystore
-Djavax.net.ssl.trustStorePassword=<Keystore password>
-Djavax.net.ssl.trustStoreType=JCEKS
```

c) Restart Cisco CVP Callserver service.
Step 10 Configure JMX of VXML Server in CVP:

a) Go to `c:\cisco\cvp\conf\jmx_vxml.conf`.
   Edit the file as shown and save the file:
   ```
   com.sun.management.jmxremote.ssl.need.client.auth = true
   com.sun.management.jmxremote.authenticate = false
   com.sun.management.jmxremote.port = 9696
   com.sun.management.jmxremote.ssl = true
   com.sun.management.jmxremote.rmi.port = 9697
   javax.net.ssl.keyStore = C:\Cisco\CVp\conf\security\.ormKeystore
   javax.net.ssl.keyStorePassword = <Keystore password>
   ```

b) Run the `regedit` command.
   Navigate to `HKEY_LOCAL_MACHINE\SOFTWARE\Wow6432Node\Apache Software Foundation\Procrun 2.0\VXMLServer\Parameters\Java`.
   Append the following to the file:
   ```
   -Djavax.net.ssl.trustStore=C:\Cisco\CVp\conf\security\.ormKeystore
   -Djavax.net.ssl.trustStorePassword=<Keystore password>
   ```

c) Restart Cisco CVP VXML Server service.

---

**Generate CA-Signed Client Certificate for ORM (to be done on Call Server)**

Log into the Call Server or VXML Server or Reporting Server. Retrieve the keystore password from the `security.properties` file.

### Note

At the command prompt, enter `more %CVP_HOME%\conf\security.properties`.

`Security.keystorePW=<Return the keystore password>`

Enter the keystore password when prompted.

---

**Before you begin**

This requires ORM of Callserver/VXML Server machine to connect to Callserver and VXMLServer ORM service.

**Procedure**

### Step 1

Go to `%CVP_HOME%\conf\security` and generate a CA-signed certificate for client authentication with callserver by running

```
%CVP_HOME%\jre\bin\keytool.exe -storetype JCEKS -keystore %CVP_HOME%\conf\security\.ormkeystore -genkeypair -alias <CN of Callserver ORM certificate> -v -keysize 2048 -keyalg RSA.
```

a) Enter the details at the prompts and type `Yes` to confirm.
b) Enter the keystore password when prompted.
Generate CA-Signed Client Certificate for OAMP (to be done on OAMP)

Log into the Call Server or VXML Server or Reporting Server. Retrieve the keystore password from the security.properties file.

At the command prompt, enter more %CVP_HOME%\conf\security.properties.

Security.keystorePW = <Returns the keystore password>

Enter the keystore password when prompted.

Procedure

Step 1

Go to %CVP_HOME%\conf\security and generate a CA-signed certificate for client authentication with callserver ORM by running %CVP_HOME%\jre\bin\keytool.exe -storetype JCEKS -keystore %CVP_HOME%\conf\security\ormkeystore -genkeypair -alias <CN of Callserver ORM certificate> -v -keysize 2048 -keyalg RSA.

a) Enter the details at the prompts and type Yes to confirm.

b) Enter the keystore password when prompted.
Step 2 Generate the certificate request for the alias by running the following command and saving it to a file (for example, jmx.csr):

```
%CVP_HOME%\jre\bin\keytool.exe -storetype JCEKS -keystore %CVP_HOME%\conf\security\ormkeystore -certreq -alias <CN of Callserver ORM certificate> -file %CVP_HOME%\conf\security\jmx.csr.
```

a) Enter the keystore password when prompted.
b) Verify that the CSR was generated successfully by running `dir jmx.csr`.

Step 3 Sign the certificate on a CA.

Note Follow the procedure to create a CA-signed certificate using the CA authority. Download the certificate and the root certificate of the CA authority.

Step 4 Copy the root certificate and CA-signed JMX Client certificate to `%CVP_HOME%\conf\security\`.

Step 5 Import the root certificate of the CA by running

```
%CVP_HOME%\jre\bin\keytool.exe -storetype JCEKS -keystore %CVP_HOME%\conf\security\ormkeystore -import -v -trustcacerts -alias root -file %CVP_HOME%\conf\security\<filename_of_root_cert>.
```

a) Enter the keystore password when prompted.
b) At Trust this certificate prompt, type Yes.

Step 6 Import the CA-signed JMX Client certificate of CVP into `.ormkeystore` by running

```
%CVP_HOME%\jre\bin\keytool.exe -storetype JCEKS -keystore %CVP_HOME%\conf\security\ormkeystore -import -v -trustcacerts -alias <CN of Callserver ORM certificate> -file %CVP_HOME%\conf\security\<filename_of_your_signed_cert_from_CA>.
```

a) Enter the keystore password when prompted.

Step 7 Import the CA-signed JMX Client certificate of CVP into `.keystore` by running

```
%CVP_HOME%\jre\bin\keytool.exe -storetype JCEKS -keystore %CVP_HOME%\conf\security\keystore -import -v -trustcacerts -alias <CN of Callserver ORM certificate> -file %CVP_HOME%\conf\security\<filename_of_your_signed_cert_from_CA>.
```

a) Enter the keystore password when prompted.
b) At Trust this certificate prompt, type Yes.

Step 8 Run the `regedit` command.

a) Navigate to `HKEY_LOCAL_MACHINE\SOFTWARE\Wow6432Node\Apache Software Foundation\Procrun 2.0\OPSConsoleServer\Parameters\Java`.
b) Append the following to the file sand save it:

```
-Djavax.net.ssl.keyStore=C:\Cisco\CVP\conf\security\ormKeystore
-Djavax.net.ssl.keyStorePassword=<keystore_password>
-Djavax.net.ssl.keyStoreType=JCEKS
-Djavax.net.ssl.trustStore=C:\Cisco\CVP\conf\security\ormKeystore
-Djavax.net.ssl.trustStorePassword=<keystore_password>
-Djavax.net.ssl.trustStoreType=JCEKS
```

Step 9 Restart OAMP service.

Step 10 Log into OAMP. To enable secure communication between OAMP and Call Server or VXML Server, navigate to Device Management > Call Server. Check the Enable secure communication with the Ops console check box. Save and deploy both Call Server and VXML Server.
[Optional] Securing JConsole Login to OAMP

This section is needed if you want to block JConsole login to OAMP.

Note

The OAMP will stop the JMX communication with the following procedure but OAMP to Call Server/VXML Server / Reporting Server will continue to work.

Procedure

Step 1
Go to c:\cisco\cvp\conf\orm_jmx.properties

Add the following to the file and save it:

javax.net.debug=all
com.sun.management.jmxremote.ssl.need.client.auth=true
com.sun.management.jmxremote.authenticate=false
com.sun.management.jmxremote.port=2099
com.sun.management.jmxremote.ssl=true
com.sun.management.jmxremote.rmi.port=3000
javax.net.ssl.keyStore = C:\Cisco\CVP\conf\security\ormKeystore
javax.net.ssl.keyStorePassword = <Keystore password>

Restart Resource Manager service.

Step 2
Go to c:\cisco\cvp\conf\jmx_oamp.conf

Comment out the OAMP JMX port (if not needed) in the following file and save it:

com.sun.management.jmxremote.ssl.need.client.auth = true
com.sun.management.jmxremote.authenticate = false
com.sun.management.jmxremote.port = 10001
com.sun.management.jmxremote.ssl = true
#com.sun.management.jmxremote.ssl.config.file= com.sun.management.jmxremote.rmi.port = 10000

Restart OAMP service.

Step 3
You must import the CA certificate in .keystore and .ormKeystore of OAMP.

With the aforesaid steps, unsecure JConsole login to OAMP will stop from remote machines but JConsole will continue to work from the OAMP host.

Secure SIP Communication between Call Server and Cisco VVB

You can secure SIP communication by:

• Exchanging the self-signed certificates between the components.
• Signing the certificates by a Certificate Authority.
Self-Signed Certificates

On Call Server

Log in to the Call Server, retrieve the keystore password from the `security.properties` file.

**Note**

At the command prompt, enter `more %CVP_HOME%\conf\security.properties`.

`Security.keystorePW = <Returns the keystore password>`

Enter the keystore password when prompted.

**Procedure**

**Step 1**

Export the Call Server certificate by running `%CVP_HOME%\jre\bin\keytool.exe -export -v -keystore %CVP_HOME%\conf\security\keystore -storetype JCEKS -alias callserver_certificate -file %CVP_HOME%\conf\security\<callserver_certificate.cer>`.

**Step 2**

Enter the keystore password when prompted.

**Step 3**

Copy the VVB/VXML gateway self-signed certificate to `%CVP_HOME%\conf\security\` and import the certificate to the callserver keystore by running `%CVP_HOME%\jre\bin\keytool.exe -import -trustcacerts -keystore %CVP_HOME%\conf\security\keystore -storetype JCEKS -alias vb_cert -file %CVP_HOME%\conf\security\<vb_certificate.pem>`.

**Note**

See Step 5 of the following Section, *On Cisco VVB* to download a VVB certificate.

**Step 4**

Enter the keystore password when prompted.

A message appears on the screen: `Trust this certificate? [no]`: Enter `yes`.

**Step 5**

Use the list flag to check your keystore entries by running `%CVP_HOME%\jre\bin\keytool.exe -storetype JCEKS -keystore %CVP_HOME%\conf\security\keystore -list`.

**On Cisco VVB**

**Procedure**

**Step 1**

Copy the CVP CallServer self-signed certificate downloaded from CVP and upload it to VVB against `tomcat-trust`.

**Step 2**

Go to `OS Admin > Security > Certificate Management > Upload certificate/certificate chain`.

**Step 3**

In `Certificate Purpose`, select `tomcat-trust`.

**Step 4**

Select the self-signed certificate of the Call Server and click `Upload`.

**Step 5**

Download the self-signed certificate of the VVB.

**Step 6**

Go to `OS Admin > Security > Certificate Management`.

**Step 7**

In the `Certificate` column, find the certificate named `tomcat`.

**Step 8**

Select the self-signed `tomcat` certificate and click `Download .PEM File`.
Step 9 After the new certificate is uploaded, restart Cisco Tomcat service.

Step 10 Go to Cisco VVB Administration > System Parameters > TLS.

Step 11 Check TLS as Enable.

Step 12 Select the supported TLS version and click Update.

Step 13 Restart Cisco VVB Engine from the VVB Serviceability page.

---

CA-Signed Certificate

On Call Server

Log into the Call Server. Retrieve the keystore password from the security.properties file.

Note

At the command prompt, enter more %CVP_HOME%\conf\security.properties.

Security.keystorePW = <Returns the keystore password>

Enter the keystore password when prompted.

Procedure

Step 1 Remove the existing certificate by running %CVP_HOME%\jre\bin\keytool.exe -storetype JCEKS -keystore %CVP_HOME%\conf\security\keystore -delete -alias callservcer_certificate.

Step 2 Enter the keystore password when prompted.

Step 3 Generate a new key pair for the alias with the selected key size by running %CVP_HOME%\jre\bin\keytool.exe -storetype JCEKS -keypair %CVP_HOME%\conf\security\keystore -genkeypair -alias callservcer_certificate -v -keysize 2048 -keyalg RSA.

Enter keystore password: <enter the keystore password>

What is your first and last name?

[Unknown]: <specify the CVP host name> E.g. cisco-cvp-211

What is the name of your organizational unit?

[Unknown]: <specify OU> E.g. CCBU

What is the name of your organization?

[Unknown]: <specify the name of the org> E.g. CISCO

What is the name of your City or Locality?

[Unknown]: <specify the name of the city/locality> E.g. BLR

What is the name of your State or Province?

[Unknown]: <specify the name of the state/province> E.g. KAR

What is the two-letter country code for this unit?

[Unknown]: <specify two-letter Country code> E.g. IN

Specify ‘yes’ for the inputs.

Step 4 Generate the CSR certificate for the alias by running %CVP_HOME%\jre\bin\keytool.exe -storetype JCEKS -keystore %CVP_HOME%\conf\security\keystore -certreq -alias callservcer_certificate -file %CVP_HOME%\conf\security\callservcer.csr and save it to a file (for example, oamp.csr).

Step 5 Enter the keystore password when prompted.
Step 6 Download the callserver.csr from %CVP_HOME%\conf\security\ and sign it from CA.
Step 7 Copy the root CA certificate and the CA-signed certificate to %CVP_HOME%\conf\security\.
Step 8 Install the root CA certificate by running %CVP_HOME%\jre\bin\keytool.exe -storetype JCEKS -keystore %CVP_HOME%\conf\security\keystore -import -v -trustcacerts -alias root -file %CVP_HOME%\conf\security\<filename_of_root_cert>.
Step 9 Enter the keystores password when prompted.
Step 10 Install the signed certificate by running %CVP_HOME%\jre\bin\keytool.exe -storetype JCEKS -keystore %CVP_HOME%\conf\security\keystore -import -v -trustcacerts -alias callserver_certificate -file %CVP_HOME%\conf\security\<filename_of_CA_signed_cert>.

On Cisco VVB

Procedure

Step 1 To generate the CSR certificate on VVB, open the administration page. From the Navigation drop-down list, choose Cisco Unified OS Administration and click Go.
Step 2 Go to Security > Certificate Management > Generate CSR Generate Certificate signing Request. Create the CSR against tomcat with the key-length as 2048.
Step 3 To download the generated CSR, click Download CSR. After the Generate Certificate signing Request dialog opens, click Download CSR.
Step 4 Open the certificate in Notepad, copy the contents and sign the certificate with CA.
Step 5 Upload the root certificate generated from the CA into VVB against tomcat-trust:
   a) Go to Security > Certificate Management > Generate CSR > Upload certificate/certificate chain.
   b) Choose tomcat-trust from the drop-down list.
   c) Click Browse and select the certificate.
   d) Click Upload to upload the root certificate of the Certificate Authority.
Step 6 Upload the signed certificate into VVB against tomcat.
   a) Go to Security > Certificate Management > Generate CSR > Upload certificate/certificate chain.
   b) Choose tomcat from the drop-down list.
   c) Click Browse and select the certificate.
   d) Click Upload.
After the certificate is uploaded successfully, VVB displays the certificate signed by <CA hostname>.
Step 7 Restart the Tomcat service and the VVB engine.

For the configuration steps, see the Manage System Parameters section.

Secure HTTPS Communication between VXML Server and Cisco VVB

You can secure HTTPS communication by:
• Exchanging the self-signed certificates between the VXML Server and VVB or VXML Gateway.
• Signing the certificates by a Certificate Authority.

Self-Signed Certificate

On VXML Server

Log in to the VXML Server. Retrieve the keystore password from the security.properties file.

Note
At the command prompt, enter more %CVP_HOME%\conf\security.properties.
Security.keystorePW = <Returns the keystore password>
Enter the keystore password wherever it prompts.

Procedure

Step 1  Export the VXML SERVER certificate by running %CVP_HOME%\jre\bin\keytool.exe -export -v -keystore %CVP_HOME%\conf\security\keystore -storetype JCEKS -alias vxml_certificate -file %CVP_HOME%\conf\security\vxml_certificate.cer.
Step 2  Enter the keystore password when prompted.
Step 3  Copy the VVB/VXML gateway self-signed certificate to %CVP_HOME%\conf\security\ and import the certificate to the callserver keystore by running keytool.%CVP_HOME%\jre\bin\keytool.exe -import -trustcacerts -keystore %CVP_HOME%\conf\security\keystore -storetype JCEKS -alias vb_cert -file %CVP_HOME%\conf\security\vvbcertificate.pem>.
Note  See Step 5 of the following Section, On Cisco VVB to download a VVB certificate.
Step 4  Enter the keystore password when prompted.
A message appears on the screen: Trust this certificate? [no]: Enter yes.
Step 5  Use the list flag to check your keystore entries by running %CVP_HOME%\jre\bin\keytool.exe -storetype JCEKS -keystore %CVP_HOME%\conf\security\keystore -list.

On Cisco VVB

Procedure

Step 1  Copy the VXML Server self-signed certificate downloaded from CVP and upload it to VVB against tomcat-trust.
Step 2  Go to OS Admin > Security > Certificate Management > Upload certificate/certificate chain.
Step 3  In Certificate Purpose, select tomcat-trust.
Step 4  Select the self-signed certificate of the VXML Server and click Upload.
Step 5  Download the self-signed certificate of the VVB.
Step 6  Go to OS Admin > Security > Certificate Management.
Step 7  In the Certificate column, select the tomcat certificate.
Step 8  Select the tomcat certificate and click Download .PEM File.
Step 9  After the new certificate uploads, restart the Cisco Tomcat service.
Step 10 Go to Cisco VVB Administration > System Parameters > TLS.
Step 11 Check the TLS check box as Enable.
Step 12 Select the supported TLS version and click Update.
Step 13 Restart the Cisco VVB Engine from the VVB Serviceability page.


CA-Signed Certificate

On VXML Server

Log in to the VXML Server. Retrieve the keystore password from the security.properties file.

Note  At the command prompt, enter more %CVP_HOME%\conf\security.properties.

Security.keystorePW = <Returns the keystore password>
Enter the keystore password when prompted.

Procedure

Step 1 Remove the existing certificate by running %CVP_HOME%\jre\bin\keytool.exe -storetype JCEKS -keystore %CVP_HOME%\conf\security\keystore -delete -alias vxml_certificate.

Step 2 Generate a new key pair for the alias with selected key size by running %CVP_HOME%\jre\bin\keytool.exe -storetype JCEKS -keystore %CVP_HOME%\conf\security\keystore -genkeypair -alias vxml_certificate -v -keysize 2048 -keyalg RSA.

Enter keystore password: <enter the keystore password>
What is your first and last name? [Unknown]: <specify the CVP host name appended with "VXML_Server"> E.g. cisco-cvp-211_VXML_Server
What is the name of your organizational unit? [Unknown]: <specify OU> E.g. CCBU
What is the name of your organization? [Unknown]: <specify the name of the org> E.g. CISCO
What is the name of your City or Locality? [Unknown]: <specify the name of the city/locality> E.g. BLR
What is the name of your State or Province? [Unknown]: <specify the name of the state/province> E.g. KAR
What is the two-letter country code for this unit?
[Unknown]: <specify two-letter Country code>  E.g. IN

Specify 'yes' for the inputs.

Step 3  Generate the CSR certificate for the alias by running %CVP_HOME%\jre\bin\keytool.exe -storetype JCEKS -keystore %CVP_HOME%\conf\security\keystore -certreq -alias vxml_certificate -file %CVP_HOME%\conf\security\vxmlserver.csr and save it to a file (for example, oamp.csr).

Step 4  Enter the keystore password when prompted.

Step 5  Download the vxmlserver.csr from CVP %CVP_HOME%\conf\security\ and sign it from CA.

Step 6  Copy the root CA certificate and the CA-signed certificate to %CVP_HOME%\conf\security\.

Step 7  Install the root CA certificate by running %CVP_HOME%\jre\bin\keytool.exe -storetype JCEKS -keystore %CVP_HOME%\conf\security\keystore -import -v -trustcacerts -alias root -file %CVP_HOME%\conf\security\<filename_of_root_cert>.

Step 8  Enter the keystore password when prompted.

Step 9  Install the signed certificate by running %CVP_HOME%\jre\bin\keytool.exe -storetype JCEKS -keystore %CVP_HOME%\conf\security\keystore -import -v -trustcacerts -alias vxml_certificate -file %CVP_HOME%\conf\security\<filename_of_CA_signed_cert>.

Step 10 Enter the keystore password when prompted.

Step 11 Restart the VXML Server.

---

**On Cisco VVB**

**Procedure**

**Step 1** Upload the root certificate generated from the CA into VVB against tomcat-trust. Go to OS Admin > Security > Certificate Management > Upload certificate/certificate chain, select tomcat-trust and upload the root certificate of the Certificate Authority.

**Note** If you use the same root certificate that was used in the Call Server configuration as described in Section, Secure Communication between Call Server and Cisco VVB and the certificate is already imported, then you can skip this step.

**Step 2** Generate the CSR against tomcat with the key-length as 2048.

**Step 3** Open the certificate in Notepad. Copy the contents and sign the certificate with CA.

**Step 4** Restart the Tomcat service and the VVB engine.


Secure HTTPS Communication between Media Server and Cisco VVB

This section describes how to import certificate from IIS MediaServer to Cisco VVB and how to create IIS CA-signed certificate.

Procedure

Step 1 Enter https://<mediaserver>:443/ in the address bar of the web browser.
Step 2 In the Security Alert dialog box, click View Certificate.
Step 3 Click the Details tab
Step 4 Click Copy to File.
Step 5 In the Certificate Export Wizard dialog box, click Base-64 encoded X.509 (.CER), and then click Next.
Step 6 In the File to the Export dialog box, specify a filename, and then click Next.
Step 7 Click Finish.
A message indicates that the export was successful.
Step 8 Click OK and close the Security Alert dialog box.
Step 9 Copy the CVP MediaServer self-signed certificate downloaded from the CVP and upload into VVB against tomcat-trust.
Step 11 Restart Cisco VVB Engine.

Secure Communication on CUCM

You can secure communication on CUCM by:

- Exchanging the self-signed certificates.
- Signing the certificates by a Certificate Authority.

Self-Signed Certificate

Procedure

Step 1 Log in to the CUCM OS Administration page.
Step 2 Go to Security > Certificate Management.
Step 3 Click Generate Self-signed.
Step 4  On the pop-up window, click Generate button.
Step 5  Restart Tomcat from CUCM CLI by running `utilsservicestartCiscoTomcat`.

Note  Tomcat will take a few minutes to stop and then start. If you access the CUCM UI during this time, you may receive a 404 error.

Step 6  When the CUCM UI is available, open the CUCM OS Administration page.
Step 7  Go to Security > Certificate Management.
Step 8  Click Find and identify the Self-signed certificate generated by the system.
Step 9  Click the CallManager Certificate name.
Step 10  In the dialog box, click Download .PEM file.

---

**CA-Signed Certificate**


**Procedure**

---

**Step 1** Enter the following command in the CLI to set the CUCM in the mixed mode, and to register the endpoints in the encrypted mode:

```
admin: utils ctl set-cluster mixed-mode
```

This operation will set the cluster to Mixed mode. Auto-registration is enabled on at least one CM node. Do you want to continue? (y/n): y

Moving Cluster to Mixed Mode
Cluster set to Mixed Mode
You must reset all phones to ensure they received the updated CTL file.
You must restart Cisco CTIManager services on all the nodes in the cluster that have the service activated.

```
admin:
```

**Step 2** Choose CUCM Admin Page > System > Enterprise Parameters. Check if Cluster Security Mode is set to 1.

**Step 3** Set the minimum TLS version command from the CLI:

```
admin: set tls client min-version 1.2
```

**WARNING** If you are lowering the TLS version it can lead to security issues **WARNING**

Do you really want to continue (yes/no)? y

Execute this command in the other nodes of the cluster.

```
Restart the system using the command 'utils system restart' for the changes to take effect

Command successful
admin: set tls ser
admin: set tls server mi
admin: set tls server min-version?
Syntax:
```

---

 Configuration Guide for Cisco Unified Customer Voice Portal, Release 11.6(1)
set tls server min-version
admin: set tls server min-version 1.2

**WARNING** If you are lowering the TLS version it can lead to security issues **WARNING**

Do you really want to continue (yes/no)? y
Execute this command in the other nodes of the cluster.

Command successful
admin:

Step 4 Create an encrypted phone profile and the SIP trunk profile. Associate them with the phone and CUCM SIP trunk.

Step 5 Go to System > Security > SIP Trunk Security Profile and create a new SIP trunk security profile.

Step 6 On CUCM SIP Trunk, check the SRTP Allowed check box.

Step 7 From SIP Trunk Security Profile drop-down list, choose TLS Secure Profile.

Step 8 Restart the TFTP and Cisco CallManager services on all the nodes in the cluster that run these services.

Step 9 Upload the root certificate generated from the CA to CUCM against CUCM-trust.

Step 10 Generate the CSR against CallManager and select the key-length as 2048.


Step 12 Click Upload Certificate on CUCM by selecting the certificate name as CallManager.

On successful completion, CUCM displays the description as Certificate signed by <CA hostname>.

Step 13 Restart TFTP and Cisco CallManager services on all the nodes in the cluster that run these services.

---

**Secure Communication between Ingress Gateway and Call Server**

You can secure communication between the Ingress Gateway and the Call Server by:

- Exchanging the self-signed certificates.
- Signing the certificates by a Certificate Authority.

**Self-Signed Certificate**

To secure SIP connection between Cisco Ingress Gateway and Call Server, import the Call Server certificate on the IOS device during the device configuration.

**Procedure**

**Step 1** Open the certificate that was exported in Step 1, on page 337.
Step 2  Click View Certificate.
Step 3  Click the Details tab.
Step 4  Click Copy to File.
The Certificate ExportWizard window appears.
Step 5  Click Base-64 encoded X.509 (.CER), and then click Next.
Step 6  Specify a file name in the File to the Export dialog box, and then click Next.
Step 7  Click Finish. A message indicates that the export was successful.
Step 8  Click OK and close the Security Alert dialog box.
Step 9  Open the certificate in Notepad.
Step 10  Access the IOS ingress GW in the privileged EXEC mode.
Step 11  Access the global configuration mode by entering the configuration terminal.
Step 12  Import the CVP CallServer Certificate to Cisco IOS Gateway by entering the following commands:
crypto pki trustpoint <Call Server trust point name>
enrollment terminal
exit
Step 13  Open the exported Call Server certificate in Notepad and copy the certificate information that appears between the -BEGIN CERTIFICATE and END CERTIFICATE tags to the IOS device.
Step 14  Enter the following command:
crypto pki auth <Call Server trust point name>
Step 15  Paste the certificate from Notepad and end with a blank line or the word quit on a line by itself.
Step 16  To generate the self-signed certificate of the Gateway, first generate 2048-bit RSA keys:
crypto key generatersageneral-keys Label <Your Ingress GW trustpointname> modulus 2048
Step 17  Configure a trustpoint:
crypto pkitrustpoint<Your Ingress GW trustpointname>
enrollment selfsigned
fqdn none
subject-name CN=SIP-GW
rsakeypair <Your Ingress GW trustpoint name>
Router(config)# crypto pki enroll<Your Ingress GW trustpointname>
% The fully-qualified domain name will not be included in the certificate
% Include the router serial number in the subject name? [yes/no]: no
% Include an IP address in the subject name? [no]: no
Generate Self Signed Router Certificate? [yes/no]: yes
Router Self Signed Certificate successfully created
Step 18  View the certificate in PEM format, and copy the Self-signed CA certificate (output starting from “-----BEGIN” to “CERTIFICATE-----”) to a file named ingress_gw.pem.

Router(config)# crypto pki export <Your Ingress GW trustpoint name> pem terminal
% Self-signed CA certificate:
-----BEGIN CERTIFICATE-----
MIIB6zCCAVGsAwIBAgIBAjANBgkqhkiG9w0BAQUFADARMQ8wDQYDVQQKEwZTSVAt
RlczwchNNMzCwOTI2MTQ1MTE2WhcnNhMjAwMDAwMlJARMQ8wDQYDVQQDEwZTSVAt
SVArnRldwgw04xJkzIhvcNAQFlEQgTAQgYMQhjBMDIgMjg adipiscing/MAgGBzIAGjwIj
9B2JdSm1N+1e4yYaSM1J1bA3jAqK+J6LwY8v4dDxj7zOVgK8nYxKytQ3OJWw8v4dDxj7zOVgK8nYxKytQ3OJWw8v4dDxj7zOVgK8nYxKytQ3OJWw8v4dDxj7zOVgK8nYxKytQ3OJWw8v4dDxj7zOVgK8nYxKytQ3OJWw8v4dDxj7zOVgK8nYxKytQ3OJWw8v4dDxj7zOVgK8nYxKytQ3OJWw8v4dDxj7zOVgK8nYxKytQ3OJWw8v4dDxj7zOVgK8nYxKytQ3OJWw8v4dDxj7zOVgK8nYxKytQ3OJWw8v4dDxj7zOVgK8nYxKytQ3OJWw8v4dDxj7zOVgK8nYxKytQ3OJWw8v4dDxj7zOVgK8nYxKytQ3OJWw8v4dDxj7zOVgK8nYxKytQ3OJWw8v4dDxj7zOVgK8nYxKytQ3OJWw8v4dDxj7zOVgK8nYxKytQ3OJWw8v4dDxj7zOVgK8nYxKytQ3OJWw8v4dDxj7zOVgK8nYxKytQ3OJWw8v4dDxj7zOVgK8nYxKytQ3OJWw8v4dDxj7zOVgK8nYxKytQ3OJWw8v4dDxj7zOVgK8nYxKytQ3OJWw8v4dDxj7zOVgK8nYxKytQ3OJWw8v4dDxj7zOVgK8nYxKytQ3OJWw8v4dDxj7zOVgK8nYxKytQ3OJWw8v4dDxj7zOVgK8nYxKytQ3OJWw8v4dDxj7zOVgK8nYxKytQ3OJWw8v4dDxj7zOVgK8nYxKytQ3OJWw8v4dDxj7zOVgK8nYxKytQ3OJWw8v4dDxj7zOVgK8nYxKytQ3OJWw8v4dDxj7zOVgK8nYxKytQ3OJWw8v4dDxj7zOVgK8nYxKytQ3OJWw8v4dDxj7zOVgK8nYxKytQ3OJWw8v4dDxj7

Step 19  Test your certificate.

show crypto pkicertificates

Step 20  To configure TLS version on the Gateway:

router# configure terminal
router(config)# sip-ua
router(config-sip-ua)# transport tcp tls <version>

v1.0 Enable TLS Version 1.0
v1.1 Enable TLS Version 1.1
v1.2 Enable TLS Version 1.2

Note: SIP TLS version 1.2 is available in Cisco IOS Software Release 15.6(1)T and higher.

Step 21  To check if the TLS version is negotiated:

router# show sip-ua connections tcp tls detail

Step 22  To enable SRTP on the incoming/outgoing dial-peer, specify SRTP:

router# configure terminal
router(config)# dial-peer voice 100 voip
router(config-dial-peer)# srtp

Note: This command is supported in Cisco IOS Software Release 15.6(1)T and higher.

Step 23  Configure the SIP stack in Cisco IOS GW to use the self-signed certificate of the router to establish a SIP TLS connection from/to the CVP Call Server.

router# configure terminal
router(config)# sip-ua
router(config-sip-ua)# crypto signaling remote-addr <peer IP address> <peer subnet mask> trustpoint <Your Ingress GW trustpoint name> strict-cipher

Example:
sip-ua
  crypto signaling remote-addr 10.48.54.89 255.255.255.255 trustpoint VG-SIP-1 strict-cipher
Step 24 Configure an outbound VoIP dial-peer to route calls to the CVP Call Server.

```
session target ipv4:<Call Server IP address>:5061
session transport tcp tls
```

Example:
```
dial-peer voice 3 voip
destination-pattern 82...
session protocol sipv2
session target ipv4:10.48.54.89:5061
session transport tcp tls
dtmf-relay rtp-nte
codec g711ulaw
```

Step 25 To import GW or CUSP certificate into the CVP Call Server:

a) Copy the Ingress GW/CUSP self-signed certificate to %CVP_HOME%/conf/security/ and import the certificate to the callserverkeystore. `%CVP_HOME%/jre/bin/keytool.exe -import -trustcacerts -keystore %CVP_HOME%/conf/security/.keystore -storetype JCEKS -alias gw_cert -file %CVP_HOME%/conf/security/<ingress GW/CUSP certificate name.pem>

b) Enter the keystore password when prompted.

c) A message appears on the screen: Trust this certificate? [no]: Enter yes.

d) Use the list flag to check your keystore entries by running `%CVP_HOME%/jre/bin/keytool.exe -storetype JCEKS -keystore %CVP_HOME%/conf/security/.keystore -list


Step 27 Restart the Call Server.

---

CA-Signed Certificate


Before you begin

- To configure SIP TLS and SRTP on the gateway, apply a security-k9 license on the gateway.
- Time sync all the nodes (CVP, VVB, Gateway) with an NTP server.

Procedure

Step 1 Create a 2048-bit RSA key.

```
Router(config)# crypto key generate rsa general-keys Label keypairname modulus 2048
```

Generates 2048 bit RSA key pair. "keypairname" defines the name of the key pair.

Step 2 Create a trustpoint. A trustpoint represents a trusted CA.

Example:
Step 3  Create a CSR (Certificate Request) to give to the MS Certificate Server.

Example:
Router(config)# crypto pki enroll ms-ca-name
% Start certificate enrollment ...
% The subject name in the certificate will include: CN=Webvpn.cisco.com
% The subject name in the certificate will include: webvpn.cisco.com
% Include the router serial number in the subject name? [yes/no]: no
% Include an IP address in the subject name? [no]: no
Display Certificate Request to terminal? [yes/no]: yes
! Displays the PKCS#10 enrollment request to the terminal.
! You will need to copy this from the terminal to a text
! file or web text field to submit to the 3rd party CA.

Certificate Request follows:
xxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxx

Redisplay enrollment request? [yes/no]: no

Router(config)#

Step 4  Sign the CSR with the root CA.

Step 5  Install the root certificate.

Router(config)# crypto pki authenticate ms-ca-name
Enter the base 64 encoded CA certificate.
End with a blank line or the word "quit" on a line by itself

-----BEGIN CERTIFICATE-----
xxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxx

-----END CERTIFICATE-----
quit

Certificate has the following attributes:
Fingerprint MD5: D5DF85B7 9A5287D1 8CD50F90 232DB534
Fingerprint SHA1: 7C4656C3 061FF7F4C 0D67B319 A855F60E BC11FC44
% Do you accept this certificate? [yes/no]: y
Trustpoint CA certificate accepted.

Step 6  Install the signed certificate for the gateway:
Router(config)# crypto pki import ms-ca-name certificate
Enter the base 64 encoded certificate.
End with a blank line or the word "quit" on a line by itself
-----BEGIN CERTIFICATE-----
xxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxxx
-----END CERTIFICATE-----
quit
% Router Certificate successfully imported

Step 7
Test your certificate.
show crypto pki certificates

Note
- To configure TLS version on the gateway:
  router#
  router# config terminal
  router(config)# sip-ua
  router(config-sip-ua)# transport tcp tls <version>
    v1.0 Enable TLS Version 1.0
    v1.1 Enable TLS Version 1.1
    v1.2 Enable TLS Version 1.2

- To check if the TLS version is negotiated:
  router# show sip-ua connections tcp tls detail

- To enable SRTP on the incoming/outgoing dial-peer, specify srtp:
  router# configure terminal
  router(config)# dial-peer voice 100 voip
  router(config-dial-peer)# srtp

Step 8
Associate the created trustpoint in Step 2 with sip-ua.

router# configure terminal
router(config)# sip-ua
router(config-sip-ua)# crypto signaling remote-addr <peer IP address>
<peer subnet mask> trustpoint <trust point name created in step2>
Installing CVP Call/VXML Servers enables IIS (for media server functionality), which opens port 443 by default for TLS connections. This port allows TLSv1.0 and TLSv1.1 connections. To close these connections, change the **Enabled** value to 0 by selecting the **Decimal** option in the following registry keys:

- **TLSv1.0:** `HKEY-LOCAL-MACHINE\SYSTEM\CurrentControlSet\Control\SecurityProviders\SCHANNEL\Protocols\TLS1.0\Server\Enabled`
- **TLSv1.1:** `HKEY-LOCAL-MACHINE\SYSTEM\CurrentControlSet\Control\SecurityProviders\SCHANNEL\Protocols\TLS1.1\Server\Enabled`


---

### Secure Communication on CUSP

You can secure communication on CUSP by:

- Exchanging the self-signed certificates between the components.
- Signing the certificates by a Certificate Authority.

### Self-Signed Certificate


### CA-Signed Certificate

**Procedure**

**Step 1** Create an RSA keypair in CUSP. From the CUSP foundation, enter the config mode and create the keypair:

```
democusp48(config)# crypto key generate rsa label <key-label> modulus 2048 default
```

**Example**

```
democusp48# conf terminal
democusp48(config)# crypto key generate rsa label cusp48-ca modulus 2048 default
```
Key generation in progress. Please wait...
The label name for the key is cusps48-ca

Step 2
Generate CSR by CA by running democus48(config)# crypto key certreq label <key-label> url ftp:
An FTP or HTTP server is required to export the CSR. Make sure the label in the command matches the label used to create the rsa private key.

Example
democus48(config)# crypto key certreq label cusps48-ca url ftp:
Address or name of remote host? 10.64.82.176
Username (ENTER if none)? test
Password (not shown)?
Destination path? /cusp48-ca.csr Uploading CSR file succeed
democus48(config)#

Step 3
Import the CA server root certificate into CUSP by running: crypto key import trustcacert label <rootCA-label> terminal.

Example
democus48(config)# crypto key import trustcacert label rootCA terminal
Certificate info
*******************************************
Owner: CN=cvpvb-GDESINGHROOTCA-CA, DC=cvpvb, DC=cisco, DC=com
Issuer: CN=cvpvb-GDESINGHROOTCA-CA, DC=cvpvb, DC=cisco, DC=com
Do you want to continue to import this certificate, additional validation will be perfom?
[y/n]: y
democus48(config)#

Step 4
Import the signed certificate into CUSP by running crypto key import cer label <key-label> terminal.

Example
democusp48(config)# crypto key import cer label cusp48-ca terminal
Enter certificate...
End with a blank line or "quit" on a line by itself
-----BEGIN CERTIFICATE-----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-----END CERTIFICATE-----
Import succeeded
democusp48(config)#exit
democusp48#

Step 5
You can list the certificates by running **show crypto key all**.

Example

democusp48# sh crypto key all
Label name: rootca
Entry type: Trusted Certificate Entry
Creation date: Sat Jul 01 14:13:14 GMT+05:30 2017
Owner: CN=cvpvb-GDESINGHROOTCA, DC=cvpvb, O=cisco, L=com
Issuer: CN=cvpvb-GDESINGHROOTCA, DC=cvpvb, O=cisco, L=com
Valid from: Wed Mar 22 14:23:10 GMT+05:30 2017 until: Tue Mar 22 14:33:09 GMT+05:30 2017
Label name: cusp48-ca
Entry type: Key Entry
Creation date: Tue Jul 04 10:47:40 GMT+05:30 2017
Owner: CN=democusp48-cvpvb.cisco.com, OU='', O='', L='', ST='', C=''  
Issuer: CN=democusp48-cvpvb.cisco.com, OU='', O='', L='', ST='', C='' 
SubjectAltName: DNS:democusp48-cvpvb.cisco.com, DNS:democusp48-cvpvb.cisco.com
Valid from: Thu Jul 04 10:41:56 GMT+05:30 2017 until: Thu Jul 04 10:41:56 GMT+05:30 2017

Configuration Guide for Cisco Unified Customer Voice Portal, Release 11.6(1)
CHAPTER 18

Unified ICME Warm Consult Transfer/Conference

When an agent attempts a warm consultative transfer/conference to another agent, but there is no agent available in the skill group to service the request, the first agent is placed in a queue to wait for the availability of an agent in the desired skill group. To place the first agent in queue, a call is initiated from Unified CM to Unified Customer Voice Portal (CVP), via a Translation Route to VRU, to provide queue music to the first agent. To Unified CVP, this appears as a new call from an IP phone.

Optionally, customer business call flows may require that IP phone users call Unified CVP directly. For example, you may have a corporate IP phone network that is serviced by a Unified CVP help desk call center. IP phone users with problems would call a Unified CVP number to open trouble tickets.

This chapter provides information about the minimal software component release requirements for the Unified ICME Warm Consult Transfer and Conference to Unified CVP feature for Type 7 VRUs. Resource sizing and configuration requirements are also included.

For information about using the Warm Consult Transfer feature with SIP and Type 10 VRUs, see Warm Transfer with SIP Calls, on page 357. For configuration procedure of Call Director and Comprehensive call flow models using SIP, see Unified CVP Call Flow Models.

• Configure Unified ICME Warm Consult Transfer/Conference to Unified CVP, on page 355
• Minimal Component Version Requirement, on page 357
• Warm Transfer with SIP Calls, on page 357
• Set Up Unified ICME Warm Consult Transfer, on page 358

Configure Unified ICME Warm Consult Transfer/Conference to Unified CVP

Procedure

Step 1

Install a new Call Server (see Installation and Upgrade Guide for Cisco Unified Customer Voice Portal for detailed information).

Note

It can be configured identically to all other Unified CVP machines, with the exception that you must add each Translation Route DNIS.
• Define it as a Type 7 VRU in the Network VRU Explorer tool in Unified ICME.

• **Network Transfer Preferred** must be disabled for this peripheral.

• Add a new DNIS in the **Add DNIS** box on the ICM tab in the Operations Console. Ensure to add each translation route DNIS.

**Step 2** If the Unified CVP machine resides in a different location from the Unified CM cluster initiating the calls, WAN bandwidth is a consideration because the prompts are played G.711 from the Unified CVP machine. In this case, size and configure the network appropriately. Wherever possible, Unified CVP should be co-located with Unified CM to eliminate these bandwidth requirements.

**Step 3** Define a SIP trunk in the Unified CM, using the Unified CVP machine IP address as the Destination address in **Device > Trunk > SIP Information**.

**Step 4** (Perform this step for IP-originated calls only). Determine if customer business call flows require that IP phone users call Unified CVP directly. In Unified CM administration, in “Route Plan” using route groups/lists/patterns, route Unified CVP DNIS’s to the Unified CVP gateway installed in Step 1.

If you want to load-balance between two Unified CVP systems:

• Create a route group and put both of the Unified CVP gateways in the route group, both with order priority 1.

• Create a route list and put the route group in the route list.

• Create a route pattern and assign the route list to the route pattern.

• In Service Parameters for Unified CM, set **Reorder Route List** to True and the **H225 TCP timer** to 5.

**Note** The Reorder Route List setting applies only for Unified CM 3.3 and earlier.

**Step 5** Create a Unified ICME script similar to the script below. (See the **Unified ICME documentation** for details). This script should be tied to the Dialed number and call type that the agent invokes to do a warm consultative transfer/conference. This dialed number’s Routing Client should be associated with a Unified CM peripheral from which the agent will be invoking the transfer or conference.
Minimal Component Version Requirement


Warm Transfer with SIP Calls

If an agent performs a warm transfer to another agent and then that agent is queued, or a SendToVRU label returns to Unified CM using jtap on the Unified CM PG connection, then you must associate a Route Pattern for that label with a SIP TRUNK to send to Unified CVP or the Proxy Server to ensure the call returns to Unified CVP. Unified CVP then sends the **request instruction** message back to Unified ICME on the Unified CVP routing client and starts the queuing.

**Note**

These SIP calls do not require MTP enablement on the SIP trunks.
When using the Warm Transfer feature for SIP Calls with queuing, and the agent completes a consult transfer to their caller while the call is still in the queue (VXML Gateway), then the call flow does not require MTP enabled on the SIP trunk that is associated with the VRU label route pattern.

Note
The MTP is not required if VXML GW version is IOS 12.4(15)T8 or 12.4(20)T2 or later versions on these T releases. In cases, where there is SIP DTMF capability mismatch, MTP is required between Unified Customer Voice Portal (CVP) and Cisco Unified Communications Manager (CUCM).

Set Up Unified ICME Warm Consult Transfer

Note
Unified CVP with a Type 10 VRU does not support multiple Network VRUs on the same Unified CVP peripheral device. Multiple customer instances can be used in order to address multiple Network VRUs, but they must then address different physical Unified CVP Call Servers as well. Calls that originate from an ACD or Unified CM, such as Warm Transfer/Conference, Helpdesk, or Outbound calls, are also limited to one Network VRU on any given Unified CVP Call Server. Note that the reverse is supported - multiple Unified CVP Call Servers can share the same Network VRU.

In this scenario, an agent transfers a call to another agent by dialing that agent's ID. If the agent is unavailable, the originating agent is placed in a queue to wait for the second agent to pick up the call.

For the first agent to be queued while waiting for another agent, set up the following configuration:

Procedure

Step 1
In the ICM Configuration Manager's PG Explorer tool Routing Client tabs, uncheck the NetworkTransferPreferred check box for Unified CM and Unified CVP routing clients.

Step 2
On the Advanced tab for the Unified CM routing client, select None for the Network VRU and the Type 10 VRU for the Unified CVP routing client.

Step 3
For the Type 10 VRU, in the ICM Configuration Manager's Network VRU Explorer tool, define a label for the Unified CM routing client as well as the Unified CVP routing client, and associate them with a customer instance.

Step 4
In the ICM Configuration Manager's Dialed Number List Tool, associate the dialed numbers for the incoming call as well as the transfer dialed number with the same customer instance.

When the second call is placed for the warm transfer and no agent is available, the label defined on the Unified CM RC plus the correlation ID will be sent back via EAPIM/JGW to Unified CM. For example, if the label is 7777777777, with a correlation ID it could be 777777777712345 because the call originated from the Unified CM RC, and also because the NetworkTransferPreferred check box is not checked.

Step 5
In Unified CM, select Call Routing > Route/Hunt > Route Pattern > Add New. Add a new route pattern to route the call to Unified CVP using the SIP trunk if you are adding from the Device Management menu (for example, 777! where ! allows label plus arbitrary length correlation ID).
When Unified CVP sees this call, it perceives it as a pre-routed call with a correlation ID and sends it back to Unified ICME to continue the script.

Unified ICME sends a temporary connection back to Unified CVP, which queues the agent call while the caller hears music on hold (MoH) from Unified CM.

When customized CTI clients are used, consult transfer mechanism is utilized to check if the second agent is really answering the call before the call is being finally transferred automatically by the customized CTI client. In this scenario, it is not required for the agents transferring the call to complete the transfer manually as customized CTI client automatically transfers the calls. However, this is applicable only when the second agent (called agent) answers the call and not before. Customized clients should wait for five seconds before completing the automatic consult transfer to avoid race conditions.
Set Up Unified ICME Warm Consult Transfer
IVRs From Perspective of Unified ICME

Unified ICME categorizes IVRs into one of the following two types:

- **Intelligent Peripheral IVRs** (in control of Unified ICME) - the carrier network routes calls to the IVR and then removes calls from the IVR for delivery to agents. With Intelligent Peripheral IVRs, once the prompting or queuing treatment of IVR is complete, the IVR has no further role to play for that call.

- **Service Node IVRs** (following prompting/queuing treatment) - the IVR initiates call delivery to agents, who are in control of Unified ICME. When functioning as a Service Node IVR, Unified CVP can stay involved with a call even after it is transferred to another VoIP endpoint.

Unified CVP can act as either IVR type.

---

**Note**

For information about the call flow models for Unified CVP, see the chapter "Unified CVP Call Flow Models".
Call Transfer Using Unified CVP in Comprehensive Mode

This section provides examples of Unified CVP call transfer scripts.

Note

The Script Editor Busy and Ring nodes are not supported.

Call Transfer Using SIP Service

You can configure the SIP Service to operate in two modes to perform Unified CVP transfers. Unified CVP remains in the signaling path for the duration of the call, and in this normal mode it uses SIP re-INVITE messages to perform the transfers. This causes Unified CVP to hold the port license for the call duration.

To operate in standard re-INVITE mode, you do not need to modify the Unified ICME script. However, to send a REFER transfer, send a dynamic label with the letters “rf” prepended to it. Or, when using a Queue node in the Unified ICME script, define an ECC variable called "user.sip.refertransfer" and set it to the value of the lowercase "y." Unified CVP then uses the REFER method to blind transfer to agent labels.

Alternatively, Unified CVP can perform a SIP REFER type transfer where it moves out of the signaling path after sending a referral to the caller to the label that Unified ICME provides. This allows Unified CVP to release the port license after the REFER is sent. Unified CVP receives notification of the outcome of the call using SIP NOTIFY messages, and this is included in the reporting database.

Note

If Unified CVP is configured to redirect calls to the ingress gateway for 9292 DN and the SIP REFER type transfer fails, then the ingress gateway must be configured to handle the failure by using the survivability script or by creating a 9292 dial peer directed to VVB.

Caution

When using REFER, do not apply the survivability script for TDM callers on the Ingress gateway. Also, SIP transfers to VoiceXML gateways for micro-applications do not use the REFER method. It is only used for non-“SEND TO VRU” type transfers. When using REFERs, note that the survivability script does not currently support REFER messaging events, so when using REFER with TDM calls on the IOS gateway, the survivability service must be removed from the pots dial peer for those calls. REFER is used as a "blind refer" operation and can typically be used when sending calls to third-party ACD agents. However, it can also be used to send calls to the Cisco Unified Communications Manager (Unified CM) extensions as well, if desired.

Example: Transfer Call to a Label

This example shows sample ICM Configuration Manager and Script Editor screen captures for a Menu application that plays a prompt presenting a menu ("Our office hours are between 8 AM and 6 PM. If you would like to talk to a customer service representative, press 0 at any time.") and then performs one of the following actions:

- If the caller presses 0, the system collects the digit, and then routes and queues the call.
- If the caller does not press 0, the system releases the call.
The Attributes tab of the Network VRU Script List tool in the figure above shows:

1. The VRU Script Name field contains two Unified CVP parameters:
   - **M**: Menu
   - **OfficeHours**: Media File name

2. The Config Params field contains the following Unified CVP parameter:
   - **0**: The number 0 is the only valid option.
Example: Queue and Transfer Call to a Skill Group

Use Unified ICME to queue a call to an agent group and instruct Unified CVP to entertain the caller with IVR scripting using the Run VRU Script and other nodes. When the resource becomes available, Unified ICME and Unified CVP perform the following tasks:

1. Unified ICME tells Unified CVP to cancel the original request.
2. Unified CVP then confirms the cancel request.
3. Unified ICME sends the label for the destination.
4. Unified CVP or the network transfers the call to a freed-up agent.
This example shows sample ICM Configuration Manager and Script Editor screen captures for a Menu application that plays a prompt presenting a menu (“For Checking, press 1. For Savings, press 2. To speak to a customer service representative, press 0.”), retrieves any caller-entered digits, and then routes and queues the call.

Figure 18: Sample ICM Configuration Manager and Script Editor Screen

The Network VRU Script List tool’s Attribute tab in the figure above shows:

1. The VRU Script Name field containing two Unified CVP parameters:
   - M: Menu
   - Queue: Media File name

2. The Configuration Param field containing the following Unified CVP parameters:
   - 1-2,0: The numbers 1, 2, and 0 are valid options
Figure 19: VRU Script Execution

Example: Queue and Transfer Call to a Skill Group

From a VRU script to play a menu to the caller such as “For checking, press 1. For payments, press 2. To speak to a customer service representative, press 3.”

If a Caller-Enhanced Delay (CED) is 0, then for the new call to be an agent group. This will only result in a Call-Back. It will exit if an agent is available. If not available right away, the call will be put into a queue.

At the same time, queue the call into the set of agent skill groups as well, with a lower priority.

While the call is in the queue waiting for an available agent in either queue, give the caller an option for entertainment. The VRU menu played to the caller says, “While waiting for the next available agent, please select from the following options. To hear music, press 1. For the latest stock update, press 2. To no longer wait for an agent and return to the main menu of this automated system, press 3. To hear a duck-quack, press 4.” When the agent is available, depending on settings and VRU interactivity, the call will be sent to the next available agent (based on routing rules).
Example: Network Transfer Script

Unified CVP provides capabilities to transfer calls to another destination after they an agent answers them. These capabilities are referred to as Network Transfer. The Network Transfer feature does not require any special installation on the part of Unified CVP. By default, the feature is disabled for all PG types except Enterprise Agent (EA).

To change the Network Transfer setting, perform the following steps:

1. Use Set node of the Script Editor to specify the `Call.NetworkTransferEnabled` variable. If you set this variable to 1, Network Transfer is enabled and if you set it to 0, Network Transfer is not enabled.

2. In EA PG setups where the EA is behind a PBX, use the `Network Transfer Preferred` check box on the Routing Client tab of the PG Explorer. Network Transfer is enabled only if this check box is checked.

Figure 20: Network Transfer Setting

---

Call Transfer From Agent to Agent

When a call is transferred from Unified CVP to an agent, and that agent wants to transfer the call to another agent, the agent can make the transfer using either the agent IP phone or agent desktop. Transfers from the IP phone are made using CTI route points that point to a Unified ICME script. Transfers from the agent desktop are made using the Dialed Number Plan.
For network transfer from either the IP phone or CTI OS Agent Desktop, you must Queue the call to skill group in the first Unified ICME script, for example "NetXfer1", to create the call context. In this script, the "networkTransferEnabled" flag must be set to "1".

**Note**
The *NetworkTransferEnabled* setting must explicitly be set to 1 in all postroute scripts.

### Configure Network Transfer From IP Phone

**Procedure**

**Step 1** In Unified CM, define a CTI Route Point, for example "9999." Associate it with the JTAPI user that is connected to Unified CCE PIM in Unified ICME.

**Step 2** In the ICM Admin Workstation, define a Dialed Number with a call Type for Unified CCE PIM. This call type can then be associated with a Unified ICME Script, for example, "NetXfer2".

**Note** Avoid defining the labels of agents for the Unified CCE PIM. Define the labels for VRU PIM so that the route result is returned to VRU instead of Unified CCE PIM. If you define the agent labels for the Unified CCE PIM, the Unified ICME router returns the route result to the VRU PIM if "Network Transfer Preferred" is enabled on the Unified CCE PIM and VRU PIM and returns the route result to the Unified CCE PIM if "Network Transfer Preferred" is disabled on the Unified CCE PIM and VRU PIM.

**Step 3** When the call is delivered to Agent 1 using the Unified ICME Script "NetXfer1", the agent can dial the number 9999 to send the call to another script, "NetXfer2."

### Configure Network Transfer From CTI OS Agent Desktop

**Procedure**

**Step 1** Define a Dialed Number Plan in Unified ICME.

The routing client is the Unified CCE PIM and dialed number is the one defined before for the Unified CCE PIM, that is, IPCC_PIM.9999.

**Step 2** Set Post Route to **Yes** and Plan to be **international**.

**Step 3** In the Agent Desk Settings, check all the **Outbound access** check boxes.

### Example of IP Transfer

An IP transfer to an Unified CCE agent is very similar to an IP transfer to an ACD (TDM) agent with the following exceptions:
• The egress Gateway for this case is Unified CM.
• When Unified CM receives the new call, it uses the “Skinny protocol” to connect to the agent at an IP phone. The voice channels are then connected from the Ingress Gateway to the IP phone.

**CLI Field on Outgoing Transfers**

Calling Line Identification (CLI) is a set of digits and related indicators (type of number, numbering, plan identification, screening indicator, and presentation indicator) that provide numbering information related to the calling party. This feature allows customers to override the CLI field on outgoing transfers, using either a Label node or an ECC variable in the Unified ICME routing script. This feature is required for transfers into Unity, which uses both Automatic Number Identification (ANI) and Dialed Number Identification Service (DNIS) to determine the appropriate mailbox to access. CLI is passed through most networks and into most call-handling devices, so this feature provides a back-door method to transmit arbitrary data during transfers when translation routing is not feasible.

The following section describes how to enable the `call.user.microapp.override_cli` ECC variable, which you must configure to enable this feature.

**Configure CLI Override**

CLI override is controlled from the Unified ICME routing script.

**Note**

For IP originated calls, you need to check the "Asserted-Identity" check box on the Unified Communications Manager, SIP Trunk configuration.

**Note**

For SIP calls, the CLI Override feature is only supported using the ECC variable as shown in second method. Using a dynamic label as in Method #1 with "CLI" prepended is not supported.

You can configure CLI override one of following two ways:

**First method**: Append `CLI=NNNNNNNN` to the label in a LABEL node. Setting NNNNNNNNN to the word `null` will blank out the CLI on the transfer.

**Example**: Setting a label node to `1111;CLI=9876543` results in a transfer to 1111 using a CLI of 9876543.

**Example**: Setting a label node to `1111;CLI=null` results in a transfer to 1111 using an empty CLI.

**Second method**: Set the `call.user.microapp.override_cli` ECC variable before invoking a transfer using Queue to Skill Group, Label node, and so on. For the `call.user.microapp.override_cli` Expanded Call Variable List, set the maximum length to the maximum length of the data that will be used for CLI override. The Unified CVP Call Server must be restarted after adding this variable to Unified ICM. Setting the variable to " " will blank out the CLI on the transfer.

**Example**: Setting `call.user.microapp.override_cli` ECC variable to `9876543` prior to a Queue to SkillGroup where agent 1111 becomes available, results in a transfer to 1111 using a CLI of 9876543.
Example: Setting `call.user.microapp.override_cli=""` ECC variable prior to a Queue to Skill Group where agent 1111 becomes available, results in a transfer to 1111 using an empty CLI.

If both of the methods are used in one routing script, the LABEL node CLI value takes precedence over the ECC variable.

CLI override takes precedence over the SetSetupCallingNum command in VBAdmin. That is, the new CLI is always be propagated to the transfer call leg regardless of the value of ShowSetupCallingNum.

CLI override also forces the presentationIndicator to presentationAllowed on the transfer call leg.

Note

For SIP calls, the CLI Override feature is only supported using the ECC variable. Using a dynamic label with "CLI" prepended is not supported.

Unified CCE Reroute on No Answer Configuration for Unified CVP

This section describes how to use the Reroute On No Answer function when using Unified CVP as a queue point for Unified CCE.

When you use Unified CCE with Unified CVP as a queuing point and routing client, configure the Reroute On No Answer function differently than when you use it with Unified IP IVR. The difference is when you use Unified IP IVR the call control is with Unified CM, whereas with Unified CVP, the call control is with Unified CVP.

Reroute on No Answer Operation for Unified CCE with Unified IP IVR

The Reroute On No Answer function ensures that when an agent does not answer a call, the call is taken away after ringing for a configurable number of seconds and presented to another agent or put back in queue, and the agent who did not answer the call is put in "Not Ready" state. An example of an agent not answering a call is when the agent is not at the desk and the presence of agent is not changed to the "Not Ready" state.

This function is implemented by setting a Reroute On No Answer timeout in the agent desk settings. When the call has been ringing for the configured number of seconds, the Unified CM PG makes the agent unavailable and send a postroute request to Unified ICME using a dialed number that is also configured in the Agent Desk Settings. A routing script is executed that determines a new destination for the call. This can be another agent, or the script can put the call back in a queue. When using Reroute On No Answer with Unified IP IVR, Unified ICME software responds back to Unified CM with the new destination for the call. Unified CM is responsible for sending the call to the right destination (IP IVR for queuing or new agent).

Reroute on No Answer Operation with Unified CVP

When you use Unified CCE with Unified CVP, Unified CM does not control the queuing platform (Unified CVP), and hence cannot send the call back to Unified CVP for requeuing. Instead, Unified CVP controls the call and needs to take action.
The solution is to use the Reroute On No Answer function only to make the agent state “Ready” or “Not Ready” when the agent does not answer the call, and to use the ICM Router Requery function to take the call away from the non-answering agent.

**Reroute on No Answer Agent Desk Settings Configuration**

For Agent state to be READY after CVP RNA expires:

- In Agent Desk Settings, the Ring no answer dialed number field is set to blank.
- Enter a value in the Ring No Answer time field. Set the timeout to the maximum time you want to allow the agent to answer a call; for example, 2 rings = 8 seconds. This value must be at least 2 seconds more than the timeout configured at Unified CVP for RNATimeout.

For Agent state to be NOT_READY after CVP RNA expires:

- In Agent Desk Settings, the Ring no answer dialed number field is set to blank.
- Do not enter a value in the Ring No Answer time field.

**Router Requery Configuration**

Router Requery is triggered by the routing client (Unified CVP) when a No Answer timer expires (a different timer than the Reroute On No Answer timer in the Agent Desk Settings).

- The No Answer timer for Router Requery is not controlled by Unified ICME, but by the switching fabric that is Unified CVP in this case. CVP 1.0 has a fixed No Answer timer of 15 seconds. The Unified CVP SIP has a configurable No Answer timer (RNATimeout) with a default value of 15 seconds.

When using Unified CVP, set RNATimeout to the desired number of seconds that the agent phone should ring before being taken away. In any case, this timeout **must be at least 2 seconds shorter than the Re-route On No Answer timeout** if it was set in the Agent Desk Settings.

After the Unified CVP VB RNATimeout expires, the VB/AS/PG sends a `EventReport=NoAnswer` to the router. The router picks another target according to the routing script and sends the Connect message to Unified CVP. The target might be another agent or it might be a VRU label to requeue the call. When the call disappears from the first agent, this agent is put in "Ready" or "Not Ready" based on No Answer Timeout in the desk setting.

**Note**

Do not set the No Answer DN in the desk setting, because this is a global Unified ICME setting for all scripts. The No Answer DN may not be suitable for all scripts depending on the complexity of the deployment. Instead, each script should have the X path of the queue node set appropriately for each script.

- Enable Requery on the node in the script that selects the first agent. Depending on the type of node used, the Requery mechanism selects a new target from the available agents or will require additional scripting. The Scripting and Media Routing Guide for Cisco Unified ICM/Contact Center Enterprise & Hosted describes how Requery works for the different nodes.

In most cases Unified CCE uses the Queue node. The Queue node requires additional scripting to handle the requeuing of the call in front of the queue. The script example below provides a standard way of handling the requeuing of the call.
If there is an available agent, the Queue node selects the longest available agent from the skill groups. If there is no available agent, it queues the call with a priority set in the node (see the following figure) and continues down the success exit of the node. When an agent becomes available, Unified ICME always selects the longest queued call from the ones with the highest priority. When the Queue node connects the call to an agent and the agent does not answer the call, Unified CVP Ring-No-Answer timeout expires causing the Requery mechanism to start.

**Figure 21: Queue to Skill Group Properties**

When this happens, the script immediately continues through the failure exit of the Queue node with the Requery Status variable set to ‘No Answer’ (= 3). The typical treatment is to put the call back into the same queue but with a higher priority than all other calls, since the call needs to go in the front of the queue, not the back.
In this script, when the Queue node selects an agent who does not answer the call, the script exits through the failure exit (X) of the Queue node. The If node tests the RequeryStatus variable. If it has value of greater than zero, this is a requery call, and the script requeues the call. In the preceding example, it also sets a flag using a call variable for reporting purposes. Assuming that there are no agents available, the Queue node immediately exits through the success exit (Checkmark). The node checks to see if this is a requeried call. If so, it increases the Queue Priority of the call so that it is handled before any other calls in queue. It then enters the normal wait loop with RunScripts.

The call flow is as follows:

- Script connects call to agent by sending connect message to Unified CVP (with requery enabled).
- Agent phone rings.
- After the Unified CVP VB RNATimeout expires, the VB/AS/PG sends an EventReport=No Answer to the router. The router picks another target according to the routing script and sends the Connect message to Unified CVP. The target might be another agent or it might be a VRU label to requeue the call.
- When the call disappears from the first agent, this agent is put in "Ready" or "Not Ready" state based on No Answer Timeout in the desk setting.

### Limitations

The only limitation for the configuration described in this section is that each call that is redirected by this mechanism is counted twice in the Skill Group—once as redirected, and next as handled (if the call is finally handled). However, the Call Type is only count this call once. Although it is counted Handled and Requeried, Requeried is not used to balance CallsOffered in the Call Type. If you want to see this call counted twice in the Call Types, address this by changing the call type in the error path before the second queue to skill group node.
Reroute Configuration on No Answer for Unified CM with Unified CVP

In case of an agent transfer, when calls are originated from Unified CM to a CTI Route Point, routing client responsibilities should be passed back to Unified CVP as soon as possible upon entering the Unified ICM script. To ensure that Unified ICM Router directs calls to Unified CVP, include a SendtoVRU node in the Unified ICM script before any Runscript or SkillGroup node executes. When the routing script executes the SendToVRU node, the ICM Router instructs Unified CVP to become the routing client to handle for any subsequent transfers or VRU call processing.

**RONA Operation to a script CTI Route Point Transfer**

The "Go to Script" node is used as a RONA destination when "enable target requery" is configured on the Queue to Skill Group node and the agent does not answer. When the ICM script executes the "Go To Script" node, script execution proceeds to the specified script. For example, when an agent does not answer a call, the X-path out of the Queue to Skill Group Node will target a "Go To Script" node with the "CTI_Route_Point_Transfer" script specified. Script processing then continues from the beginning of the CTI_Route_Point_Transfer's script and proceeds as usual.

Following are the valid destinations out of the X-path of Queue to Skill Group node:

- Another skill group
- A prompt
- GoTo node (do not use "Dynamic Label")

**Limitations**

The limitation for the configuration described in this section is that the disposition of the requeried call is not correctly reported. The Redirect No Answer field in the agent and skill group reports do not show calls that are redirected by this mechanism. Each call that is redirected by this mechanism is counted twice—Once as abandoned, and next as handled (if the call is finally handled). There are two Unified CCE TerminationCallDetail records for this call—One for the rerouted call (with CallDisposition ‘Abandoned while Ringing’, code 3), and other for the handled call with a CallDisposition depending on how the call was finally handled. The scripting example above shows how a Peripheral Call Variable can be used to mark and count calls Requeried because of no answer. A custom reporting template can be written to report on this data.

**Call Survivability**

This section describes how to install and configure Unified CVP with a script that allows the gateway to transfer a call in the event of a critical Unified CVP application error or WAN failure. Place this application on the incoming pots dial-peer or the incoming VOIP dial-peer that is destined for Unified CVP. Call survivability is supported in all Unified CVP call flow models except the VRU-Only call flow model. In the Unified CVP Standalone call flow model, survivability is invoked if the gateway encounters an error from the CVP Voice Server, the "param survive" parameter is included and a survivability service is defined.

In the event of critical Unified CVP application errors or a WAN failure that would normally disconnect the caller, this script allows the gateway to attempt a transfer to some alternate location after the failure occurs instead of disconnecting the caller. In the event that the call cannot be transferred to an alternate agent, the script plays a "call-back-later" message and disconnects the call.

This script provides the following capabilities:

- Perform multiple types of transfer in call failure conditions:
• *8 transfer connect (outpulse)
• Hairpin
• SRST
• Hookflash Relay
• Two B-Channel Transfer (TBCT)

• Differentiate call recovery behavior by incoming DNIS.
• Differentiate call recovery behavior by incoming DNIS and how long the call had been in Unified CVP prior to failure.
• Differentiate call recovery behavior based on time of day and date.

• Hand off to an auto-attendant type application in the event of some downstream failure (for example, WAN failure, Unified ICME failure, Unified CVP failure). This auto-attendant functionality can be BACD of CME, a Unified CVP Standalone call flow model, a VXML Server application, or a custom-written VXML application.

Caution
This script is a component of the Unified CVP software. Hence, do not make any modifications to this script. Modifications to this script not made as part of an official Unified CVP release nullify Cisco support responsibility for this script.

Install Call Survivability Script

Procedure

Step 1
Log in to the Operations Console, and copy all script and prompt files to the gateway.

Step 2
On the gateway, perform the following:

For a Unified CVP Comprehensive call flow model, define the following services:

```
application
service survive flash:survivability.tcl
paramspace callfeature med-inact-det enable
service handoff flash:handoff.tcl
```

And, then add the following parameters:

```
ip rtcp report interval 2000
gateway
timer receive-rtcp 4
```
This causes survivability to be invoked between 8 and 16 seconds \((2000\text{ ms} \times 4) \times 2\) for an active call after a WAN failure. If IOS detects the absence of both RTP and RTCP packets after 8 to 16 seconds, it raises an error event and survivability is invoked. (The factor of 2 is a built-in IOS factor that cannot be configured. Do not adjust these values lower as this can cause the survivability event to be prematurely invoked.)

The timer **receive-rtcp** command configures a media activity timer for SIP calls.

For a **Unified CVP Standalone** call flow model, first define one service:

```plaintext
application
  service my-survivability-service flash:survivability.tcl
```

You can replace `my-survivability-service` with any desired name.

Then associate the `my-survivability-service` that you just created as a parameter on the CVPSelfService.tcl service associated with the incoming pots dial-peer. Note that the text "param survive" must be entered exactly as shown, but the `my-survivability-service` service can be renamed to the service name of your choice. For example:

```plaintext
dial-peer voice XXXX pots
  service my-CVP-service
  incoming called-number NNNNN
  service my-CVP-service flash:CVPSelfService.tcl
  param CVFPrimaryVXMLServer my-VXML-server-IP
  param CVFBackupVXMLServer my-backup-VXML-server-IP
  param CVFSelfService-app my-VXML-server-app
  param keepalive my-CVP-service
  param survive my-survivability-service
  service my-survivability-service flash:survivability.tcl
```

Optionally, start a background keepalive service to the VXML Server. For example, for a service name of "my-standalone-service":

```plaintext
service my-standalone-service
  param keepalive my-standalone-service
```

This service prevents the caller from hearing a period of silence at the start of each call if the VXML Server is down, as the gateway will know the current status of the VXML Server.

**Step 3**

On the gateway, perform a "call appl voice load my-survivability-service" and "call appl voice load handoff."

**Step 4**

Perform the following:

On a **Unified CVP Comprehensive** call flow model:

- Create a Unified CVP pots dial-peer on the gateway, placing the Unified CVP called number on an incoming-called-number parameter.

- Assign the my-survivability-service service to this dial-peer.

On a **Unified CVP Standalone** call flow model, no special survivability dial-peer needs to be created. However, the parameter "param survive my-survivability-service" must be included on the CVPSelfService.tcl service.
This parameter indicates which service to run in the event of a system failure. In this way, different survivability services can be invoked depending on the incoming pots dial-peer invoked.

## Configure the Gateway for Call Survivability

Configure the following parameters on the gateway for call survivability:

- **open-hours-agent**—The destination recovery target DNIS to be used when the current time matches any open-hours-time parameter. The script cycles through all agents sequentially until an agent answers. If no agent answers, (or in the case of a takeback transfer, the PSTN does not take back the call), the script cycles through all after-hours-agents (maximum of 50 agents).
  - **Syntax:** `open-hours-agentX DNIS`
  - **Arguments:** `X` = a number from 0 to 49, `DNIS` = target destination for the recovery transfer.
  - **Example 1:** `DTMF*8,9875551212` (When PSTN *8 takeback is desired), where **DTMF** - Indicates takeback and transfer via DTMF tones **8** - The sequence the switch recognizes to perform the takeback. **Zero or more commas** - Each comma represents a pause of 100 ms. Some switches require a pause between the takeback sequence and the DNIS. **9875551212** - The actual DNIS to which the PSTN should transfer the call.
  - **Example 2:** `HF,,,,9875551212` (when hookflash transfer is desired) where: **HF** - Indicates takeback and transfer via hookflash relay **Zero or more commas** - Each comma represents a pause of 100 ms. Some switches require a pause between the hookflash and the DNIS. **9875551212** - The actual DNIS to which the switch should transfer the call. **Note:** When using either DTMF or hookflash takeback, you need to configure the following additional parameters on the gateway voice ports:

    voice-port 7/1:0
    no echo-cancel
    enable no non-linear
    no vad
    playout-delay maximum 250
    playout-delay nominal 200
    playout-delay minimum high
    playout-delay mode fixed

  - **Example 3:** `9875551212` (when hairpin or SRST transfer is desired)
  - **Example 4:** `TBCT9875551212` (when TBCT is desired)
  - **Example 5:** `<retry>` (when a retry to the original CVP DNIS is desired) - Assuming the original Unified CVP DNIS was `4444`, `<retry>` will send the call to CVP using DNIS. **4444 56<retry>78** will send the call to CVP using DNIS `5644478`.

- **after-hours-agent**—The destination recovery target DNIS to be used when the current time matches any after-hours-time parameter or as a default destination if transfers to the open-hours-agent's fail. The script will cycle through all agents sequentially until one answers (maximum of 50 agents). If no one answers, a call-back-later message will be played to the caller and then disconnected.
  - **Syntax:** identical to open-hours-agent
- **open-hours-time**—A string representing the date or days of week and time of day that open-hours-agent's will be used for the recovery transfer (maximum of 20 values). Month/day has higher selection priority than days of the week.
  - **Syntax:** open-hours-timeX {month/day | days-of-week} [:HHMM-HHMM]
  - **Arguments:** X = a number from 0 to 19, month/day = month of year and day of month (no year), days-of-week = a string of up to seven digits representing the days of the week (Sunday = 0, Saturday = 6), HHMM-HHMM = the starting and ending time of the period, expressed in 24-hour clock notation.

- **after-hours-time**—A string representing the date or days of week and time of day that after-hours-agents use for the transfer. These do not explicitly need to be listed. If the current date/time does not fall in an open-hours-time slot, it defaults to an after-hours agent. A typical use is to specify holidays that would fall on working weekdays. A maximum of 20 values are allowed.
  - **Syntax:** identical to open-hours-time

- **open-hours-cvptime**—You may want to choose a particular recovery agent based on how long the call had been in Unified CVP before the failure occurred. If no open-hours-cvptime is specified, the associated open-hours-agent will be used regardless.
  - **Syntax:** number-of-seconds
  - **Arguments:** X = a number from 0 to 19, corresponding to the associated open-hours-agent
    number-of-seconds 55 would use open-hours-agent 0 only when the call had been in Unified CVP less than 55 secs.

- **after-hours-cvptime** - Same as open-hours-cvptime, but applies instead to after-hours-agents.

- **alert-timeout** - A numeric value indicating the maximum number of seconds the destination phone should ring before aborting the call attempt.
  - **Syntax:** alert-timeout 20

- **setup-timeout**—A numeric value indicating the maximum number of seconds that the tcl script will wait in establishing a tcp connection to Unified CVP before aborting the call attempt. This value should be greater than the "h225 timeout tcp establish" parameter under the voice class h323 configuration on the gateway.
  - **Syntax:** setup-timeout 7

- **aa-name**—If non-blank, indicates that when a failure occurs, the Unified CVP survivability script hands off the caller to the BACD auto-attendant application. Enter the following:

```
service <survivability-servicename>
param aa-name <BACD-servicename>
service <BACD-servicename>
param isn-name <survivability-servicename>
```

Where servicename is the service name of the BACD auto-attendant script to which control should be passed.
Procedure

- **standalone**—If non-blank, indicates that when a failure occurs, this Unified CVP survivability script passes control to the service name specified. Typically, that service would reference the CVPSelfService.tcl script to invoke a Call Studio application to provide IVR treatment to the caller; for example:

```
  service survivability flash:survivability.tcl
  param standalone vxmlapp
  service vxmlapp flash:CVPSelfService.tcl
```

- **standalone-isntime**—Select the standalone option depending on how long the call had been in Unified CVP before the failure occurred. If no standalone-isntime is specified, the standalone option is invoked if it is non-blank.
  a) **Syntax:** standalone-isntime {> OR <} number-of-seconds
  b) **Arguments:** number-of-seconds = number of seconds the call was in Unified CVP before the call failed, prefixed with > or <. For example, standalone-isntime <2 would use standalone only when the call had been in Unified CVP less than 2 seconds.

- **icm-tbct**—A numeric boolean value (0 or 1) indicating whether or not Unified ICME scripts will issue TBCT transfers. Default is 0 (by default, Unified ICME does not handle TBCT transfers). Set this value to 1 to enable TBCT transfers issued from a TBCT label in an Unified ICME script.
  a) **Syntax Example:** icm-tbct 1

- **disableDnisStrip**—By default survivability.tcl will strip of all leading zeros from the dialed number. To disable this, you can set the disableDnisStrip parameter to a value of 1.
  a) **Syntax Example:** disableDnisStrip 1

Configure the following parameters on the gateway for call survivability in case of REFER call flow:

- **refer-prefix**—A numeric array value of 3 digits indicating whether to handle transfers as SIP REFER pass-through or SIP REFER consume on the gateway. If the transfer number matches this prefix then SIP REFER pass-through is used, otherwise SIP REFER consume is used.
  
  **Syntax Example:** refer-prefix "800 888 877 866 855"

**Note**

If survivability is configured for REFER pass-through scenario, then the gateway must have outbound dial-peer for the referred DN.

**What to do next**

Configure the following parameters on the gateway for call survivability in case of REFER call flow:

- **refer-prefix**—A numeric array value of 3 digits indicating whether to handle transfers as SIP REFER pass-through or SIP REFER consume on the gateway. If the transfer number matches this prefix then SIP REFER pass-through is used, otherwise SIP REFER consume is used.
  
  **Syntax Example:** refer-prefix "800 888 877 866 855"

- **refer-pass-setup-timeout**—A numeric value indicating the maximum number of seconds that the tcl script will wait in establishing a call that is a refer pass-through. To disable the timer, you can set the refer-prefix parameter to a value of 0. The default value is 7.
Examples of Call Survivability

In the first Call Survivability example, the following configurations are used:

```
service survivability flash:survivability.tcl
param open-hours-Agent 0 9777123400
param open-hours-Agent 1 4444888
param open-hours-time 12345:0900-1730
param open-hours-time 12/18:0600-2300
param after-hours-Agent 0 7777008
param after-hours-Agent 1 8766008
param after-hours-time 7/21:0700-0800
param after-hours-time 11/25
param setup-timeout 7
param alert-timeout
dial-peer voice 800232 pots
application survivability
incoming called-number 8002321765
direct-inward-dial
```

Using the above survivability configurations, review the following cases:

- **Case 1:** Assume today is a holiday, Thursday, 11/25 at 1300 hours. Since 11/25 is defined as a specific after-hours-time, it is selected before the 12345:0900-1730 open-hours-time, which also falls on a Thursday. If the WAN fails, this script first tries a transfer to 7777008, and then to 8766008.

- **Case 2:** Assume today is Saturday, 12/18 at 0900 hours, peak of the holiday shopping season. Since 12/18 is defined as a specific open-hours-time, it is selected for an open-hours-agent even though it falls on a Saturday, which would normally be an after hours time. If the WAN fails, this script first tries a transfer to 9777123400, then try 4444888, 7777008, and 8766008.

- **Case 3:** If time-of-day routing is not important, but you need a last-resort transfer mechanism, put one or more DNIS in the after-hours-agent slots and do not define any times. Any failed call is always directed to the list of after-hours-agents.

The next example illustrates how to organize call survivability functionality by incoming DNIS, create a separate application for each DNIS and apply desired call recovery properties to each application. For example:

- Assume billing callers dial 45XX and sales callers dial 55XX to access Unified CVP.

- Assume that a billing call fails somewhere in the course of the call:
  
  - If the call fails and the call had been in Unified CVP less than 30 seconds (this would also include the case where the call had *never* made it to Unified CVP; for example, 0 seconds), send the caller back through the PSTN via a *8 takeback to 8005556666.
  
  - If the call fails and the call had been in Unified CVP greater than or equal to 30 seconds, send the caller back through the PSTN via a *8 takeback to 8007778888.

- Assume that a sales call fails somewhere in the course of the call:
  
  - If the call fails (in this case, the amount of time the call had been in Unified CVP is irrelevant), send the caller back through the PSTN via a hairpin transfer to 8009990000.
• Assume the PSTN switch is sending ANI and DNIS in such a way that the ANI and DNIS are concatenated together in the DNIS field. Assume that ANI length is 10 and DNIS length is 4. Also assume that ANI can be blank; for example, blocked caller ID.

The IOS configuration elements necessary to accomplish these cases are shown below.

Dial-peers 2 and 4 are necessary in the event of no ANI (blocked caller ID). The lower preferences of dial-peers 2 and 4 is to protect against the case where a caller's ANI begins with 45, for example. For example, assume caller with ANI 4521111111 dialles the sales DNIS. Without lower preferences, the caller would have matched dial-peer 2 and gone to the billing application instead of sales (you wanted it to match dial-peer 3).

The following are the configuration elements for the second example:

dial-peer voice 1 pots
preference 1
application billing
incoming called-number 45..
#------------------------------------------
dial-peer voice 2 pots
preference 2
application billing
incoming called-number 45..
#------------------------------------------
dial-peer voice 3 pots
preference 1
application sales
incoming called-number 55..
#------------------------------------------
dial-peer voice 4 pots
preference 2
application sales
incoming called-number 55..
#------------------------------------------
dial-peer voice 5 pots
destination-pattern 8009990000
port 7/0:D (or whatever port is desired)
#------------------------------------------
dial-peer voice 6 voip
incoming called-number 8009990000
codec g711ulaw (To force the call to g711ulaw on the outgoing hairpin)
#------------------------------------------
service billing flash:survivability.tcl
param after-hours-agent0 DTMF*8,,,8005556666
param after-hours-cvptime0 <30
param after-hours-agent1 DTMF*8,,,8007778888
param after-hours-cvptime1 >29
param ani-dnis-split 10:4
#------------------------------------------
service sales flash:survivability.tcl
param after-hours-agent0 8009990000
param ani-dnis-split 10:4
**Enhanced Location Call Admission Control**

Enhanced Location Call Admission Control (ELCAC) is used to maximize local branch resources, keeping a call within the branch whenever possible and limiting the number of calls that go over the WAN. Unified CVP supports queue-at-the-edge, a simpler and more effective configuration of ELCAC than the transfer and queue calls with Unified CVP. Using the queue-at-the-edge functionality, the call originating from a specific branch office is deterministically routed to a local VXML Gateway based on priority, which means that ELCAC always selects a local branch agent, if possible.

*Note*


**ELCAC Topic Definitions**

The following definitions are used in the configuration of ELCAC:

- **Phantom Location**: A default location with unlimited bandwidth used when calculating calls that are hairpinned over a SIP trunk or when the SIP call is queued at the local branch, to enable correct bandwidth calculations. The Phantom location should be assigned to the gateway or trunk for CVP.

- **SiteID**: The SiteID is a string of numbers that is appended to the label from Unified ICM so that the dial plan can be configured to route the call to a specific destination, such as the branch VXML gateway or egress gateway, or Unified CM node. The SiteID can be appended at the front of the label, at the end, or not at all. This configuration is separate from the Unified CM location configuration, and is specific to Unified CVP. The SiteID is used to indicate the real location of the call and allow the bandwidth to be deducted from the correct location.

- **Shadow Location**: This new location is used for inter-cluster trunks between two Cisco Unified Communications Manager clusters. This location is not used as inter-cluster ELCAC is not supported in Unified CVP 9.0(1).

**ELCAC Queue-at-the-Edge Configuration**

The following steps provide an example configuration for ELCAC with queue-at-the-edge functionality.

Through the Unified CM, configure all branches so that Location and Bandwidth are defined:

1. From Unified CM Administration, select **System > Location**. Click **Find** to list the locations and add new ones as appropriate.

*Note*

*Unlimited* must be unchecked for each branch (the box to the left of the location name); otherwise bandwidth is not deducted for that branch. (The Phantom location still has unlimited bandwidth even when unchecked.)
Figure 23: Cisco Unified CM Administration—Find and List Locations

2. For the branch phones, configure each phone so that it is assigned the branch location for that phone.
   - Select **Device > Phone**. Click **Find** to list the phones.
   - Select a phone and set the **Location** field.
Verify that the Cisco AXL Web Service is started and that an Application User is defined and has a role of Standard AXL API Access.

- From Cisco Unified Servicability, select Tools > Control Center > Feature Services
- Start the Cisco AXL Web Service, if it is not started.
- From Cisco Unified CM Administration, select User Management > Application User. Verify you have a user with the role of Standard AXL API Access, or create a new one and add that user to a group that has the role of Standard AXL API Access.

On Unified CVP, perform the following steps using the Operations Console:

1. In Device Management > Unified CM, in the section Enable Synchronization for Location, enable synchronization and provide the credentials required to log in.

2. In System > Location, click Synchronize to retrieve the locations defined on Unified CM. Select System > Location and verify that the locations have been synchronized from Unified CCM.

3. In Device Management > Gateway, define the Ingress and VXML gateways.

4. Assign IDs. In System > Location, select a location.
   - Assign a Site ID and Location ID to the location, then add the associated gateways to the location.
   - Repeat for each of the locations.
5. In **System > Location**, navigate to **Call Server Deployment** and select the Call Servers where the configuration is to be deployed. Click **Save and Deploy**.

6. For the insertion point of the SiteID, use the default location **between the Network VRU label and the correlation ID** as shown in the following screenshot.

**SIP Deployments—Unified CM Steps:**

1. Using Unified CM, create a SIP trunk toward the SIP proxy server and select the **Phantom** location.

![SIP Trunk Configuration](image)

2. Create a SIP trunk for each ingress gateway and make the location of these ingress TDM-IP gateways the actual branch location.

3. Create a route pattern pointing the Network VRU Label of the CCM routing client to the SIP trunk toward the SIP proxy you created in Step 1.
The SIP proxy should route the Network RRU label of CCM routing client to the farm of CVP Call Servers.

4. For any IP-originated calls, the CCM route pattern should be associated with the SIP trunk created in Step 1.

5. Using Unified CM Administration, select Device > Device Settings > SIP Profile > Trunk Specific Configuration > Reroute Incoming Request to new Trunk based on > Call-Info header with the purpose equal to x-cisco-origIP.

6. Associate the new SIP profile from Step 3 with the trunk defined in Step 1 and each Ingress gateway defined in Step 2.

Locations-Based Call Admission Control Configuration

Locations-based call admission control (CAC) is used in the Unified CCE branch-office call flow model, which is also known as the Centralized Model. This means that all servers (Unified CVP, Unified ICME, Unified CM, SIP Proxy server, and Media Servers) are centralized at one or two data centers, and each branch office (of which there can hundreds or thousands) contains only a gateway and IP phones.

This section provides an overview on how to configure Unified CVP to perform the following tasks:

- Accommodate Unified CM locations-based CAC.
- Minimize bandwidth usage on the WAN.

This section also describes other call flow and bandwidth usage issues to consider.

The following sections do not include detailed installation and configuration instructions. They are intended to provide you with guidance as you set up the Unified CVP solutions in your network. For additional information about how to install, set up, run, and administer Unified CVP, see the Installation and Upgrade Guide for Cisco Unified Customer Voice Portal.

Unified CM Service Configuration Settings

Set the following configuration parameters to make Unified CM use the Ingress gateway instead of Unified CVP as the originating location of the call.

- Set "Accept Unknown TCP connection" in Unified CM Service parameters.
- Set the Unified CM Service parameter “GK controlled trunk that will listen to 1720” to “None”.
- Do not define Unified CVP as a gateway device in Unified CM.
- Define the Ingress gateways as gateway devices in Unified CM. Assign the correct location to the devices.

These settings ensure that CAC can be adjusted based on the locations of the calling endpoint and the phone.

Unified CVP Bandwidth Utilization

The following factors contribute to WAN bandwidth usage by Unified CVP in a CAC with Distributed Queuing call flow model:
The following sections describe the bandwidth requirements of these factors in an example Centralized Call Control with Distributed Queuing call flow model. The examples in these sections are based on data that Cisco obtained from testing.

In these examples, assume that:

- Each call begins with some IVR treatment followed by a transfer to an agent.
- Each branch has 20 agents and each agent handles 30 calls per hour. Thus, the total number of calls is as follows:
  \[
  20 \times 30 = 600 \text{ calls per hour} = 0.166 \text{ calls per second (CPS)}.
  \]

**VoiceXML Documents**

A VoiceXML document corresponds approximately to a Run External node in a Unified ICME script.

A round trip of a VoiceXML document between Unified CVP and the gateway consumes an average of 7 KB (7000 bytes). If each call includes approximately 20 VoiceXML documents, the WAN bandwidth consumed by VoiceXML documents can be calculated as follows:

- 7000 bytes * 20 VoiceXML documents * 8 bits = 1,120,000 bits per call
- 0.166 CPS * 1,120,000 bits per call = 185.9 Kbps per remote site

**Prompt Retrieval**

Store the voice prompts at the following locations:

- In flash memory on each local site gateway - In this way, gateways do not need to retrieve .wav files for prompts and WAN bandwidth is not affected. However, if a prompt needs to change, you must change it on every gateway.
- On an HTTP media server - In this way, each local site gateway (if properly configured) can cache many or all prompts, depending on the number and size of the prompts.

When prompts are stored on an HTTP media server, the refresh period for the prompts is defined on that server. The bandwidth consumed by prompts consists of the initial loading of the prompts at each gateway and of the periodic updates at the expiration of the refresh interval.

As an example of determining the bandwidth consumed by prompts, assume that a call flow has 50 prompts with an average size of 50 KB (50,000 bytes) each. Also, assume that the refresh period for the prompts is defined as 15 minutes (900 seconds) on the HTTP media server.

The WAN bandwidth required for prompts in this call flow can be calculated as follows:

- 50 prompts * 50,000 bytes * 8 bits = 20,000,000 bits
• 20,000,000 bits / 900 seconds = 22.2 Kbps per branch

Gateway Prompt Caching Considerations

When you store audio prompts on an HTTP media server, proper gateway prompt caching methods are necessary to optimize both the performance of the gateway and network bandwidth consumption. Gateway performance decreases by approximately 35-40% if caching is disabled entirely.

Configure Caching on the Gateway

**Procedure**

**Step 1**
Set the following settings on the gateway:

a) ivr prompt memory 15000
b) http client cache memory file 500
c) http client cache memory pool 15000

**Note**
The 'http client cache memory file' represents the largest size prompt file (in Kbytes) that can be cached. In general, break up customer prompts larger than 500K (about a minute in length) into smaller, more manageable pieces to facilitate loading and caching. For example, queue music could be a repetitive loop of a 30 second prompt. Note also that because the prompts are streamed, the prompt will not be cached unless the whole prompt is played. Therefore, you must make prompts a manageable size.

**Step 2**
Synchronize the datetime between the gateway and the HTTP media server.

**Note**
Synchronization does not have to be exact, but at least within a minute or two. Times that are not synchronized can cause prompts to never refresh or they will refresh with every call, both of which are undesirable behaviors.

**Step 3**
On the media server, set the content expiration (for example 15 minutes).

Determine Gateway Caching

To determine if you have properly configured gateway caching, perform one of the following actions:

**Procedure**

- The IIS log on the media server records every time a client requests a prompt. If caching is set up correctly, these requests appear approximately every X minutes, where "X" is the number of minutes defined as the refresh interval for any particular prompt. The log is located at C:\WINNT\system32\LogFiles\W3SVC1\ex*.
- Run 'show http client cache' on the gateway. The 'Fresh Time' column equals the refresh time period set on the HTTP media server. For example, if the refresh period was set to 15 minutes, it says 900 seconds. The 'Age' column shows how many seconds have passed since the prompt was last refreshed. In general, this number will be less than the 'Fresh Time'. However, if no call has ever accessed the prompt recently, this number could be greater than the fresh time. Prompts are only refreshed when triggered by a call.
and the prompt 'Fresh Time' has expired. If the Fresh Time is a very high value, the only way to remove the prompt from cache is to reload the gateway.

**UUI as Correlation ID**

Unified CVP uses the User-to-User Information (UUI) from the incoming call as a Correlation ID in the VRU-Only call flow model. This feature allows customers to transfer Correlation IDs through their network; for example, using a Call Routing Service Protocol (CRSP) NIC for call control.

**Note**

This feature applies only to the Unified CVP VRU-Only call flow model.

The network has no place to store a Correlation ID, so it must be "hidden" in the ISDN setup that arrives at the IOS gateway and then is extracted by the gateway. The UUS parameter, also known as the User-to-User Information (UUI) of the Generic Transparency Descriptor (GTD) data, can be used to "hide" the Correlation ID, provided the call control client has the capability of inserting a Correlation ID value into the GTD.

When the call arrives at the gateway from the network, the call control client extracts the value and appends it to the DNIS before sending an HTTP request to the Type3 Unified CVP Call Server.

**How It Works**

The call control client (such as the CRSP NIC) inserts the desired Correlation ID value into the dat field of the UUS parameter of the NSS IAM message. These NSS messages are used as the basis of building the GTD data that ultimately arrives at the IOS gateway from the PSTN. See the ITU-T Narrowband Signaling Syntax spec (Q.1980.1) for a detailed description of the IAM message and UUS parameter, included below for convenience. Note that the dat field contains pairs of hexadecimal digits, meaning that if the Correlation ID is "12345", the dat field must be populated as "3132333435". The gateway bootstrap.tcl script converts back to "12345" before appending to the DNIS and passing to the Unified CVP Call Server in the HTTP URL.

To configure a gateway, see Configure Gateway, on page 205.

**Related Topics**

Configure Gateway, on page 205

**Debugging Tips**

**Debug Trace Settings for the Gateway**

On the gateway, enter the following code:

```
debug voip application script
debug gtd
```

**GTD Values in the Gateway Log**

In the gateway log, look for the following GTD values:
External Transfers in Unified ICME

Unified ICM Script Label for Outpulse Transfer

Labels in Unified ICM scripts for Unified CVP calls that require outpulse transfer mode must be prepended with the characters DTMF followed by *8 and some number of commas, where each comma represents a pause of 100 milliseconds. By configuring the target label with the form DTMFnnnn (where nnnn are the digits to outpulse), Unified CVP sends the digits out-of-band using H.245 signaling to the Ingress gateway for outpulsing.

To use the AT&T Transfer Connect feature to transfer the call to the number “4441234”, configure the label as DTMF*8,,4441234.

---

Note

Usually the PSTN switch expects a delay between the *8 and the phone number. Each comma represents 100ms by default. It can be changed with the SetTakebackDelay command in VBAdmin.

Note

In outpulse transfer mode, Unified CVP sends whatever digits are in the label to the Gateway for outpulsing. It is the customer’s responsibility to confirm interoperability with the target switch.

Note

In your Unified ICM script, when using outpulse transfers with SIP calls, digits can only be outpulsed on a call that has already been established. This means that it is necessary to transfer the call to the VXML gateway with a run external script node before you can send the DTMF*8 label. The Unified ICM script cannot send the DTMF*8 label back to Unified CVP for the first connect message in the call because the call has not been answered at this point. The Unified CVP Call Server uses SIP INFO messages to send the digits to the gateway for outpulsing.

Note

When using outpulse transfers with SIP, you can also use the comma duration as the default interdigit pause duration.
For example, with the default 100 msec comma duration, a label such as "DTMF*8,,,8009785001" will have 300 msecs between the first 8 and the second 8. The interdigit pause will also be 100 msecs. The tone duration is also configurable and defaults to 100 msecs.

Note
Outpulse transfer with SIP uses SIP INFO messages being sent to the TDM gateway, where the outpulsing of digits occurs. If the agent using the CTI desktop performs a blind transfer (single step transfer), and the scheduled script for the transfer DN returns a DTMF type label, the Unified Communications Manager SIP Trunk can loop the CVP DTMF label through the bridged call using an UPDATE message. Unified CVP can get the label back and convert the digits to SIP INFO messages to forward to the ingress gateway. This only works on blind transfers, and is not supported on consult transfers.

Unified ICME Script Label for Two B-Channel Transfer

For Unified CVP calls that require Two B-Channel Transfer (TBCT) mode, add a label node to your Unified ICME script with the following syntax:

TBCT99#8005551212#

Replace "8005551212" with your transfer destination target; TBCT99 and the # sign are mandatory.

By configuring the target label in this form, Unified CVP sends the digits to the Ingress endpoint for Two B-Channel transfer.

Unified ICME Script Label for Hookflash Transfer

Prepend labels in Unified ICME scripts for Unified CVP calls that require hookflash transfer mode with the characters HF. By configuring the target label with the form HFnnnn (where nnnn are the digits to call), Unified CVP sends the digits to the Ingress endpoint for hookflash transfer.

If the switch requires a pause after the hookflash, insert commas between the HF and the transfer number. (Each comma represents 100 milliseconds.)

For example, to use the hookflash feature to transfer the call to the number “4441234” with a 500-millisecond pause after the hookflash, configure the Unified ICME label as "HF,,,,4441234."

Multicast Music on Hold (MMoH)

Multicasting may be used for Music On Hold with supplementary services on Unified CM as an alternative to the unicast MoH.

There are two ways to deploy this feature:

- With the Unified CM multicasting the packets on the local LAN.
- With the branch gateway(s) multicasting on their local LANs.

The latter is used when survivable remote site telephony (SRST) is configured on the gateway, and allows the deployment to utilize MOH locally and avoid MOH streaming over the WAN link.
Associate the SIP Trunk for Unified CVP (configured on Unified CM) with a Media Resource Group List (MRGL) that supports MMOH resources. Access the following links for configuration details and on how to create the MRGL:

- Configuring Music on Hold
- Integrating Cisco CallManager and Cisco SRST to Use Cisco SRST as a Multicast MoH Resource

Multicast MOH Usage Guidelines

The following guidelines apply when using Multicast MOH:

- Do not use this setting globally, or on a dial peer on the Ingress or Egress Gateway:

  \[\text{modem passthrough nse codec g711ulaw}\]

  This setting might cause Unified CM to stop the MOH after a timeout period of 10 to 12 seconds.

- Do not set media inactivity on the Ingress Voice Gateway because multicast MOH does not send RTP or RTCP, and the call might get disconnected due to media-inactivity configuration. The setting media-inactivity criteria does not support multicast traffic.

- SIP-based multicast MOH is not supported on a 5400 platform because CCM-manager-based MOH subsystems are not supported on 5400 platform. This limitation also affects the ability of a TDM caller to hear multicast packets broadcasted from the Unified CM MOH server.

Mixed G.729 and G.711 Codec Support

Transcoders (DSPs) are required if the two endpoints participating in the call cannot negotiate a common codec. Therefore, midcall codec negotiation greatly reduces the need for transcoders.

CVP supports mixed G.711 and G.729 codecs in Standalone and Comprehensive SIP deployments with Cisco Unified Border Element Enterprise Edition (CUBE) and Cisco Unified Communications Manager (Unified CM). Calls that are ingressed through a SIP trunk from the carrier to a CUBE require Cisco IOS 15.1(2)T or later for mixed codec support. You can use any combination of codecs on the legs of a call. For example, a caller can place a call using the G.729 codec, hear an IVR prompt played using the G.711 codec, be transferred to the first Agent using the G.729 codec, and then transferred to the second agent using the G.711 codec.

A typical use case where transcoders may be required is when phones in a WAN connected location only support the G729 codec, and CVP is set up for G711 support. In this case, when these phones call into CVP, Unified Communications Manager engages transcoders. For inbound calls that arrive from a gateway or CUBE can start with G711 at CVP, then later renegotiate to G729 with the agents without the need for transcoders.

Transcoders (DSPs) are controlled by CUBE and Unified Communications Manager depending on the call flow. Because most of the service providers support midcall codec negotiation, transcoders in CUBE are not necessary. You commonly need transcoders controlled by Unified Communications Manager to support call flows, in which the phone supporting G729 is calling into CVP supporting G711.
Post Call Survey for SIP

A Post Call Survey takes place after normal call treatment. It is used to determine whether customers are satisfied with their call center experiences. This feature lets you configure a call flow that, after the agent disconnects from the caller, optionally sends the call to a Dialed Number configured for a Post Call Survey.

The Unified CCE script can enable and disable Post Call Survey on a per-call basis by testing for conditions and setting an expanded call variable that controls post call survey. For example, the script can invoke a prompt that asks callers whether they want to participate in a survey. Based on the caller's response, the script can set the expanded call variable that controls whether the call gets transferred to the Post Call Survey dialed number.

The Post Call Survey call works like a regular call from the Unified CCE point of view. Scripts can be invoked and the customer can use the keypad on a touch tone phone and voice with ASR/TTS to respond to questions asked during the survey. During Post Call Survey, the call context information is retrieved from the original customer call.

Note
For reporting purposes, the Post Call Survey call has the same CallGUID and call context as the original inbound call.

Note
Unified CVP can only send call variables and predefined ECC variables and ECC array like ToExtVXML and FromExtVXML in the call context to the NEW_CALL for PCS.

If you wish to use the Post Call Survey feature through Unified CVP, you must configure it on the Call Server. Also, you can configure the Unified ICM script to toggle the use of Post Call Survey on and off. The two configuration topics that follow, explain these methods.

Configure Call Server for Post Call Survey

In the following procedure, enter a dialed number pattern for the inbound call and a dialed number pattern for the post call survey. In both cases, the patterns can use alphanumeric characters and wildcard characters such as the exclamation point (!), asterisk (*), and single digit matches, such as the letter X or period (.). The pattern can end with an optional greater than (>) wildcard character. The maximum length of the dialed number pattern is 24 characters.

Procedure

Step 1

Step 2
Log in to the Operations Console and select Device Management > Unified CVP Call Server. The Find, Add, Delete, Edit Call Servers window opens.

Step 3
Click the Call Server for which you want to configure Post Call Survey. The Edit CVP Call Server Configuration page displays.
Configure ICM for Post Call Survey

Configuration is not required on Unified ICM to use Post Call Survey, however, you can turn the feature off (and then on again) within an ICM script by using the ECC variable `user.microapp.isPostCallSurvey` and a value of n or y (value is case insensitive) to disable and re-enable the feature.

Configure the ECC variable to a value of n or y before the label node or before the Queue to Skillgroup node. This sends the correct value to Unified CVP before the agent transfer. This ECC variable is not needed to initiate a Post Call Survey call, but you can use it to control the feature once Post Call Survey is configured using the Operations Console. As long as a DN is mapped in the Operations Console for Post Call Survey, the call will be automatically transferred to the configured Post Call Survey DN.

Note

- The Post Call Survey DN is called if the Unified CVP has received at least one CONNECT message from ICM (either from the VRU leg or from the Agent leg). Use the END node in your ICM script if the Post Call Survey is not required for the calls disconnected from the IVR.

- If Router Requery is configured incorrectly and the Ring-No-Answer timeout expires, the caller is still transferred to the Post Call Survey DN. This can occur if a Queue node is used and Enable target requery is not checked.
## Procedure

<table>
<thead>
<tr>
<th>Step</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Step 1</strong></td>
<td>On the Unified ICM Administration Workstation, using configuration manager, select the <strong>Expanded Call Variable List</strong> (ECC) tool.</td>
</tr>
<tr>
<td><strong>Step 2</strong></td>
<td>Create a new ECC variable with <strong>Name</strong>: <code>user.microapp.isPostCallSurvey</code>.</td>
</tr>
<tr>
<td><strong>Step 3</strong></td>
<td>Set <strong>Maximum Length</strong>: to 1.</td>
</tr>
<tr>
<td><strong>Step 4</strong></td>
<td>Check the <strong>Enabled</strong> checkbox. Then click <strong>Save</strong>.</td>
</tr>
<tr>
<td><strong>Step 5</strong></td>
<td>Select <strong>Manage &gt; Call Types</strong>.</td>
</tr>
<tr>
<td><strong>Step 6</strong></td>
<td>Add the call type for Post Call Survey, and click <strong>Save</strong>.</td>
</tr>
<tr>
<td><strong>Step 7</strong></td>
<td>Select <strong>Manage &gt; Dialed Numbers</strong>.</td>
</tr>
<tr>
<td><strong>Step 8</strong></td>
<td>Create Dialed Numbers with Routing Type External Voice for each of the Post Call Survey Dialed Number Patterns created in CVP and associate them to the Post Call Survey Call Type you just added.</td>
</tr>
<tr>
<td><strong>Step 9</strong></td>
<td>Click <strong>Save</strong>.</td>
</tr>
<tr>
<td><strong>Step 10</strong></td>
<td>If you added the new expanded call variable, you must restart the active generic PG (side A or B) to register the new variable.</td>
</tr>
<tr>
<td></td>
<td>If the expanded call variable already existed, you can skip this step.</td>
</tr>
</tbody>
</table>

**Note** The `user.microapp.isPostCallSurvey` setting takes effect on CVP only when it receives a connect or temporary connect message. Therefore, if you do not want the survey to run, without first reaching an agent (such as 'after hours of treatment'), you must set the `isPostCallSurvey` to `n` before the initial 'Run script request'.
Configure High Availability for Unified CVP

- Server Groups, on page 397
- Redundancy and Failover for Unified CVP, on page 399
- ASR and TTS Server Location Setup, on page 401
- Unified CVP Call Servers, on page 405
- Unified CVP VXML Servers, on page 406

Server Groups

A Server group is a dynamic routing feature that enables the originating endpoint to have knowledge of the status of the destination address before attempting to send the SIP INVITE. Whether the destination is unreachable over the network, or is out of service at the application layer, the originating SIP user agent can have fore-knowledge of the status through a heartbeat mechanism.

The Server Groups add a heartbeat mechanism with endpoints for SIP. This feature enables faster failover on call control by eliminating delays due to failed endpoints.

The following list is a summary of important configuration items:

- Server Groups are not automatically added to your configuration. You must explicitly configure Server Groups for their deployment and turn on this feature.

- If you have already configured the local SRV feature and therefore created a srv.xml file, you must run the srvimport.bat command before you configure Server Groups using the Operations Console. Otherwise, your existing definitions will be overwritten. This process is explained in the configuration details that follow.

- You define Server Groups using the Operations Console. You must always configure at least one Call Server first, because you will not be able to save the Server Groups configuration without assigning it to at least one Call Server.

Configure Server Groups

Complete the following steps to configure Server Groups:

1. If you have previously created an srv.xml file, after you upgrade your Unified CVP installation, run the batch file srvimport.bat to transfer your prior configuration to the new Server Groups feature.
The srvimport.bat file is located in the CVP bin directory. This batch file takes your srv.xml file as an argument. Copy this file from your Call Server configuration directory. Running srvimport.bat brings this configuration data into the Operations Console.

Note: You must stop the OAMP (Operations Console) service before you run the .bat file.

2. If you have not defined a Call Server using the Operations Console, refer to Configuring a Call Server in the Operations Console online help.


4. A Server Group consists of one or more destination addresses (endpoints) and is identified by a Server Group domain name. This domain name is also known as the SRV cluster name, or Fully Qualified Domain Name (FQDN). Define the FQDN and add it to the list. Refer to Configuring Server Groups in the Operations Console online help.

5. Refer to SIP Server Group Configuration Settings in the Operation Console online help to complete the Server Group configuration.

6. Click the Call Server Deployment tab and select the Call Server(s) that you want to associate with the Server Group(s). Then click Save & Deploy.

Note: When you associate the Call Server(s) configuration, all the SIP Server Group configurations are applied to the Call Server(s), but individual deployment of SIP Server Group is not supported.

Server Groups Diagnostics

The CVP log file has traces which show endpoint status events. From the diagnostic servlet, click on the link for dump SIP state machine to display information as shown in the following example:

Figure 25: Server Group Diagnostics
Redundancy and Failover for Unified CVP

This section describes redundancy and failover mechanisms for ASR, TTS, Media, and VXML Servers in the Unified CVP solution.

Redundancy for VXML Server Applications

VXML Server applications rely on the gateway’s configured default for ASR and TTS servers, which allow only a single host name or IP address to be specified for each. This differs from the Unified CVP micro-applications based applications, which support automatic retries to specifically named backup ASR and TTS servers.

Use the following configuration on the gateway if you are using Nuance or Scansoft ASR/TTS servers:

```
ip host asr-en-us 10.10.10.1
ip host tts-en-us 10.10.10.2
```

Use the following configuration on the gateway if you are using Nuance or Scansoft ASR/TTS servers:

```
mrcp client rtpsetup enable
ivr asr-server rtsp://asr-en-us/recognizer
ivr tts-server rtsp://tts-en-us/synthesizer
http client cache memory pool 15000
http client cache memory file 500
ivr prompt memory 15000
ivr prompt streamed none
mrcp client timeout connect 5
mrcp client timeout message 5
rtsp client timeout connect 10
rtsp client timeout message 10
vxml tree memory 500
http client connection idle timeout 10
no http client connection persistent
```

The URL configured by the above ivr commands defines the gateway's default target for ASR and TTS services, and is in effect for all calls handled by that gateway. You can override it dynamically in your VXML Server application by populating the Cisco-proprietary VoiceXML properties `com.cisco.asr-server` or `com.cisco.tts-server`.

Note

For ASR/TTS failover to function when using Custom VXML Applications, you require either an Application Control Engine (ACE) or any other supported load balancer.

Redundancy for Micro-App-Based Applications

When ACE is used for ASR or TTS servers, the IVR Service plays a significant role in implementing a failover mechanism for Media Servers, ASR/TTS Servers and micro-app-based applications. Up to two of each such servers are supported, and the IVR Service orchestrates retries and failover between them.
IVR Service Failover Mechanism

The IVR Service failover mechanism applies to:

- Connections between the IVR Service and the IOS Voice Browser, only.
- All communication between the IOS Voice Browser and an ASR Server, TTS Server, or Media Server.
- Media Server, when the ICM Script ECC variable, `user.microapp.media_server`, is set to mediaserver. When `user.microapp.media_server` is set to mediaserver, the IVR Service uses the IP Address defined on the gateway as:
  - `ip host mediaserver 10.86.129.50`
  - `ip host mediaserver-backup 10.86.129.51`

If `user.microapp.media_server` is configured as the hard-coded IP Address of the media server, then the IVR Service will not perform any failover for the media server.

If the IVR Service receives a Call Result error code value of 9 (MEDIA_FILE_NOT_FOUND), 33 (GENERAL_ASR_TTS), 31 (MEDIA_RESOURCE_ASR) or 32 (MEDIA_RESOURCE_TTS), it does the following:

- When attempting to connect to a *Media Server*, the IVR Service:
  - Resends the request the number of times defined in the IVR Service Configuration's *Media Server Retry Attempts* field.
  - If the connection is not successful after the specified number of attempts, and the IVR Service Configuration's *Use Backup Media Servers* field is set to *Yes* (the default), the IVR Service makes the same number of attempts to retrieve the media from a backup media server before failing and generating an error.

  The backup media server is defined on the gateway as `<mediaserver>-backup`.

- Passed the error in a Call State Event to the ICM Service, which then passes it to Unified ICME.

- When attempting to connect to an *ASR/TTS Server*, the IVR Service:
• Resends the request the number of times defined in the IVR Service Configuration's ASR/TTS Server Retry Attempts field.

• If the connection is not successful after the specified number of attempts, and the IVR Service Configuration's Use Backup ASR/TTS Servers field is set to Yes (the default), the IVR Service makes the same number of attempts to connect to a backup ASR/TTS server before failing and generating an error.

Note: The backup ASR and TTS servers are defined on the gateway as asr-<locale>-backup and tts-<locale>-backup.

• Passes the error in a Call State Event to the ICM Service, which then passes it to Unified ICME.

Each new call attempts to connect to the primary server. If failover occurs, the backup server is used for the duration of the call; the next new call will attempt to connect to the primary server.

Note: This failover mechanism differs from that used in prior releases of Unified CVP software. Legacy releases used a sticky connection. In a sticky connection, if failover occurs to a backup server, subsequent new calls automatically connect to the backup server, rather than attempt to connect with the primary server.

If the Unified CVP IVR Service fails, the following conditions apply to the call disposition:

• Calls in progress are default-routed to an alternate location on the originating gateway. (Survivability does not apply in NIC-routing models.)

• New calls are directed to an in-service Unified CVP IVR Service.

ASR and TTS Server Location Setup

There are two ways to specify an external media server for TTS and ASR operations:

• Specify an ASR and TTS Server Location Globally on the Gateway, on page 402

• Specify an ASR and TTS Server Location with an Individual VoiceXML Document, on page 403

Note: While using ASR/TTS, use a single version of MRCP (v1/v2) instead of using it in mixed mode.

Related Topics

Specify an ASR and TTS Server Location Globally on the Gateway, on page 402
Specify an ASR and TTS Server Location with an Individual VoiceXML Document, on page 403
Specify an ASR and TTS Server Location Globally on the Gateway

Media server sessions are created for each call to IVR applications, regardless of whether an application needs to communicate with the media server. Follow these steps to specify an ASR and TTS server location globally on the gateway.

Procedure

Step 1 Define the Hostname to IP Address mapping for the ASR and TTS servers.

```
ip host asr-en-us 10.78.26.31
ip host tts-en-us 10.78.26.31
```

Step 2 Define the Voice class URI that matches the SIP URI of the ASR Server in the dial-peer.

```
voice class uri TTS sip
pattern tts@10.78.26.31
```

Step 3 Define the Voice class URI that matches the SIP URI of TTS server in the dial-peer. Syntax - voice class uri tag sip.

```
voice class uri ASR sip
pattern asr@10.78.26.31
```

Step 4 Define the SIP URI of the ASR and TTS Server. Syntax - sip:server-name@host-name | ip-address.

```
ivr asr-server sip:asr@10.78.26.31
ivr tts-server sip:tts@10.78.26.31
```

Step 5 Set up a SIP VoIP dial-peer that is an outbound dial-peer when the Gateway initiates an MRCP over SIP session to the ASR server.

```
dial-peer voice 5 voip
session protocol sipv2
destination uri ASR
dtmf-relay rtp-nte
codec g711ulaw
no vad
```

Step 6 Set up a SIP VoIP dial-peer that is an outbound dial-peer when the Gateway initiates an MRCP over SIP session to the TTS server.

```
dial-peer voice 6 voip
session protocol sipv2
destination uri TTS
dtmf-relay rtp-nte
codec g711ulaw
no vad
```

Step 7 Specify the name or IP address of a SIP server; usually a proxy server. You can then configure the dial-peer session target as session target sip-server. Syntax - sip-server {dns:[host-name] |ipv4: ip-addr[:port-num]}.

```
sip-ua
sip-server ipv4:10.78.26.31
```
Specify an ASR and TTS Server Location with an Individual VoiceXML Document

Media server sessions occur for each call to that application. If only a small number of applications require TTS/ASR media sessions, use the `<property>` extensions within those applications to define the external media server URL in the VoiceXML script.

**Note**

Specifying the URL of media servers in a VoiceXML document takes precedence over the gateway configuration. Any value that is configured on the gateway is ignored if the same attribute is configured with a VoiceXML property.

**com.cisco.tts-server**

The “com.cisco.tts-server” allows the document to specify an external media server for text-to-speech operations. The media server is specified in the form of an URI, and is used in all consecutive TTS operations until the next media server is specified. An external media server specified by a property in the script takes precedence over being specified by a command through the CLI.

It can be defined for:

- An entire application or document at the `<vxml>` level
- A specific dialog at the form or menu level
- A specific form item

You can format the media server URI for Media Resource Control Protocol version 1 (MRCP v1), which uses Real Time Streaming Protocol (RTSP), IP Address or Hostname; or MRCP v2, which uses Session Initiation Protocol (SIP), IP Address or Hostname for example:

```xml
<property name="com.cisco.tts-server" value="rtsp://tts-server1/synthesizer" />
<property name="com.cisco.tts-server" value="sip:mresources@mediaserver.com" />
<property name="com.cisco.tts-server" value="10.10.10.10" />
<property name="com.cisco.tts-server" value="ttsserver.com" />
```

**com.cisco.asr-server**

The “com.cisco.asr-server” allows the document to specify an external media server for recognize operations. The media server is specified in the form of an URI, and is used in all consecutive ASR operations until the next media server is specified. An external media server specified by a property in the script takes precedence over being specified by a command through the CLI.

You can format the media server URI for Media Resource Control Protocol version 1 (MRCP v1), which uses Real Time Streaming Protocol (RTSP), IP Address, or Hostname, or MRCP v2 which uses Session Initiation Protocol (SIP), IP Address or Hostname for example:

```xml
<property name="com.cisco.asr-server" value="rtsp://asr-server/synthesizer" />
<property name="com.cisco.asr-server" value="sip:mresources@mediaserver.com" />
<property name="com.cisco.asr-server" value="10.10.10.10" />
```
Set Up the VoiceXML Document Properties

Procedure

Step 1
In Unified Call Studio, view the properties for the AgeIdentification.

Step 2
Specify the VoiceXML document properties at either the root or node level.

Step 3
Select Properties > General Settings > Language, and specify “en-us” as the language.

Certain third-party software and hardware are compatible only with US English.

Example Gateway Configuration for MRCPv2 with Failover

```
--------Primary Server--------
ip host asr-en-us 10.78.26.83
ip host tts-en-us 10.78.26.83
ivr asr-server sip:asr@asr-en-us
ivr tts-server sip:tts@tts-en-us

voice class uri ASR sip
pattern asr@asr-en-us*
voice class uri TTS sip
pattern tts@tts-en-us*

dial-peer voice 5 voip
destination uri ASR
session target ipv4:10.78.26.83
session protocol sipv2
dtmf-relay rtp-nte
codec g711ulaw
no vad

dial-peer voice 6 voip
destination uri TTS
session target ipv4:10.78.26.83
session protocol sipv2
dtmf-relay rtp-nte
codec g711ulaw
no vad

--------Backup---------------------
dial-peer voice 7 voip
destination uri ASR
session target ipv4:10.78.26.20
session protocol sipv2
dtmf-relay rtp-nte
codec g711ulaw
preference 2
no vad

dial-peer voice 8 voip
destination uri TTS
session target ipv4:10.78.26.20
session protocol sipv2
```


dtmf-relay rtp-npe
codec g711ulaw
preference 2
no vad

Unified CVP Call Servers

Call Server load balancing is only supported on IVR only deployments.

Note

Probes

The probe below is used to determine whether the Call Server is up and in service. The probe passes only if the Call Server is In Service. This probe is an HTTP probe using the ACE server.

The ACE server Call Server probe sends an HTTP request to 
/cvp/VBServlet?MSG_TYPE=HEARTBEAT&TIMEOUT=0. This probe takes a little more than 4 seconds to send back a response. If the Call Server is In Service, the HTTP 200 OK response returns.

Refer to the Cisco ACE 4700 Series Appliance Server Load-Balancing Configuration Guide.

To create the Call Server HTTP probe, place the following lines in the configuration for the ACE server:

```
        probe http PROBE_CALLSERVER_HTTP
        port 8000
        interval 6
        faildetect 1
        passdetect interval 6
        passdetect count 1
        receive 5
        request method get url /cvp/VBServlet?MSG_TYPE=HEARTBEAT&TIMEOUT=0
        open 1
        expect status 200 200
```

QoS for Unified CVP Call Server

Quality of Service (QoS) is the measure of transmission quality and service availability of a network (or internetworks).

Note

For more information about defining QoS criteria, see the latest Enterprise QoS Solution Reference Network Design Guide.

For more information to create policy based QOS, see section Create Policy Based QoS, on page 121.

Related Topics

Create Policy Based QoS, on page 121
Unified CVP VXML Servers

Real Servers: Configure the Physical Servers

Create a real server for every physical VXML Server you would like to load balance. Associate the probe with each server by creating a section, as shown in the following example, for each VXML server in the server farm.

```plaintext
rserv host vxml1
probe PROBE_SERVICE_ICMP
ip address 10.1.1.15
inservice
rserv host vxml2
probe PROBE_SERVICE_ICMP
ip address 10.1.1.16
inservice
```

HTTP Probe Configuration

The probe below is used to determine whether the VXML Server is up and in service. The probe passes only if the VXML Server is In Service. To create the VXML Server HTTP probe, place the following lines in the configuration for the ACE server.

The VXML Server probe sends an HTTP request to /CVP/Server?probe=true. If the VXML Server is up and inservice, HTTP 200 OK is returned. In the HTTP probe below, the http request is made to the port specified in the probe and the IP of the real server that this probe is associated with.

```plaintext
probe http PROBE_VXMLSERVER_HTTP
port 7000
interval 5
receive 3
faildetect 1
passdetect interval 5
passdetect count 1
request method get url /CVP/Server?probe=true
expect status 200 200
open 1
```

Note

In order to get the "?", press CTRL-V before pressing the question mark.

Server Farm Configuration

```plaintext
serverfarm host vxmlserver
probe PROBE_VXMLSERVER_HTTP
rserv vxml1 7000
inservice
rserv vxml2 7000
inservice
```

Sticky Server Farm
For a VXML Server to preserve HTTP session information, you must ensure that, once the ACE server has chosen a particular VXML Server from the list of servers in a server farm, the ACE server continues to send all traffic for that session to the same VXML Server. To accomplish this, use a *sticky group*.

Refer to the Cisco ACE 4700 Series Appliance Server Load-Balancing Configuration Guide.

The following definitions apply to the settings shown below:

- **http-cookie**: Sticky method being used. In this method, when the ACE server examines a request for content, and determines through policy matching that the content is sticky, the ACE server examines any cookie or URL present in the content request. The ACE server uses the information in the cookie or URL to direct the content request to the appropriate server.

- **Cookie insert**: The ACE server inserts the cookie on behalf of the VXML Server upon the return request, so that the ACE server can perform cookie stickiness even when the VXML servers are not configured to set cookies. The cookie contains information that the ACE server uses to ensure persistence to a specific real server.

The following ACE server configuration code accomplishes the *sticky* function.

```plaintext
sticky http-cookie ACE_COOKIE VXXMLServer_HTTP_STICKY
cookie insert
serverfarm vxmlserver
```

**Class map Configuration**

```plaintext
class-map match-all vxmlservlet_HTTP_CLASS_L3
2 match virtual-address 10.1.1.17 tcp eq 7000
```

**Policy map Configuration**

```plaintext
policy-map type loadbalance first-match vxmlservlet_HTTP_POLICY_L7
class L7_HTTP_CLASS
sticky-serverfarm VXXMLServer_HTTP_STICKY

policy-map multi-match POLICY
class vxmlservlet_HTTP_CLASS_L3
loadbalance vip inservice
loadbalance policy vxmlservlet_HTTP_POLICY_L7
loadbalance vip icmp-reply active
```
IPv6 Configuration

- Configure IPv6 on Unified CVP Call Server, on page 409
- Configure IPv6 on Unified Communications Manager, on page 409
- Add a Common Device Configuration Profile in Unified Communications Manager, on page 410
- Configure SIP trunk from Unified Communications Manager to Unified CVP, on page 412
- Gateway Configuration, on page 413
- Transcoder Configuration in Unified CM and IOS Gateway, on page 414

Configure IPv6 on Unified CVP Call Server

For IPv6-enabled deployments, you must add an IPv6 address to your Unified CVP Call Server's existing network interface.

Procedure

| Step 1 | On the Unified CVP Call Server, navigate to Control Panel > Network and Sharing. |
| Step 2 | Click Ethernet. |
| Step 3 | From the Ethernet Status window, select Properties. |
| Step 4 | Check the Internet Protocol Version 6 (TCP/IPv6) check box, and choose Properties. |
| Step 5 | Choose Use the following IPv6 address radio button. |
| Step 6 | Enter values in the IPv6 address, Subnet prefix length, and Default gateway fields. |
| Step 7 | Click OK and restart Windows when prompted. |

Configure IPv6 on Unified Communications Manager

Enable IPv6 in Unified Communications Manager

Perform the following procedure to enable IPv6 on all the Unified Communications Manager in your cluster.
IPv6 Configuration

Cluster-Wide Configuration in Unified CM Administration

Perform the following procedure to set IPv6 as the addressing mode preference for media and signaling cluster-wide.

Procedure

Step 1 From Cisco Unified CM Administration, choose System > Enterprise Parameters > IPv6 Configuration Modes to configure the cluster-wide IPv6 settings for each Unified Communications Manager server.
Step 2 From the Enable IPv6 drop-down list, choose True.
Step 3 From the IP Addressing Mode Preference for Media drop-down list, choose IPv6.
Step 4 From the IP Addressing Mode Preference for Signaling drop-down list, choose IPv6.
Step 5 From the Allow Auto-configuration for Phones drop-down list, choose Off.
Step 6 Save your changes.

Add a Common Device Configuration Profile in Unified Communications Manager

In an IPv6-enabled environment, you may have both IPv4 and IPv6 devices.

Perform the following procedure to add an IPv4, IPv6, or dual stack common device configuration profile in Unified Communications Manager.

Procedure

Step 1 From Cisco Unified CM Administration, choose Device > Device Settings > Common Device Configuration.
Step 2 Click Add New and enter the name of the new common device configuration profile.
Step 3 From the IP Addressing Mode drop-down list:
  • To add an IPv6 common device configuration profile in Unified Communications Manager, choose IPv6 only.
• To add an IPv4 common device configuration profile in Unified Communications Manager, choose IPv4 only.
• To add a dual stack common device configuration profile in Unified Communications Manager, choose IPv4 and IPv6. Then choose IPv4 from the IP Addressing Mode Preference for Signaling drop-down list.

Step 4  Save your changes.

Associate the Common Device Configuration Profile with Gateway Trunk

Perform the following procedure to associate the common device configuration profile with the Gateway trunk. This procedure applies to the Ingress Gateway.

Procedure

Step 1  From Cisco Unified CM Administration, choose Device > Trunk.
Step 2  Click Find.  Choose the trunk profile that you want to view.
Step 3  From the Common Device Configuration drop-down list:
  • To associate the IPv6 common device configuration profile with the Gateway trunk, choose the IPv6 common device configuration profile.
  • To associate the IPv4 common device configuration profile with the Gateway trunk, choose the IPv4 common device configuration profile.

Note  Unified CM gateway trunk supports only an IPv4 or IPv6 trunk. You cannot associate a dual stack common device configuration profile to a Unified CM gateway trunk.

Step 4  Enter the IPv6 address in the Destination Address IPv6 field.

Note  Unified CM to Gateway trunk supports only standard SIP Profile and does not support ANAT enabled dual-stack SIP trunk.

Step 5  Save your changes.

Associate the Common Device Configuration Profile with an IPv4 or IPv6 Phone

Procedure

Step 1  From Cisco Unified CM Administration, choose Device > Phone.
Step 2  Click Find.  Choose the trunk profile that you want to view.
Step 3  From the Common Device Configuration drop-down list: choose the IPv6 common device configuration profile.
Configure SIP trunk from Unified Communications Manager to Unified CVP

The following sections describe the steps to configure the SIP trunk from Unified Communications Manager to Unified CVP.

Add a SIP Profile in Unified CM

This option allows a dual-stack SIP trunk to offer both IPv4 and IPv6 media. Perform this procedure for IPv6-enabled deployments only.

Procedure

| Step 1 | From Cisco Unified CM Administration, choose Device > Device Settings > SIP Profile. |
| Step 2 | Click Add New and enter the name of the SIP profile. |
| Step 3 | Check the Enable ANAT check box on the SIP Profile. |
| Step 4 | Save your changes. |

Associate the Dual Stack Common Device Configuration Profile with SIP Trunk

You only need to perform this procedure if you have an IPv6 enabled deployment.

Procedure

| Step 1 | From Cisco Unified CM Administration, choose Device > Trunk. |
| Step 2 | Click Find. Choose the trunk profile that you want to view. |
| Step 3 | From the Common Device Configuration drop-down list, choose the Dual Stack Common Device Configuration Profile. |
| Note | For more information on how to add a Dual Stack Common Device Configuration Profile, see Add a Common Device Configuration Profile in Unified Communications Manager, on page 410. |
| Step 4 | Save your change. |
Gateway Configuration

Configure an Interface to Support IPv6 Protocol Stack

This procedure applies to both the Ingress and the VXML gateway.

Procedure

Configure the following on the Gateway:

> Enable
> configure terminal
> interface type number
> ipv6 address{ ipv6-address / prefix-length | prefix-name sub-bits / prefix-length}
> ipv6 enable

Enable ANAT in Ingress Gateway

Procedure

Configure the following on the Gateway:

> conf t
> voice service voip
> SIP
> ANAT
> bind control source-interface GigabitEthernet0/2
> bind media source-interface GigabitEthernet0/2

Enable Dual Stack in the Ingress Gateway

Procedure

Configure the following on the Gateway:

> conf t
Transcoder Configuration in Unified CM and IOS Gateway

A transcoder is required in the following scenarios:

- An agent logged in to an IPv6 endpoint needs to send or receive transfers from an agent logged in to an IPv4 endpoint.
- An agent logged in to an IPv6 endpoint needs to connect to a VXML Gateway for self service.
- A multicodec scenario to convert a stream from a G.711 codec to G.729 codec.


Configure the CVP Call Server Dial Peers in Ingress Gateway

The Ingress Gateway to Unified CVP outbound dial peer configuration uses the IPv4 address of Unified CVP as the session target.
Network-based Recording Configuration

- CUCM Configuration, on page 415
- Create a Recording Profile, on page 415
- Configure the SIP Trunk from CUCM to Recording Server, on page 416
- Creating a Recorder Route Group, on page 416
- Add a Route Group to a Route List, on page 416
- Create a Route Pattern Based on the DN for the Recorder, on page 417
- Configure the Device Phone for Recording, on page 417
- Enable the Device Phone for Recording, on page 418
- Configure the Ingress Gateway for Recording, on page 418
- Configure the Outgoing Trunk from CVP to CUCM, on page 419
- Gateway Setup for Network-based Recording, on page 419

CUCM Configuration

Network-based recording is configured using Cisco Unified Communications Manager Administration. Network-based recording is controlled by using a recording profile assigned to the line. The recording can be selective or full-time audio-only recording. You can either configure CUBE or phone as the forking device and you can change the forking device during a call.

Create a Recording Profile

Procedure

Step 1 Choose Device > Device Settings > Recording Profile.
Step 2 To add a new recording profile, click Add New.
Step 3 In the Name field, enter a name to identify the recording profile.
Step 4 In the Recording Destination Address field, enter the directory number (DN) or the URL of the recorder that associates with this recording profile. This field allows any characters except the following characters: double quotation marks ("), back quote (‘), and space ( ).
Configure the SIP Trunk from CUCM to Recording Server

Procedure

Step 1 Choose Device > Trunk.
Step 2 To add a new SIP trunk, click Add New.
Step 3 In the Device Name field, enter a unique identifier for the trunk (which is the IP address of the MediaSense recorder).
Step 4 In the Description field, enter a name for the trunk.
Step 5 From the SIP Profile drop-down list, choose Standard SIP Profile for this SIP trunk.
Step 6 In the Recording Information section, click None.
Step 7 Click Save.

Creating a Recorder Route Group

Procedure

Step 1 Choose Call Routing > Route/Hunt > Route Group.
Step 2 In the Available Devices drop-down list, choose a device to add and click Add to Route Group to move it to the Selected Devices list box. Repeat this step for each device that you want to add to this route group.
Step 3 In the Selected Devices drop-down list, choose the order in which the new device or devices must be accessed in this route group. To change the order of devices, click a device and use the Up and Down arrows to the right of the list box.
Step 4 To add the new device or devices, and to update the device order for this route group, click Save.

Add a Route Group to a Route List

Procedure

Step 1 Choose Call Routing > Route/Hunt > Route List.
Step 2 Locate the route list to which you want to add the route group.
Step 3 To add a route group, click Add Route Group.
The Route List Details Configuration window is displayed.

**Step 4** Click Save.

---

**Create a Route Pattern Based on the DN for the Recorder**

**Procedure**

**Step 1** Choose **Call Routing > Route/Hunt > Route Pattern**.

**Step 2** Choose the route list for which you are adding a route pattern.

**Step 3** Click Save.

---

**Configure the Device Phone for Recording**

**Procedure**

**Step 1** From the **Cisco Unified CM Administration**, choose **Device > Phone**. Click **Find** to list the phones.

**Step 2** Click **Find**.

Choose the trunk profile that you want to view.

**Step 3** From the **Association Information** area, click the link associated with your phone.

**Step 4** From the **Recording Option** drop-down list, choose one of the following options:

- **Call Recording Disabled** — The calls that the agent makes on this line appearance are not recorded.
- **Automatic Call Recording Enabled** — The calls that the agent makes on this line appearance are automatically recorded.
- **Application Invoked Call Recording Enabled** — The calls that the agent makes on this line appearance are recorded if an application invokes calling recording.
- **Device Invoked Call Recording Enabled** — This option supports the external call control feature. If the policies on the policy server dictate that a chaperone must monitor and record calls, choose this option.

**Step 5** From the **Recording Profile** drop-down list, choose an existing recording profile.

**Step 6** Set the **Recording Media Source** preference (either Phone Preferred or Gateway Preferred) when enabling recording on the line appearance of the device.

**Step 7** Click Save.
Enable the Device Phone for Recording

Procedure

Step 1  To enable phone-based recording, choose Device > Phone.
Step 2  From the Built In Bridge drop-down list, choose On.
Step 3  If the recorder does not support codecs (for example, G.722, ILIBC), enable Cisco Unified CM to ignore the preference if audio codecs.
   a)  Choose System > Service Parameters.
   b)  From the Server drop-down list, choose the server.
   c)  From the Server drop-down list, choose the service that contains the Accept Audio Codec Preferences in Received Offer parameter.
   d)  From the Accept Audio Codec Preferences in Received Offer drop-down list, choose Off.
   e)  Click Save.

Configure the Ingress Gateway for Recording

Procedure

Step 1  Choose Device > Trunk.
Step 2  In the Device Name field, enter the IP address of the Ingress Gateway.
Step 3  From the Device Pool drop-down list, choose Default.
Step 4  From the Call Classification drop-down list, choose Use System Default.
Step 5  From the Location drop-down list, choose Hub_None.
   The locations feature does not track the bandwidth that this device consumes.
Step 6  From the AAR Group drop-down list, choose None.
Step 7  From the Tunneled Protocol drop-down list, choose None.
Step 8  From the QSIG Variant drop-down list, choose No Changes.
Step 9  From the ASN.1 ROSE OID Encoding drop-down list, choose No Changes.
Step 10  From the Packet Capture Mode drop-down list, choose None.
Step 11  In the Recording Information area, click the This trunk connects to a recording-enabled gateways radio button.
Step 12  Click Save.
Configure the Outgoing Trunk from CVP to CUCM

Procedure

Step 1: To create a new SIP profile for recording, choose Device > Device Settings > SIP Profile.
Step 2: To add a new SIP profile, click Add New.
Step 3: In the Name field, enter a name to identify the SIP profile.
Step 4: In the Default MTP Telephony Event Payload Type field, enter the default value, 101.
Step 5: From the Early Offer for G.Clear Calls drop-down list, choose Disabled to disable Early Offer for G.Clear Calls.
Step 6: From the User-Agent and Server header information drop-down list, choose Send Unified CM Version Information as User-Agent Header.
Step 7: From the Version in User-Agent and Server Headers drop-down list, choose Major and Minor.
Step 8: From the Dial String Interpretation drop-down list, choose Phone number.
Step 9: From the Confidential Access Level Headers drop-down list, choose Disabled.
Step 10: From the SDP Session-level Bandwidth Modifier for Early Offer and Re-invites drop-down list, choose TIAS and AS.
Step 11: From the Accept Audio Codec Preferences in Received Offer drop-down list, choose Default.
Step 12: In the Trunk Specific Configuration section, from the Reroute Incoming Request to new Trunk based on drop-down list, choose Call-Info Header with purpose=x-cisco-origIP.
Step 13: Click Save.

Gateway Setup for Network-based Recording

To set up the gateway for network-based recording, use the following Telnet command:

```
uc wsapi
  message-exchange max-failures 100
  response-timeout 300
  source-address 12.34.56.78 (IP address of gateway)
  probing interval negative 20
  probing interval keepalive 255
provider xmf
  remote-url 1 http://12.34.56787:8888/ucm_xmf (IP address of CUCM)
```

Note: When using ISR G2 for network-based recording, ensure that the VXML Voice Gateway functionality is not enabled on the same gateway.
Java Runtime Environment Minor Update

Use the JREUpdate.bat script to install a minor update of Java Runtime Environment (JRE) version on your Unified CVP Server. For example, you can install a minor update of JRE version 1.7.0_63 to 1.7.0_67.

Download the JREUpdate.zip from the following location:

https://software.cisco.com/download/release.html?mdfid=270563413&softwareid=280840592&release=10.5%281%29&relind=AVAILABLE&rellifecycle=&reltype=latest

Note

The script does not support a major upgrade of JRE versions. For example, the script does not allow a major upgrade of JRE Version 1.7 to 1.8.

Procedure

Step 1
Download and install the preferred Java Development Kit (JDK) version on your personal machine.

Step 2
Copy the JRE folder from the installed JDK to a known location on the Unified CVP Server. For example, C:\JRE.

Note
The jre folder is available in the JDK root folder. For example: C:\jdk1.7.0_67\jre.

Step 3
Right-click the JREUpdate.zip file and extract the files to a known location on your Unified CVP Server. For example, C:\Cisco\CVP\bin.

Step 4
Run this script from the command prompt: C:\Cisco\CVP\bin >JREUpdate.bat apply C:\JRE.
The script runs and Unified CVP JRE is updated to the new version.

Step 5
Ensure that the script output displays the updated JRE version.

The JREUpdate.bat script takes a backup of the old JRE to C:\Cisco\CVP\jre.old folder location. To revert to the previous backup version of JRE, run this script from the command prompt:
C:\Cisco\CVP\bin>JREUpdate.bat revert.
Tomcat Update

Perform the following procedure to update Tomcat version on Call Server, Reporting Server, Operations Console, VXML Server, and Web Services Manager (WSM). For example, you can update from Tomcat version 7.0.24 to 7.0.47.

Before you begin

- Save a backup copy of the Tomcat folder from the following locations:
  - For Call Server: C:\Cisco\CVP\CallServer
  - For Reporting Server: C:\Cisco\CVP\CallServer
  - For VXML Server: C:\Cisco\CVP\VXMLServer
  - For Operations Console: C:\Cisco\CVP\OPConsoleServer
  - For WSM: C:\Cisco\CVP\wsm\Server

  **Note**
  Save a backup copy of the Tomcat folder on a directory path that is different from the default destination folder (C:\Cisco\CVP).

  Rename the Tomcat folders with a different name. For example: Tomcat_backup.

Procedure

**Step 1**
Stop the Tomcat service.

**Step 2**
Remove the Tomcat folder from the following locations:
  - For Call Server: C:\Cisco\CVP\CallServer
  - For Reporting Server: C:\Cisco\CVP\CallServer
• For VXML Server: C:\Cisco\CVP\VXMLServer
• For Operations Console: C:\Cisco\CVP\OPConsoleServer
• For WSM: C:\Cisco\CVP\WSM\Server

Step 3
Download the Tomcat binary apache-tomcat-7.0.47-windows-x86.zip file from the following location: https://archive.apache.org/dist/tomcat/tomcat-7.

Step 4
Right-click the apache-tomcat-7.0.47-windows-x86.zip file and extract the files to a known location on the local drive.

Step 5
Rename the folder apache-tomcat-7.0.47 to Tomcat.

Step 6
Copy the Tomcat folder to the following locations:
• For Call Server: C:\Cisco\CVP\CallServer
• For Reporting Server: C:\Cisco\CVP\CallServer
• For VXML Server: C:\Cisco\CVP\VXMLServer
• For Operations Console: C:\Cisco\CVP\OPConsoleServer
• For WSM: C:\Cisco\CVP\WSM\Server

Step 7
Copy the webapps folder from the Tomcat_backup folder (…\Tomcat_backup\webapps) and paste it in the following folder locations:
• For Call Server: C:\Cisco\CVP\CallServer\Tomcat
• For Reporting Server: C:\Cisco\CVP\CallServer\Tomcat
• For VXML Server: C:\Cisco\CVP\VXMLServer\Tomcat
• For Operations Console: C:\Cisco\CVP\OPConsoleServer\Tomcat
• For WSM: C:\Cisco\CVP\WSM\Server\Tomcat

Step 8
Do not replace the existing jar files. Copy only the missing jar files from the Tomcat_backup folder (..\Tomcat_backup\lib) to the following locations.
• For Call Server: C:\Cisco\CVP\CallServer\Tomcat\lib
• For Reporting Server: C:\Cisco\CVP\CallServer\Tomcat\lib
• For VXML Server: C:\Cisco\CVP\VXMLServer\Tomcat\lib
• For Operations Console: C:\Cisco\CVP\OPConsoleServer\Tomcat\lib
• For WSM: C:\Cisco\CVP\WSM\Server\Tomcat\lib

Step 9
Update the new server.xml files with the existing properties from the backed up server.xml files.

Step 10
For Tomcat upgrade of WSM, ensure the jaas.conf from the backed up Tomcat folder is copied to the new Tomcat/conf folder.

Note
• For Tomcat upgrade of WSM on Call Server VM for CVP, ensure cvp-dp.war is only present in the Tomcat/Webapps folder.

• If the following Context tag is present in server.xml, then comment it out:

```xml
<Context docBase="cvp-config" path="/cvp-config">
  <Realm appName="CVPCallCenterRealm"
    className="org.apache.catalina.realm.JAASRealm"
    roleClassNames="com.cisco.cvp.wsm.cvpconfig.auth.CVPRolePrincipal"
    userClassNames="com.cisco.cvp.wsm.cvpconfig.auth.CVPUserPrincipal"/>
</Context>
```

Step 11
Back up connector.property that was created before starting the process from:.
• For Operations Console:
  C:\Cisco\CVP\OPConsoleServer\Tomcat_backup\bin\connector.property

• For VXML Server:
  C:\Cisco\CVP\VXMLServer\Tomcat_backup\bin\connector.property

Step 12  Restore these to:

• For Operations Console:
  C:\Cisco\CVP\OPConsoleServer\Tomcat\bin\connector.property

• For VXML Server: C:\Cisco\CVP\VXMLServer\Tomcat\bin\connector.property

Step 13  Restart the following Tomcat services:

• Cisco CVP CallServer
• Cisco CVP OPSConsoleServer
• Cisco CVP VXMLServer
• Cisco CVP WebServicesManager

Step 14  Ensure that the CVP Diag portal is up and running.

Step 15  Check Tomcat and CVP logs for any exceptions.
INDEX

A
application report 264, 265, 268

C
contacts report 266

E
engine tasks report 265

R
real-time reports 260, 261, 262, 263, 264, 265, 266, 269
application tasks 265
application tasks summary 264
available reports 260
contact summary 264
contacts 266
engine tasks 265
printing reports 262
resetting statistics 262
running reports 261
sessions 269
setting appearance 263

real-time reports (continued)
setting options 262
viewing subreports 261

S
sessions report 269

T
Tools menu 264, 265, 266, 269, 270, 272
application task summary 264
application tasks 265
contact summary report 264
contacts 266
engine tasks 265
Open Printable Report 270
Options 272
Refresh Connections 270
report 264
Reset All Stats 269
sessions 269
Tools 269
Views 270
Tools meny 271
Settings 271